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HOUDINI FOUNDATIONS

概要
映画、テレビ、ビデオゲーム、VR 向けに 3D アニメーションや VFX を作成する
には、技術的なスキルはもちろん、創造的なスキルも必要です。Houdini は、
これらの世界を 1 つにまとめるのに最適なツールです。コンセプトから最終
的な仕上げまで、プロジェクトを探求、創造、洗練させていくことができます。 

Houdini には、CG コンテンツの生成用に設計されたさまざまなツールが備
わっていますが、Houdini ならではの特徴が、ノードベースのプロシージャル
なワークフローです。このアプローチなら、制御可能なショットの作成、複数
回のイテレーション、期限の遵守の達成が容易になります。Houdini を学習
するときには、ノードやネットワークの扱い方を理解することが成功へのカギ
です。

学習内容
	� この「概要」の章では、重要なコンセプトやアイデアを理解するのに役立つ、
Houdini の基本情報を紹介します。はじめからすべてを理解するのは難し
いでしょう。この章を参照しながら、Foundations チュートリアルを進め、
知識を積み上げていってください。
	� 3D ソフトウェアの使用経験がある方は、そこで培ったスキルを活かせます。Scene View とシェルフツールを
使ってインタラクティブにショットを構築する方法を学んでから、Houdini のプロシージャルな性質を利用する
ためのノードやネットワークの使い方に進みます。 

3D やコンピュータグラフィックスに初めて触れる方にも、Houdini はぴったりのパッケージです。この学習教材
「Foundations」は一定の基礎知識があることを前提としているため、知らない CG の概念については、調べなが
ら読み進めることをお勧めします。Houdini を学習すると、Houdini だけでなく、3D アプリケーション一般につい
て、内部で何がなされているかについての理解が進みます。

「Foundations」のチュートリアルを完了したら、SideFX.com には他のチュートリアルもあります。ぜひ挑戦してく
ださい メインメニューで Learn > Learning Paths を選択すると、SideFX および Houdini コミュニティのメンバー
が作成したレッスンの一覧を確認できます。たくさんのレッスンを用意していますので、Houdini のスキルアップに
お役立てください。

HOUDINI を 
無償でダウンロードする
SideFX が提供する学習用体験版で、レッスン
を実行できます。体験版 Houdini Apprentice 
なら、Houdini の機能を無償で利用できます。 
ただし、レンダリング解像度やユーザインター
フェースの制限、ウォーターマークの追加など、 
制約事項がいくつかある点に留意してください。 
Houdini Apprentice は、SideFX の Web サイトで
ダウンロードできます。定期的に更新される最新
バージョンも、この Web サイトで提供しています。
SideFX.com/download

 独立系のアニメータおよび 
ゲーム開発者
学習用体験版では物足りない方には、Houdini 
Indie がお勧めです。Apprentice のようなウォー
ターマークが追加されないうえ、最大 4K x 4K の
高いレンダリング解像度が可能です。商用利用に
ついては、約 1000 万円以下の収益の用途に制限
されます。 
この Indie ライセンスにより、Houdini は個人プ
ロジェクトやインディゲームの開発に最適なツー
ルとなっています。詳細は以下をご覧ください。 
SideFX.com/indie

ドキュメントバージョン 4.0.1J | 2023 年 8 月 | Houdini 19.5+  
© SideFX Software



Houdini では、すべてがプロシージャルです。つまり、モデリング、	
キャラクタリギング、ライティング、レンダリング、ビジュアルエフェクト
のすべてにおいて、ノードベースのワークフローの恩恵を受け、ノード	
ネットワークを構築するだけで、クリエイティブなタスクに必要とされ
るすべての手順を実行できます。ネットワークは他のネットワークと
「通信」でき、それによってさらに複雑なシステムを構成します。

プロシージャル
Houdini では、ユーザのすべてのアクションがノードとして格納されま
す。ノードはネットワークに「接続」され、「レシピ」を作ります。レシピ
を微調整して繰り返し可能な成果を定義でき、イテレーションごとに	
ユニークな結果を得ることができます。重要な情報をアトリビュートと
いう形で下流に渡すことができるノードの機能が、Houdini のプロシー
ジャルな性質を支えています。

VFX が得意
Houdini がビジュアルエフェクトアーティストを魅了し続けているの
は、パーティクルやダイナミクスを扱うには、このプロシージャルな	
ワークフローが理想的だからです。ビジュアルエフェクトはたいてい、
ショット内で起きるアクションに反応するよう設計されており、プロシー
ジャルなソリューションがそうした反応を「自動化」します。Houdini を
使用すると、スタジオの生産性が向上し、制作プロセスをより詳細に
制御できるようになります。

Houdini はまた、大規模なデータセットを扱えるため、リジッドボディ
の破壊、流体、パーティクルなど、多数のレイヤーが相互作用して	
最終的な結果が作成される、複雑なビジュアルエフェクトにも対応で
きます。

プロシージャルな表現
モーショングラフィックスのプロジェクトでは、プロシージャルなアプ
ローチによって、視覚的に魅力的なエフェクトを豊富に作ることができ
ます。こうした特殊効果の多くは、ノード上でパラメータをアニメート
し、現実にはありえないような面白い方法でノイズを追加することで	
得られます。

幅広い CG パイプライン 
VFX とモーショングラフィックスだけではありません。Houdini は、モデ
リングからレンダリング、キャラクタ制作からゲーム開発まで、パイプラ
インのあらゆる部分に対応できる基本ツールを備えています。Houdini 
のプロシージャルなワークフローは、あらゆる CG コンテンツの作成を
サポートします。その過程では、複数のイテレーションを検討したり、
細部にわたって変更を加えることもできます。

ノードは Houdini ならではの特長であり、パワーの根源ですが、	
ビューポートやシェルフツールも豊富に用意されています。それらを	
インタラクティブに使用しながら、Houdini でネットワークを構築する
ことができます。

Houdini について
Houdini は、モデリング、アニメーション、レンダリング、シミュレーションに使用できる CG（コンピュータグラフィッ
クス）アプリケーションです。Houdini を学習しながら、ノード、ネットワーク、アセットをインタラクティブに操作する
という、制作プロセスの新しい制御方法を探求していきます。
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結果の制御しやすさ
プロダクションの細部まで編集できるのは、Houdini のノードでパラ
メータに変更を加えると、ネットワークを通じて次々に変更が伝達さ
れ、結果が更新されるからです。この制御しやすさは制作プロセス全
体で維持されるため、土壇場で決断をしても、従来の CG パイプライン
のようなコストはかかりません。

ツールの構築
ノードベースのアプローチのもう 1 つの利点は、ノードネットワークを
カプセル化してカスタムノードを簡単に作成できることです。コードを
書く必要もなく、同僚と共有できます。Houdini の再利用可能なネット
ワークは、Houdini Digital Asset と呼ばれる特別なノードに、手間
をかけずに簡単にラップできます。

これらのアセットは、Houdini はもちろん、Autodesk Maya、	
3ds Max、Unreal、Unity などの他のアプリケーションでも Houdini 
Engine プラグインを使用して開けます。アセットのプロシージャルな
性質もそのまま保たれます。

 

全データへのフルアクセス
一般的なアニメーションまたはビジュアルエフェクトのパイプラインで
は、オブジェクトに情報が蓄積されていきます。通常は Velocity、キャ
プチャウェイト、UV テクスチャ座標などのポイントまたはプリミティブ
アトリビュートとして保存されます。他の 3D アプリケーションはこの	
情報を隠し、舞台裏で制御しようとしますが、Houdini にはこうした
データを使用および管理できるツールが備わっています。はるかに	
パワフルで柔軟なアプローチが可能となるため、プロダクション全体
が大きく改善します。

新しい考え方
Houdini を使い慣れると、ショットやゲームレベルに新たな方法でアプ
ローチできるようになり、個人およびチームの生産性が向上します。	
柔軟性に優れた Houdini では、プロジェクトのライフサイクル全体を
サポートするツールを構築できます。また、問題や課題に対処するだ
けでなく、弱点を予測し、さらなる効率化を実現するプロシージャルな
ソリューションを利用できます。 

Andriy Belichenko

Houdini を学ぶことは、今後のプロジェクトへのアプローチ方法を	
再定義するような、多目的なアプリケーションを探求することです。	
この新しい考え方を受け入れ、想像以上の深いレベルで CG の世界を
探求しましょう。 

Houdini ではコードを書く必要がありますか?
いいえ、書く必要はありません! それどころか、他の 3D アプリケーションならコードを書かなければ得られない結果を、
Houdini のノードベースのワークフローのおかげでインタラクティブに作れることもよくあります。Houdini はまさに 
アーティストのためのツールです。スクリプトやエクスプレッションを使用する技術的な側面もありますが、備わっている
ツールだけで驚くべき成果を得られます。また、ノードの仕組みのおかげで、創作プロセスにつきものの試行錯誤も簡単
に行えます。 
コードで作業したい方には、Houdini は Houdini インターフェース内で多くの言語をサポートしています。Wrangle ノード
では VEX と Python を使用でき、PyQT もサポートされています。Houdini のエクスプレッション言語である HScript も 
使用できるうえに、特定のニーズに合わせて混用することも可能です。
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Houdini ワークスペース
Houdini のユーザインターフェースは、他の CG アプリケーションを使用してきたアーティストには馴染みやすい 
でしょう。最大の違いは、ノードとネットワークを管理するペインです。ワークスペースはさまざまに設定可能で、 
作業方法に合わせてセットアップすることができます。

Houdini は、3D シーンを構成する各種要素をさまざまな方法で表示
できます。カメラ越しにジオメトリを見る Scene View や、プロシージャ
ルノードとネットワークを管理するネットワークビューなどを使用して、
各ショットが技術的に機能することを確認しながら、クリエイティブな
決定を下すことができます。 

Radial メニュー
Houdini のツールにアクセスする方法の 1 つに、X、C、V のホットキー
を使ってアクセス可能な Radial メニューがあります。いずれかのホッ
トキーを押すと、Radial メニューが表示され、各種オプションを選択で
きます。各メニューの主な内容は次の通りです。
	� スナップ 	 X
	� メイン 	 C
	� ビュー	 V

Radial メニューの仕組みを理解すると、ウィジェットに頼らずに、	
素早くマウスカーソルを動かすだけでツールにアクセスできます。 

デフォルトで Main と表示されている、メニューバーの上部のカスタム
メニューを変更できます。OS X では、これが Radial メニューです。

シェルフツール
ワークスペースの上部には複数のシェルフがあり、オブジェクト、	
ジオメトリ、カメラ、ライト、エフェクトを作成したり操作できるツール
が多数搭載されています。

これらのツールは Scene View で機能し、多くの場合、何らかの相互
作用を伴います。ツールを使用すると、1 つまたは複数のノードが作成
され、パラメータエディタやネットワークエディタで微調整することが
できます。 
シェルフは、Houdini を使い始めたばかりのアーティストには非常に
重要なリソースです。クリック回数を減らすことができ、配置された	
ノードのネットワークからさまざまなことを学べるためです。

タブメニュー
Scene View またはネットワークビューでツールにアクセスするもう 	
1 つの方法が、Tab キーです。利用可能なツールやノードのメニューが
表示されます。

入力を開始すると、	
対応するツールがメニューに	
表示される

ツールシェルフ - シェルフツールを使用すると、Scene 
View でオブジェクトやジオメトリを操作できます。
ツールバー :
選択モード - シーン、ジオメトリ、またはダイナ
ミックオブジェクトにフォーカスします。

選択ツール - Select、Secure Selection。

トランスフォームツール - ノード固有の 
コントロール用の Move、Rotate、Scale、Pose、 
または Handle ツール。

スナップツール - グリッド、プリミティブ、 
ポイントへのスナップと複数スナップを 
オンにします。
ビューイング - View ツールを使用してタンブル、 
パン、ドリーしたり、Render Region ツールを使用し
て Scene View でレンダリングできます。クリックした
ままにすると、2D パン/ズームに変更できます。

出力ツール - これらのツールを使ってシーンを 
レンダリングしたり、フリップブックを作成できます。
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 3D View ツール
ビュー操作で使用できるホットキーの組み合わせをいくつか紹介しま
す。実際に View ツールを使用している間は、スペースバー/ Alt を	
省略できます。
	�  タンブル	 スペースバーまたは Alt（Opt）+ 左マウスボタン（LMB）
	�  パン	 スペースバーまたは Alt（Opt）+ 中マウスボタン（MMB）
	�  ドリー	 スペースバーまたは Alt（Opt）+ 右マウスボタン（RMB）

View ツールはツールバーにあります。スペースバーまたは Alt キー
を押すと、一時的に View ツールを呼び出すことができます。ビューで	
選択または操作しているときに、視点を素早く変更したい場合には
非常に便利です。 
ビューイングに集中したい場合は、Escape を押すと View ツールに	
移動できます。ビューの操作に使用できる便利なホットキーをいくつか
ご紹介しておきましょう。
	� Home Grid	 スペースバー + H
	� Home All 	 スペースバー + A
	� Home Selected 	 スペースバー + G

 2D パン/ズーム
オペレーションコントロールツールバーにある 2D パン/ズームツール
をクリックすると、3D カメラの位置を変えることなく、2D でのビューを
変更することができます。左上のウィジェットでは、クリックしてパンや
ズームしたり、Ctrl + LMB クリックでビューをリセットできます。これ
は、ロックされたカメラで作業する際に便利なツールです。 

2D パン/ズームウィジェット

Ctrl + LMB でリセット

2D パン/ズームボタン

2D パン/ズーム

LMB ドラッグでパン 
MMB スクロールまたは 
RMB ドラッグでズーム

 一人称視点のカメラ
View ツールでは、ビデオゲームで目にするような、一人称視点の	
フライスルーモードをオンにできます。
	� 一人称視点のオン/オフ	 M
	� ドリーイン/ドリーアウト	 W/S 
	� 右にパン/ 左にパン	 A/D
	� 視点を回転	 LMB

ビューポートディスプレイメニュー
Scene View の右上にあるメニューまたは V Radial メニューを使用し
て、オブジェクトの表示方法やビューの構成を変更できます。

シェーディングメニュー
オブジェクトディスプレイメニュー

ビューメニュー

シェーディングメニュー - Wireframe、Flat Shaded、Smooth 
Shaded、Smooth Wire Shaded などのオプションがあります。
オブジェクトディスプレイメニュー - ネットワーク内に入ったとき、	
ジオメトリを非表示にするか、表示するか、ゴースト表示するかを設定
します。 
ビューメニュー - Scene View をパースビューや正射投影ビューなどの
さまざまなビューに分割できます。

Display Options バー
Scene View の右側にある Display Options バーでは、ビューポート表
示のオプションにアクセスできます。いくつかをご紹介しましょう。

 Reference Plane/Ortho Grid - 参照用やグリッドスナッピングに
使用できるグリッドをオン/オフします。 

 Construction Plane - オブジェクトやポイントの配置場所を定義
するのに使用されるコンストラクション平面をオン/オフします。 

 Lock Camera - 現在のカメラをビューに固定して、ビューを変更
するとカメラのトランスフォーム値も変更されるようにします。

 High Quality Lighting with Shadows - ビューポートレンダリン
グの最高画質を設定します。

 Display Primitive Normals - シーンのすべてのプリミティブに	
属する法線を表示し、その方向を特定します。

Display Options
Scene View とネットワークビューには、それぞれ Display Options 	
パネルがあり、Display Options バーの下部にあるアイコンをクリック
することでアクセスできます。

  Display Options 	 D

ビューポートディスプレイメニュー - オブジェクトの表示方法やビューの
構成を変更できます。
ペインタブ - これらのタブを使用すると、複数のパネルを同時に作成し
たり整理できます。
オペレーションコントロール - このツールバーと Handle ツールを使用
すると、選択したノードのパラメータにアクセスできます。
パラメータエディタ - 選択したノードに値を設定したり、エクスプレッショ
ンを追加したり、キーフレームを設定することができます。
Display Options バー - 法線、ポイント番号、ライティングといった 
シーンのディスプレイオプションを制御できます。
Scene View - 作業内容を視覚化したり、ハンドルを使ってシーン内の 
オブジェクトをインタラクティブに操作できます。
ネットワークエディタ - ノードのネットワークを表示したり管理して、 
シーンの基礎構造を操作できます。
プレイバー - 選択したノードで現行時間を設定したり、キーフレームを 
編集できます。プレイバーを使用すると、キーフレームをコピーアンド
ペーストすることもできます。
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ペインとデスクトップ
Houdini ワークスペースは、シーンデータをユニークな方法で編成した、いくつかのペインに分かれています。 
3D ビューでインタラクティブに作業したり、スプレッドシートでアトリビュート値を分析することもできます。 
こうしたさまざまな UI 要素を有効に利用する方法を学ぶことが重要です。

ペインとペインタブ
Houdini ワークスペースはペインに分割されており、シーンをセット
アップしたり探求できるようになっています。ペインタブを使用すると、
同じゾーン内に複数のペインをオーバーラップさせて、便利な状態に
保つことができますが、デフォルトでは表示されません。
ワークスペースでペインタブをクリックすると、そのペインタブにアク
セスできます。閉じるには X をクリックします。+（プラス）メニューを	
使用すると、表示されているペインを変更したり、新しいペインを追加
することができます。 

ペインタイプ
ペインタブを RMB クリックして、タイプを変更します。たくさんのペイ
ンタイプから選択できます。一部のタイプにはホットキーがあります。
他のタイプのいくつかも、ここにリストしました。すべてのタイプについ
て詳しく確認するには、別途ドキュメントを参照してください。

Network View（Alt + 2） - このビューでは、ノードやネットワークを確認した
り、ニーズに合わせて接続、再接続、再編成を行うことができます。
Parameters（Alt + 3） - パラメータに値を設定したり、エクスプレッションを
追加したり、ノードのプロパティを制御することができます。
Tree View（Alt + 4） - ノードを階層表示します。これは、シーン階層を理解
するのに便利です。

Viewers > Scene View（Alt + 1） - 3D 空間でインタラクティブに作業でき
ます。このタイプのビューでは、1 つまたは複数のビューポートをセットアップ
できます。複数の Scene View パネルを同時に開いて、さまざまな視点から
シーンを見ることが可能です。 

Composite View（Alt + 0） - Compositing（COP）ノードを使用して作成され
た画像やコンポジットを表示します。
Viewers > Motion FX View（Alt + ^） - Houdini のチャンネルオペレータ
（CHOP）ノードを使用して作成されたモーションを表示します。 

Solaris > Scene Graph - Solaris（LOP）ノードを使用する際、USD シーング
ラフを表示します。
Solaris > Render Gallery - テストレンダリングを保存し、すべての画像を
確認した後、各画像の設定に戻すことができます。
Solaris > Light Linker - ライトとオブジェクトを接続します。

Render Scheduler - 完了したレンダリングや進行中のレンダリングを表示し
ます。レンダリングを停止したり、強制終了することができます。
Material Palette（Alt + 7） - シーン内のすべてのマテリアルを表示し、オブ
ジェクトやジオメトリに割り当てることができます。

Animation > Animation Editor（Alt + 6） - キーフレームとアニメーション
カーブを管理できます。アニメーションエディタには、テーブルビューとドー
プシートビューもあります。

Animation > Channel List - チャンネルグループを作成し、Houdini でアニ
メートする際にスコープされたチャンネルを管理できます。
Animation > Autorigs - 二足リグ、四足リグ、フェイシャルリグ用に、独自の
リグをモジュールから構築できるツールにアクセスできます。
Animation > Character Picker - このペインを使用すると、キャラクタリグ
のパーツを簡単に選択できるようになります。
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Inspectors > Geometry Spreadsheet（Alt + 8） - ジオメトリのアトリビュー
ト値を表示します。UV、法線、独自に設定したカスタム値などが含まれます。
Inspectors > Data Tree - Light Bank、Material Stylesheet、Object 
Appearance エディタにアクセスできます。

Mantra Rendering > Render View（Alt + 9） - インタラクティブな Mantra 
レンダリングを開始します。シーン内で変更を加えると、更新されます。
Mantra Rendering > Take List - 特定のパラメータを変更することで、	
さまざまな「テイク」を探求できます。テイクを管理して、気に入ったものに
フォーカスできます。

TOPS > Task Graph Table - グラフ内のすべてのワークアイテム、または	
特定のノードのすべてのワークアイテムのメタデータを表示します。

Misc > Orbolt Asset Browser - Orbolt.com のアセットにアクセスできま
す。このペインを使用するには、orbolt.com アカウントでログインする必要
があります。

Misc > Textport - コマンドを入力できます。
Misc > Python Shell - Python コマンドを入力できます。

ペインの整理と折り畳み
ペインとツールバーは、それぞれの UI にある矢印をクリックすること
で、折り畳んだり展開することができます。ペイン全体は左右に折り畳
むことができ、中央のグリップを使用すると、内容を反転させることも
できます。これらのオプションにより、マウスを 1 回クリックするだけで
他のペインを非表示にし、特定のペインにフォーカスすることが可能
です。

ここをドラッグして分割線を移動 

ここを LMB クリックして上に折り畳む

ここを LMB クリックして下に折り畳む

ここを LMB クリックしてペインを反転
Alt + LMB クリックして向きを反転

ペインメニュー
各ペインの左上には、ペインを最大化、最小化するためのボタンと、
ペインメニューにアクセスするための矢印が表示されています。	
このメニューでは、ペインやペインのコピーを切り離したり、ペインの
削除や分割を行うことができます。また、各ペインの UI を決めるため
のオプションもあります。

デスクトップ
タブを開き、分割線を追加し、ペインタブを整理していくと、自分なり
のワークスペースをセットアップできます。レイアウトを保存するには、
Desktop メニュー（OSX では Windows > Desktop）を使用します。	
このメニューでは、保存したデスクトップにアクセスしたり、独自のデ
スクトップを保存したり、作業中にデスクトップを管理することができ
ます。デスクトップを保存すると、ペインレイアウト、Radial メニュー、
表示されているシェルフセットが保存されます。

シーンを保存した場合、どのデスクトップを見ているかは記憶されま
すが、作業中にペインレイアウトに加えられた変更は記憶されません。
明示的にデスクトップに保存するか、新しいデスクトップを作成しない
限り、これらの変更は消えてしまいます。 

シェルフとシェルフセット
ワークスペースの上部にあるシェルフを管理するには、矢印アイコン
の下に表示されるメニューにアクセスします。このメニューを使用し
て、シェルフセットを操作できます。また、非表示になっているシェルフ
セットをデスクトップに表示させることもできます。

カラー設定
ワークスペースのカラースキームを選択することで、Houdini UI の	
外観をカスタマイズできます。Edit > Color Settings を選択して
オプションウィンドウを表示し、デフォルトのHoudini Dark または 
Houdini Light を選択します。ダウンロードボタンをクリックして、
Houdini コミュニティで作成されたカラースキームのリストから選択し
てもかまいません。 
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ノードとネットワーク
Houdini のノードベースのワークフローは、プロシージャルなアーキテクチャの中核です。Houdini を有効活用する
ためには、これらのノードやネットワークを直接操作できることが非常に重要です。ノードというと専門的に聞こえる
かもしれませんが、実際には非常にアーティストフレンドリーで、使いやすい仕組みです。

Houdini でツールを使用すると、ノードが作成され、他のノードに接続
されます。できあがったネットワークでは、ユーザアクションの履歴が
分かるうえ、変更や微調整を簡単に加えられます。Houdini で作業す
るうえでは、ノードネットワークの効果的な使用方法を学ぶことが重要
です。 

ノードフラグ
各ノードには、表示されているか、ロックされているか、バイパスされてい
るかを表すさまざまなフラグがあります。フラグそのものをクリックするか、
Radial ノードメニューを使用して、フラグを設定できます。

Bypass の切り替え

情報ボックス

Freeze の切り替え

Display の切り替え

Template の切り替え

 Display フラグ （R） - このフラグを使用すると、表示させる出力ノードを
選択でき、ノードは中空のリングでハイライトされます。

Render フラグ （T） は、レンダリングに出力されるノードを設定します。その
ノードは塗りつぶされた円でハイライトされます。Display フラグとは別にこ
れを設定するには、Display フラグを Ctrl クリックします。

 Template フラグ （E） - このフラグは、ノードをグレーで表示します。	
参照やスナップに使用することができます。 

 Freeze フラグ - ロックされたノードでキャッシュ化します。ネットワーク
がクックされるとき、チェーン内の前のノードはすべて無視されます。

 Bypass フラグ （B） - ネットワークがクックされるとき、このフラグを設定
したノードは無視されます。 

ノードの接続と接続解除
ビューポートで作業するとき、多くの場合、ノードは自動的に配置、	
接続されます。ネットワークを再編成したい場合は、ノードの接続と	
接続解除を手動で行う必要があります。
ネットワークエディタでノードを扱ったり接続する方法をいくつか紹介
します。
	� ノードの接続 	 出力から入力を LMB ドラッグ
	� 複数ノードの接続	 J を押しながら複数のノード間をドラッグ
	� 新しいノードの挿入 	 出力またはワイヤー上を RMB
	� ノードの挿入	 LMB ドラッグしてワイヤー上にドロップ
	� ワイヤーからの接続解除 	 LMB でノードを選択して振る
	� ワイヤーの切断	 Y を押しながらワイヤーを横切るようにドラッグ
	� ノードの移動	 LMB ドラッグ
	� 選択したノードのコピー	 Alt + LMB ドラッグ
	� 参照コピー	 Alt + Shift + Ctrl + LMB ドラッグ

ドットを使ってネットワークを整理できます。
	� ドットの追加 	 ワイヤーを Alt + LMB
	� ドットのピン留め /ピン解除	 ドットを Alt + LMB

ノードギャラリー
ギャラリーでは、ネットワークに直接追加したいノードに素早くアクセ
スすることができます。ギャラリーには、日常の作業でよく使用するノー
ドが含まれており、すべてのノードに Tab キーでアクセスできます。
Windows > Gallery Manager を使用して独自のギャラリーを作成し
たり、ノードを RMB クリックしてから Save to Gallery... を選択する
ことで、ギャラリーにアイテムを追加できます。 
Mat ネットワークに保存されたノードは、Mantra マテリアル用の 
Mantra  のように適切なキーワードが用いられている限り、Material 
Palette でも利用可能です。

ネットワークパス - 現在のネットワークレベルまで
のパス。このバーを使用して他のネットワークに 
移動することも可能です。

ペインメニュー - ネットワークを整理するための 
メニューとアイコン。

ネットワークの背景 - ペインメニューを使用して、
画像を追加したりグリッドをセットアップし、 
ノードを整理しやすくすることができます。

ネットワークボックス - 関連するノードをグループ
化します。素早く折り畳んだり展開することができ
ます。

ステッキーノート - メモを追加して、他のアーティ
ストがネットワークを簡単に理解できるようにした
り、説明を加えたりします。

ノードギャラリー - ここからネットワークにノードを
ドラッグできます。下部のフィルタを使用して、 
必要なノードを見つけられます。

ネットワークビュー
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ネットワークタイプ
Houdini にはさまざまな種類のノードがあり、それぞれが独自のコン
テキストで機能します。ネットワークタイプは、ネットワークビューの右
上に表示されます。各タイプのノードは、他のネットワークに接続する
ことができます。ノードタイプが違っても接続方法は同様ですが、それ
ぞれ固有の働きをします。
	� シーン	 オブジェクト 	 OBJ
	� ジオメトリ	 サーフェスオペレータ	 SOP
	� Solaris	 ライティング/レイアウトオペレータ	 LOP
	� マテリアル	 VEX Builder 	 MAT
	� Motion FX	 チャンネルオペレータ	 CHOP
	� VEX	 VEX Builder	 VOP
	� 出力	 レンダリングオペレータ	 ROP
	� タスク	 タスクオペレータ	 TOP
	� ダイナミクス	 ダイナミクスオペレータ	 DOP
	� コンポジット	 コンポジットオペレータ	 COP/IMG

Houdini を使い続けるうちに、このノードタイプを語る「秘密」の言語を
理解し、それをプロシージャルに適用する方法が分かるようになるは
ずです。

ネットワークパス
ノードは階層的に編成されており、ネットワークマネージャまたはサブ
ネットワークと呼ばれる、別のノードにネスト化されている場合もあり
ます。これらの階層を管理しやすくするために、ほとんどのペインの上
部にはブラウザのようなパスが表示されています。

親ノード

バック/フォワードボタン

パス階層

パスの 
ピン留めコンテナノード

  ターゲットを別のペインにドラッグ

このパスを使用して、階層を上下に移動したり、他のネットワークに	
移動することができます。デフォルトでは、Scene View で選択すると	
パスが変化しますが、パスをピン留めしてフォーカスを保持することも
可能です。また、ピン留めしたペインにターゲットアイコンをドラッグ
し、パスを同期させることもできます。 

ネットワークナビゲーション
ネットワークタイプ間の移動には、さまざまな方法があります。Scene 
View でオブジェクトを操作しながら自然の流れで行う方法もあれば、
素早く移動できるショートカットカットもあります。 

選択モード - Scene View で選択すると、ネットワークエディタが選択
した位置にジャンプします。選択モードによって、選択する際のネット
ワークタイプが変化します。
ネットワークパス - 親ノードを LMB クリックして、上のレベルに移動
できます。コンテナノードを LMB クリックすると、同じレベルのノード
にアクセスしたり、他のコンテナノードの中に入ることができます。

Radial メニュー - N を押して Radial メニューを開き、ネットワーク内を上下
に移動したり、別のネットワークタイプに移動することができます。
ホットキー - 以下のホットキーを使ってネットワーク内を移動しながら、選択
したオブジェクトを使用できます。
	� ノードの中に入る	 I
	� 上のレベルに移動する	 U
	� オブジェクト/ ジオメトリを切り替える	 F8
	� 前または次のネットワークに切り替える 	 Alt +  または Alt +  

クィックマーク - ネットワークロケーションを設定して、素早くその	
ロケーションに戻ることができます。必要に応じて使用でき、後で上書
きも可能です。忘れても問題ありません。シーンファイルには保存され
ません。
	� クィックマークの設定 	 Ctrl + 1, 2, 3, 4 または 5
	� クイックマークに戻る 	 1, 2, 3, 4 または 5
	� 前のビューに戻る	 `

選択と表示のホットキー
ネットワークエディタでは、パンやズームしながらネットワーク全体を
操作する必要があります。これらのアクションに使用するキーの組み
合わせを紹介します。
	� パン 	 MMB
	� ズーム	 RMB
	� ノードの選択 	 LMB
	� 追加選択 	 Shift + LMB
	� 選択解除 	 Ctrl + LMB

ノードを詳しく知る
Radial メニューを使用するか、 
ノードをMMB クリックして情報ボッ
クスを表示します。このパネルでは、
ノードの内容、グループ、 
アトリビュートに関する情報や、 
その他の重要事項について確認で
きます。また、ワークフローに影響
しているエラーも表示されます。

このパネルは自動的に閉じますが、
ピンアイコンをクリックすると、 
作業中も表示したままにできます。
このパネルを使ってコメントを追加
し、ネットワークビューに表示させ
ることができます。 

ノード - ネットワークの最終出力に寄与するオペレーショ
ンを表します。

ネットワークタイプ - どのネットワークタイプで作業して 
いるかを示します。

ワイヤー - どのようにノード同士がつながり、どのように 
データがネットワーク内で渡されているかを示すラインです。

ドット - ドットを追加すると、ノードを整理しやすくなります。

表示リング - この小さい円は、Scene View にどのノード
が表示されているかを示します。

レンダーリング - この大きい円は、表示されているノード
に関係なく、レンダリングノードを示します。

コメント - 他のアーティストがネットワークを理解しやすい
よう、ノードのコメントを表示できます。

パレット - メニューのボタンを使用して、ノードの色や形状
を設定できるパレットを表示できます。 
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パラメータ、チャンネル、アトリビュート
Houdini のすべてのノードは、希望の結果が得られるよう、パラメータ、チャンネル、アトリビュートによって 
駆動されます。Houdini で使用されている用語は、他の3Dアプリケーションとは異なる場合があります。 
時間をとって、Houdini での用語の意味を理解することをお勧めします。

パラメータ
パラメータとは、Houdini ノードの値、スライダ、ボタン、チェックボッ
クスのことを指します。これらは他のアプリケーションでアトリビュート
と呼ばれる場合もありますが、Houdini ではアトリビュートを別の意味
で使用します。
パラメータ値は、パラメータエディタで、またはビューポートでハンドル
を使用して変更することができます。各パラメータには RMB メニュー
があり、コピー、ペースト、デフォルトに戻すといった重要なオプション
が多数用意されています。

 パラメータの検索
ノードには多数のパラメータがあり、すべてを見ていくのは時間がかか
ります。右上の虫眼鏡をクリックすると、検索バーが表示され、名前と
内容に基づいてパラメータをフィルタリングできます。エクスプレッショ
ン、オーバーライド、さらにはパラメータ値そのものを使用して、パラ
メータを見つけることができます。

チャンネル | キーフレーム
パラメータにキーフレームを設定するには、Alt キーを押しながら、	
名前または値のフィールドを LMB クリックします。キーフレームを	
設定すると、パラメータのフィールドの色が変わり、アニメートされた
チャンネルが作成されます。キーフレームがパラメータに関連付けら
れ、アニメーションエディタでアクセスできるようになります。

チャンネル | エクスプレッション
値そのものではなく、hScript  または Python  を使用して、パラメータ
にエクスプレッションを追加することもできます。パラメータエディタの
右上に、使用する言語を選択できるメニューがあります。Ctrl + Eを	
押すと、スクリプトツールを多数備えたエクスプレッションエディタが
表示され、作業が容易になります。

シーンデータの参照
パラメータを RMB クリックして、Reference > Scene Data を選択す
ると、参照したいものを具体的に選択できるウィンドウが表示されま
す。シーン内の任意のノードから選択して、チャンネル参照を作成でき
ます。この方法なら、正確な構文で適切なエクスプレッションを書く苦
労なしに、参照を作成できます。

ナビゲーションバー - このバーでは、ノードがシーン
階層のどこに位置しているかを確認できます。
ノードのタイプと名前 - ノードタイプとノード名が 
表示されます。アイコンをクリックすると、ノードを
使用するためのメニューが表示されます。
検索バー - 虫眼鏡のアイコンをクリックすると、 
名前や内容でパラメータを検索できます。
パラメータの変更 - パラメータがデフォルトから 
変更されると、値が太字で表示されます。フォルダ 
タブ名も太字になります。
アニメーションパラメータ - パラメータにキー 
フレームを設定すると、緑でハイライトされます。
パラメータのロック - パラメータを RMB クリックして、 
ロックしたりロック解除できます。グレーでハイライト 
されます。
選択してマッチ - これらのアイコンを使用すると、 
パラメータ値を他のオブジェクトにマッチさせる 
ことができます。 

パラメータエディタ
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カスタムパラメータ
パラメータエディタの右上にあるギアアイコンをクリックすると、	
Edit Parameter Interface を選択できます。このウィンドウでは	
カスタムパラメータを追加して、ノードネットワークの他の部分に	
リンクすることができます。

アトリビュート
アトリビュートを使うと、ジオメトリにデータを取り付けられます。	
そのデータは、オペレーションを完了するまでチェーン内のノードで
順に使用されます。fuel アトリビュートは Pyro FX シミュレーションを
駆動し、UV アトリビュートはテクスチャリングをセットアップします。
Houdini ノードによって作成されるアトリビュートも、独自に作成する
カスタムアトリビュートもあります。 

クラス - アトリビュートは、ポイント、プリミティブ、ディテール、頂点に属し
ます。これは、チェーンでどのように使用されるかに影響します。 
タイプ - 浮動小数点、整数、文字列のアトリビュートタイプをセットアップでき
ます。

ATTRIBUTE RANDOMIZE
Attribute Randomize を使用すると、アトリビュートを作成し、その値
を即座にランダム化することができます。例えばこの例では、ボックス
の色、回転、スケールがランダム化されています。 

Attribute Transfer
ノードチェーン内で、アトリビュートはジオメトリに取り付けられ、	
他のノードでも使用されます。Attribute Transfer を使用すると、	
他のジオメトリピースにアトリビュートを渡すこともできます。この例で
は、球が定義された閾値に基づいて、ボックスにカラーアトリビュート
を渡しています。 

ATTRIBUTE WRANGLE
Houdini には、アトリビュートを作成したり使用するための多様な	
ノードがあります。Attribute Wrangle ノードを使用すれば、スクリプ
トベースのアプローチを取ることも可能です。これは、多くのテクニカ
ルディレクタが非常にやりやすいと感じる方法でしょう。 

アーティストにとっては、ノードを使用した方がこうした情報を扱いや
すいものです。Houdini を有効活用するには、アトリビュートを適切に
使用することが重要であり、いずれはアトリビュートについて学ぶ必要
がある時がきます。

Geometry Spreadsheet
Geometry Spreadsheet では、非表示のものも含め、 
すべてのアトリビュート値を確認できます。

ナビゲーションバー - このバーでは、ノードが
シーン階層のどこに位置しているかを確認 
できます。

ノード名 - どのノードが現在選択され、これらの
アトリビュート値を生成しているかを示します。

Attribute Class ボタン - これらのボタンを使用する
と、表示する属性の種類をフィルタリングできます。

ポイント番号 - ジオメトリのポイント番号は、モデル
上でのアトリビュートの位置を特定しやすくします。

アトリビュート値 - ノードネットワークチェーンの
このポイントでの値です。

フィルタ - 多くのパラメータを使用している場合
は、ここにパラメータ名を入力すると、リストを
フィルタリングできます。
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ジオメトリの選択
Houdini での作業では、さまざまな要素を選択して操作する必要があります。ポイント、エッジ、プリミティブなどの
オブジェクトやジオメトリコンポーネントを効率的に扱うためのツールやオプションが多数用意されています。

  Select ツール
Select ツールを使用すると、選択に集中でき、操作ハンドルは表示さ
れません。 
	�  Select ツール	 S

Move や Rotate ツールを使用する場合や、Secure Selection が
オンのときは、Select ツールを呼び出して選択する必要があります。
Secure Selection をオフに切り替えると、自由に選択できるようにな
ります。
	� 他のツールの使用中に Select ツールを呼び出す	  S を押したままにする 
	�  Secure Selection の切り替え 	 ~

選択タイプ
追加選択、選択解除、選択/選択解除の切り替え、すべて選択、なに
も選択しないなど、さまざまホットキーがあります。これらのテクニッ
クは、Houdini ワークフローで重要な役割を果たします。
	� 選択 	 LMB
	� 追加選択	 Shift + LMB
	� 選択解除	 Ctrl（Cmd）+ LMB
	� 選択 / 選択解除の切り替え	 Ctrl（Cmd）+ Shift + LMB
	� すべて選択	 A（オブジェクトレベル）/ N（ジオメトリレベル）
	� なにも選択しない	 N（オブジェクトレベル）/ Shift + N（ジオメトリレベル）

選択テクニック
ビューポートでは、4 種類の選択タイプのいずれかでジオメトリにアク
セスできます。
	�  Box Selection	 F2
	�  Lasso Selection 	 F3
	�  Brush Selection	 F4
	�  Laser Selection	 F5

選択フィルタを使用して、可視のジオメトリにフォーカスしたり、グルー
プを選択したりすることもできます。選択を容易にするオプションが、
多数用意されています。
	�  Select Visible Geometry Only	 Shift + V
	�  Select Fully Contained Geometry Only	 Shift + C
	�  Select Groups または Connected Geometry	 9
	�  Select Whole Geometry	 オペレーションコントロールツールバーで選択
	�  Select by Normals	 オペレーションコントロールツールバーで選択

選択モード
選択モードを使用すると、オブジェクトやコンポーネントを選択できるよ
うになります。ツールバーのボタンやホットキーを使用すれば、オブジェ
クトレベルからジオメトリレベルに簡単にジャンプすることも可能です。 
オブジェクト - オブジェクトネットワークレベルは、オブジェクトのトランス
フォームを操作する場所です。View ツール以外のツールでは、次のホット
キーでオブジェクトレベルに戻ることができます。
	�  オブジェクト	 1

ジオメトリ - Viewツール以外では、次のいずれかのホットキーを使用すると、
選択したコンポーネントが選択可能な状態になっているジオメトリレベルに
ジャンプすることができます。
	�  ポイント 	 2
	�  エッジ	 3
	�  プリミティブ（フェース）	 4
	�  頂点 	 5

 TWEAK モード
同時にアクティブにできるジオメトリ選択モードは、1 つだけです。
Edit ノードで作業している場合は、Tweak モードでポイント、エッジ、
プリミティブの組み合わせを選択することができます。 

選択モードのメニュー
各選択モードには、シーンにどのように 
作用するかを変更できるオプションが用意
されています。これらのオプションにアクセ
スするには、各モードのアイコンを LMB  
クリックまたは RMB クリックします。

コンポーネントを扱う場合、このメニュー
では Show Display Operator または 
Show Current Operator を選択できま
す。Edit ノードを使用しているとき、これら
のオプションは Scene View の上部でも 
利用可能です。 

オブジェクトレベルでは、このメニューは 
異なります。オブジェクトの種類に応じた
フィルタや、マテリアル、拘束、デジタル 
アセットをより簡単に選択するためのオプ
ションが含まれています。

エッジループ - エッジループを選択するには、エッジを
選択した状態でダブルクリックします。不完全なループ
を選択するには、一方の端を選択して A を押してから、
もう一方の端のエッジを選択します。これは、ポイント
やプリミティブでも機能します。同じテクニックを使用
して、ポイントループやプリミティブループも選択する
ことができます。 

選択タイプ - 上部のバーにあるこのオプションを使
用して、選択のタイプを変更できます。Box、Lasso、
Brush、Laser のいずれかを選択できます。フィルタオ
プションもいくつかあります。

編集 | コンポーネント - これらのボタンから、どのコン
ポーネントを作業するかを選択します。ここではエッジ
選択がオンになっています。

Secure Selection - 他のツールを使用する間、現在の
選択をロックします。これがオンの状態で Select ツー
ルを呼び出すには、ホットキー S を押したままにします。

Select ツール - Select ツールを使用して選択すること
ができます。ホットキーの S を押してアクセスできます。

選択オプション
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選択コンポーネントのツールでの扱い
ビューポートでポイント、プリミティブ、またはエッジを選択してから
ツールを使用すると、ノードが作成され、選択がノードの Group パラ
メータにリストされます。 

例えば、ここではプリミティブ 5、6、9、10 が polyextrude  ノードで
使用されていることが分かります。Group ノードにリストされ、フェー
スを押し出すのに使用されているのを確認できます。

 

入力ジオメトリノードのトポロジを変更した場合、フェースの数が増減
したり、押し出しの場所が移動することがあります。このような場合は、
必要に応じてフェースを再選択します。

これを行うには、polyextrude  を選択し、Enter を押して Handle 
ツールに移動してから、̀  を押して再選択モードに切り替えます。	
新しいプリミティブを選択してから Enter を押すと、新しい選択が 
Group パラメータで使用されます。

すべて選択と Group フィールド
入力ジオメトリのすべてのプリミティブを選択するには、Group パラ
メータを空のままにします。入力ジオメトリのトポロジが変更された
場合も、ノードがすべて処理してくれます。 
ビューポートですべて選択（N）を使用すると、ツールの使用時、通常こ
のフィールドは空のままになります。一部のツールでは、Group フィー
ルドに選択したすべてのパーツが表示されるので、手動でフィールドを
クリアして空にしなければなりません。

Group ノード
Group ノードを使用すると、ポイント、頂点、ポリゴン、エッジの選択
を名前で定義し、参照することができます。グループの定義は、ビュー
アでコンポーネントを選択するか、範囲やエクスプレッションを使って
数学的に行います。その後、ポイント番号やプリミティブ番号を使う	
代わりに、Group パラメータにグループ名を割り当てます。

 

使用可能な Group ノードをいくつか紹介します。
	� Group Create - インタラクティブな選択、境界ボックス、フェースの	
法線の向き、エッジの角度を使用して、グループを作成します。

	� Group by Range - 範囲とシンプルなパターンを選択して、グループを	
作成します。 

	� Group Expression - VEX エクスプレッションを使用して、グループメン
バーシップを定義します。
	� Group Paint - インタラクティブなペイントインターフェースを使用して、
グループ化するジオメトリを選択します。

シェーディングオプション - Scene View に
何を表示するかを決定します。ここでは 
Smooth Wire Shaded が選択されています。

RMB メニュー - Select ツールの使用時、 
このメニューでは選択の反転、境界の選択、
選択の拡大と縮小などの選択オプションに 
アクセスできます。

ディスプレイフィルタ - ボーン、Null オブ
ジェクト、ライト、カメラなど、必要ないも
のを非表示にして、作業に集中できるよう
にすることができます。

Display Options - 選択モードは、選択し
やすいようにエッジやポイントを示してくれ
ますが、他のツールの使用時、それらは表
示されません。これらのオプションを使用す
ると、特定のモデリングツールを使用してい
ないときでも、さまざまな要素を表示した
ままにすることができます。 
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トランスフォームと編集
オブジェクトの基本のトランスフォームツールから、アニメーションリグの Pose ツール、ジオメトリを形状変更する 
Edit ノードまで、ビューポートでインタラクティブなハンドルを使用できる各種ツールが用意されています。 
Houdini では、これらのハンドルは、作業中のノードと密接に結びついています。 

トランスフォームツール
トランスフォームツールでは、ハンドルを使用してオブジェクトを操作し
たり、ジオメトリの形状を変更します。オブジェクトをトランスフォーム
すると、オブジェクトレベルのパラメータが更新され、変更内容が反映
されます。 
	�  Move	 T
	�  Rotate	 R
	�  Scale	 E
	�  Pose	 Ctrl + R
	�  Handle	 Enter

Handle ツールを使用すると、選択したノード特有のハンドルが表示さ
れます。これらのツールを使用している間は、S を押したままにするこ
とで再選択できます。新しく選択したら S を放して、トランスフォームを
続けます。

トランスフォームハンドル
Move ハンドルを使用すると、1 軸または 2 軸で移動したり、中心を	
使用してカメラ平面に沿って移動することができます。Rotate ハンド
ルと Scale ハンドルでも同様の操作が可能です。

1 軸

2 軸

カメラ平面
（3 軸）

 

MMB 移動
ハンドルを直接クリックしたくない場合は、空きスペースで中マウスボ
タンをクリックしながらドラッグすると、コンストラクション平面に沿っ
て移動できます。最も近い軸に沿って移動するように変更するには、
Edit > Preferences > Handles で Translate Handle を Map Drag 
to Axis に設定します。 

MMB 上下にドラッグ
Preferences が  
Map Drag to Axis に 
設定されている場合、 
Y 軸に沿って動く

  POSE ツール
アニメートするときは、Pose ツールを使用してボーンを操作したり、	
オブジェクトの動きを示すモーションパスハンドルを表示します。	
その後、接線ハンドルやキーフレームを使用して、ビューポートで動き
を変更します。 

モーションパス
ハンドル

IK ハンドル

編集 | コンポーネント - これらのボタンを 
使用して、編集したいコンポーネントを選択
します。ここでは Points オプションが選択さ
れています。

Move ツール - Move ツールでは、Scene 
View のハンドルを使用して選択を移動でき
ます。

Move ハンドル - 矢印を使用すると 1 軸で 
移動でき、正方形のドットを使用すると 2 軸
で移動することができます。ハンドルを RMB 
クリックすると、ハンドルオプションが表示さ
れます。

Soft Edit Radius - サーフェス上のポイント
を移動するとき、この半径値を使用して、 
ソフトな減衰を作成できます。プリミティブま
たはエッジでは、Soft Edit Radius は機能し
ません。

ジオメトリの編集
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  Edit ノード
ジオメトリコンポーネントを移動しようとすると、Edit ノードが配置さ
れ、トランスフォームを受け入れます。ジオメトリのトランスフォームだ
けでなく、サーフェス上を滑るようにしたり、法線に対して垂直にトラン
スフォームしたり、Sculpt を適用することも可能です。
	�  Edit	 T/R/E
	�  Slide on Surface	 L
	�  Peak	 H
	�  Sculpt	 B

ソフトな減衰
ポイントをトランスフォームするとき、Soft Edit Radius 使用すると減
衰を作成できます。ビジュアライザが呼び出され、サーフェス上のどこ
で減衰が発生しているかを確認できます。

Peak ハンドル

Soft Edit  
ビジュアライザ

Soft Edit HUD

EDIT オプション
Edit ノードを RMB クリックすると、選択をトランスフォームするための
オプションが表示されます。選択を円にしたり、まっすぐにすることが
できます。これらのオプションは、ポイントとエッジに対して機能します
が、プリミティブに対しては機能しない場合もあります。
	� Make Circle	 Shift + C
	� Evenly Space Selection	 Shift + E
	� Relax Selection	 Shift + R
	� Straighten Selection	 Shift + S

  Handle ツール
シェルフツールを使った後は、たいてい Handle ツールに切り替えら
れています。また、ネットワーク内のノードを選択し、Scene View で 
Enter キーを押しても、Handle ツールに切り替わります。これにより、
polyextrude ノードの distance  パラメータなど、選択したノード特有
のパラメータにフォーカスしたハンドルが表示されます。 
Show Current Operator - デフォルトでは、表示ノード以外のノードを選択
すると、それが現行ノードとなり、ジオメトリのワイヤーフレームが表示され
ます。その後、ハンドルを使用してこの中間ノードを操作しながら、シェーディ
ングサーフェス上で結果を評価できます。 

Show Display Operator - もう 1 つのオプションは、表示オペレータを常に
表示します。この場合、チェーン内のノードを選択してもワイヤーフレームは
表示されず、ハンドルは表示ノードにフォーカスしたままになります。

パラメータは現行ノードのパラメータエディタで変更できますが、	
ハンドルは表示ノードのパラメータで機能し続けます。 

ハンドルオプション
すべてのハンドルにメニューがあり、
任意の部分を RMB クリックすること
でアクセスできます。

このメニューには、ハンドルを整列し
たり、ノードのパラメータから切り離
したり、Pivot Mode に設定するなど
のオプションが用意されています。 
これらのオプションを使用して、ハン
ドルの動作をカスタマイズできます。

また、ハンドルのパラメータすべてを
キーフレームに設定したり、ハンドル
の全パーツをデジタルアセットにプロ
モートすることもできます。パラメー
タをプロモートすると、アセットレベ
ルでハンドルにアクセスできるように
なります。

シェーディングオプション - Scene View に何を表示す
るかを決定します。ここでは、Smooth Wire Shaded 
が選択されています。

Sloppy Selection - Edit ノードが Sloppy 選択を使用
している場合、3 つのコンポーネントボタンを同時に選
択することができます。これらすべてのボタンを使用し
たより流動的な選択プロセスが可能です。

RMB メニュー - フォーカスしたい編集のタイプなど、
Edit ツールオプションにアクセスできます。Scene View 
の上部のバーでもこの情報を利用可能です。

コンポーネントの選択 - このメニューを使用してコン
ポーネントタイプを選択できます。メインツールバーに
もこれと同じオプションがあります。

Edit オプション - Make Circle や Straighten 
selection などのオペレーションを使用して、 
コンポーネントを編集できます。
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モデリングツール
Houdini には、ジオメトリを作成、形成、変形して目的の外観にするツールが多数用意されています。 
ここでは、Houdini のジオメトリ（SOP）コンテキストでモデルを構築する際、よく使用する各種ツールのうち 
一部を取り上げます。

作成
ジオメトリの作成は、基本形状を使用するか、カーブを描画すること
から開始します。いずれの場合も、そのツール名のオブジェクトが作
成され、その内部にジオメトリ/ SOP ノードが含まれます。ツールには 
Create シェルフまたは Radial メニューからアクセスできます。

 プリミティブ - Houdini には、Box、Sphere、Tube、Torus プリミティブ	
形状と、さまざまなプラトン立体があります。

 Grid - Grid ツールは、多様なモデルの出発点として最適です。ジオメトリ
レベルで形状とサイズを設定できます。

 Curve - コントロールポイントを配置しながらカーブを描画し、その後 
Bezier、NURBS、またはポリゴンカーブを作成します。

ポリゴンモデリング
ポリゴンは、最も一般的なジオメトリタイプの 1 つで、中でもビデオ
ゲームプロジェクトでは必須です。Houdini には、モデルの開発に	
使用できる、包括的なポリモデリングツールセットが含まれています。

 PolyDraw - このツールを使用すると、コンストラクション平面で、または
既存のジオメトリにスナップすることで、インタラクティブにポリゴンメッシュ
を描画できます。

 PolyExtrude - 1 つまたは複数のポリゴンを押したり引いたりして、ジオ
メトリの形状を変更します。押し出しのプロファイルを制御して、さまざまな
形状を得られます。 

 PolyBevel - 選択したエッジにベベルをかけて、まっすぐな面取りや丸い
面取りを作成します。通常、Polyxtrude や Boolean などの前のノードの出力
グループを使用して、適切なエッジを自動的に見つけられます。

 PolyBridge - ブリッジの形状を制御しながら、2 組のポリゴンをつなげ
ます。

 PolySplit/Edge Loop/Knife - これらのツールを使用すると、ポリゴンを
分割してモデルにディテールを追加できます。

 PolyExpand 2D - 2D 平面上のカーブやエッジを取り込み、任意のオフ
セット値に基づいてジオメトリを作成します。

 PolyReduce - 四角形トポロジと UV を維持したままポリゴン数を減らす
ことで、異なるレベルのディテールを作成できます。

 PointWeld - ポイントのグループを他のターゲットポイントにインタラク
ティブにスナップさせ、それらを結合します。

ユーティリティノード
Houdini はプロシージャルなため、コピー、クリップ、ミラーなどの	
モデリングアクションを行うと、ネットワークにノードが作成されます。
この仕組みにより、後で戻って変更を加えるのも簡単にできます。 

 Clip - クリッピング平面を基準にモデルを切断します。クリップの方向を
設定したり、片側、もう片側、または両方を保持するかどうかを選択できます。

 Mirror - クリッピング平面を基準にジオメトリを反転します。ミラー後に
ポイントを結合するオプションがあります。

 Copy and Transform - トランスフォーム値に基づいて複数のコピーを
作成します。

 Blast - モデルからポリゴンを削除します。選択したポリゴンを削除するか
保持するかを選択できます。ポイントまたはポリゴンを選択している状態で 
Delete キーを押すと、それらを削除できます。

 Dissolve - 周囲のジオメトリを壊すことなく、エッジを削除できます。	
エッジを選択した状態で Delete キーを押すと、そのエッジを削除できます。

 サブディビジョンサーフェスモデリング
Houdini では、ポリゴンでモデリングした後、オブジェクトのパラメータ
エディタの Render タブにあるオプションを使用して、サブディビジョ
ンサーフェスとして表示したりレンダリングすることができます。また、
ジオメトリレベルで Subdivide ノードを作成し、ポリゴンを追加すれ
ば、よりディテールの多いトポロジで作業できます。

 

サーフェス化ツール
Houdini には、プロファイルカーブを受け取ってサーフェスを構築する
ツールがあります。入力カーブは、Bezier、ポリゴン、NURBS カーブの
いずれか、またはそれらの混合です。

 Revolve - 軸を基準にプロファイルカーブを回転させて、ジオメトリを作
成します。結果はハンドルを使って微調整できます。

 Skin - 複数のカーブを受け取り、それらをサーフェスに変換します。
 Rails - 1 つまたは複数のプロファイルカーブを 1 つまたは複数のレール

カーブに沿ってコピーしてから、結果をスキン化してサーフェスを取得します。
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  BOOLEAN
Boolean ツールを使用すると、ジオメトリの減算（Subtract）、	
結合（Union）、交差（Intersect）を計算できます。このノードは非常に
複雑なトポロジを扱うことができ、サーフェスを分解して、リジッドボ
ディダイナミクスを用いた破壊を作成することができます。多くの場合、
ボロノイベースの Shatter ノードよりもリアルな結果を得られます。 

Boolean ツールは出力グループを作成し、それを使って Polybevel 
ノードなどの他のノードに接続できます。こうすることで、Boolean に
対する更新は、2 つ目のノードに渡されたタイミングで適切に更新され
ます。 

変形ツール
ポイントを直接編集してジオメトリを形づくることもできますが、より	
汎用的なアプローチが必要な場合もあります。次のノードは、ジオメト
リをプロシージャルに形成するためのオプションを備えています。

 Bend - キャプチャ範囲と方向を設定して、含まれるジオメトリに対して	
曲げ、捻じり、テーパ、収縮などを適用します。

 Lattice - ジオメトリの周りにラティスを構築し、ケージ上のポイントを	
編集してジオメトリの形状を変更できるようにします。カスタムのケージも	
使用可能です。

 Mountain - ノイズ関数を適用してサーフェスを変形し、ランダムな結果
を作成します。このノードでは、ポイントが実際に動かされます。

 Ripple - ジオメトリに波紋の形状を作成します。
 Waves - ノイズ関数を追加して、時間の経過に応じてアニメートされる、

波のようなパターンを作成します。リアルな海を作成するのに最適です。

  COPY TO POINTS + SCATTER AND ALIGN
一般な Houdini ワークフローでは、サーフェス上にポイントをばら撒
いて整列させてから（Scatter and Align）、ポイントにコピー（Copy 
to Points）します。その後、オブジェクトをスケールしたり回転するた
めのアトリビュートを適用すると、有機的な結果が得られます。これは、
木や岩を含む風景を作成する際によく使用される方法です。 

  TOPOBUILD
Houdini の TopoBuild ノードを使用すると、Pixologic の ZBrush よう
なアプリケーションでスキャンしたり作成した高解像度のジオメトリに	
直接ポリゴンを描画できます。アニメーション用のクリーンなトポロジを
作成してから、元のモデルのディテールを法線マップにベイクできます。 

  ボリューム
ボリュームには、空間内のボクセル（3 次元ピクセル）の値を格納でき
ます。ダイナミクスツールを使用する際の衝突をサポートしたり、雲を
作成するためによく使われます。また、モデリングでは、複数の形状を 
1 つのボリュームにまとめ、それを変換してサーフェスに戻すことも可
能です。

 

ジオメトリタイプ
Houdini は、プリミティブ、ポリゴン、NURBS、Bezier など、さまざまなジオメトリタ
イプをサポートしています。こうしたタイプ間の変換が可能であり、1 つのオブジェクト
内で複数のジオメトリタイプを結合することもできます。 
ポリゴンモデルは、Pixar の OpenSubdiv 標準を使用して、サブディビジョンサー
フェスとして表示およびレンダリングするようセットアップすることができます。サブディ
ビジョンと NURBS は両方とも、テッセレーション設定に依存することなく、Karma と 
Mantra で非常に滑らかにレンダリングされます。
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UV とテクスチャ
2D マップを 3D オブジェクトに適切にフィットさせるには、ジオメトリの平坦化したビューを定義する UV 座標が必要
です。Houdini で最初にジオメトリを作成したときには、UV はありません。プリミティブオブジェクトにも、組み込み
の UV はありません。これは、1 つまたは複数の SOP ノードを使用して、ジオメトリレベルで UV を追加する必要が
あることを意味します。

UV テクスチャの表示
Houdini のジオメトリには、デフォルトでは UV テクスチャアトリ
ビュートがセットアップされていないため、UV ツールを使用して
追加する必要があります。UV をセットアップすると、Display Options 
バーの Show UV Texture がオンになり、ジオメトリにテクスチャグリッ
ドが表示されます。UV テクスチャを表示したくない場合や、カラーテク
スチャに変更したい場合は、オフにします。 

UV PROJECT
このノードでは、いくつかある投影テクニックの 1 つを使用して、UV 
を割り当てます。投影タイプを選択したら、オブジェクトに合わせて
投影を初期化します。これにより、UV が反転される場合があるため、
Rotate X の値を 90 ではなく -90 に設定する必要があります。上の図は 
Orthographic（正投影）、下の図は Toroidal（ドーナツ状）投影です。 

UV FLATTEN
UV Flatten は、選択したエッジまたはエッジグループで事前定義した
境界を基に、ジオメトリをアンラップ（展開）します。UV ビューでポイン
トをピン留めしたり、希望するルックになるよう島を調整して、結果を
微調整できます。 

threedscans.com より、彫刻のスキャン

UV Edit と UV Distortion
個々の頂点や頂点グループを編集するには、UV Edit または UV 
Transform ノードのいずれかを使用します。UV Edit ノードは 1 つの	
ノードで大量の編集を行えますが、UV Transform は 1 つのノードで行え
る編集は 1 つです。そのため、よりプロシージャルな結果を得られます。
UV ビューポートメニューで Display > UV Distortion を選択すると、	
どの程度多くの編集を加えたかを確認できます。

UV LAYOUT
UV Layout は、UV 島を作成し、可能な限り効率的に UV 空間内に	
詰め込みます。ジオメトリ上で利用されるテクスチャ量が最大化され、
レンダリングとゲームプレイの両方を最適化できます。

領域ハンドルを使用して、UV レイアウトを UV 空間の特定の部分に	
配置できます。後続のレイアウトがこのレイアウトを避けるようにする
には、Pack Island in Cavities of Other Islands オプションを使用
します。 

UDIM
使用できるのは単一の UV タイルだけではありません。UDIM を使用	
すると、UV を多数のタイル上に拡張できます。このテクニックでは、
UV 島が密接に詰め込まれないため、ディテールの豊富なテクスチャ
マップを作成できます。テクスチャマップに適切に番号が付けられ、	
適切なタイルに割り当てられます。
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UV アトリビュート
前の項では、ジオメトリにアトリビュートを割り当てて、重要な情報を
ネットワークに伝えられるのだと学びました。UV は、テクスチャマップ
をモデルにラップできる頂点アトリビュートで、同じようにネットワーク
に伝達されます。 
これらのアトリビュートは UV ビューポートで視覚化され、Geometry 
Spreadsheet で分析されます。このようなアトリビュートは、上級 TD 
がスクリプトを使用して UV を管理するための Attribute Wrangle ノー
ドをはじめ、さまざまなな SOP ノードで使用できます。

UV セット
同一ジオメトリに複数の UV セットを作成できます。UV ノードを使用する
ときに、UV アトリビュートを設定します。デフォルトでこれは uv ですが、
uv2 を作成して、2 つ目のセットを作成することも可能です。異なる UV 
セットは、VOP でテクスチャを割り当てるときに使用します。これにより、
テクスチャマップごとに異なる UV アトリビュートを使用できます。

上の 2 つの画像では、1 つ目は Toroidal（ドーナツ状）投影で uv  UV ア
トリビュートに割り当てられていますが、2 つ目は Orthographic（正投
影）でuv2  UV アトリビュートに割り当てられています。これらの UV ア
トリビュートには任意の名前を付けることができ、例えば uv2  ではな
く bob  としてもかまいません。

UV ビューポートメニュー
UV ビューポートメニューを使用すると、UV アトリビュートに基づいて 
UV を表示できます。また、このメニューでは背景画像を確認すること
もできます。背景画像は、デフォルトの UV グリッドか、割り当てられた
マテリアルから引き出されたテクスチャマップです。 

このメニューには、UV Overlap、UV Backfaces、UV Distortion と
いったディスプレイオプションもあります。これらのオプションは、UV 
を評価して、さらに微調整が必要かどうかを判断するのに役立ちます。

ATTRIBUTE TRANSFER
アトリビュートの管理に使用できる SOP ノードの 1 つである Attribute 
Transfer を使用すると、あるジオメトリの UV アトリビュートを、
Proximitity（近接度）に基づいて別のジオメトリに転送することができ
ます。 
これは、モデルのトポロジを変更したが、元のモデル用に UV を作成し
た際の作業内容を保持したい場合に便利です。

現行ツール - Scene View の 
上部には、Handle ツールが 
アクティブであれば、選択した
ノードが表示されます。

背景 - メインタイルの背景は、 
UV メニューのオプションを使用
して設定できます。

メインタイルの外側 - 複数の 
タイルをカバーする UDIM を使用
しない限り、テクスチャが繰り返
されるため、メインタイルの外側
の領域に配置されたポリゴンは
メインタイル上の同じ領域とオー
バーラップします。

SCENE VIEW | UV

UV メニュー - UV ビューにいると
き、このメニューには UV に 
関連したさまざまなオプションが
表示されます。

ビューメニュー - このメニューでは、
このビューポートに表示するの UV 
ビューを選択できます。

レイアウトハンドル - このハンドル
は、UV Layout ノードの一部です。
タイルの特定の部分の UV に集中
できます。

既存データを基準とした詰め込み 
- UV が既に設定されている既存の
ジオメトリの周囲に、UV を詰め込
みます。 
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ルックデブ : シェーダとマテリアル
シーン内のオブジェクトをレンダリングするには、シェーダとも呼ばれるマテリアルをジオメトリに割り当てる必要が
あります。Houdini では、これらのマテリアルやシェーダは Material/Vex Builder ネットワークで作成されます。 
ノードを使用してマテリアルを構築する機能は、ショットのルックを定義する際の強力なツールとなります。

Houdini では、さまざまなタイプのノードをいくつかのネットワーク	
タイプに分けていますが、マテリアルの場合は /mat ネットワークタイ
プを使用します。ここでは、Karma と Mantra 向けの VEX オペレー
タや、Karma 向けの Material X をセットアップすることができます。
MaterialX は、Lucasfilm® が開発したオープン規格で、アプリケーショ
ンとレンダラ間でルックデベロップメントコンテンツを転送するために
使用されます。 

MATERIAL PALETTE
Material Palette を使用して VEX ベースのマテリアルを追加し、	
クリックアンドドラッグでオブジェクトに割り当てることができます。	
このペインには、シーン内のマテリアルを管理するワークスペースが	
あり、Material Library LOP など、サブネットワークを表すタブに分
かれています。Tab キーを使用して、MaterialX シェーダをマテリアル
ネットワークに追加できます。配置すると、Material Palette に表示さ
れるようになります。

LOP でのマテリアルの割り当て
Solaris LOP コンテキストでマテリアルを割り当てるには、まず /mat  
ネットワークを含む Material Library LOP を作成します。このノード
を使用するか、下流で Assign Material LOP を使用して、マテリアル
を割り当てられます。Material Palette では、ギャラリーからライブラ
リにマテリアルをドラッグできます。LOP では、矢印ボタンを使ってシー
ングラフのマテリアルリストにアクセスできます。

Principled Shader
Material Palette には、Brent Burley 氏による Disney "principled" 
BRDF（Disney 原則 BRDF）をベースとしたマテリアル、Principled 
Shader が含まれています。このシェーダは、アーティストが扱いやす
いように、物理的ではなく「原則に基づいた」ものになっています。
Principled Shader は、Base Color、Bump、Normal、
Displacement などのパラメータに直接テクスチャを割り当てられるよ
うになっています。割り当てたテクスチャマップはビューポートに表示
され、簡単にさまざまなルックを実現することができます。 
このマテリアルは他の VOP に接続することで拡張可能ですが、それが
必須なわけではありません。ギャラリーに含まれるマテリアルの多く
は、このシェーダのバリエーションです。

PRINCIPLED SHADER CORE
Principled Shader Core ノードは、Principled Shader 内にあり、
シェーディングモデルの主な機能を含んでいます。ただし、すべての	
テクスチャリング機能を搭載しているわけではありません。 
このノードを使用してゼロから堅牢なシェーダを構築するには、
Houdini のシェーダ構築ツールを使用して VOP ノードを追加する	
必要があります。このためには、ノードビューでノードを接続したり、
Shader FX メニューを使用してノードを追加したりします。

MATERIAL PALETTE

ギャラリー内のマテリアル -  
ここにリストされるマテリアルは、
ディスク上のギャラリーファイル
に保存されています。右側のシー
ン領域か、ビューポートのオブ
ジェクトにドラッグできます。
シーン内のマテリアル - ここには
シーンファイルの一部であるマテ
リアルが表示されます。ここから
ビューポートにドラッグすること
で、オブジェクトに割り当てること
ができます。
Material Library LOP -  
LOP コンテキストでセットアップ
されたマテリアルは、Material 
Library に配置できます。ギャラ
リーからここにマテリアルをドラッ
グすることができます。

Update Material アイコン - 
すべてのマテリアルアイコンを
更新するには、このボタンを 
クリックします。1 つずつ更新
するには、マテリアルを RMB 
クリックします。

マテリアルの割り当て - シーン
内のオブジェクトとパレット内 
のマテリアルを選択すると、 
このボタンを使用してマテリア
ルを割り当てることができます。

ダブルクリックして編集 -  
いずれかのマテリアルをダブル
クリックすると、ノードビューに
ジャンプして、/mat レベルで
編集できるようになります。
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マテリアルのレイヤー化
オブジェクトをユニークなルックにするために、マテリアルをレイヤー
化することができます。Layer Mix ノードを使用して 2 つの異なるマテ
リアルを組み合わせ、1 つのルックを作成します。例えば、このテクニッ
クを使って光沢のある金属マテリアルとマットな錆マテリアルをレイ
ヤー化することが可能です。そうしておいてから、アルファチャンネルを
テクスチャ化し、サーフェスあるいはディスプレイスメント、またはその
両方を組み合わせたマテリアルを設定します。

MATERIAL BUILDER
レイヤー化したノードを新しいマテリアルに変換したい場合は、ノード
を選択して、Edit > Collapse Selected into Material を選択します。
これにより、ノードが Material Builder 内に配置され、引き続き微調
整を行えます。このレベルでは、output  と collect  ノードがあり、ネッ
トワークを効率的に動作させることができます。

デジタルアセットとしてのマテリアル
マテリアルを Houdini デジタルアセットとして保存することで、マテリ
アルをさらに効率化できます。Asset Properties ペインで、Save タ
ブに移動して Save Cached Code を選択すると、Mantra でレンダリ
ングするときにマテリアルが事前にコンパイルされます。また、テクス
チャマップをデジタルアセットに読み込んで、アセットファイル内からそ
れらを参照することも可能です。マテリアルを HDA に変換することで、
チームとの共有が容易になります。

SHADER FX メニュー
マテリアル VOP を使用するときは、ネットワークビューでノードを追加
して接続するか、各パラメータの右端にあるアイコンをクリックすると
表示される Shader FX メニューを使用します。このメニューを使用す
ると、作業したいパラメータにフォーカスして、コンテキストでノードを
作成できます。

パラメータエディタで、右端のアイコンから各パラメータの接続タイプ
を確認できます。
	� 接続なし	  
	� Parameter ノード	  
	� 他のノードと接続	  
	� 非表示の接続	  

プロシージャルなマテリアルの割り当て
多くのデータを扱うプロダクションでは、多くの場合、プロシージャル
なアプローチでマテリアルを割り当てる必要があります。Solaris や 
Karma でこれを実現するには、Assign Material LOP や Material 
Variation LOP などのノードを使用します。 
Mantra を使用している場合、Data Tree パネルを使用してマテリア
ルをオブジェクトに割り当てることができ、このペインから Material 
Stylesheets にアクセスできます。スタイルシートでは、ルールを使用
して大規模なオブジェクトグループにマテリアルやテクスチャを割り当
てられます。 

シェーダ構築

ノードパス - 現在のパスを確認でき、
マテリアルネットワーク内を移動しや
すくなります。

VOP ノード - マテリアルコンテキスト
では、マテリアルノードから開始し、
VOP ノードを接続して、マテリアルの
テクスチャリングをカスタマイズしま
す。完了したら、すべてを折り畳んで 
Material Builder ノードに戻すこと
ができます。

ノードコネクタ - ドットを MMB ク
リックしてアクセスする Shader FX 
メニューを使用して、この領域にノー
ドを追加できます。ドットを RMB ク
リックすると、完全なノードメニュー
が表示されます。

Principled Material - 単体で割
り当てたり、Layer Mix に接続で
きる代表的なマテリアルです。

Layer Mix - マテリアルでのレイ
ヤー出力は、このミックスノードに
送ることができます。これをジオメ
トリに割り当てられます。

Material フラグ - レイヤーのミッ
クスを Material Palette に表示さ
せたい場合は、このフラグをオン
にします。

アルファ - ここでは、VOP ノード
が Layer Mix ノードのアルファを
送り、2 つのレイヤーマテリアルの
アルファマスクを作成しています。
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Solaris : レイアウト
Solaris は、ルックデブ、レイアウト、ライティングに特化した Houdini のコンテキストで、USD が中核にあります。
このコンテキストに取り込まれたオブジェクトやジオメトリは USD となり、専用のノードを使用してオブジェクトの 
配置、ジオメトリのインスタンス化、ショットレイアウトの管理などを行えます。

SOLARIS : LOP
Solaris 環境を使用するには、/stage ネットワークに移動するか、
LOP ネットワークを作成します。ここに、ジオメトリの取り込み、マテリ
アルの割り当て、ライトやカメラの追加を行うためのノードが配置され
ます。これらのノードでは、共有アセットを使用してシーケンスやショッ
トを作成したり、プロシージャルな編集ノードで各ショットの設定を	
カスタマイズすることができます。

その中核において、Solaris 環境はすべてを USD（Universal Scene 
Description）に変換します。USD は、PIXAR によって作成されたオー
プンソースイニシアティブです。Solaris/LOP コンテキストでは、プロ
シージャルノードで USD をネイティブに使用し、参照、ペイロード、	
レイヤー、コレクション、バリアント、詳細レベルといった USD の概念
を管理できます。

LOP ネットワークは、Karma または他の Hydra 互換レンダラを使用し
てレンダリングできます。Hydra は、USD をビューポートにレンダリン
グしてインタラクティブに探求したり、最終レンダリングとしてディスク
上にレンダリングするためのテクノロジです。

SCENE IMPORT : オブジェクトを LOP に
Houdini のオブジェクトレベルでレイアウトやライティングを扱うことに
慣れたアーティストは、Scene Import LOP ノードを使用すると、ジ
オメトリ、ライト、カメラを簡単に LOP に取り込んでレンダリングでき
ます。制御された USD シーングラフを作成したい場に合は、別のアプ
ローチをお勧めしますが、Karma や他のレンダラに素早くアクセスす
るには Scene Import ノードが役立ちます。

USD 用にアセットを準備
Component Builder LOP ネットワークまたは USD Export SOP を
使用して、プロップを構成する方法もあります。ジオメトリとマテリア
ルをプロップごとにセットアップしてから、レイアウト段階で使用できる
ように USD として書き出します。 

 

プロップの一部には、バリアントを使用して、レイアウト時に選択する
バリエーションを複数作成します。この USD の概念をセットアップでき
る LOP ノードがあります。
USD としてプロップをセットアップしたら、そのファイルを Sublayer 
や Reference LOP を使用してより大きいレイアウトシーンファイルに
取り込み、Edit LOP を使ってプロップを配置します。アセットが適切
に準備されていれば、ジオメトリ、マテリアル、バリアントがセットアッ
プされ、準備が整った状態のアセットを使用できるようになります。

SOLARIS デスクトップ
ステージ - ステージビューは、
レイアウトやライティングを確
認したり、プリミティブ、ライト、
カメラをインタラクティブに操
作して適切にセットアップする
ための場所です。
ビューポートレンダー -  
ステージでは、Houdini GL ま
たは Storm を使用して、USD 
GL ソリューションをレンダリン
グできます。また、Karma や 
Hydra 準拠のサードパーティ製
レンダラにインタラクティブにレ
ンダリングすることも可能です。
シーングラフ - USD 構造は、 
レンダリング可能なシーングラ
フを提供し、このパネルを使用
してグラフを検査できます。

Stage Manager - この 
ノードは、USD ファイルを 
読み込んで、ステージ上に
配置することができます。

LOP ノード - LOP のすべて
のアクションは、プロシー
ジャルノードを使って実現 
されるため、簡単に戻って
変更を加えられます。

Scene Graph Details - 
シーングラフでアイテムを 
選択すると、詳細を確認し、
パイプラインでのステータス
を把握できます。
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STAGE MANAGER
Stage Manager は、ディスク上の USD アセットを参照したり、それら
を 3D 空間でトランスフォームしたり、シーン階層を調整するためのワ
ンストップノードとして設計されています。これには、入力レイヤーを
平坦化し、上流からの変更をブロックすることも含まれます。この柔軟
性の欠如は、迅速なセットアップが可能という利点によってバランスさ
れています。

物理ベースの編集 
すべてのプロップをステージに読み込んだら、Edit LOP を使用してプ
ロップを移動することができます。編集は別の非破壊レイヤーとなり、
参照されたアセットは元のまま残るので、後で戻る必要がある場合も
安心です。

Edit LOP の Use Physics オプションをオンにすると、Houdini のリ
ジッドボディの機能を利用して衝突を検出したり、オブジェクトをリア
ルに配置できるようになります。3D ビューでインタラクティブに作業し
ながら、自然で有機的なルックを実現できます。

インスタンス化
USD には、LOP で利用できるインスタンス化ソリューションがあります。
Instance LOP では、1 つまたは複数のオブジェクトを入力して、LOP 
内でセットアップしたポイントに分散させることができます。これらの
ポイントは、シーンからジオメトリをインポートし、モデルから抽出した
サーフェスにポイントをばら撒くことで作成されます。
マテリアルは、さまざまな方法でインスタンスに割り当てることができ
ます。その方法の 1 つである Material Variation LOP では、ジオメト
リごとにレンダリングプロパティを設定することも可能です。

また、Layout Asset Browser と Layout LOP を使用すると、ブラウ
ザで選択したアセットを参照するインスタンスポイントをブラシワーク
フローで配置、編集、トランスフォームすることができます。

USD への書き出し
LOP グラフのさまざまなポイントで、ノードを RMB クリックして LOP 
Actions > Inspect Active Layer を選択することで、USD コードを
検査できます。また、平坦化したステージを検査することも可能です。
USD に書き出すときは、すべてのレイヤーを分解することも、平坦化
した単一のグラフとして保存することもできます。

シーングラフ
Stage - LOP を作成するため
のトップレベルのネットワーク
コンテキストです。 
また、この作業のすべてを 
LOP ネットワークで行えます。
Scene Graph Path - これら
は、ステージのルックを定義す
る USD レイヤーおよびサブレ
イヤーを表します。ほとんどの
場合、ディスク上のさまざまな 
USD ファイルがショットから 
参照されています。
Primitive Type - それぞれの
プリミティブに、タイプ、つまり
挙動を定義するスキーマがあ
ります。これは、各レイヤーの
ステージに対する寄与を特定
するのに役立ちます。

Draw Mode - パス内の任
意の要素の表示を、Full 
Geometry、Bounding Box、
Textured Cards のいずれかに
変更できます。
ディスプレイオプション -  
各レイヤーの可視性やアク
ティベーションを設定できま
す。シーングラフから何かを 
削除することはできないため、
非表示にしたり非アクティブに
する必要があります。 
Variants - レイヤーにバリア
ントがある場合は、選択され
ているものがここに表示され
ます。
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Solaris : カメラとライト
ショットをレンダリングする前に、カメラ越しにシーンを見て、シーンを照明する必要があります。Solaris/LOP  
コンテキストは、レイアウト、ルックデブ、ライティング、Karma によるレンダリング、オブジェクトレベルでは  
Mantra によるレンダリング向けに設計されており、ライトとカメラをセットアップできます。

  カメラ
カメラは、LOP Lights and Cameras シェルフからアクセスができま
す。シェルフツールで Alt クリックすると、現在のビューがカメラビュー
に変わります。ネットワークビューで Camera ノードを作成した場合
は、ビューポートの左上にある No cam メニューをクリックすると、	
カメラ越しに見られるようになります。 

カメラを調整するには、別のビューから、またはカメラ越しに見ながら、
カメラハンドルを使用して操作します。Display Options バーには 	

 lock camera to view ボタンがあり、View ツールを使ってカメラ
の位置を変更できます。

 このオプションはオンのままにしないでください。オンのままにする
と、ビューを変更しただけでカメラビューが変わってしまうことになり
ます。気に入ったカメラビューは、トランスフォーム値をロックして、
ビューを変更しても失われないようにすることをお勧めします。

カメラプロパティ
LOP コンテキストのカメラには、カメラの画像生成方法を決める主な
プロパティがあります。 
View タブ
	� Projection - 遠近法または正投影のどちらにするかを選択します。
	� Focal Length - 焦点距離を選びます。値が小さいほどワイドなショット
（広角）に、値が大きいほどロングショット（望遠）になります。
	� Horizontal/Vertical Aperture - 絞りは、カメラに入る光の量を制御す
るゲートです。

Sampling タブ
	� Shutter Open/Close - シャッターを開いておく時間を決定します。	
この設定は、モーションブラーに影響します。
	� Focus Distance - カメラから焦点平面までの距離。Depth of Field を	
使用している場合には、どのオブジェクトを鮮明に見せる（焦点にする）	
かを決定します。
	� F-Stop - レンズの絞り。デフォルトは 0 で、焦点の範囲を無効にしてい
ます。

Shift + F を押すと、焦点平面が表示され、どのようにジオメトリと交
差しているかが分かります。カメラ越しに見ているときに、サーフェス
を Shift クリックまたはドラッグすると、そのポイントと交差するように
焦点平面を動かせます。カメラ視点外のときは、焦点平面上のハンド
ルを使用してその平面を動かし、被写界深度を設定します。

焦点平面の表示 
 （Shift + F）

サーフェス上を  
Shift クリック

ライティングセットアップ

ビューポートレンダリング -  
ライティングを決定するには、
Karma または RenderMan や 
Arnold などのレンダラを使用し
てビューポートでレンダリング
できることが重要です。 
HoudiniGL も使用できますが、
これらのメインレンダラほど効
果的ではありません。

ライトハンドル - カメラと同じ 
ように、一歩下がってビュー内
のライトを操作します。専用の
コントロールを使用して、カメ
ラビューでライトを設定するこ
とも可能です。

Primitive Path - USD シーン
グラフ内のライトの場所を設定
します。

ライトタイプ - このメニューで
は、ライトタイプを選択します。
Light LOP では、すべての 
ライトタイプにアクセスでき、
切り替えもできます。

ライトパラメータ - 円錐角や 
強度など、ライトのプロパティ
を制御するパラメータが幅広く
用意されています。

Light LOP ノード - ライトは
個々に、LOP ノードとしてネッ
トワークに追加されます。
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  ライト
ライトにはシェルフからもアクセスでき、同様のハンドルを使って配置
できます。Houdini には、さまざまなライトタイプが用意されています。
 Point Light - ポイントから全方向にライトを放出します。電球にも似た、

いわゆる点光源です。 
 Spot Light - 円錐形のライトのビームを、ポイントから特定の方向に放射

します。
 Area Light - 指定した領域上に、たくさんの光源を自動的に分散します。

Line、Tube、Grid、Disk、Sphere の 5 つの形状のエリアライトから選択でき
ます。

 Geometry Light - ジオメトリオブジェクトのサーフェスシェーダを使用し
て色を付けたライトを、シーンに放出します。

 Distant Light - 平行光線を放射します。このライトは、太陽光線に似て
います。

 Environment Light - 半球または球の環境からのライトをシーンに投影
します。 

カメラビューでのライティング 
Light または Light Mixer LOP を選択および表示している場合、カメ
ラ越しに見ながら、ライトのプロパティの多くを設定することができま
す。Specular（Shift + S）、Diffuse（Shift + D）、Shadow（Shift + F）
オプションを使用すると、シーン内のサーフェスをクリックしてライトを
セットアップできます。 

LMB クリックして 
ピボットを配置

Shadow モード 
（Shift + F）

Shift + LMB クリック 
してターゲットを配置

その後、Ctrl ドラッグして、ショットからライトの距離を変更したり、
Ctrl + Shift ドラッグして明るさを変更することができます。ビューポー
トでこうした操作を行うと、ハンドルをドラッグするために離れる必要
がないため、作業中のショットに集中できます。

LIGHT LINKER
ライトを特定のオブジェクトにリンクするのは、ショットのライティング
を制御するのに最適な方法です。Solaris では、Light Linker LOP を
使用してリンクできます。このノードには、オブジェクトとライトを接続
するためのインターフェースが含まれています。

ライトコレクションを使用すると、プリミティブとライト間の相互作用を
定義したルールを用いて、より効率的にリンクを適用できます。 

ライトのインスタンス化
Solaris/LOP コンテキストでは、Houdini のプロシージャルなジオメト
リノードを使用してポイントを作成し、それらのポイントにライトをイン
スタンス化できます。その後、ポイントにアトリビュートを追加して、例
えば、輝度を順に変化させて、レトロなマーキー看板のようなエフェク
トを作成することができます。このアプローチなら、ライトをセットアッ
プしやすいうえ、エフェクトを追加したり、ショットのニーズに合わせて
変更することも非常に簡単です。

LIGHT MIXER
ライトリスト - このリストには、ミキ
サーに接続しているすべてのライトが
表示されます。
コレクション - ライトをコレクション
にまとめると、ミキサー内でグループ
として機能させることができます。
ソロ - 星アイコンをクリックすると、
ライトまたはコレクションをソロにす
ることができます。
強度スライダ - 1 つ目のスライダで、
ライトまたはライトコレクションの強
度を制御できます。
露出スライダ - 2 つ目のスライダは、
露出を制御します。強度の微調整に
利用できます。
ライトカラー - ここをクリックして、 
ライトまたはライトコレクションに色
付けします。
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レンダリング
ショットをレンダリングするとは、カメラとライトを使用して 3D オブジェクトをデジタルで撮影し、 
画像または画像シーケンスを生成するようなものです。ゲームアーティストは、ゲームのシネマティクスのために 
レンダリングすることもあれば、高解像度から低解像度のオブジェクトにテクスチャをベイクするために、 
レンダリングすることもあります。

KARMA
Karma は物理ベースのレイトレーサーで、Solaris/LOP コンテキストで 
USD ファイルを扱えるよう設計されています。CPU 上で動作し、ディス
プレイスメントおよびサビディビジョンサーフェスのためのアダプティブ
（適応型）テッセレーション、マルチセグメントのモーションブラー、	
インスタンス化、ヘアーとファー、強力なボリュームレンダリングの	
サポートといった機能を備えています。 
Karma は、USD イメージングフレームワークである Hydra で機能し
ます。ビューポートで使用してインタラクティブに更新したり、Karma 
ノードを使用してディスクにレンダリングすることができます。

Karma は、VEX、USD Preview、Material X で作成したシェーダを扱え
ます。 

Karma XPU
Houdini 19.5 には、Karma XPU レンダリングエンジンのベータ版が
含まれています。この GPU/CPU のハイブリッドレンダラは、アルファ版
としてリリースされています。多くの機能は開発中であるため、この	
エンジンはテスト目的でのみ使用します。XPU は、Scene View の 
Display Options、または Karma ノードで選択できます。

Karma XPU では、USD Preview シェーダと Material X を扱えますが、
VEX には対応していません。

サードパーティ製レンダラ
USD をサポートする Solaris では、RenderMan、Autodesk Arnold、
V-Ray、Maxon RedShift、AMD ProRender といった他の Hydra 	
デリゲートにレンダリングすることが可能です。

 

ビューポートレンダリング
Karma レンダラの主な利点の 1 つは、パースビューで使用できること
です。Karma を選択することで、インタラクティブなレンダリングが	
可能となり、Solaris/LOP コンテキストでライティングやルックデブに	
関する決定を下すことができます。

 

ビューポート | KARMA

レンダリング設定 - Karma LOP を使用して
レンダリング設定を定義し、ディスクにレンダ
リングできます。ここでは、ディスクにレンダ
リングする際のパスや、カメラ設定などを設
定します。

Karma LOP - Karma LOP を Solaris ノード
ネットワークの終端に追加します。この LOP 
のさまざまなバージョンを使用することで、 
テストレンダリングや最終ショットなど、それ
ぞれ異なる結果をセットアップできます。

MPlay - Karma と Mantra の両方から 
MPlay に直接レンダリングできます。または、
ディスクにレンダリングしてから MPlay で 
開き、結果を確認することも可能です。 
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レンダリング設定
ステージをレンダリングするときは、ビューポートのレンダリング設定
を使用します。レンダリングの最終的なルックを作成するには、Karma 
LOP を使用してフレーム範囲、カメラ解像度、デノイザ、より高画質の
レンダリング設定を設定します。 

RENDER GALLERY
Render Gallery を使用すると、スナップショットを撮って進行状況を
確認できます。各スナップショットには、ルックのすべての設定が含ま
れ、そのスナップショットと合致するようにシーンをいつでも戻すことが
できます。スナップショットにはラベルが付けられ、フィルタリングでき
るので、アクセスも簡単です。 

MANTRA
Mantra は、Solaris が導入される前に開発された Houdini のレンダラ
です。ジオメトリ、インスタンス、ボリュームの高効率なレンダリングが
密に統合された、物理ベースのレンダリングエンジンですが、Solaris/
LOP では動作しません。 

出力ノード
ショットをレンダリングするには、レンダリング出力ノードを作成する
必要があります。このためには、Render > Create Render Node > 
Mantra - PBR を選択します。 

また、Tab キーを使用して出力ネットワークに Karma ROP を追加す
ることもできます。この中には、オブジェクトレベルからすべての可視
オブジェクトを取得する LOP ネットワークが含まれています。 
ROP ノードを使用すると、ディスクまたは Mplay にレンダリングするこ
とができます。これらのノードには、サンプリング、ノイズレベル、全体
的なレンダリング品質など、最終画像を制御するためのパラメータが
多数含まれています。
オブジェクトやオブジェクトのグループごとに異なる ROP を設定できま
す。異なるノードを接続することで、ROP の依存関係を作成できます。
チェーンの最後のノードでレンダリングボタンを押すと、残りのすべて
のノードが先にレンダリングされます。 

レンダリング出力 | AOV
ROP には、画像平面をセットアップするためのコントロールが用意され
ており、Direct Lighting、Indirect Lighting、Shadows、Depth な
どのレンダリングレイヤーを作成できます。Karma と Mantra の両方が
これらのパスをレンダリングでき、Houdini のコンポジットコンテキスト
である COP や、Nuke などの外部コンポジットツールで読み込めます。 

Background Plate LOP を使用すると、背景が見透けるようにシーン
に穴をつくるマットオブジェクトをセットアップできます。このジオメトリ
は、影を受けたり、光に反射するため、オブジェクトがリアルに馴染み
ます。

MPLAY
MPlay では、Karma や Mantra 
などのレンダラでレンダリングし
た画像を確認できます。
メインメニュー - 画像または 
画像シーケンスをプレビュー用
に読み込みます。別フォーマット
で保存することも可能です。 
レンダリングレイヤー - この 
メニューを使用すると、color、
normal、diffuse_direct、
reflect-direct  など、さまざまな
レンダリングレイヤーを表示する
ことができます。
プレイバー - 画像シーケンスを
読み込んだ場合、これらのコント
ロールを使用して、シーケンスを
再生したり、スクラブすることが
できます。

Render Time - このビューに
直接レンダリングする場合も 
あるため、レンダリング時間 
情報が表示されます。
表示オプション - MMB ドラッグ
でパンしたり、RMB ドラッグで
ズームイン/アウトできます。
チャンネル - これらのボタンを
クリックすると、赤、緑、青、 
またはアルファチャンネルに 
集中したり、それらの組み合わ
せを確認することができます。
ガンマ設定 - ビューポートの輝
度、コントラスト、ガンマを設定
できます。デフォルトでは、リニ
アワークフローをサポートする
ガンマ値 2.2 が使用されます。
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プレイバー
プレイバーを使用すると、時間をスクラブしたり、キーフレームを設定および編集することができます。 
プレイバーでも簡易の編集が可能ですが、細部まで調整する目的ではアニメーションエディタを使用します。

現行時間
現行時間は、フィールドと 
フレーム範囲の黒のマー
カー上に表示されます。 
マーカーを使用してプレイ
バーをスクラブできます。 

フレーム範囲
全体の範囲は、左端のアニ
メーションコントロールボ
タンで定義します。表示範
囲は、範囲の下部にあるハ
ンドルを使って縮小するこ
とができます。

キーの編集
キーを設定すると、その
キーがプレイバーに表示さ
れます。Shift キーを押し
ながら LMB でキーを選択
してから、MMB でドラッグ
してキーを編集します。

キーの設定
Set Key ボタンをクリック
して、キーフレームを設定
します。小さい矢印をク
リックすると、Auto キーな
どのオプションメニューが
表示されます。

再生コントロール
再生、一時停止、次のキー
への移動を素早く行えま
す。その下には、アニメー
ションオプションやリアル 
タイム再生のボタンがあり
ます。 

時間とモーション
アニメーションは、経時的な変化を伴います。オブジェクトの位置、形状、色など、何であれ、時間の経過とともに 
変化させれば、それはアニメーションです。Houdini には、キーフレームベースのワークフロー向けのさまざまな 
ツールに加えて、時間とモーションをより高度に操作できる Motion FX と CHOP が用意されています。

  キーフレームの設定
キーフレームを使用すると、特定の時点に特定のパラメータ値を設定
することができます。パラメータ値が変化すると、シーン内のオブジェ
クトがアニメートされます。その後、アニメーションカーブを使用して、
キーフレーム間のモーションの品質を決定できます。以下に、Scene 
View で作業しながらオブジェクトにキーフレームを設定できる主な
ホットキーを紹介します。
	� キーフレームの設定	 K
	� AutoKey の切り替え	 Alt + K
	� ハンドルをキーフレーム	 Ctrl + K
	� 位置をキーフレーム	 Shift + T
	� 回転をキーフレーム	 Shift +R
	� スケールをキーフレーム	 Shift + E

パラメータエディタでキーフレームを設定することも可能です。	
Alt キーを押しながらパラメータ名またはパラメータフィールドをク
リックするか、パラメータを RMB クリックして Keyframes > Set 
Keyframe を選択します。こうすると、一度に 1 つのパラメータにキー
フレームを設定できます。

  プレイバー
プレイバーはメインのワークスペースの下部にあり、アニメーションを
再生したりスクラブできます。時間はフレーム単位で、デフォルトのフ
レームレートは 24 フレーム/秒です。 
左側には再生コントロールがあります。素早く再生をセットアップした
り、時間を操作するホットキーをいくつか紹介します。 

	� 再生	 
	� 逆再生	 
	� 次のフレーム	 
	� 前のフレーム	 
	� 開始フレーム	 Ctrl + 
	� 次のキーフレーム	 Ctrl + 
	� 前のキーフレーム	 Ctrl + 

プレイバーで、キーフレームを編集することもできます。プレイバーで
フレーム範囲を RMB クリックすると、キーを Cut、Copy、Paste する
オプションに加え、Replace、Cycle、Repeat、Stretch といった特殊
なペーストにもアクセスできます。これらのオプションにも独自のホッ
トキーがあり、メニューに記載されています。アニメーションエディタ
に移る前に、プレイバーでさまざまな作業を行うことが可能です。

チャンネル
アニメーションエディタでキーフレームを設定したり、アニメーション
カーブを表示するときには、チャンネルを操作することになります。 
キーフレームを設定したチャンネルを持つオブジェクトを選択すると、
そのチャンネルがアクティブになり、キーフレームがプレイバーや	
アニメーションエディタに読み込まれます。オブジェクトを選択解除	
すると、チャンネルをピン留めしない限り、それらのチャンネルも選択
解除されます。 
チャンネルをピン留めするには、プレイバーの右側、アニメーションエ
ディタの左側、またはチャンネルリストペインにあるチャンネルリスト
を使用します。このリストで 1 つまたは複数のチャンネルを選択するこ
とで、キーフレームを設定したり編集する対象のチャンネルを絞り込み
ます。 

チャンネルリストペイン
チャンネルリストペインでは、チャンネルグループ、アニメーションレ
イヤー、アクティブなチャンネルを扱うことができます。リストを使用し
てチャンネルのグループを作成すれば、アクセスがしやすくなります。
また、グループを使ってチャンネルをピン留めすると、異なるオブジェ
クトを選択した場合でもそのチャンネルを操作できます。これは、キャ
ラクタにキーフレームを設定する場合に便利なペインです。

  Flipbook
シーンをアニメートするとき、そのモーションをプレビューしたいことが
あります。Scene View の左側のツールバーにある Flipbook ツールを
使用すると、ビューポートからフレームをキャプチャして、その結果を	
リアルタイムでムービーとして再生できます。
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ONION SKINNING
Onion Skinning を使うと、現行のフレーム前後のフレームのオブジェ
クトをゴーストとして表示できます。Onion Skinning は、オブジェク
トの Misc タブでオンにします。Frames Before、Frame After、Frame 
Increment などのオニオンスキンのオプションは、ビューポートの 
Scene タブの Display パネル（d）で確認することができます。

  モーションパスハンドル
Pose ツールを使用してアニメートする場合、Motion Path オプション
をクリックしてハンドルを表示すると、選択したオブジェクトのアニメー
ションを時間経過に応じて確認できます。また、ハンドルを使用して
モーションの形状を操作することもできます。 

モーションパスハンドル

オニオンスキン

接線ハンドル

アニメーションエディタ
選択したチャンネルはアニメーションエディタに読み込まれ、キーフ
レームとアニメーションカーブ、またはスプレッドシートやドープシート
として表されます。キーフレームは選択と編集が可能で、カーブの形
状は接線ハンドルを使って調整できます。カーブはキーフレーム間の
モーションを定義するもので、モーションの質を定義するうえで重要な
役割を果たします。 
チャンネルを操作するときには、以下のホットキーを使ってキーフレー
ムやアニメーションカーブを確認できます。
	� すべてを表示 / ホーム 	 H
	� パン 	 MMB
	� ズーム	 RMB

Motion FX
キーフレームとアニメーションカーブはノードのパラメータに格納され
ますが、チャンネルオペレータ（CHOP）を使用すると、よりプロシー
ジャルなノードベースのアプローチでモーションを操作することができ
ます。 
最も簡単にチャンネルオペレータを作成するには、パラメータを RMB 
クリックして、Motion FX サブメニューから選択します。チャンネルリ
ストを使用して、これらのエフェクトをチャンネルグループに適用する
ことも可能です。

Motion FX は、Channel CHOP に抽出および格納される、キー
フレームによる動きに適用できます。その後、Cycle、Noise、
Smooth、Limit、Lag などのエフェクトを既存の動きに適用します。
Constraints シェルフにはさまざまなツールがあり、パラメータ設定に
よってターゲットの方を向くようにしたり、遅延させたり、微震するよう
にできます。

こうしたノンリニアなアプローチなら、非常に柔軟かつユニークな方法
でモーションを扱えます。

エディタオプション - この 
エディタは、グラフ、ドープシー
ト、テーブルの表示を切り替え
られます。
Channel Groups - グラフの 
この領域にはチャンネルグ
ループが表示され、簡単にチャ
ンネルを選択したりピン留め
できます。
Animation Layers - この 
領域では、複数チャンネルを
重ねて、異なるイテレーション
を作成できます。
Channel List - ここには選択
したオブジェクトのチャンネル
が表示されます。グラフで確認
したいチャンネル名を選択し
ます。

アニメーションエディタ

キーハンドル - 垂直バーを 
使用してキーを前後の時間に
移動したり、ボックスを使用し
て値を編集できます。
接線ハンドル - カーブの形状
を調整するために、キーフレー
ム前後の接線の角度を定義し
ます。
カーブ - アニメーションカーブ
は、キーフレーム間のモーショ
ンを定めます。これによって
モーションの質が決まります。
カーブ関数 - これらを使用し
て、アニメーションカーブや 
ハンドルのディスプレイオプショ
ンを設定できます。
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キャラクタリギングと FX
Houdini には、キャラクタやクリーチャを作成するための広範なリギングツールが搭載されており、 
それらを Houdini デジタルアセットにラップしてアニメータに渡すことができます。さらには、ヘアー、ファー、 
マッスル、布、群衆など、キャラクタのルックを向上させるためのキャラクタ FX ツールも備わっています。 

  BONES
Houdini では、Rigging シェルフにある Bones ツールと Bones 
from Curve ツールを使用して、ボーンを描画および編集できます。
ボーンチェーンはそれぞれ、チェーンルートとボーンで構成されてい
ます。他の 3D アプリがジョイントベースであるのに対し、Houdini 
は Length や Rest Angle のパラメータを持つ Bone ノードを使用し
ます。 
また、Bones ツールを使用すると、チェーンにインバースキネマティク
スを追加して、エンドエフェクタや、場合によってはツイストエフェク
タを加えることも可能です。キネマティクスは、独自のサブネットワー
クに存在するチャンネルオペレータ、つまり CHOP ノードによって	
駆動されます。

ジオメトリのキャプチャ
キャラクタのジオメトリをボーンにキャプチャして、リアルな動きを
表現するために必要な変形を作成できます。Houdini のボーンには 
Capture Region があり、ジオメトリを包含するようセットアップでき
るうえに、ジョイント部分には適切な重なりが作られます。このプロセ
スにより、ポイントにウェイトアトリビュートが割り当てられ、ボーンが
移動したり回転したりするときにジオメトリを制御する Deform ノード
に供給されます。

最初にキャプチャしたジオメトリは、希望するルックとは異なるでしょ
う。さまざまなツールを使用して、キャプチャウェイトを編集したり 
ペイントすることで調整していきます。ジョイントのウェイトを滑らかに
して、曲げをリアルにしていきます。また、Deform ノードに接続した 
DeltaMush ノードを使用して、ポイント変形の効果を平滑化すること
も可能です。
Bone Capture Biharmonic という新しいテクニックを使用すると、
広範なポイントウェイトがなくても、ジオメトリをキャプチャして、ジョ
イント部分を希望通りのルックにすることができます。この方法では、
四面体メッシュに Biharmonic（重調和）関数をセットアップすることで、
より全体的なソリューションが作成されます。 

デジタルアセットキャラクタ
Houdini キャラクタをリギングしてアニメーションチームと共有するに
は、ボーン、ジオメトリ、マテリアルを Houdini デジタルアセットにラッ
プする必要があります。 
これにより、ファイルがディスク上に作成され、アニメータは複数の
ショットで簡単に参照できます。ハンドルやキーパラメータはトップレベ
ルで操作が可能で、アニメータはリグの内部構造を気にすることなく、
キーフレームを設定できます。また、Pose Library や Character Picker 
のセットアップをアセットに保存して、素早くアクセスできるようにする
ことも可能です。

キャラクタのパーツに加えた変更はアセットに保存され、すべての
ショットが更新されます。この仕組みにより、堅牢かつ管理しやすいキャ
ラクタパイプラインが実現します。

  KINEFX
KineFX は、リターゲットやモーション編集にプロシージャルな基盤を
提供するキャラクタツールセットです。将来は、リギングやアニメーショ
ンにも拡張の予定です。ジオメトリコンテキストにおけるこの新しい
ワークフローは、限りない柔軟性とキャッシュ機能を備え、迅速かつ	
プラグアンドプレイのリギング体験を実現します。
ジオメトリ（SOP）コンテキストに実装された KineFX は、ジョイントを
通常のポイントジオメトリとして扱い、エッジ接続によってリグの階層
を定義します。Houdini のオブジェクトレベルからリグを取り込むこと
も、FBX キャラクタを読み込むことも可能です。
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チャンネルグループ
Houdini でアニメートする際は、スコープされているチャンネルにキー
フレームを設定したり、アニメーションエディタに表示することができ
ます。通常は、現在選択しているチャンネルがこれに該当します。また、
チャンネルグループはまとめることも可能です。チャンネルをスコープ
したりピン留めすると、キーフレームを設定しやすくなります。
キャラクタをデジタルアセットとしてセットアップしてある場合は、パラ
メータエディタの左上にあるアイコンをクリックし、Parameters and 
Channels > Create Nested Channel Groups を選択して、アセット
のフォルダ階層をガイドとしてグループを作成します。適切に設計され
たキャラクタアセットであれば、この作業は簡単です。

キャラクタ FX | ヘアーとファー
Add Hair ツールでキャラクタにヘアーを追加したら、Houdini のヘ
アーとファーのツールセットを使ってセットアップとグルーミングを行
います。これらのツールセットではガイドヘアーも使用できます。ワイ
ヤーシミュレーションでアニメートすると、リアルな仕上げになります。
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キャラクタ FX | マッスルとスキン
Houdini では、アニメートしたクリーチャにマッスルを追加し、シミュ
レーションを実行することなく、それらをスキンデフォーマとして適用で
きます。まず、ジオメトリコンテキストで Muscle ノードを使用して、	
シンプルなマッスルのフォームを作成します。 
その後、マッスルの形状と位置を調整し、キャラクタリグに取り付けた
ら、自動セカンダリアニメーションまたは Jiggle（微震）を有効にしま
す。Houdini のマッスルシステムは、統合されたデジタルアセットを使
用しながら、FEM（ダイナミクスシミュレーション）および非 FEM（スキン
デフォーマ）ワークフローに対応できるように設計されています。

群衆シミュレーション
群集シミュレーションは、キャラクタのスケルトン、スキンジオメトリ、
アニメーションクリップで構成されるエージェントから始まります。	
これらはポイントに割り当てられ、シンプルなルールの組み合わせに
よって複雑な挙動を作り出します。また、エージェントは他の動的要素
と相互作用が可能です。例えば、エージェントが走り過ぎる車にぶつ
かってラグドールになったり、群衆がフィールド上のアクションに反応
するようトリガを設定したりできます。 

CHARACTER PICKER
このペインでは、リグのパーツを
選択するためのインターフェース
を作成できます。これをファイルに
保存して、ディスク上のデジタル 
アセットファイルに追加することも
可能です。

タブ - 手、足、顔など、体のパー
ツごとにタブをセットアップでき
ます。

コントロール - リグの各ハンドルに
マーカーを配置し、テキストや 
カラーで区別できるようにします。

背景画像 - キャラクタの視覚表現
を追加して、マーカーと体のパー
ツを適切に関連付けられるように
します。

POSE LIBRARY
Pose Library ペインでは、後で参
照できるように、キャラクタのポー
ズやクリップをキャプチャすること
ができます。ポーズを適用するに
は、プレイバーでフレームに移動
し、ここで目的のポーズをクリック
します。

ポーズ - 単一フレームから取り込
んだポーズが保存されています。
そのポーズに設定されているすべ
てのパラメータが、現在のシーン
のキャラクタに適用されます。 
このポーズから別のポーズへの 
遷移を補間することも可能です。

クリップ - クリップには、一定期間
にわたるキーフレームが保持され
ています。例えば、歩行サイクル
やバク転などの特徴的な動きが含
まれます。
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ダイナミックシミュレーション
Bullet のリジッドボディ破壊、Pyro FX の火と煙、Vellum ソフトボディ、FLIP 流体などを作成するとき、 
Houdini では、統合されたダイナミクス環境を利用できます。異なるソルバ間で相互にやり取りできるため、 
結果についての制御がしやすい環境です。

シェルフツール
ダイナミックシミュレーションのセットアップには、ダイナミクスまたは 
DOP コンテキストのノードと、ジオメトリまたは SOP コンテキストの
ノードから成るネットワークが必要です。シェルフツールを使用すると、
これらのノードをすべて追加できるうえ、より少ないクリック数でシミュ
レーションをセットアップできるので、とても便利です。セットアップし
たら、ネットワークの中に入り、それぞれのノードを確認できます。

シェルフツールは、ノードグループを自動的にセットアップしたい場合
に適しています。シェルフツールによって構築されたネットワークの構
成を確認しておくと、DOP ネットワークをゼロからセットアップする際
に役立ちます。

ダイナミクスソルバ
シミュレーションの中心は、ダイナミクスソルバです。シミュレーション
の頭脳として、すべてのダイナミクスオブジェクト、フォース、衝突オブ
ジェクトを受け取り、それらを統合して最終結果を作ります。シェルフ
ツールは、ソルバをダイナミックネットワークに組み込み、ノードを接
続してくれます。

 Rigid Body Solver - 効率的な Bullet ソルバや Houdini の組み込みソル
バを使用して、リジッドオブジェクトの落下や衝突をシミュレートします。 

 Static Solver - オブジェクトを衝突ジオメトリとして機能させたいが、	
シミュレーションの影響を受けないようにしたい場合に使用します。 

 Flip Solver - FLIP 流体シミュレーションによって、しぶきや波のエフェク
トを作成します。

 Whitewater Solver - FLIP の計算が完了した後、このソルバを実行する
ことで Foam（泡沫）、Spray（飛沫）、Bubble（泡）を作れます。

 Vellum Solver - POP Solver の一種で、布、ヘアー、粒、流体、風船な
どのソフトボディに対して統合的に対応しています。

 POP Solver - パーティクルや粒に使用され、さまざまなパーティクルベー
スのシナリオを幅広くシミュレートします。粒のシミュレーションは、ソフトボ
ディや布の類のシミュレーションにも使用できます。

 Wire Solver - ヘアーやファー、船の索具や木の枝などのワイヤー状の	
オブジェクトに使用できるソルバです。

 Finite Element Solver - 連続体や四面体で定義されるソリッドの力学を
シミュレートします。このソルバは、筋肉、ソフトボディシミュレーション、折れ
る木をはじめとする破壊ショットに使用されます。

 Cloth Solver - キャラクタなどの変形ジオメトリと衝突する布シミュレー
ションを作成します。

 SOP Solver - SOP ネットワークを使用して、オブジェクトの形状を時間の
経過とともに変化させます。オブジェクトがぶつかってへこむ壁などをシミュ
レートできます。

OPENCL
POP Grains ノード、Pyro ソルバ（Advanced タブ）、FLIP Solver
（Volume Motion > Solver タブ）などのソルバで OpenCL を使用
する場合、GPU を使用するとシミュレーションが高速化できます。

フォース
ダイナミックな動きを作るには、動きのためのフォースが必要です。	
最も基本的なフォースは重力ですが、扇風機、流体、磁石などの外部
フォースも、シミュレーションの動きに寄与します。

 Gravity Force - オブジェクトが重力フィールド内にあるかのように、	
オブジェクトに下向きのフォースを適用します。 

 Drag Force - 現行のモーションに抵抗するフォースと回転モーメントを	
オブジェクトに加えることで、減速させたり、運動量を小さくしたりします。

 Uniform Force - 正確な量のフォースと回転モーメントをオブジェクトに
適用します。Noise DOP によって増強し、乱流を追加することもできます。

 Fan Force - 円錐状のフォースをオブジェクトに加えます。
 Fluid Force - 流体によって布やワイヤーなどのソフトボディを変形します。
 Wind Force - 押す力によってオブジェクトの Velocity を上げますが、	

風自体の速度を越えることはありません。
 Magnet Force - メタボールで定義したフォースフィールドを使って、	

オブジェクトを引き寄せまたは遠ざけます。 
 Vortex Force - 渦巻きのようなフォースを作成して、竜巻周辺のオブジェ

クトのように、カーブを軸にオブジェクトを周回させます。

ダイナミクスオブジェクト
オブジェクトを選択し、シェルフツールを使ってシミュレーションに追加
すると、Houdini はダイナミクスオブジェクトを作成します。ダイナミク
スオブジェクトは、オブジェクトのジオメトリを使用して、密度、摩擦、
跳ね返りなどのダイナミクスプロパティを追加します。

アクティブと Static（静的）
アクティブなダイナミクスオブジェクトは、フォースや衝突の影響を受け
ますが、Static オブジェクトは影響を受けません。アニメーションジオ
メトリや変形ジオメトリを使用したい場合は、ダイナミックオブジェクト
の Initial Object Type メニューまたは Use Deforming Geometry 
チェックボックスを使用して、これを定義する必要があります。
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衝突
衝突オブジェクトも、シミュレーションに大きく関係する要素です。	
地面をセットアップして、衝突用に連続したサーフェスを作成したり、
静的または変形するオブジェクトを使用できます。

それぞれのダイナミクスオブジェクトに、衝突ボリュームを表示したり
最適化するための設定があります。衝突の精度はできるだけ高くした
いものですが、それに応じてかかるシミュレーション時間の長さとの	
バランスも考慮します。 

リジッドボディ拘束
Rigid Bodies シェルフには、シミュレーションにも影響させられる	
拘束が多数あります。例えば、Pin、Spring、Slider などの拘束です。	
また、リジッドボディシミュレーションのセットアップ時に Glue 
Objects を使用すると、接着を「弱める」か、衝突が発生するまで、	
オブジェクト同士を接着しておくことができます。

プレイバーの表示
シミュレーションを開始するには、プレイバーで Play を押します。	
シミュレーションが進むと、プレイバーがハイライトされ、どれくらいの
シミュレーションがメモリにキャッシュ化されたかが分かります。	
その後、再度シミュレーションを実行することなく、その領域をスクラブ
できます。 

ディスクへのキャッシュ化
シミュレーションが完了したら、DOP 内から sim ファイルを保存して
ロックします。また、File Cache ノードを使用して、シミュレーション
ジオメトリを bgeo シーケンスに書き出すことも一般的な方法として	
使われています。こうすると、プロダクションのライティングやレンダリ
ングの段階で、シミュレーション結果を扱いやすくなります。 

ゲーム向けリアルタイム FX
ゲームでは、爆発などのエフェクトをゲームエンジンでリアルタイムに
最適化する必要があります。リジッドボディ、Pyro FX、流体など、さま
ざまな種類の Houdini シミュレーションをゲーム用のアートに変換す
る方法については、SideFX Labs ツールを確認してください。 

シェルフツールを使用してダイナミク
スオブジェクト、衝突オブジェクト、 
またはフォースを作成すると、 
全パーツを組み合わせた 
AutoDopNetwork が作成されます。

Static Object - これらのノードは、
地面や静止衝突オブジェクトのプロ
パティをセットアップします。

Static Solver - ダイナミクス 
オブジェクトが入力オブジェクトと 
相互作用する間、入力されるオブジェ
クトを静止したままにします。

Merge ノード - ダイナミクスシステム
の複数の部分を結合します。 
シミュレーション中、すべてが相互に
作用するように、ノードはチェーンの
上流と下流で評価されます。

AUTODOPNETWORK

ダイナミクスオブジェクト -  
このノードはジオメトリを DOP に
取り込んで、基本のプロパティを
割り当てます。

Rigid Body Solver - 関係する 
オブジェクトのシミュレーションを
生成するソルバです。

フォース - 重力や風などのフォー
スを使用して、ダイナミクスオブ
ジェクトに影響を与えるノード
です。

Output ノード - このノードを
使用すると、シミュレーションを
キャッシュ化したい場合に .sim 
ファイルを出力できます。
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Cloud FX とボリューム
Houdini のビジュアルエフェクトで重要なのは、ボリュームデータの使用です。Houdini では、ボリュームは 
内部的にツールの機能をサポートしますが、ボリュームが何であるか、さらにはボリュームを直接扱う方法を学ぶ 
ことをお勧めします。

ボリュームでは、ポイントやポリゴンではなく、ボクセルを使用して 
オブジェクトを表現します。ボクセルは 3 次元ピクセルです。立方体の
グリッドを構成する各ボクセルには、ボリュームの表示方法を示す情報
が含まれ、うっすらとした雲のような形状の表現にも適しています。 
ボリュームベースのオブジェクトの視覚的な品質は、3D グリッドの解
像度に応じて決まります。解像度が高いほど、品質は高くなりますが、
パフォーマンスに影響があります。

 

ISO OFFSET
Isooffset ノードはジオメトリコンテキストにあり、マニフォールド（多
様体）のポリゴンジオメトリを受け取って、Houdini が使用できる 
Houdini ボリュームを構築します。さまざまな Output タイプが選択可
能で、フォグや四面体メッシュとして形状を表示することができます。

元のジオメトリ フォグ 四面体メッシュ : 立方体

CLOUD FX
このツールセットは、ジオメトリを雲のような VDB ボリュームに変換し、
ライティングを施します。Cloud Rig ツールは、個々の雲を形成するだ
けでなく、Cloud、Cloud Noise、Cloud Light など、最終的なルック
に寄与する低レベルツールを理解するためにも役立ちます。

構築されたネットワークは、雲のソースを読み込んでから他のノードを
適用することで、Houdini ボリュームと VDB による雲のようなエフェク
トを作成します。Houdini には、空をボリュームクラウドで埋め尽くす 
Sky Rig ツールも用意されています。

Unreal などのゲームエンジンで使う雲の風景を作成するには、
Houdini で Sky Rig を使用し、それをメッシュに変換すれば、生成
サーフェスとして使用できます。このアプローチに関しては、SideFX 
の Web サイトで Andreas Glad によるチュートリアルを確認してくだ
さい。

OPEN VDB
「OpenVDB」は、アカデミー賞を受賞したオープンソースの C++  
ライブラリで、3 次元グリッド上に離散化されたスパースボリューム
データを効率的に格納および操作するツール群で構成されています。
DreamWorks Animation 社によって開発およびメンテナンスされて
おり、長編映画制作でのボリュームアプリケーションでよく使用され
ます。- openvdb.org

Houdini には、さまざまな OpenVDB ボリュームノードがあり、ジオメ
トリをボリュームに変換するジオメトリ（SOP）ネットワークで利用でき
ます。

内部的なボリューム
Houdini のツールの多くは、見えないところで、つまり内部的にボ
リュームを使用しています。以下は、ボリュームが作業に寄与している
例です。 

	� コライダ - デフォルトで、ボリュームはダイナミックシミュレーション用に
ジオメトリをコライダに変換します。

	� シミュレーションフィールド - ボリュームは、ダイナミックシミュレーショ
ンに寄与する Density（密度）や Velocity（速度）などのフィールドを定義し
ます。 

	� ヘアーとファーのツール - これらのツールは、グルーミングの計算を支援
するためにボリュームデータを使用します。

	� 地形 - Height Field ツールは、それぞれのボクセルに各グリッドポイント
での地形の高さを含む 2D ボリュームを使用します。

	� レンダリング - ボリュームは、Mantra で Water Depth（waterdepth）と 
フォグのエフェクトを作成します。
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地形と Height Field
Houdini の一連の heightfield ノードを使用すると、プロシージャルに地形を生成できます。形状を重ねたり、 
ノイズを追加したり、侵食のシミュレーションを実行することで、デジタル景観のルックを定義できます。 
このワークフローはコンポジットに似ていますが、すべての作業を 3D 形状で行います。

Houdini には、地形を生成および形成するための各種ジオメトリノー
ドが用意されています。これらのツールは、2D ボリュームを使用して
地形を表現し、各ボクセルにはそのグリッドポイントでの地形の高さ、
つまり Height Field が含まれています。ジオメトリネットワークに	
渡されるデータには、複数の Height Field を含めることができます。
これらのツールには、Terrain デスクトップからアクセスできます。 
Houdini のビューポートでは、2D Height Field を 3D サーフェスとして
視覚化でき、マスクフィールドは 3D サーフェス上に赤色で表示されま
す。Height Field のレンダリング専用の Mantra プロシージャルがあり、
ダイナミックシミュレーションでは衝突サーフェスとして使用できます。

ARON KAMOLZ

パターン
Heightfield ノードを配置して基本の解像度を定義すると、
Heightfield Pattern ノードを使ってさまざまな初期形状にアクセス
できます。線形、同心円、放射状のランプ、線形階段、星などの放射
状に対称的な形状、ボロノイセルなどをセットアップできます。
これらの形状をブラーさせたり歪ませて、地形の開始点となる形状を
作成します。また、複数の要素を組み合わせたり重ねることで、さらに
洗練された結果に仕上げることも可能です。 

ノイズ
地形を構築する際に、レイヤーにノイズを追加して自然なルックにする
ことができます。Perlin、Sinusoid、Worley  など、さまざまな種類の
ノイズが用意されています。地形のリアルさが増すだけでなく、さまざ
まなノイズを適用した複数の形状を組み合わせることで、多様性に富
んだハイパーリアルな結果を得られます。

マスク
Height Field ツールはまた、それぞれのボクセルにマスクレイヤー
を含む 2 次的なタイプの 2D ボリュームも使用します。ほとんどの 
Terrain ノードは、2 番目の入力でマスクレイヤーを受け取り、そのノー
ドが変更する地形の領域をマスクによって制御します。
マスクの利用方法はさまざまあり、マスクを使用することで、ディテー
ルの追加や地形の形成が行いやすくなります。Height Field にマスク
をペイントすることも可能です。 

浸食
Heightfield Erode ノードは、雨量、土壌の侵食性、エントレインメン
ト率を変数として使用することで、侵食や堆積をシミュレートします。
このノードは、プレイバック中に反復的に動作します。最初のフレーム
では何の影響も受けていないように見えます。浸食のシミュレーション
を確認するには、プレイバーで Play を押す必要があります。 

エクスポートオプション
ゲームエンジンなどの他のアプリケーションで使用するために、地形
をエクスポートする方法は 2 通りあります。Heightfield Output ノー
ドを使用すると、Height / マスクレイヤーを画像としてディスクにエク
スポートし、テクスチャとして取り込むことができます。 
あるいは、Houdini デジタルアセットを作成し、Houdini Engine プラ
グインを使用して Unreal や Unity などのアプリケーションで開くこと
も可能です。これらのデジタルアセットは、ゲームエンジンの組み込み
の地形ツールで扱うことができます。
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SideFX Labs
SideFX Labs は、Houdini のアーティストおよびゲーム開発関連の向けワークフローの高速化を目的とした、 
ハイレベルなツール群です。メッシュ処理、リアルタイム FX、UV 編集、シミュレーションからのモーションベクトル 
作成など、開発中のツールも多数あります。 

Houdini のすべての機能は映画、TV、ゲームのコンテンツ制作に	
使用できますが、Labs ツールセットは、現在の Houdini では対応が
難しい、アーティスト固有のタスクにも対応できます。通常の Houdini 
開発サイクルとは別に開発されており、テスト目的での試用が可能に
なった時点で提供されます。Houdini 内から直接ダウンロードするか、
SideFX Labsの GitHub ページからアクセスできます。

ツールのダウンロード
Labs ツールは、Houdini と一緒にインストールすることも、SideFX 
Labs シェルフタブからアクセスすることもできます。たいていはデスク
トップに表示されないため、追加するための操作が必要です。表示さ
れたら、Update Toolset ボタンをクリックします。すると、インストー
ルを促すダイアログが表示されます。ツールの多くがベータ版のため、
このときには Production Builds Only オプションをオフにします。

 

シェルフにはツールのほとんどが表示されますが、ビューポートやネット
ワークビューで Tab を押した場合にのみ利用できるツールもあります。
こうしたノードは、識別しやすいように先頭に Labs が付いています。

FX ツール 
Houdini は強力な FX ツールで知られていますが、SideFX Labs には、
ゲームまたはバーチャルプロダクションなどのリアルタイム環境で使用
するために結果を処理するツールがあります。また、シミュレーション
を最適化して、テクスチャ、FBX、CSV などに出力する各種ツールもあ
ります。

 Vertex Animation Textures - Vertex Animation Textures ROP は、布、
リジッドボディ破壊、流体、パーティクルの複雑なアニメーションを再生する、	
リアルタイムマテリアルで使用するメッシュとテクスチャをエクスポートし
ます。

 

 Flipbooks Texture - Pyro FX 向けテクスチャアトラスを作成およびプレ
ビューできる、高速 GL または Karma ベースのツールです。

 Destruction Cleanup - リジッドボディのシミュレーション結果をエクス
ポートする前に、余計なジオメトリを削減し、法線を整え、アトリビュートを
整理します。

 Skinning Converter - Skinning Converter は、トポロジが変わらない変
形メッシュシーケンスをボーンベースのアニメーションに変換する SOP です。

 Make Loop - アニメートさせたメッシュ、ポイント、ボリュームを受け取っ
てループにします。

 Volume to Texture - Volume Texture ツールを使用すると、Ryan 
Brucks 氏による UE4 のボリュームプラグインで使用可能なテクスチャを書き
出せます。

 Flowmap - このユーティリティツールは、入力ジオメトリ上にフローマッ
プテンプレートをセットアップします。

 Flowmap Visualize - Houdini ビューポートでのフローマップテクスチャ
の高品質リアルタイムプレビューです。

 Flowmap Obstacle - Flowmap Obstacle SOP を使用すると、障害物ジ
オメトリに基づいてフローマップを簡単に修正できます。

 Niagara ROP - 弾丸シミュレーションから衝撃、分割データ、補間データ
を抽出および書き出して、UE4 Niagaraデータインターフェースで使用できる
ようにするオールインワン HDA です。

 Gamedev Procedural Smoke - Procedural Smoke SOP は、煙を表現
したアニメーションボリュームを生成します。

 ROP Vector Field - ボリュームまたはポイントクラウドから、UE4 と互換
性のあるベクトルフィールドを生成します。

メッシュ処理
高精度のメッシュをゲームに取り込むまでには、フォトグラメトリ、トポ
ロジのクリーンアップ、メッシュのリダクション、UV レイアウト、マップ
のベイクなど、いくつものステップがあります。Labs ツールを使用と、
ワークフローをまとめ、一般的なソフトと統合することで、このプロセ
スを簡略化できます。

 AliceVision Photogrammetry - AliceVision は、3D 再構築とカメラ追
跡アルゴリズムを提供する、フォトグラメトリのコンピュータビジョンフレーム
ワークです。

 ZBrush Bridge - GoZ は Zbrush の高速ファイル転送機能です。ファイル
のパスや拡張子といった設定なしに、Houdini と Zbrush 間で、シームレスに
メッシュを送信できます。 

 Delete Small Parts - 接続性とサイズに基づいてパーツを削除します。
 Delight - 高解像度のフォトグラメトリスキャンに含まれる、アンビエント

ライティング情報を除去します。
 GameRes - 高解像度モデルを低解像度モデルにする、フルパイプライン

ノードです。
 Maps Baker - ほぼインタラクティブな速さで、高解像度モデルから低解

像度モデルへのテクスチャベイクを生成します。
 LOD Hierarchy - LOD 階層を作成して FBX としてエクスポートします。 
 Mesh Sharpen - メッシュの曲率に基づいてジオメトリを鋭くします。 
 Edge Damage - ジオメトリのエッジに摩耗を加えます。 
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ワールドの構築 
デジタルワールドはより大きく、より複雑になっています。効率的な	
ワールド構築ワークフローを用いることが重要です。ニューヨークを	
再現したい、密林を育てたい、SF アドベンチャーに屋内のディテール
を加えたい。このようなときが、Lab ツールの出番です。

 Physics Painter - Physics Painter は、ユーザが他のオブジェクト上に	
物理オブジェクトをペイントできるようにする SOP です。

 Building Generator - ユーザ定義モジュールのライブラリを使用して、
低解像度のブロックアウト（枠組み）ジオメトリを詳細なビルに変換します。

 OSM Import - Open Street Map は、街路データの優れたデータベース
です。このノードは、OSM ファイルや、ビルや道路のさまざまなタグ付きアト
リビュートをすべて効率的に Houdini にロードします。

 OSM Buildings - OSM データからビルを生成します。
 Tree ツール - Labs の Tree ツールにはいくつかのツールがあり、組み合

わせて使用することで木、茂み、植物などの複雑な枝構造を作成できます。
 Cable Generator - ケーブルの高い位置の「ピン」ポイントと低い位置の

「垂れ」ポイントを表現したカーブを与えると、この SOP はユーザ定義可能
なケーブルの本数、形状、色で垂れ下がったケーブルを生成します。

 Curve Branches - カーブ上にカーブを散乱させます。いくつもの直感的
なコントロールを使用して、クリーンな幾何学的な枝から有機的なブドウの
枝までを表現可能です。この SOP を複製してチェーン接続すれば、再帰的成
長を表現でき、L-System のようなルックをより柔軟な制御で得ることができ
ます。

 Dirt Skirt - オブジェクトと地面が交差した箇所にジオメトリ「スカート」を
作成します。これは、ゲームエンジンでソフトブレンドとして使用します。

 Lot Subdivision - ポリゴンをパネルに分割します。市街地の作成やディ
ティールアップに便利です。

 MapBox - mapbox.com で提供されているデータを使用して、色、高さ
が定義された Open Street Map（OSM）カーブを生成します。

 SciFi Panels - SF 風のパネルを生成するサンプル HDA です。
 Snow Buildup - 入力メッシュに積雪を模倣したジオメトリを追加します。
 Terrain Texture Output - Terrain Texture ROP SOP は、Height Field 

から画像データをレンダリングします。

モデリング
Labs ツールには、ゲーム用のジオメトリを簡単に作成できるように	
設計された、さまざまモデリングツールがあります。

 Decal Projector - デカール（局所的なジオメトリとテクスチャ）をジオメト
リ上に投影します。

 Calculate Slope - 方向と比較してサーフェスの勾配を計算し、オプショ
ンでその結果をブラーしたり再マップすることができます。

 Curve Sweep - プロファイルのタイプ、幅、捻じりの挙動の単純なコント
ロールを使って、入力カーブに沿ってプロファイルを回転させます。

 Extract Silhouette - XYZ のいずれかの軸から投影されたオブジェクトの
アウトラインを作成します。

UV マッピング
テクスチャ UV は、ゲームアート作成で大きい割合を占める作業工程
です。これらのツールは Houdini の既存の UV ツールセットを強化す
るもので、より素早く効率的に作業できるようにします。

 Auto UV - 自動的にオブジェクトにシーム（継ぎ目）を生成し、UV Flatten 
を即時に実行します。

 Inside Face UVs - 破壊されたジオメトリの内部フェースに UV を生成します。
 UV Transfer - ソースジオメトリとターゲットジオメトリの間で UV を転送

します。
 UV Visualize - UV を視覚化するヘルパースクリプトです。シーム（継ぎ目） 

の視覚化、UV 空間とモデリング空間の間のワープ、グリッドテクスチャのタイ
リングの変更、島の視覚化といった機能が含まれます。

 Texel Density - このツールは、アセットとプロジェクトの解像度に基づい
て、プリミティブ単位でアセットの現行テクセル密度を計算します。 

インテグレーション
これらのツールは、Houdini とゲームエンジンの間でのインポート・	
エクスポートが簡単になります。

 Substance COP - Houdini 向け Substance プラグインを使用すると、
Substance Archive ファイルを Houdini の COP に読み込むことができます。

 Rizom UV - RizomUV Bridge は、4 種類の SOP のセットで、Houdini と 
RizomUV 間のやり取りを簡易化します。

 Quad Remesher - QuadRemesher ノードは、Exoside 社の 
QuadRemesher コマンドラインインターフェースのラッパーです。

 Instant Meshes - DDS（DirectDraw Surface）ファイルを読み込みます。
 Sketchfab - ジオメトリを Sketchfab にアップロードします。
 3D Facebook Image - 3D シーンを Facebook にアップロード可能な 

2.5D 画像に手早く出力できます。
 Marmoset ROP - Marmoset ROP を使うと、Houdini 内で手軽に mview 

を生成できます。
 Gaea Tor Processor - Gaea Tor Processor を使用して、Gaea で作成さ

れたビルドの .TOR ファイルをロードできます。

UX
Labs ツールの中には、Houdini を使用するアーティストのユーザエク
スペリエンスの向上を目的に作られたものもあります。

 Crash Recovery - File メニューにあるこの機能は、不運にもクラッシュ
してしまったファイルを素早く修復します。

 Network Paint - ネットワークエディタで描くだけで、カラフルな注釈を
ネットワークに追加できます。

 Sticker Placer - 数字、アイコン、ユーザが作成したグラフィックスを配置
して、ネットワークに注釈を付けることができます。

 External Script Editor - VEX、Python、OpenCL、エクスプレッションを
扱う際に、外部 IDE とのライブ接続をセットアップできます。

その他
他にもさまざまなツールが追加されています。SideFX.com/labs をご覧くだ
さい。
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ファイル管理
アーティストとして成功するには、Houdini での作業で作成したすべてのファイルの管理方法を理解することは、 
とても大切です。一般的なシーンファイルは、ディスク上で外部依存関係を持っていることがあります。 
ファイルを別のコンピュータに移動する場合には特に、これらの管理が重要になってきます。

プロジェクトディレクトリ
Houdini はハードドライブ上に散在するファイルを扱うことはできます。
そうすると、作業内容を共有したり、ファイルの依存関係を管理するの
が難しくなってしまいます。File > New Project を使用してプロジェ
クトディレクトリをセットアップするか、File > Set Project を使用して
既存のプロジェクトディレクトリを作業の「ホームベース」として選択し
ましょう。こうすると、必要なプロジェクトファイルすべてに、ローカル
の依存関係が簡単にセットアップできます。

シーンファイル | .hip
Houdini で主に使用するファイルタイプは、.hip ファイルです。このファ
イルには、すべてのノードとネットワークが含まれています。作業内容
を保存する際は、このファイルタイプを使用します。

UNIVERSAL SCENE DESCRIPTION | USD
Houdini では、Solaris のライティングとルックデブ環境は、PIXAR が
作成したオープンソースイニシアティブである USD（Universal Scene 
Description）を使用しています。Solaris では USD がネイティブであ
り、プロシージャルノードを使用して、参照、ペイロード、レイヤー、	
コレクション、バリアント、詳細レベルを管理できます。

Houdini デジタルアセット | .hda
Houdini ネットワークをカプセル化し、Houdini デジタルアセットつま
り .hda ファイルに保存することも可能です。アセット内のパラメータを
トップレベルにプロモートして、アセット用のカスタム UI を作成できま
す。これらのファイルは他のアーティストと簡単に共有でき、プロジェ
クトのライフサイクルを通じてアセットが発展していく間も、堅牢な参
照アーキテクチャを提供します。

アセットの作成と読み込みには、Asset メニューを使用します。	
また、シーンに読み込まれたアセットは、そのメニューにある 	

Asset Manager を使用して管理できます。シーンに読み込まれた 
2 つの HDA ファイルが同じ名前の場合、Houdini はマネージャで設定
されたルールに基づいてどちらかを選択します。HDA ファイル内のア
セット定義に加えられた変更は、そのファイルを参照するシーンに自
動的に反映されます。なお、古いデジタルアセットファイルは拡張子が 
.otl の場合がありますが、機能は .hda ファイルとまったく同じです。

APPRENTICE と INDIE ファイル
Houdini Apprentice と Houdini Indie は、商用バージョンの Houdini 
では開くことができない、別のファイルタイプを使用します。Apprentice 
はシーンに .hipnc（non-commercial : 非商用）、アセットに .hdanc ファ
イルを使用し、Indie はシーンに .hiplc（limited commercial : 限定的な
商用）、アセットに .hdalc ファイルを使用します。

作業のバックアップ
デフォルトでは、Houdini は保存するたびに、シーンファイルとデジ
タルアセットファイルの番号付きのバックアップを作成します。前のイ
テレーションを見直したい場合や、作業ファイルに問題があった場合
は、そのファイルに戻ることができます。また、Edit > Preferences > 
Save and Load Options で Houdini を AutoSave に設定することも
可能です。なお、これらのバックアップファイルはディスク容量を消費
するため、時々削除しましょう。 

FILE SOP
File > Import > Geometry を使用してジオメトリを Houdini にイ
ンポートすると、ジオメトリ（SOP）レベルに File ノードが配置されま
す。このファイルはディスク上のファイルとの接続を維持し、ファイルに
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変更が加えられると、Houdini シーンも更新されます。接続を解除し
たい場合は、File ノードをロックする必要があります。 

ファイルの依存関係（$HIP/$JOB）
ジオメトリやテクスチャファイルなど、ディスク上のファイルを参照する
ノードを使用している場合には、プロジェクトディレクトリを別のコン
ピュータやクラウドに移動した場合にどうなるかは、パスによって決ま
ります。絶対パスは、ファイルを移動すると切れてしまいます。したがっ
て、シーンファイルをパスの「ホームベース」として使用する $HIP や、
プロジェクトディレクトリを使用する $JOB を使用する必要がありま
す。シーンファイルが適切にセットアップされているかどうかを確認す
るには、Render > Preflight Scene を使用します。

ディスク容量の管理
巨大なシーンファイル、バックアップファイル、大規模なシミュレーショ
ンは、かなりのディスク容量を消費します。ディスクの容量を使いすぎ
て、コンピュータが不安定にならないように注意してください。容量が
大きいファイルは外部ドライブに保存し、コンピュータのメインディスク
には日常業務をこなすのに十分な容量を残しておきます。

相互運用性
Houdini からインポートしたり、エクスポートする際に使用できるファ
イルフォーマットは、多数あります。一般的な Houdini パイプラインで
使用される主なフォーマットを紹介しましょう。

Houdini ファイル - Houdini でのみサポートされるファイルフォーマッ
トをいくつか紹介します（.hip と .hda を除く）。 
.bgeo - ジオメトリと UV、Velocity、法線などの関連アトリビュートを保存
するフォーマットです。アニメーションやシミュレーションを番号付きの bgeo 
ファイルとして保存することで、動きも保存可能です。bgeo.gz ファイルは、	
このフォーマットの圧縮バージョンです。

.sim - シミュレーションデータを保存して、シミュレーションをディスクに
キャッシュ化することができます。このファイルも使用できますし、.bgeo で	
シミュレーションをキャッシュ化することも可能です。

.ifd - Mantra でレンダリングする際に作成されるシーン記述フォーマットで
す。通常、このファイルは Houdini でレンダリングする際に作成されますが、
ディスクに保存して Mantra で直接レンダリングすることもあります。

.pic - Houdini で使用されていた古い画像ファイルフォーマットです。デフォル
トのフォーマットは、オープンソースの EXR に置き換えられました。 
.rat - この画像フォーマットは、Mantra でレンダリングされるテクスチャマップ
に最適です。すべてのテクスチャはいずれこのフォーマットに変換されるので、
MPlay を使ってこのフォーマットに変換すると、レンダリングが高速化します。

画像フォーマット - ショットのレンダリングやテクスチャマップには、こ
れらの業界標準のフォーマットが使用されます。
.exr - OpenEXR は、Industrial Light & Magic 社が開発したハイダイナミック
レンジ（HDR）画像ファイルフォーマットです。Houdini のレンダリングを保存
する、デフォルトのフォーマットです。 

.jpg/.png - 画像を Web にパブリッシュする際に使用されるフォーマットです。 

.tga/.tif - ビデオゲームのテクスチャマップによく使用されるフォーマットです。 

ジオメトリフォーマット - ジオメトリのインポートとエクスポートでは、
次のフォーマットが最も一般的です。
.usd - Solaris/LOP で使用されるフォーマットで、他のアプリケーションと	
共有するためのオープンソース交換フォーマットでもあります。
.abc - Alembic は、オープンコンピュータグラフィックス交換フレームワーク
です。 
.fbx - Autodesk 社が所有するフォーマットで、ゲームエンジンや他の 3D アプ
リケーションとデータをやり取りする際によく使用されます。ジオメトリ、リギ
ング、モーションおよびシェーダ情報を保持できます。 

.obj - Wavefront 社が独自に開発したシンプルなジオメトリフォーマットです。

プリフライトパネル
Render メニューから Pre-Flight Scene を 
選択して、シーンのセットアップを評価できます。

参照ファイル - プリフライトパネルでは、$HIP  
または $JOB のどちらかを参照して、シーンファ
イルのファイル参照を確認することができます。

緑でハイライトされた参照 - $HIP や $JOB に 
対する相対参照は緑で表示され、正常に機能 
していることが示されます。

不正確な参照 - ファイル参照が絶対パスであり、
$HIP や $JOB に対する相対参照でない場合は、
赤で表示されます。プロジェクトを他のアーティ
ストと共有したり、クラウドで共有する場合は、
事前に修正する必要があります。

Edit Expression - 任意のファイル名をクリック
し、エクスプレッションを右クリックすると、Edit 
Expression ウィンドウが開きます。

39

フ
ァ

イ
ル

管
理



エクスプレッションとスクリプト
Houdini はプロダクションレベルのソリューションであるため、作業ではスクリプトが重要な役割を果たします。 
アーティストはエクスプレッションを書くだけで十分なことがほとんどである一方、テクニカルディレクターは 
より長い時間をこうしたテクニックに費やすことになります。Houdini は、Hscript、Python、VEX をサポートして 
います。

HSCRIPT エクスプレッション
HScript は、エクスプレッションの記述に使用できる情報を取得および
操作するための、素早く簡潔な方法となるように設計されています。	
エクスプレッションとは通常、単純な文字列や数値ではない、任意の
値です。これは、変数のような単純な場合もあれば、方程式やエクス
プレッション関数である場合もあります。

フィールドにタイプするだけで、パラメータに直接エクスプレッションを
入力することができます。Enter を押すと、フィールドが緑でハイライト
されます。パラメータ名をクリックするだけで、エクスプレッションと	
エクスプレッションの結果を切り替えられます。
チャンネル参照を作成する場合は、パラメータを RMB クリックして 
Copy Parameter を選択し、リンクさせたいパラメータに移動して 
Paste Relative References を選択します。
また、2 つ目のパラメータを RMB クリックし、Reference > Scene 
Data を選択しても同じです。表示されるパネルで、他のオブジェクト
やノードからデータを選択すると、エクスプレッションが構築されます。
この方法で、複数のパラメータにエクスプレッションを設定することも
可能です。

エクスプレッションエディタ
関数の複雑さやパラメータの種類によっては、エクスプレッションエ
ディタを使用することもできます。エクスプレッションエディタを開くに
は、パラメータを RMB クリックして Expression > Edit Expression 
を選択するか、パラメータ上にマウスを置いて Alt + E を押します。

PYTHON
Python は、CG 業界では統合や標準化をサポートするスクリプト言語
として一般に使われ、よく知られています。その理由から、ツール開発
に向いています。 
Houdini における Python は、Houdini Object Model（HOM）上に	
構築されています。HOM は、Python スクリプト言語を使用して 
Houdini から情報を取得し、制御することができる API です。	
Python では、HOM を定義するモジュール、関数、クラスの階層の	
トップが hou パッケージです。hou モジュールは、パラメータエディタ

や hython コマンドラインシェルでエクスプレッションを記述するときに
自動的にインポートされます。
Houdini でエクスプレッションを記述するのに Python を使用すること
もできます。これには、ノードのパラメータエディタの上部にあるエク
スプレッション言語オプションを変更します。

 

Python コマンドの入力には、Python シェルパネルも使用可能です。	
また、hou モジュールを標準の Python シェルにインポートして、
Houdini を既存の Python ベースのスクリプトに統合することもでき
ます。

ツールシェルフ
シェルフツールは Python でセットアップされています。こうしたコード
を確認するには、任意のシェルフツールを RMB クリックして Edit ツー
ルを選択します。

PYSIDE/PYQT
Python Panel エディタペインでは、PySide2 または PyQt5 イン
ターフェースを作成、編集、削除できます。また、このエディタでは、
Houdini ペインタブメニューのエントリだけでなく、Python Panel の	
インターフェースメニューのエントリも管理できます。このパネルには
サンプルコードがいくつか付属しており、試してみることができます。

PYTHON ステート
Python で Viewer State を記述すると、ビューポート内でのノードに	
対するユーザ操作をカスタマイズできます。これを利用して、アーティ
ストフレンドリーなインターフェースをツールに構築できます。詳細な
情報は、ドキュメントを参照してください。
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VEX
VEX はハイパフォーマンスなエクスプレッション言語で、シェーダの記
述など、Houdini のほとんどの場所で使われています。VEX 評価は、
一般に非常に効率的で、コンパイル済み C/C++ コードに近いパフォー
マンスを発揮します。 
VEX はスクリプトの代用ではありませんが、シェーダやカスタムノード
を記述するために使う、小さくて効率的な汎用言語です。VEX は大ま
かには C 言語ベースですが、RenderMan シェーディング言語と同様
に C++ の考え方を採用しています。
VEX は、Houdini のさまざまな場所で使われています。
モデリング – VEX SOP により、Point アトリビュートを操作するカスタムサー
フェスノードを記述できます。ポイントを動かしたり、速度を調整したり、色を
変更することができます。さらに、ポイントをグループ化するなど、さまざま
な便利なタスクを実行できます。

レンダリング – Karma と Mantra が、シェーディング計算に VEX を使用して
います。これには、ライトシェーダ、サーフェスシェーダ、ディスプレイスメン
トシェーダ、フォグシェーダが含まれます。

コンポジット – VEX Generator および VEX Filter COP を使用すると、複雑な
カスタム COP を VEX で記述できます。エクスプレッションは C/C++ と同様の
速度で評価し、Pixel Expression COP よりも 1000 倍高速に実行されます。

CHOP– VEX CHOP で CHOP をカスタマイズすることができます。CHOP 関数
は任意の数の入力チャンネルを操作して、任意の方法でチャンネルデータを
処理できます。場合によっては、VEX コードはコンパイル済み C++ コードより
も高速で実行可能です。

ファー – プロシージャルなファーの動作を VEX で実装しています。

VOP
VEX を使いたいが、コードは書きたくない場合には、VOP コンテキスト
でノードベースのインターフェースを使用することができます。このた
めには SOP コンテキストで Attribute VOP ノードを使用し、中に入っ
て VOP を使って VEX コードを作成します。入力ジオメトリを受け取っ
て、それを操作できます。

Parameter VOP を使用すると、SOP レベルで使用する、浮動小数点
のスライダのようなインターフェース要素を構築できます。こうすると、
VOP レベルに戻ることなく VEX コードを実行できます。 

VOP コンテキストは、アーティストがインタラクティブに VEX コード
を作成できるように設計されています。スクリプト経験者にとっては、
Wrangle ノードに直接コードを記述する方が合理的かもしれません。

WRANGLE ノード
VEX を使い慣れたユーザがアトリビュートを微調整する低レベルの 
Attribute Wrangle ノードを含む、Wrangle ノードを使用することも
できます。チャンネル、ボリューム、変形を扱う Wrangle ノードもあり
ます。 

Wrangle ノードの使用方法を知りたい場合は、Entagma.com をご覧
ください。コンテンツを作成する、より技術的なアプローチを学習でき
ます。アーティストの考え方も取り入れた、素晴らしいチュートリアル
がいくつも提供されています。 

コンパイルブロック
ジオメトリネットワーク（SOP）では、ネットワークの一部をコンパイル
ブロックに含めることで、コードを記述した場合と同じくらい効率的に
機能させることができます。ネットワークの働きにはいくらか制約が	
課されるとはいえ、適切な状況で使うと、大きなメリットを得られます。

HOUDINI DEVELOPMENT KIT | HDK
Houdini をさらに深く活用するには、HDK があります。HDK は、
SideFX のプログラマーが Houdini ファミリー製品の開発に使用してい
るのと同じ C++ ライブラリの包括的なセットです。HDK を使用すると、
Houdini インターフェ-スのさまざまな領域をカスタマイズできるプラグ
インを作成できます。ここでは、開発キットの用途の例をいくつか紹介
します。
	� カスタムのエクスプレッション関数を追加する
	� カスタムのコマンドを追加する（hscript または HOM）
	� カスタムのオペレータを追加する（SOP、COP、DOP、VOP、ROP、CHOP、
Object）

	� 非標準のレンダラをサポートする出力ノードを追加する
	� カスタムのライティングや大気効果をレンダラに追加する

HDK の詳しい使い方は、SideFX の Web サイトにアクセスし、
Support > Documentation > HDK を選択してください。
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タスク
Task Operator（TOP）を使用すると、タスクを整理およびスケジューリングし、インテリジェントに演算ファームに 
分散できます。これにより、各タスクとタスクの進行状況との関連を示すディペンデンシーグラフを維持しながら、 
データを並列で処理することができます。 

Procedural Dependency Graph
TOP は、Procedural Dependency Graph を使用して構築された 
Houdini のネットワークタイプです。Procedural Dependency Graph 
とは、複雑な依存関係をノードで視覚的に記述するテクノロジで、	
実行可能なタスクセットを生成し、スケジューラの助けを借りて演算
ファームに分散させます。結果を評価したら、ネットワーク全体を再
クックしなくても、グラフの一部に変更を加えることが可能です。

TOP ノード
タスクまたは TOP ノードを使用すると、パイプラインのタスクを管理で
きます。各タスクの並列処理と分散が最終的な目的です。TOP ノード
がタスクを生成すると、そのタスクはドットで表示されます。タスクが
クックされると、このノードや子 TOP ノードで新しいタスクが実行され
ます。

スケジューラ
スケジューラ系ノードは、必要な依存関係を満たしたタスクを受け取
り、計算リソースを割り当てます。各タスクが完了すると、スケジュー
ラはタスクグラフに通知します。タスクグラフが PDG グラフに通知す
ると、次の対象タスクに移行します。PDG は、HQueue、Deadline、
Tractor などの業界標準のスケジューラや、Python で記述したスケ
ジューラをサポートしています。

TOP ノードのクック
タスクグラフができたら、ノードをクックします。グラフの途中でノード
をクックすることも、チェーンの終端の出力ノードをクックすることも	
可能です。
	� Cook Selected Node	 Shift + G
	� Dirty and Cook Selected Node	 Shift + V

進捗状況は、タスクバーで確認できます。TOP ノードでは、タスクのドッ
トを RMB クリックして、そのタスクをクックするか Dirty（変更あり）に
するかを選択できます。タスクを Dirty（変更あり）にすることとは、ネッ
トワークを再クックすると、それらのタスクが再計算されることを意味
します。クリーンなタスクは再クックされません。完了した作業をやり
直す必要がないことは、TOP のメリットの 1 つです。

依存関係
グラフ内のタスクのドットをクリックすると、そのタスクが依存している
上流のタスクと、そのタスクに依存している下流のタスクにつながって
いる細いラインが表示されます。 
上流で変更があった場合、タスクは自動的に Dirty（変更あり）になり、
依存関係がある下流のタスクも Dirty（変更あり）になります。PDG グラ
フが効果的なパイプラインツールとして機能するための、重要なプロ
セスです。

ノードを RMB クリック....

TOP ノード
入力 - ノードは、入力に供給される情報を受け取り、
データごとに 1 つのタスクに分割します。

進捗ホイール - 完了、クック中、未開始（キュー）の
タスクの数を表示します。

TOP ノード - これは、現在クック中のノードです。 
実行されているタスクに対する指示を含みます。
ノードを RMB クリックすると、サポートされるアク
ションのメニューが表示されます。

タスク - 各タスクは小さいドットとして示されます。
色は現在の状態を示し、タスクのドットを RMB ク
リックすると、グラフのその部分について詳細を確
認することができます。

出力 - タスクが完了すると、このノード上の他の 
タスクがまだアクティブであっても、出力は次の 
ノードに結果を渡します。
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Task Graph Table
ノードを RMB クリックすると、Open Task Graph Table を選択でき
ます。Task Graph Table には、タスクが項目別にリストされ、インデッ
クス、状態、クック時間、優先度などの情報も確認できます。このウィ
ンドウの項目をクリックすると、ネットワークビューではノード上のタス
クのドットがハイライトされます。

データのインポート/エクスポート
TOP グラフにデータを取り込む際は、さまざまなオプションを使用し
て、ジオメトリ、画像、スクリプトなどのデータにアクセスできます。
Houdini デジタルアセットを使用してプロシージャルネットワークを	
適用したり、Houdini の他の部分と接続してデータをインポートしたり
エクスポートすることが可能です。

WEDGE ノード
PDG の重要なワークフローである Wedge 化により、デザインの複数
のイテレーションを素早く作成できます。その後、すべての異なるオプ
ションを TOP グラフで処理し、最後に収集して最終的な出力を作成で
きます。 

画像モザイクと動画の出力
TOP では、ImageMagik を使用してコンタクトシートを作成できます。
コンタクトシートを使用すると、デザインのイテレーションを評価して
最適な選択をしたり、シーンを彩るプロップのバリエーションを生成す
ることができます。また、オーバーレイを使用してネットワークから情
報を引き出すことで、最善の判断を下しやすくなります。

他のアプリとの統合
TOP には、Shotgun や Autodesk Maya などの他のアプリケーション
と連携するためのノードが含まれています。ネットワークを Houdini 外
に拡張し、パイプラインのすべての部分を補強できます。

Pilot PDG アプリケーション
TOP ネットワークは、Houdini 内からセットアップおよび実行できます
が、ファームの管理者や、TOP ネットワークの作成に特化したパイプラ
イン TD は PilotPDG を使用できます。Houdini に関連するタスクにつ
いては、非グラフィカルで動作する Houdini Engine を呼び出して実行
します。

TOP ネットワーク
このネットワークタイプでは、処理
されるネットワークを管理および
確認できます。

タスクバー - ネットワークを開始
および停止したり、進捗を確認で
きます。

ネットワークパス - グラフがセット
アップされている TOP ネットワー
クまでのパスが表示されます。

TOP メニュー - TOP ネットワーク
を整理したり処理するための各種
オプションがあります。

進捗バー - ネットワークタスク全
体の進捗を確認できます。

TOP ノード - これらのノードは、
特定のコマンドをタスクに変換し、
スケジューラで送信することでタ
スクを完了します。

依存関係ライン - タスクをクリック
すると、ネットワーク上の他のタス
クとの接続を確認できます。

スケジューラ - スケジューラ系 
ノードは、データがどこで処理さ
れ、いくつのノードが関与するかを
決めます。

完了したタスク - ノードがすべ
てのタスクの処理を完了すると、
チェックマークが付加されます。

進行中のタスク - 進行中には、 
まだ完了していないタスクを確認
できます。
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HOUDINI デジタルアセット　
プロシージャルなツール構築
ノードネットワークは、Houdini にプロシージャルな性質を与え、繰り返し適用可能なレシピを定義します。 
Houdini デジタルアセットを使用すると、これらのネットワークをラップして、カスタムツールやスマートアセットを 
作成できます。このようにしてアーティストが構築したツールは、何度でも繰り返し使用でき、スタジオ全体の 
生産性を向上します。

Houdini のノードベースのワークフローが優れている点の 1 つは、	
アーティストが同じ手順を繰り返すのではなく、既存のノードネットワー
クに変更を加えることで複数のイテレーションを生成できることです。
プロセス全体をはじめからやり直すことなく、いくつものユニークな	
結果を得られます。 
Houdini デジタルアセットはこれをさらに一歩進め、1 つまはた複数
のネットワークを単一のノードにカプセル化し、パラメータをトップレベ
ルにプロモートします。このノードはディスクに保存され、作成された
ファイルは共有可能で、他のアーティストがそれぞれのシーンにロード
できます。

アーティストが構築するツール
Houdini デジタルアセットは、Houdini のインタラクティブなツールを
使用して作成します。ノードからアセットプロパティパネルにパラメータ
をドラッグすることで、ハイレベルなインターフェースを構築でき、コー
ドを記述することなく、カスタムツールを作成できます。つまり、テクニ
カルアーティストたちはカスタムツールを構築し、それを手軽に同僚に
使ってもらうことができるわけです。 
Houdini デジタルアセットは、階段や家具などのプロシージャルな	
プロップや、爆発などのビジュアルエフェクトの場合もあれば、サーフェ
ス上にオブジェクトをばら撒くポピュレートツールなどの汎用的なツー
ルである場合もあります。現在のプロジェクト専用のコンテンツを作成
するにしても、すべてのプロジェクトに使える大規模なツールセットを
構築するにしても、それぞれの制作ニーズに応じた Houdini デジタル
アセットのコレクションを構築できます。 

パイプラインフレンドリー
Houdini デジタルアセットがシーンファイルにロードされると、ディスク
上の .hda ファイルを参照します。つまり、アセットに加えられた変更
は、そのファイルを参照しているすべての人に自動的に取得されます。 
このため、パイプライン全体で、変更を反映するのが非常に簡単です。
ディスク上の 1 つのアセットを参照するだけで、最新のイテレーション
で更新されたら、即座に新しいアセットにアクセスできるわけです。
Houdini デジタルアセットファイルが格納できるのはアセット定義だけ
ではありません。アセットで使用される画像、ジオメトリファイル、スク
リプトも保存できます。したがって、他の人がアセットを使用する際は、
関連するすべての情報を利用できます。

CONTENT LIBRARY と ORBOLT
Content Library は、完全なシーンファイル、完全にリギングされた
プロップ、レンダリング可能なビジュアルエフェクト、アニメート可能な
キャラクタ、ゲームアセットなど、2D および 3D アセットを備えたオン
ラインアセットリポジトリです。アクセスするには、SideFX の Web サイ
トで Get > Content Library を選択します。 
Orbolt は、多種多様なデジタルアセットを提供する、オンラインのア
セットマーケットプレイスです。Houdini には、作業時に使えるように、
ダウンロードまたは購入した Orbolt アセットを保存しておくためのパ
ネルがあります。

.hda ファイル

デジタルアセットの作成
Houdini

Houdini

デジタルアセット 
として保存

1	Houdini でノードと	ネットワークを作成します。

2	ネットワークをパッケージ化し、他のアーティストと共有可能な Houdini デジタルアセット（.hda）	
ファイルとして保存します。

4	アセットを使用するには、.hda ファイルを Houdini に再度ロードします。 

アセットレベルにプロモートされたパラメータの
み使用できます。他のすべてのパラメータはロッ
クされます。

同じアセットを複数の Houdini シーンで何度でも
使用できます。HDA ファイルに変更を加えると、
他のすべてのアセットも簡単に同期されます。

3	パラメータとハンドルをアセットのトップレベルに	プロモートすることで、アセットのインターフェース
を構築します。 
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HOUDINI ENGINE
他のアプリとの共有
Houdini Engine を使用すると、Houdini のプロシージャルなノードベースのアプローチを使い慣れたアプリケー
ションに取り込めます。このテクノロジを利用して Houdini デジタルアセットを共有すれば、同僚は Autodesk® 
Maya® や 3ds Max® などの 3D アプリケーションや、Unity® や Unreal® といったゲームエディタに直接アセットを
ロードできます。

他のアプリケーションを使用しているアーティストが 
Houdini デジタルアセットのメリットを享受できるの
は、Houdini Engine プラグインのおかげです。Houdini 
Engine API で作成されたプラグインにより、.hda ファイ
ルとすべてのハンドルおよびコントロールをホストアプリ
ケーションにロードできます。アセットでパラメータが設
定されると、Houdini は「内部」でノードとネットワークを
クックし、その結果をホストに返します。

HOUDINI ENGINE API
これを実現しているのが Houdini API で、API を利用し
てホストアプリケーション向けのプラグインが作成され
ています。HAPI は、フラットかつ小規模な API で、習得
も簡単です。独自のプラグインを作りたい開発者向けに、
Github で提供されています。

HOUDINI ENGINE プラグイン
Houdini インストーラから、またはオンラインでアクセスできる 
Houdini Engine プラグインがいくつかあります。プロダクション環境で
実証済みのこれらのプラグインなら、アーティストやスタジオは安心し
て利用できます。
各プラグインは、一般的な Houdini アセットの機能とホストアプリケー
ションの仕組みの間を橋渡しするように設計されています。例えば、	
ボリュームを使用するクラウドアセットは、Maya では問題なく機能	
するものの、ボリュームがサポートされていない Unity や Unreal では	
解釈されません。

無償の Houdini Engine for Unity/Unreal または無償の Houdini 
Engine Indie ライセンスで動作するプラグイン:
	� Unreal
	� Unity

Houdini Engine ライセンスまたは無償の Houdini Engine Indie 	
ライセンスで動作するプラグイン:
	� Autodesk Maya
	� Autodesk 3ds Max 
	� 独自開発のプラグイン

Houdini Engine を使用して Autodesk Maya にロードされた Houdini デジタルアセット

HOUDINI ENGINE パイプライン

Houdini
Engine

ホスト 
アプリケーション

Houdini 
ライブラリ

Houdini

デジタルアセット

をロード

.hda ファイル1	Houdini Engine プラグインを使用して、	.hda ファイルをホストアプリケーションに
ロードします。

3	Houdini Engine が Houdini ライブラリファイルをコールし、アセット内のノード
とネットワークを「クック」します。 

4	アセットがロードされたり、パラメータが変更されると、Engine は Houdini ライブ
ラリを取得し、ノードをクックしてから、	
結果をホストに返します。 

2	ホストアプリケーションが、Houdini Engine を使用してアセットとインターフェースを	
受け取ります。

Houdini Engine プラグインが動作する 
ホストアプリケーション
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映画および TV のパイプライン
アニメーションと VFX
実写プレートにビジュアルエフェクトを施すにしても、フル CG のショットを作成するにしても、映画や TV プロジェク
トの最終目標は動画です。動画の映像は、キャラクタ、セット、エフェクトなどのアセットを最終的なコンポジットで 
1 つにまとめあげることで、作られています。

Houdini は、映画および TV 番組制作パイプラインの全段階に使える、
フル機能のパッケージです。モデリングからレンダリング、アニメーショ
ン、最終的なコンポジットまで、Houdini にはクリエイティブなプロセ
スを支えるプロシージャルなツールが搭載されています。長年にわた
り、Houdini が業界標準になっているのは VFX の分野です。SideFX は、
アカデミー賞でのオスカー獲得をはじめ、科学技術部門での賞をいく
つも受賞しています。
プロシージャルモデリング、ライティング、キャラクタ作成といった分野
も強化されており、スタジオからは熟練の Houdini アーティストを求
める声が高まっています。

HOUDINI CORE / HOUDINI FX
パイプラインで使用する Houdini には、2 つの商用バージョンがありま
す。Houdini Core は DOP を除くすべての Houdini ツールを搭載し、
Houdini FX は完全なツールセットを搭載しています。Houdini FX で	
作成したシーンや VFX は、Houdini Core でステージング、アニメート、
ライティング、レンダリングが可能です。FX アーティストは Houdini FX 
ライセンスで、それ以外のユーザは Houdini Core ライセンスを使用す
ることで、堅牢なパイプラインが得られます。 
例えば、シニアテクニカルディレクターが Houdini FX を使用して特定
のプロダクションの課題を解決し、その結果のノードとネットワークを 
Houdini デジタルアセットにラップする使い方があります。アーティスト
フレンドリーな UI を構築し、アニメータや VFX アーティストがコスト効
率のよい Houdini Core でショットを作るのを支援します。 

相互運用性
ほとんどのスタジオは、多種多様な 3D アプリケーションを使用して、
パイプラインの各領域に対処しています。Houdini には、異なるアプ
リケーション間でデータをやり取りできるようにする、相互運用性に優
れたツールが多数あります。USD、Alembic、FBX、EXR のどれを使用
していても、アーティストはさまざまな DCC アプリケーション間を簡
単に行き来できます。また、Houdini Engine プラグインを使用すると、
アセットのプロシージャルなコントロールを保持したまま、Autodesk® 
Maya® や 3ds Max® などのアプリケーションに Houdini デジタルアセッ
トを取り込むことができます。
小規模なスタジオで、短納期に対応するプロダクションでは、大規模
なファイル交換は避けたいことでしょう。フル機能のプロシージャルな
既成パイプラインである Houdini なら、すべての段階を扱えます。 

レンダリングとシミュレーションの分散
画像のレンダリングや VFX のシミュレーションは、時間がかかる処理で
す。フォトリアリスティックな結果を得たい場合には、さらに長い時間
を要します。Houdini では、Houdini Engine のバッチモードを使用し
て、レンダリングおよびシミュレーションタスクを演算ファームに分散さ
せることができます。
シミュレーションの分散により、短時間で結果が得られるだけでなく、
1 台のコンピュータではメモリ不足が懸念されるようなエフェクトも処
理できます。シミュレーションをスライスして分散させることで、最終的
な結果に妥協することなく、メモリを管理できます。Houdini Engine 
を使用して、ファームでシミュレーションを実行することを強くお勧めし
ます。

映画および TV のパイプライン

Render
 VFX

 Layout Animate Light Render Composite

Lighting
 VFX

Simulate
 VFX

Animate
 VFX

 

 

 

Distribute
Sims

Distribute
Render

Distribute
Render

Particles and 
Dynamics

RigModel

Houdini FX

Houdini CORE
Karma Render/Mantra

Houdini Engine

USD, FBX, OBJ, EXR etc...

File Transfer
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ゲーム開発および VR のパイプライン
インタラクティブ体験
ビデオゲームやバーチャルリアリティのプロジェクトで重視なのは、スムーズなゲームプレイ体験を実現するよう 
高度に最適化されたコンテンツを使用して、インタラクティブな 3D 世界を構築することです。映画に似たゲーム 
シネマティクスのレンダリングとは、異なるタイプのパイプラインを用いることになります。 

ゲームパイプラインの中核は、Unreal や Unity などの
ゲームエンジンです。これらのエンジンが、ゲームアート
とゲームインタラクションを統合し、プレイ可能な体験を
作り出します。ゲームアーティストは Houdini を使用し
て、地形の作成、レベルの設計と配置、プロシージャル
モデルの構築、キャラクタの構築とアニメーション、火、
流体、破壊などのリアルタイム FX の作成を行うことがで
きます。

ゲームエンジンへのエクスポート
Houdini からゲームエンジンにコンテンツを取り込むに
は、2 通りの方法があります。従来は、FBX や OBJ といっ
たファイルフォーマットにエクスポートし、それをエンジン
にインポートしていました。Houdini でプロシージャルな	
システムを作成し、その結果を平坦化します。
もう 1 つの方法は、Houdini デジタルアセットを作成し、Unreal や 
Unity 向けの Houdini Engine プラグインを使用してゲームエンジン
にロードすることです。これらのアセットは、パラメータやコントロール
を保持したまま、ゲームエディタにインポートされます。ゲームエディ
タ内で変更を加えることができ、Houdini Engine がバックグラウンド
で動作してアートワークを更新します。
ゲームアーティストはエディタ内でこのプロシージャ性を活用で
き、ゲームをコンパイルする際に、アートワークがベイクされます。
Houdini Engine はランタイムソリューションではないため、ゲームプレ
イの一部としてアクセスすることはできません。 

リアルタイム FX
Houdini は VFX で知られており、ゲームの FX 作成に最適なツールで
す。しかし、FX は、テクスチャシート、フローマップ、頂点アニメーショ
ンテクスチャなどのテクニックを用いて最適化する必要があります。	
エフェクトのフットプリントを可能な限り軽くすることで、ゲームの	
フレームレートが保持され、コマ落ちも起きません。本ドキュメントで
紹介し たSideFX Labs ツールは、このようなワークフローをサポートす
るよう設計されています。

Houdini Engine を使用して Unreal にロードされた Houdini デジタルアセット

ゲーム開発および VR のパイプライン Houdini FX

Houdini CORE
Game Engines/Other Apps

Houdini Engine Plug-ins

FBX, OBJ, USD, EXR etc...

File Transfer
Maya/

3DS Max

AnimateRigModel

 

Procedural
Modeling

Level 
Design

Export

Game
Engine

Realtime FX

Play Game

Compile/
Bake Assets

Save as
HDA

 

Terrain
Generation

Populate
Environment
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製品とライセンス
Houdini を使い始めるにあたり、Houdini 製品の種類を知っておくと
役立ちます。大規模なスタジオ、小規模なスタジオ、新たに立ち上げ
た独立系（インディ）制作チームなど、それぞれのニーズに応じた各種 
Houdini 製品があります。また、学校のラボや無償で学習したい学生
のための Houdini もあります。 

商用ライセンス 
Houdini Core – モデラー、ライティングアーティスト、キャラクタリグ
ガー、アニメータ、ゲームアーティスト向けに設計され、コンポジティ
ングやモーション編集などの機能も搭載しています。Houdini FX で作
成したシーンは、Houdini Core で開いてレンダリングできるため、VFX 
のライティングに最適です。
Houdini FX – Houdini FX は、Houdini Core に含まれるすべてのツー
ルに加えて、パーティクルおよびダイナミックシミュレーションツールも
搭載しています。Houdini FX のプロシージャルワークフローを使用す
ると、流体、Pyro FX、粒、布、ヘアとファー、群衆、ソフトボディエフェ
クトなどを作成できます。
Houdini Engine – Houdini Engine は、コマンドラインからバッチモー
ドで実行し、レンダリングや分散ダイナミックシミュレーションを一括
で処理することができます。また、Autodesk® Maya®、Autodesk® 3ds 
Max®、Unity®、Unreal® をはじめ、他のデジタルコンテンツ作成アプリ
ケーションに Houdini デジタルアセットをロードするときにも Houdini 
Engine が使用されます。

INDIE ライセンス
Houdini Indie - 起業したばかりのアニメータやゲーム制作者に、
Houdini のアニメーションおよび VFX ツールのすべてを提供します。
Houdini Indie の商用利用は、約 1000 万円以下の収益に制限されて
います。 
Houdini Engine Indie – Houdini Engine Indie ライセンスを使用す
ると、Houdini Indie をバッチモードで実行したり、Houdini デジタル
アセットを他のコンテンツ作成アプリにロードすることができます。

ライセンスについて
Houdini Education – Houdini Education は、学校、トレーニングセ
ンター、学生による使用を目的として設計された、Houdini FX のフル
機能バージョンです。Houdini Education では、Houdini Apprentice 
で作成したファイルを開くことができます。
Houdini Apprentice – Houdini Apprentice は、Houdini FX の無料
体験バージョンで、学生、アーティスト、ホビーユーザが非商用目的の
個人プロジェクトに使用できます。受賞歴のある Houdini FX のほぼす
べての機能にアクセスできるので、スキルの強化や個人プロジェクトに
役立ちます。Apprentice ではディスクにシーンを保存可能ですが、レ
ンダリング画像にはウォーターマークが追加されます。

注意 : Indie、Apprentice、Education で作成したシーンファイル
とアセットは、商用バージョンの Houdini では使用できません。ファ
イルフォーマットが異なるうえ、異なるライセンスタイプ間でのファイ
ル共有は EULA（エンドユーザー使用許諾契約書）で認められていま
せん。

ライセンスタイプ
ワークステーション（ノードロック） – このライセンスタイプは 1 台の	
コンピュータ上で使用でき、ローカルサーバーまたは SideFX.com 	
からのみアクセス可能です。
ローカル / グローバルアクセス（フローティング） – これらのライセンス
はサーバー上にセットアップでき、アーティストチームで共有可能です。
アーティストが Houdini を起動すると、利用可能なライセンスがある
場合、ライセンスがサーバーからチェックアウトされます。ローカルラ
イセンスは単一のスタジオ向けで、グローバルライセンスは異なる場
所にあるスタジオで共有することを目的に設計されています。

ライセンスのインストール
ライセンスを取得したら、Houdini License Administrator（hkey）
アプリケーションを開き、File > Install Licenses を選択して、ライセ
ンスをインストールします。ログインとパスワードの入力を求められま
すが、これは SideFX.com の Web サイトで設定したものと同じです。 
ローカルにインストールするのではなく、sidefx.com をライセンスサー
バーとして使用できるようになりました。ログインライセンスを使用す
るには、常に SideFX アカウントでログインしている必要があります。
異なるコンピュータを使ってログインすることもできますが、一度に使
用できるのは 1 台のみです。この方法は、独立系制作者や学生ユーザ
に最適です。 
ローカルおよびグローバルアクセスライセンスは、この方法で中央
サーバーにインストールできます。ライセンスにアクセスする全員が、
そのサーバーを利用できるようにする必要があります。 
また、ライセンスを確認したい場合は、SideFX.com の Web サイト
の右上に表示されるアバターをクリックし、Services を選択して、
Manage Licenses リンクをクリックします。

年間アップグレードプラン（AUP）
Houdini への投資を最大化する年間アップグレードプラン（AUP）は、
ビジュアルエフェクトスタジオ、ゲームスタジオ、3D アーティストに重
要な特典を提供します。プロダクションレベルのテクニカルサポート、
最新のソフトウェア機能強化を含むフルリリースとドットリリース、バグ
修正を含むデイリービルドなどをご利用いただけます。 

SIDEFX サポート
Apprentice ユーザを含むすべてのお客様は、インストールやライセン
スに関する問題について、メールサポートシステムで SideFX にお問い
合わせいただけます。複雑なプロダクションに関する問題や質問は、
年間アップグレードプランおよび商用レンタルのお客様のみ、サポート
チームに問い合わせが可能です。
弊社のサポート担当窓口は、support@sidefx.com です。	
次の情報をメールに含めてください。
	� お使いのオペレーティングシステム（Windows XP など）
	� Houdini のバージョンおよびビルド番号
	� インストールの問題の概要、ライセンスの問題がある場合には 

診断ファイル

サポートプロラムの詳細については、SideFX.com/support をご覧く
ださい。

48

HO
UD

IN
I F

OU
ND

AT
IO

NS



商 用 独立系（インディ） 学 習

製品 HOUDINI FX HOUDINI CORE HOUDINI INDIE EDUCATION APPRENTICE

対象ユーザ スタジオ | 商業アーティスト 独立系 | フリーランス 学校 | 学生 ホビーユーザ

価格 SideFX.com を参照 1 年間 $269 USD 1 年間 $75 USD 無償

オペレーティングシステム Windows、LINUX、Mac OSX

モデリング     

キャラクタ     

アニメーション     

Solaris : レイアウトツール     

Solaris : ルックデブとライティング     

Karma/Mantra レンダリング     

地形     

合成     

ボリューム     

Pyro FX  Simple Fireball   

流体  シンプルな Flip   

リジッドボディ  Simple Fracture   

パーティクル  -   

Vellum Cloth  Simple Cloth   

ワイヤーダイナミクス  -   

群衆  -   

ライセンス 商用 限定的な商用 非商用
ワークステーション（ノードロック）    - 

ローカル/グローバルアクセス（フローティング）   -  -

ユーザインターフェース

Houdini GUI アクセス     

コマンドラインアクセス     

GUI ウォーターマーク - - 透かし入り（小） 透かし入り（小） 透かし入り（小）

プラグインサポート     

HOUDINI ENGINE

HOUDINI ENGINE プラグイン     なし

Engine 用アセット作成     Education ライセンス用

Orbolt 用アセット作成     

レンダリング

Karma トークン 5  / 10* 5 / 10* 1 10 1

Mantra トークン 無制限 無制限 1 10 1

サードパーティ製レンダラ     なし

ウォーターマーク付きレンダリング - - - - 

解像度 無制限 無制限 無制限 無制限 1280 x 720

シーン

.hip   .hipalc .hipanc .hipanc

.hda   .hdalc .hdanc .hdanc

ジオメトリ

USD     .usdnc

FBX     インポート

Alembic     インポート

.bgeo     

画像

.pic   .piclc  .picnc

.exr     ウォーターマーク付き

.tif     ウォーターマーク付き

.png/.jpg     ウォーターマーク付き

機
能

フ
ォ

ー
マ

ッ
ト

比較表 

* 商用のワークステーションライセンスには Karma トークンが 5 つ付属し、ローカルおよびグローバルアクセスライセンスには Karma トークンが 10 個付属しています。
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HOUDINI FOUNDATIONS 

モデリング、レンダリング、	
アニメーション 
Houdini へようこそ。このレッスンは、サッカーボールのモデリング、レンダリング、アニメーション、シミュレーショ
ンをゼロから行います。スクワッシュ＆ストレッチ（潰しと伸ばし）の理論を使用して昔ながらのバウンシングボール
のアニメーションを作成し、テクスチャとマテリアルを適用し、ライトとカメラを追加します。また、ダイナミクスを
使用してサッカーボールの一群をシミュレートする方法も探ります。 

はじめての Houdini シーンを作成し、Houdini のさまざまな部分を確認し、インターフェースや必須のツールなど
を実際に使っていきます。Scene View でインタラクティブに作業する方法と、ネットワークビューを使用してノー
ドを管理しながら、モデルを整えたり、アニメーションリグを構築する方法を学びます。また、Solaris ステージで
マテリアルとテクスチャをセットアップしてから、Houdini の組み込みのレンダラである Karma を使ってレンダリン
グし、最後にはリジッドボディシミュレーションを作成します。

レッスンの目標
Houdini のプロシージャルなノードベースのワークフローを使用して、サッカーボールのモデリング、 
レンダリング、アニメーション、シミュレーションを行います。

学習内容
	� View ツールを使用する方法
	� シェルフ、Radial メニュー、Tab キーを使用する方法
	� ジオメトリを作成する方法
	� ノードとネットワークを使用する方法
	� カスタムアトリビュートと For-Each ループ をセットアップする方法
	� マテリアルとテクスチャ UV をセットアップする方法
	� ショットのレイアウトを作成し、Karma でレンダリングする方法
	� キーフレームを設定し、Motion FX を追加する方法
	� リジッドボディダイナミクスを使用する方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✔

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔
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プロジェクトファイル
SideFX.com の サッカーボールチュートリ
アルのページ（このドキュメントを入手した場
所）から、intro_lesson  ディレクトリをダウ
ンロードします。home または documents 
ディレクトリにある、Houdini Projects ディ
レクトリに配置してください。   

パート 1 

Houdini UI の確認
はじめに、Houdini ワークスペースと、頻繁に使うことになる 3 つのペインを理
解しておきましょう。ビューポートではオブジェクトをインタラクティブに作成でき、
パラメータエディタではノードプロパティを編集でき、ネットワークエディタでは
ノードネットワークを直接操作することができます。   

01 File > Set Project を選択します。ダウンロードした intro_
lesson  ディレクトリを見つけ、Accept を押します。これで、この

ショットに関連するファイルがすべて、先ほどコピーしたプロジェクトディレ
クトリとそのサブフォルダに配置されるようになります。 

File > Save As... を選択すると、新しい intro_lesson  ディレクトリが表示
されます。ファイル名を soccerball_01.hip（または football_01.hip）に
設定し、Accept をクリックして保存します。 

02 ビューポートで、C を押して Radial メニューを表示します。この
メニューから Create > Geometry > Box を選択します。カーソ

ルの位置に、シーン内への配置待ちの状態にあるボックスの輪郭が表示さ
れます。Enter を押して、原点の位置に配置します。

Scene View にボックスが作成され、ネットワークエディタにノードが追加さ
れ、パラメータエディタにはオブジェクトパラメータが表示されます。これ
らの各種インターフェース要素を使用しながら、プロジェクトを進めていき
ます。

03 Houdini の View ツールを見ていきましょう。次のホットキーを
押してください。

	� タンブル	 スペースバーまたは Alt（Opt）+ LMB クリック + ドラッグ
	� パン	 スペースバーまたは Alt（Opt）+ MMB クリック + ドラッグ
	� ドリー	 スペースバーまたは Alt（Opt）+ RMB クリック + ドラッグ

ホームをすることで、ビューをリセットしたい場合もあります。そうし
た場合に便利なホットキーもあります。

	� Home Grid	 スペースバー + H
	� Home All	 スペースバー + A
	� Home Selected	 スペースバー + G

Radial メニュー
Houdini のツールには、X、C、V のホットキーを使ってアクセスできる 
Radial メニューからもアクセスできます。いずれかのホットキーを押すと、
Radial メニューが表示され、各種オプションを選択できます。各メニューの
主な内容は次の通りです。

	� スナップ 	 X
	� メイン（またはカスタム）	 C
	� ビュー	 V

52

HO
UD

IN
I F

OU
ND

AT
IO

NS
 



選択のホットキー
Select、Move、Rotate、Scale、Handles ツールを使用する場合、	
次のホットキーで選択モードと作業するレベルを決定します。

	� オブジェクト 	 オブジェクトレベル	 1
	� ポイント 	 ジオメトリレベル	 2
	� エッジ	 ジオメトリレベル 	 3
	� プリミティブ/ 面 	 ジオメトリレベル	 4
	� 頂点 	 ジオメトリレベル	 5

RMB クリックでメニューにアクセス

07 チェーン内のノードをいくつか選択してみましょう。選択したノードのハンドルが表示されますが、表示は最終的な形状のままで
す。各ノードの Display フラグを設定し、表示ノードを変更してみましょう。
バイパスやテンプレートといったフラグも試してください。polyextrude  
ノードをネットワークから移動して、その後同じ場所に戻します。 

最後に、すべてを元に戻し、subdivide  ノードの Display フラグを設定し
ます。これは非常に重要です。Display フラグによって、オブジェクトレベル
での表示が決まるからです。Display フラグは必ず正しく設定してください!

04 オブジェクトを選択した状態で、I を押し、そのジオメトリレベル
に移動します。Shift キーを使ってハンドルをドラッグし、原点を

中心に Z 軸に沿って長くします。

Houdini でオブジェクトを作成すると、オブジェクトのトランスフォームを管
理するオブジェクトレベルと、形状を定義するジオメトリレベルができます。
I を押すと、このオブジェクトのジオメトリレベルに入ることができます。	
また、ネットワークエディタでオブジェクトノードをダブルクリックしても、	
ジオメトリレベルに入れます。後でオブジェクトレベルに戻るには、U を押
します。

05 S を押して Select ツールに切り替えたら、4 を押してプリミティ
ブの選択にアクセスします。N を押してすべてを選択してから、

C を押して Radial メニューを表示し、Model > Polygons > Poly Extrude 
を選択します。 

Scene View の上部にあるオペレーションコントロールツールバーまたはパ
ラメータエディタで、Divide Into を Individual Elements に設定し、ハン
ドルを使用して Distance を約 0.4 に設定します。これにより、各プリミティ
ブの法線に沿って面が押し出されます。 

ネットワークビューには 2 つのノードが表示されています。Houdini では手
順を進めるたびにノードが作成され、それらのノードでシーンを調整してい
きます。

06 N を押して新しい面をすべて選択したら、Tab を押して sub… 
と入力し、リストから Subdivide を選択します。Houdini のツー

ルにアクセスするには、Tab キーも便利な方法です。ツール名を入力する
と、リストに候補のツールが表示されるので、サブメニューをナビゲートしな
くても必要なツールを簡単に見つけることができます。

パラメータエディタで、Depth を 2 に設定します。ジオメトリが細分化され、
ポリゴンの数が増えます。Houdini には、オブジェクトレベルで細分化を表
示できるオプションもあり、ジオメトリを実際に追加しなくても細分化を確
認できます。しかしここでやりたいことは、ポリゴンの作成です。 
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パート 2

サッカーボールの作成
次は、ボックスをサッカーボールの形をしたプラトン立体に置き換えます。Houdini のプロシージャルなアプローチなら、Box ノードを 
Platonic Solids ノードに置き換えられます。そこから他のノードを調整して、サッカーボールらしい見た目にします。入力ノードの置き換
えができるため、シンプルなジオメトリでネットワークのプロトタイプを作成しておけば、柔軟性が高まります。 

01 ネットワークエディタで、Tab キーを使用して Platonic Solids 
ノードをネットワークに追加します。クリックしてチェーンの最上

部付近に配置します。platonic  ノードを polyextrude  に接続します。パラ
メータエディタで、Solid Type を Soccer Ball に設定します。box  ノードを
選択して削除します。

Houdini はプロシージャルのため、入力ノードを変えても、ネットワーク全
体が適切に機能することは珍しくありません。作業の柔軟性が高まるだけ
でなく、変更後の結果が気に入らなければいつでも、元の形状を接続し直
せばよいわけです。

02 polyextrude  ノードを選択します。Handle ツールがアクティブ
になっていることを確認したら、ビューポートでハンドルを使用

して、Distance の値を下げます。パラメータエディタでパラメータ値を設
定してもかまいません。これでサッカーボールらしい見た目になりました。
subdivide  ノードを表示している場合でも、polyextrude  ノードを選択す
ると、そのハンドルとパラメータにアクセスできることを覚えておきましょう。

このプリミティブタイプで準備がすべて整ったと思うかもしれませんが、実
際には、平らな面で構成された切頂正二十面体にすぎません。丸いサッカー
ボールが必要なので、もう少し手を加える必要があります。 

03 ビューポートで V を押し、Radial メニューで Shading > 
Smooth Shaded を選択します。ビューポートの右上のメニュー

を使用しても、シェーディングを変更できます。

このサッカーボールは、正式な革製のサッカーボールではなく、安いビニー
ルボールのように見えます。これからノードを追加し、分岐させながら見た
目を向上させていきます。

分析を終えたら、シェーディングの設定を Smooth Wire Shaded に戻し
ます。

シェーディングオプション
View Radial メニューまたはビューポートの右上にある Shading  
メニューから、さまざまなシェーディングオプションを使用できます。 
オブジェクトのシェーディングでは、ビューポートの右端にある表示オプ
ションでライティングが決まります。ヘッドライト、通常のライティング、
シャドウ付きの高品質なライティングのいずれかを選択できます。 
シェーディングビューからワイヤーフレームに素早く切り替えるには、 
W キーを押します。

Disable Lighting

Headlight Only

Normal Lighting

High Quality Lighting

High Quality with Shadows
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05 platonic  ノードと polyextrude  ノードの間に、subdivide  ノー
ドをドラッグします。接続されたワイヤー上にドロップすると、	

自動的に挿入されます。挿入されない場合は、接続されるまで少し動かし
てみてください。押し出される前に、球のディテールが増加します。

06 ネットワークエディタで Tab キーを使用して Ray ノードを追加
し、subdivide  の後に接続します。次に、sphere ノードをネッ

トワークに追加して、Radius を 1, 1, 1 に、Primitive Type を Primitive 
に設定します。sphere を ray  ノードの 2 つ目の入力に接続します。これに
より、細分化されたボールが完全な球に投影されます。 

これは、Houdini の非常に強力なノードです。あるジオメトリのポイントを
別のジオメトリに投影します。細分化されたサッカーボールが完全には丸く
ないという、ここでの問題にぴったりの解決策です。

07 polyextrude ノードに Display フラグを再度設定します。
Divide Into を Individual Elements に設定すると、すべての

小さいポゴンが押し出されますが、それは望ましくありません。Connected 
Components に設定して、すべてのポリゴンが押し出されるようにします。

このネットワークでは、ボールが細分化された後で、サッカーボールの元の
パッチを押し出す方法が必要です。これを行うには、元のジオメトリのプリ
ミティブ番号を使用します。

04 ネットワークビューで Y を押し、subdivide  ノードと 
polyextrude  ノードをつなぐワイヤーを横切るようにドラッグ

して、接続を解除します。より丸みのあるサッカーボールになるように、
subdivide を残り 2 つのノードの間に移動します。 

Ray ノード
Ray ノードは、ポイントを別のジオメトリに投影するツールです。おもちゃのピンアートに似ていま
す（子供の頃に遊んだことはありませんか）。実際、これは Houdini でピンアートのボードをセッ
トアップするために使用するノードです。
ヘルプの確認 | 各ノードについて詳しく知りたい場合は、パラメータエディタの右上にある  ヘ
ルプボタンをクリックすると、そのノードのオンラインドキュメントが表示されます。シェルフのツー
ル上にカーソルを置いて、F1 を押してもヘルプを確認できます。Houdini で開けるサンプルファ
イルが用意され、そのノードの機能を学べるようになっているヘルプもたくさんあります。

55

サ
ッ

カ
ー

ボ
ー

ル
の

作
成



アトリビュートの使用
アトリビュートは、ポイント、プリミティブ、頂点に割り当てることができ
ます。一般的なアトリビュートには、カラー（Cd）や UV などがあります。
ノードにカーソルを置いて Radial メニューから i を選択すると、チェー
ン内の任意の場所でアトリビュートを確認できます。また、Geometry 
Spreadsheet パネルでもアトリビュート値を確認することができます。
このレッスンでは、patches  というカスタムアトリビュートを作成し、
For-Each ループで活躍してもらいます。

01 AttributeCreate ノードを platonic  ノードの後に追加しま
す。Name を patches  に、Class を Primitive に設定します。

Value フィールドの最初の値を @primnum に設定します。 

このエクスプレッションは、プリミティブ番号アトリビュートを取得し、それを 
patches  という新しいアトリビュートに変換します。 

02 attributecreate  ノードを選択した状態で、メインのビューポー
トの横にある Geometry Spreadsheet タブをクリックします。

Primitive ボタンをクリックすると、左側にプリミティブ番号が表示され、
パッチの色を示す 3 つのカラーアトリビュートと、プリミティブ番号と一致す
る patches  アトリビュートも表示されます。 

ray  ノードをクリックします。このアトリビュートは、形状が細分化されると
きに繰り越されます。もっと多くのプリミティブがあることが分かりますが、
patches  アトリビュートは 31 までで、その後は 0 に戻ります。

03 Scene View タブに戻り、Display Options バーの 	
  Visualization ボタンを RMB クリックし、Scene の横にあ

る +（プラス）記号をクリックして、Marker を選択します。Edit Visualizer 
パネルで、Name と Label を Patch_Numbers  に、Type を Marker に、
Class を Primitive に、そして Attribute を patches  に設定します。 

パート 3

For Each ノード
ここで魔法が働きます。最後に作成したアトリビュートを For-Each ループに送り、それぞれの元のパッチに多数のポリゴンが含まれてい
ても、それらのパッチが押し出されるようにします。ポリゴンを押し出した後、もう一度細分化すると、サッカーボールが革製らしく見える
ようになります。 

patches = 0
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05 ネットワークエディタで Tab を押し、For-each Named 
Primitive と入力して、2 つのノードにアクセスしてシーンに

配置します。ray  ノードと polyextrude  ノードの間に foreach_begin  
を接続し、polyextrude  ノードの後に foreach_end  を接続します。
foreach_end  ノードを選択し、パラメータエディタで Piece Elements は 
Primitives に設定したままにし、Piece Attribute を patches  に設定しま
す。foreach_end  ノードに Display フラグを設定します。

patches  アトリビュートに基づいて、元のパッチが一斉に押し出されている
のを確認できるはずです。押し出されていない場合は、polyextrude  ノー
ドで Divide to が Connected Components に設定されていることを確
認してください。

06 Single Pass の横にあるチェックボックスをクリックし、どうな
るかを確認します。スライダをドラッグして、それぞれのパッチが

個別に押し出される様子を確認してください。10 よりも大きい値に設定す
ると、さらに多くのパッチを確認できます。

Single Pass をオフにして、完全な形状を表示します。for-each  ノードがす
べてのパッチを作成し、最終的なジオメトリを返します。For-Each ループは、
Houdini で頻繁に使用する強力なノードセットです。

07 foreach_end  ノードの後に Fuse ノードを追加し、その 
Display フラグを設定します。これは、ピースをつなげて単一の

トポロジにするノードです。for-each  ノードでは、バラバラのパッチに分割
しましたが、それらを再結合することはしませんでした。

Fuse の後に Subdivide ノードを追加します。depth を 2 に設定します。
ビューポートでディテールが加わり、これを使用してモデルを評価できるよ
うになります。ポリゴンの数は増えますが、まだ真の細分化サーフェスとし
てレンダリングされるわけではありません。Houdini では、ジオメトリを追
加することなく、ビューポートで細分化表示を設定することも可能ですが、
この Subdivide ノードはレッスンの後半で必要となります。

08 サッカーボールが革製に見えるように、polyextrude  の値を変
えて試しましょう。ここでは Distance を 0.1、Inset を -0.02 に

設定してください。パッチが丸みを帯びて、ルックが向上します。 

オブジェクトレベルに移動し、パラメータエディタでオブジェクトの名前を 
soccerball_geo  に変更します。ノードを選択するか、F2 を押すか、名前
をダブルクリックします。Render タブをクリックし、Render Polygons as 
Subdivisions (Mantra) をオンにして、レンダリング時の真の細分化をセッ
トアップします。  Render Region ツールを選択したら、ビューポートで
サッカーボールの周りにボックスを描き、プレビューレンダリングを作成しま
す。キャンセルするには、その領域の右上にある X ボタンをクリックします。

04  Visualization ボタンがオンになっていることを確認します。
ビューポートのサッカーボール上にパッチの値が表示されていま

す。元のプラトン立体からのプリミティブ番号が、細分化された面に転送さ
れています。Display フラグを別のノードに設定して、関係を確認してみま
しょう。この情報は、For-Each ループを使用して適切にパッチを押し出すた
めに使用されます。

Visualization ボタンをオフにして、作業内容を保存します。ここまでの手順
について、やや抽象的で専門的すぎると感じているかもしれませんが、大丈
夫です。努力はもうすぐ実を結びます。

attributecreate  ノード ray  ノード
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パート 4

UV のセットアップ
マテリアルやテクスチャをセットアップするには、オブジェクトに適切な UV がセットアップされていることが大切です。 
Houdini のジオメトリには UV が付属していないため、自分で作成しなければなりません。つまり、ネットワークにノードを追加する 
必要があり、ここでは UV Quickshade と UV Flatten ノードを追加します。

01 soccerball_geo  オブジェクトの中に入ります。ネットワーク
ビューで、Tab > UV Quickshade を押し、foreach_end  ノード

のすぐ後に新しいノードを追加します。Display フラグ を設定します。

Texture Map の横にあるファイル選択ボタンをクリックします。/tex フォ
ルダに移動し、soccerball_color.rat  を選択します。このテクスチャマップ
がジオメトリに表示されますが、投影方法を使用して UV を作成したため、
全体が引き伸ばされたように見えます。

注 : 既存のテクスチャに合わせて UV をセットアップするのは、通常の作業
順ではありません。逆の順番をあえて使っているのは、自分でテクスチャを
ペイントする必要がないからです。 

02 Scene View で、N を押してすべてを選択してから、Tab > UV 
Flatten を選択します。Group フィールドで、@patches>19 と

いうエクスプレッションを入力します。これにより、パッチ境界を使用してサッ
カーボールジオメトリの暗いパッチが平坦化され、UV がレイアウトされま
す。   

このツールを使用すると、UV ビューが表示されます。右上の UV (vertex) 
メニューをクリックして、Background > soccerball_color.rat  を選択しま
す。すると UV パネルの背景にこのテクスチャが表示されます。このテクチャ
には、画像の中央にチームのロゴが、上部には暗いパッチのための暗い領
域が含まれています。   

03 Handle ツール を RMB クリックし、Min:  ハンドルをオンにしま
す。下部にある矢印ハンドルを、すべてのパッチがテクスチャマッ

プ上部の暗い領域内に入るまで引き上げます。

このノードを fuse  または subdivide  の後に配置していたら、使用する境界
はなかったでしょう。Houdini では既存のネットワークの途中で UV をセット
アップでき、作業に柔軟性を持たせられます。

04 uvflatten  ノードの後、Fuse ノードの前に、もう 1 つ UV Flatten 
ノードを追加します。Group フィールドで、@patches<20 とい

うエクスプレッションを入力します。これにより、明るいパッチが平坦化され
ます。 

Handle ツール を RMB クリックし、Min:  ハンドルをオンにします。上部に
ある矢印ハンドルを、すべてのパッチがテクスチャマップ下部の明るい領域
内に入るまで引き下げます。

完了したら、Handle ツール を RMB クリックし、Min:  ハンドルをオフにし
ます。

Scene View で RMB クリックし、メニューで Texture Visualization > Off 
を選択します。これでグリッドが非表示になります。

上にドラッグ

下にドラッグ
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06 UV ビューに移動し、ピンとパッチをロゴの中央になるように移
動します。Y を押して回転ハンドルに切り替え、パッチを回転して

ロゴの位置を調整します。   

UV ビューでパッチの頂点をピン留めすると、位置を固定できます。最初は
隣接するパッチとのオーバーラップがいくらかありますが、再パックによって
簡単に修正できます。

05 uvflatten  ノードを選択し、Handle ツールをクリックします。ジ
オメトリ上にカーソルを置くと、パッチがハイライトされるのが分

かります。ビューポート上部にあるオペレーションコントロールツールバー
の Pin Vertices ボタンをクリックします。 

この画像に表示されたパッチにカーソルを置き、3D ビューで、目的のパッチ
の中央の頂点を Shift クリックして選択します。UV ビューに、ピンと操作用
のハンドルが追加されます。

07 オペレーションコントロールツールバーの Repack ボタンをク
リックして、新しいパッチを中心に残りのパッチを再編成します。

引き続きピンを使用してパッチを動かせますが、UV のオーバーラップを回避
するには、もう一度再パックが必要です。   

08 quickshade  ノードをバイパスに設定し、テクスチャマップの割
り当てを非表示にします。このノードが必要なのは、UV をセット

アップするときのみです。サッカーボールに UV グリッドが表示されます。 

パースビューで UV を非表示にするため、Display Options バーで Show 
UV Texture when UV’s Present ボタンをオフにします。

Null ノードをチェーンの終端に追加して、名前を GEOMETRY_OUT  に変
更します。ネットワークチェーンの終端の定義には、この種のノードを使うこ
とをお勧めします。作業内容を保存します。

UV FLATTEN
UV Flatten ノードの動作は、2 つの工程で構成されています。シーム（継ぎ目）によって定義された、
個々のテクスチャのピースを受け取り、それらを 2D テクスチャ空間へと平坦化して、ポリゴンサイズ
の均等化を試みます。 
このノードで、平坦化アルゴリズム用の拘束を追加することができます。この拘束により、レイアウトア
ルゴリズムが強制的に特定の条件を満たすようにすることで、最終的な UV レイアウトをさらに制御で
きるようになります。このノードの状態で、ツールを使って拘束を指定すれば、ノードをインタラクティ
ブに使用できます。または、Enable Manual Layout をオフにすると、このノードをプロシージャルに
使用できるようになります。

Shift クリック

UV テクスチャの表示
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パート 5

レイアウト : カメラとライト
レンダリング用のシーンを作成するには、ジオメトリを Houdini の Solaris または LOP コンテキストに取り込むことになります。 
これは、ルックデブ、レイアウト、ライティングに特化した環境で、USD (Universal Scene Description) を基盤に構築されています。 
これを使用すると、Solaris ワークフローの一部として、Scene View で適切に動作する Karma レンダラでレンダリングすることができ
ます。

01 ネットワークビューで、Tab > Match Size を押し、subdivide  
と GEOMETRY_OUT null  の間にこのノードを追加します。

GEOMETRY_OUT  ノードに Display フラグを設定します。 

matchsize  ノードを選択し、Justify Y を Min に設定して、地上に乗るよう
にボールを引き上げます。これで、正しい位置でレンダリングできます。

02 デスクトップを Solaris に変更します。パスバーに stage と表示
されていることを確認してください。 

ネットワークビューで Tab > Scene Import を選択し、クリックしてノードを
配置します。Force Objects フィールドの横にあるノードセレクタボタンを
クリックし、ポップアップウィンドウで soccerball_geo  オブジェクトを選択
してから Accept Pattern をクリックします。 

Scene View で、スペースバー + H など、ビューのリセット用ツールを使用
して、サッカーボールがよく見えるようにします。

注 : Objects フィールドではなく Force Objects を使用します。Force 
Objects は、オブジェクトの Display フラグがオフになっていても、LOP 
にオブジェクトを取り込むからです。

03 ネットワークビューで、Tab を押して Grid と入力します。ク
リックしてノードを配置し、名前を backdrop  に変更します。

backdrop  ノードをダブルクリックして、ジオメトリレベルに入ります。 

grid  ノードを選択し、Size を 80, 80、Centerを 0, 0, -20 に設定します。	
grid  ノードの出力を RMB クリックして、Bend と入力します。クリックして
ノードを配置したら、Display フラグを設定します。Bend を 75、Capture 
セクションで Capture Origin を 0, 0, -30、Capture Direction を 
0, 0, -1、Capture Length を 5 に設定します。 

grid  ノードの出力を RMB クリックして、Subdivide と入力します。
Display フラグを設定し、Depth を 2 に設定します。

04 ステージレベルに戻ります。backdrop  ノードを sceneimport  
に接続します。sceneimport の出力を RMB クリックし、

Camera と入力します。Enter を押してノードを配置したら、その Display 
フラグを設定します。   

Scene View で、原点にカメラハンドルが表示されます。ズームアウトして
シーンを見下ろすようにしたら、カメラが左側からサッカーボールを見るよ
うにハンドルを調整します。地面に沿ってハンドルを動かしたい場合には、
コンストラクション平面をアクティブにすると操作がしやすくなります。	
また、軸ハンドルで方向を制御したり、カメラを地面から持ち上げることも
可能です。
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09 ネットワークビューで、lights  ノードの出力を RMB クリックし、
Light Mixer と入力してから Enter を押してノードを配置し、	

その Display フラグを設定します。パラメータエディタに特殊なパネルが	
作成され、左側にライトがリストされます。 

3 つのライトをリストから右側の領域にドラッグします。星アイコンをクリッ
クして各ライトをソロにして寄与度を定めたら、Exposure でライティング
を微調整します。intensities がとても高いので、強度バーの上のアイコン
をクリックし、ポップアップメニューでショットに適した Max Value を設定し
ます。完了したら、Solo ボタンをオフにしてすべてのライトを表示します。

06 LOP Lights and Camera シェルフで Environment Light 
ツールをクリックし、Enter を押してそれを原点に配置します。

Intensity を 0.5 に設定し、少し和らげます。

カメラメニューの左にあるメニューをクリックし、Karma に設定します。	
これで、ビューポートで Karma レンダラが使用されるようになります。

Nvidia グラフィックカードがあり、最新のドライバをインストールしてい
る場合は、Optix Denoiser をオンにすると、画像をより素早く処理できま
す。Display Options バーでそれをオンにするか、D を押して Render 
Display Options の Enable Denoisingを設定します。

05 Scene View の右上の No cam  メニューをクリックし、
camera1  を選択します。これでカメラ越しに見えるようになり、

見え方を調整できます。 

求めているのはこのビューではないでしょう。いくらか変更します。Scene 
View の右側にある  Lock camera to view ボタンをクリックします。	
表示ツール（スペースバー + LMB/MMB/RMB）を使用してカメラの位置を
調整します。 

重要 : 完了したら、Lock Camera ボタンをオフにします。

07 LOP Lights and Camera シェルフで Point Light ツールをク
リックし、Enter を押してそれを原点に配置します。ライト越し

に見えるようになります。カメラを再度 camera1  に設定します。

ノードをアクティブにした状態で、Shift + F を押して Shadow モードをオ
ンにします。オペレーションコントロールツールバーでクリックしても同じ
です。サッカーボールの上部をクリックしてピボットポイントを設定したら、
Shift クリックして地面にターゲットを配置します。Ctrl ドラッグ でライトの
距離を設定します。

Ctrl + Shift ドラッグで、ライトの強度を変更できます。サッカーボールです
ぐに見て取れるほどの影響を与えるには、かなり高く設定する必要があり
ます。

08 ネットワークビューで、pointlights  ノードの出力を RMB クリッ
クし、Light と入力してから Enter を押してノードを配置し、そ

の Display フラグを設定します。

ノードをアクティブにした状態で、Shift + S を押して Specular モードを
オンにします。サッカーボールの右側をクリックして、鏡面反射が集中する
領域を定義します。 

Ctrl ドラッグでライトをサッカーボールから離し、Ctrl + Shift ドラッグで
ライトの強度を変更します。

Denoise

Solo
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パート 6

ルックデブ : マテリアル
マテリアルとシェーダは、LOP/Solaris のコンテキスト内で作成することもできます。この場合、シーングラフにマテリアルを追加してから、
ジオメトリに割り当てます。マテリアルは、Material Library ノード内で作成され、LOP/Solaris レベルで割り当てられます。背景にテク
スチャを追加するには、UV を作成して、マップを適切に配置できるようにする必要があります。 

01 ネットワークビューで Tab > Material Library を押し、既存
のノードのネットワークのすぐ上にノードを配置したら、それを 

backdrop  ノードに接続します。ノードをダブルクリックして、VEX Builder 
レベルに下がります。 

Tab > Principled Shader を押してノードを配置します。その名前を 
soccerball_mat  に変更します。Base Color を 白（1, 1, 1）に設定します。

このノードを Alt ドラッグして、2 つ目の Principled Shader を作成し、名前
を backdrop_mat  に変更します。Base Color を暗い緑色に変更します。

02 ステージレベルに戻り、Tab > Assign Material を押して、
sceneimport  と camera  ノードの間にノードを配置します。 

パラメータエディタで、Primitives の横の矢印ボタンをクリックし、ビュー
ポートで soccerball  ジオメトリを選択します。Enter を押し、Primitives 
フィールドにそのパスを追加します。Material Path の横にある矢印をク
リックし、ポップアップウィンドウで materials > soccerball_mat を選択
してから OK をクリックします。

+（プラス）ボタンをクリックし、backdrop  と backdrop_mat についても
この手順を繰り返します。

03 materiallibrary  ノードをダブルクリックして中に入り、
soccerball_mat  ノードを選択します。Textures タブをクリック

し、Base Color の Use Texture をクリックしたら、Texture の横のボタン
を使用してファイルウィンドウを開きます。横のリストで $HIP をクリックした
ら、tex  フォルダをクリックして開き、soccerball_color.rat  をワンクリック
して選択します。Accept をクリックし、テクスチャをマテリアルに割り当て
ます。 

$HIP 参照により、シーンファイルの位置に対して相対的に参照するように
なります。このようにすると、プロジェクトディレクトリを別のコンピュータ
に移動しても、引き続き参照が機能します。

04 Textures タブで、前の手順で学んだテクニックを使用して、
Roughness と Reflectivity にテクスチャを割り当てます。	

tex  フォルダで適切なテクスチャを見つけます。

マテリアルの Bumps & Normals タブに移動して、Enable ボタンをクリッ
クします。Texture Path の横にある矢印をクリックして、tex ディレクトリか
ら soccerball_normal.rat ファイルを選択します。Effect Scale を約 0.5 
に設定し、どうなるかを確認します。
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Houdini のマテリアル
Houdini のマテリアルは VEX Builder コンテキストにあり、この場合
は Material Library ノード内にネストされます。マテリアルは、マテリ
アルの品質を定義する VOP ノードまたは Material X ノードで構成さ
れています。 
Principled Shader は、単体でテクスチャマップを割り当て、多様な
ルックを生成できる優れたマテリアルです。独自のシェーダやマテリア
ルを構築して、より高度なルックを実現することも可能です。 

05 Scene View で、camera1  越しにショットを確認します。サッカー
ボールのロゴがカメラに対してよい位置にないので、ボールを回

転する必要があります。 

Scene View で、サッカーボールを選択します。Tab > transform を押しま
す。チェーンの終端に transform ノードが追加されます。Handle ツールで、
R を押して Rotate ハンドルにしたら、ロゴがきれいに見えるようにボール
を回転します。タンブルする必要がある場合もあります。

これは、Karma または Houdini GL ビューで行うことができます。変更が
気に入らない場合は、ノードを削除してもう一度試します。soccerball_
geo  を選択解除するには、シーングラフ でそれを Ctrl クリックします。

06 backdrop マテリアルにいくつかテクスチャマップを追加しましょう。materiallibrary  ノードをダブルクリックして、backdrop_
mat  ノードを選択します。 

Base Color を 1, 1, 1 に設定し、この色がテクスチャマップに乗算されるよ
うにします。Textures タブをクリックして、Base Color の Use Texture を
クリックします。ファイル選択ボタンをクリックして、$HIP から /tex ディ
レクトリに移動し、backdrop_color.rat  を選択します。Reflectivity  に 
backdrop_reflect.rat テクスチャを追加してもよいでしょう。 Scene View 
を見ると、UV が適切にセットアップされておらず、テクスチャマップも機能
していないことが分かります。

07 ステージレベルに戻り、backdrop  ノードをダブルクリックし
てジオメトリレベルに移動します。grid  と bend  の間に UV 

Project ノードを追加します。サーフェスを曲げる前に UV が作成されるよ
う、ここにノードを追加していきます。

uvproject  ノードで、Initialize タブをクリックして Initialize ボタンを押し
ます。Transformation タブに戻り、V Range を 0, -1 に設定します。これ
により、UV の方向が適切になります。

重要 : subdivide ノードに Display フラグを再度設定します。

08 ステージレベルに戻ります。ネットワークビューで、Tab > 
Karma を押し、Karma Render Settings と USD Render 

ROP ノードを追加します。それらをチェーンの終端に接続します。
karmarendersettings  ノードを選択して、Image Output > Filters タブ
で Denoiser を nvidia Optix Denoiser に設定してデノイザをオンに戻し
ます。

usdrender_rop  ノードを選択します。Render to Mplay ボタンをクリッ
クします。Mplay が開き、進行中のレンダリングが表示されます。File > 
Save Frame As を選択し、画像をディスクに保存します。
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パート 7

サッカーボールのリギング
バウンシングボールのアニメーションを作成するには、シンプルなリグの作成からはじめます。これで、キーフレームが設定しやすくなりま
す。そのためには、ビューポートでインタラクティブに作業できるように、Null オブジェクトをセットアップします。また、サッカーボールの
ジオメトリネットワークにノードを追加して、ボールの回転、スクワッシュとストレッチを適用します。

01 Build デスクトップに戻り、パスバーの 1 つをクリックしてオブ
ジェクトレベルに移動し、obj  を選択します。ネットワークエディ

タで、soccerball_geo  を Alt ドラッグしてコピーを作成します。このノード
の名前を socccerball_anim に変更します。 

soccer_anim  を使用して、リグを構築します。soccer_geo  ノードの 
Display フラグをオフにして、非表示にします。元のセットアップは変更した
くありません。そのオブジェクトは、Solaris コンテキストのショット 1 で使用
されているからです。この新しいサッカーボールは、アニメートされるショッ
ト 2 で使用します。

02 Create シェルフで、Null ツールをクリックしてから Enter を押
し、それを原点に配置します。名前を soccerball_ctrl  に変更

します。Misc タブに移動し、Control Type を Circles に、Orientation を 
ZX Plane に設定します。Display Uniform Scale を 4 に設定します。	
これでリグのハンドルが作成されます。簡単に選択でき、後のレンダリング
工程ではレンダリングされません。

ネットワークエディタで、soccerball_anim  オブジェクトの入力を 
soccerball_ctrl  Null の出力に接続し、親子関係を作成します。Null を動
かすと、ボールも動くようになります。soccerball_anim  の選択フラグを
オフにして、アニメーションの間ビューポートで誤って選択しないようにしま
す。代わりに soccerball_ctrl を使用します。 

03 soccerball_ctrl  ノードを選択します。パラメータエディタで、
Transform タブをクリックしてから Translate X パラメータを 

RMB クリックします。Copy Parameter を選択します。 

soccerball_anim  オブジェクトの中に入ります。subdivide と matchsize  
ノードの間に Transform  ノードを追加します。Rotate Z を RMB クリック
し、Paste Relative References を選択します。このパラメータに、チャン
ネル参照のエクスプレッションが配置されます。

ch(“../../soccerball_ctrl/tx”)

これで、コントロールオブジェクトの動きがこのノードの回転とつながるよう
になります。

04 パラメータをクリックしてチャンネルを展開します。ボールの外周
（2 π r）を使用して、ボールが前進するときの回転を定めます。 

エクスプレッションを次のように変更します。
-ch(“../../soccerball_ctrl/tx”)*360/(2*$PI*1.1)

まず、先頭にマイナス（-）記号を追加します。その後、エクスプレッションで
ボールの位置に 360 度を乗算し、2 π r（πは $PI）で除算します。オブジェク
トレベルで、soccerball_ctrl  を X 軸に沿って動かします。エクスプレッショ
ンにより、ボールが動きに合わせて回転します。完了したら、ボールを原点
に戻します。

Alt ドラッグ
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05 ビューポートで、もう 1 つ Null オブジェクトを原点に作成しま
す。名前を squash_ctrl  に変更します。Misc タブに移動して、

Control Type を Box に、Display Uniform Scale を 0.2 に設定します。

Null をボールの真上に移動します。Translate Y は約 2.5 になるはずです。
パラメータエディタで、Modify Pre-Transforms メニューを選び、Clean 
Translates を選択します。これにより、Null が地面より上にあっても、その 
Translate Y 値が 0 に設定されます。Null でスクワッシュとストレッチを駆
動するためには、0 のデフォルト値が必要となります。

06 soccerball_ctrl  Null を squash_ctrl  Null の親にします。これ
により、コントロール Null をアニメートすると、このセカンダリ

の Null が動くようになります。 

squash_ctrl  ノードの Translate Y パラメータを RMB クリックします。
Copy Parameter を選択します。このパラメータを使用して、ボールのスク
ワッシュとストレッチを駆動します。こうすることで、ビューポートからインタ
ラクティブにスクワッシュとストレッチを制御できるようになります。

07 soccerball_anim  オブジェクトの中に入ります。matchsize  
の後に Bend ノードを追加します。Limit Deformation to 

Capture Region チェックボックスをオフにします。 

Right ビューに移動して Set Capture Region ボタンをクリックします。	
グリッドスナッピングをオンにして、ボールの底部と上部に 1 つずつポイン
トを配置します。これにより、Up Vector は 0, 0, 1、Capture Direction 
は 0, 1, 0、Capture Length は 2.2 に設定されるはずです。   

Length Scale と Preserve Volume をオンにしたら、Length Scale を 
RMB クリックして、Paste Relative References を選択します。エクスプ
レッションの最後に +1 を追加します。 

08 オブジェクトレベルに移動し、パースビューを表示します。Transform X および Transform Z パラメータを RMB クリッ
クし、Lock Parameter を選択して、squash_ctrl  でこれらのパラメータ
をロックします Scale  および Rotate  パラメータを RMB クリックし、Lock 
Parameter を選択して 3 つすべてのチャンネルをロックします。 

soccerball_ctrl  オブジェクトを選択します。Translate X と Translate Y 
を除くすべてのチャンネルをロックします。これでコントロールを選択する
と、ロックされていないチャンネルのハンドルのみが表示されるようになり
ます。アニメータは選択したパラメータのみを操作でき、リグが扱いやすく
なります。

09 リグを X と Y で動かして、テストしてみましょう。2 つ目のハンドルを使用して、スクワッシュとストレッチを適用します。すべての
パーツがうまく機能していることを確認したら、すべての値を 0 に戻し、ア
ニメーションの準備をします。 

Scene View の左側のツールバーで Secure Selection をオフにすることを
お勧めします。Move ツールを使用している間、2 つのコントロール Null を
選択しやすくなります。オフにしない場合は、選択を切り替えるたびに S キー
を押す必要があります。 

シーンファイルを保存してから、次に進みます。
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Pose ツール
Move または Handle ツールを使用すると、サッカーボールのリグの 2 つのコン
トロールオブジェクトを簡単に操作できます。Pose ツールを使用する利点は、
Motion Path ハンドルにアクセスでき、インバースキネマティクスを使用している場
合は、専用のハンドルを使用できることです。そのため、リグにキーフレームを 
設定する場合は、このツールを必ず思い出してください。Secure Selection がオン
になっていても、Pose ツールで別のオブジェクトを選択可能です。

Select

Secure Selection [~]

Move [T]

Rotate [R]

Scale [E]

POSE [Y または Ctrl + R]

Handle [Enter]

01 タイムラインの左端の下段で、Global Animation Options ボ
タンをクリックします。End  を 120 に設定し、Close をクリック

します。これにより、タイムラインの範囲が 120 フレームに設定されます。 

フレーム 1 にいることを確認します。左側のツールバーで  Pose ツール
をクリックし、soccerball_ctrl  を選択します。ボールを X 方向の約 -15 に
移動したら、K を押してキーフレームを設定します。タイムラインをフレーム 
120 に移動します。ボールを X 方向の約 15 に移動したら、K を押して 2 つ
目のキーフレームを設定します。 

タイムラインをスクラブし、ボールがアニメートされていることを確認しま
す。リグの設計に基づいて、移動および回転するはずです。

02 タイムラインをフレーム 12 に移動し、K を押して中間のキーを
設定します。フレーム 36 と 60 で繰り返します。これらのキーフ

レームは、すべて地面上にあります。 

次にフレーム 1 に移動し、ボールを Y 方向に上げます。もう 1 つキーを設定
する必要はありません。この移動によって、フレーム 1 に既に設定してある
キーフレームが更新されるからです。

フレーム 24 に移動し、ボールをフレーム 1 よりも少し低い位置まで Y 方向
に上げます。K を押してキーフレームを設定します。フレーム 48 に移動し、
ボールをさらに少し低い位置まで上げます。K を押してもう 1 つキーフレー
ムを設定します。

03 タイムラインをスクラブすると、ボールが浮いたように見えます
が、ボールが着地するときは、強く当たるようにしたいわけです。

Animation Editor ペインタブをクリックします。 

Scoped Parameters リストで Translate Y  チャンネルをクリックします。	
H を押して、カーブのビューをホーム（リセット）します。ボールが着地する 
3 つのキーフレームを選択し、グラフのすぐ上にあるFunction ツールバー
で  Untie Handles ボタンを押します。何もない空間をクリックして選択
を解除したら、接線ハンドルを微調整して、着地の各ポイントのカーブを鋭
角にします。 また、上部のハンドルは平坦にして、バウンドのピークでボー
ルの速度を遅くします。 

パート 8

バウンシングボールのアニメーション
サッカーボールのリグを使用して、バウンドする（弾む）ボールをアニメートします。キーフレームを設定したり、アニメーションカーブを 
調整したり、ビューポートでハンドルを使って速度を調整する方法を学びます。バウンシングボールは、アニメーションの練習によく使われ
る課題で、Houdini でのアニメーションの基礎を学ぶのにも最適です。
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04 Scene View に戻り、結果をプレビューします。ボールが着地す
るたびに、弾むようになりました。Pose ツールがアクティブで、

soccerball_ctrl  ノードが選択されていることを確認します。上部のバーで、
Motion Path ハンドルをオンにします。これにより、ボールのバウンドのパ
スが表示されます。それぞれのキーフレームマーカーをクリックして、弾み
方を微調整します。カーブをより詳細に制御するには、ハンドルを RMB ク
リックして Show Tangents をオンにします。 

soccerball_anim  オブジェクトの Misc タブに移動して、Onion Skinning 
を Full Deformation に設定します。スペースバー + D を押し、Scene タ
ブで Frame Increment、Frames Before、Frames After のカラーを調
整します。   

05 タイミングの調整には、タイムラインも使用できます。Shift を押
し、フレーム 1 からタイムラインの最後のキーまで境界ボックス

をドラッグして、すべてのキーを選択します。次に、ボックスの端のハンドル
の下を MMB ドラッグして、バウンドのタイミングをスケールし、スピードを
上げます。MMB を使用して各キーを選択してから、MMB でドラッグしても、
それぞれのキーフレームのタイミングを好きなように調整できます。

ここでは、バウンドのタイミングを決定します。希望する動き方になるまで	
試してください。Translate X の値が原因で、弾み方が自然ではないかもし
れません。それは次の手順で修正します。

06 Animation Editor ペインタブをクリックして、2 つのカーブを
表示します。Scoped Parameters リストで、soccerball_ctrl  の 

Translate X をクリックします。最初と最後のキーを除く、すべてのキーを
選択します。Delete を押します。カーブハンドルを使用して、急な傾斜が
緩い傾斜に移行するようにします。こうすると、ボールの動きは始めが速く、
終わりでゆっくりになります。

Motion Path ハンドルで X 方向のポイントを再び調整すると、その方向には
中間キーがないため、おかしな結果になることに注意してください。これ以
降は、Y 方向の微調整にのみこのハンドルを使用します。

07 Scene View に戻ります。Motion Path ハンドルを RMB クリッ
クし、Persistent を選択します。これにより、スクワッシュとスト

レッチにキーフレームを設定する際のガイドとして、ハンドルを保持してお
けます。 

squash_ctrl を選択し、Motion Path をオフにします。最初のバウンドに
移動して、1 フレーム戻ります。squash_ctrl  のハンドルを選択し、ボール
を少し引き伸ばし（ストレッチし）ます。K キーをでキーフレームを設定しま
す。バウンドのフレームに移動し、ハンドルを下げてスクワッシュ（潰し）を作
成します。もう 1 つキーを設定します。1 フレーム進め、ボールが丸くなるま
でストレッチし（引き伸ばし）ます。もう 1 つキーを設定します。この手順を
すべてのバウンドで繰り返します。

08 完了したら、モーションをスクラブして再生し、結果をプレビューします。バウンドのピークで、ボールが引き伸ばされていること
を確認してください（ストレッチ）。モーションを正しく評価するには、タイム
ラインで  Real Time Toggle がオンになっていることを確認します。 
次に Animation Editor を使用して、スクワッシュとストレッチを微調整し
ます。キーフレームとサッカーボールのバウンドが揃っていることを確認しま
しょう。

ここを MMB ドラッグ
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Motion FX
キーフレームとアニメーションカーブはノードのパラメータに格納されますが、チャンネル
オペレータ（CHOP）を使用すると、よりプロシージャルなノードベースのアプローチでモー
ションを操作することができます。 
Motion FX は、Channel CHOP に抽出および格納される、キーフレームによる動きに適
用できます。その後、Cycle、Noise、Smooth、Limit、Lag などのエフェクトを既存の動
きに適用できます。Constraints シェルフにはさまざまなツールがあり、パラメータ設定
によってターゲットの方を向くようにしたり、遅延させたり、微震するようにできます。

10 動きの一部が地面の下にもぐっています。ボールが地面よりも上で揺れるようにする必要があります。 

オブジェクトレベルに戻ります。soccerball_ctrl  Null オブジェクトを選択し
ます。Translate Y を RMB クリックし、Motion FX > Limit を選択します。
Minimum を 0 に、Maximum を 6 に設定します。これで、ボールはずっと
上下に揺れ動くのではなく、いくらか揺れながら地上を移動するようになり
ます。

11 ボールが弾んでいる間は、ノイズは必要ありません。ノイズが必要なのは、ボールが転がりはじめてからです。Amplitude の
キーフレームを設定して、ノイズをオン/オフできるようにします。 

新しく作成した motionfx ネットワークで、noise1  CHOP ノードを選択
します。ボールが弾まなくなり、転がり始めるフレーム 37 に移動します。
Amplitude を Alt クリックして、キーフレームを設定します。フレーム 1 に
移動して、Amplitude を 0 に設定します。Amplitude を再度 Alt クリック
して、2 つ目のキーフレームを設定します。Animation Editor でカーブを
選択します。Function ツールバーの Constant ボタンをクリックします。	
これで、振幅なしから振幅 1 へとシャープに切り替わります。

12 完了したら、ウィンドウを閉じます。Motion Path ハンドルを 
RMB クリックして Persistent をオフにし、選択解除したらハン

ドルが表示されないようにします。 

Scene View の左側にあるツールバーで、  Render Flipbook ボタンをク
リックします。デフォルト設定のまま、Start をクリックします。シーケンスが
キャプチャされるまで待つと、Mplay ウィンドウにフリップブックが表示され
ます。これを再生したりスクラブして、動きを評価します。

作業内容を保存します。

09 soccerball_ctrl  Null オブジェクトを選択します。Translate Y 
を RMB クリックし、Motion FX > Noise を選択します。パネ

ルが開き、そこに表示されたパラメータを使用してノイズを制御できます。 
soccerball_ctrl  の Translate Y チャンネルに情報を送り返す CHOP ノー
ドを含む、新しいサブネットワークが作成されます。

Amplitude を 5 に設定し、Play を押してどのように見えるかを確認しま
す。上下に大きく動き、まるで激しい乱流のようです。Amplitude を 1 に	
設定して、ボールの動きに加わる揺れを少なくします。

68

HO
UD

IN
I F

OU
ND

AT
IO

NS
 



04 Select ツールを使用して、新しいアニメートされたサッカーボー
ルをクリックします。Scene View で、Tab > Transform を押し

て、Transform ノードをグラフに追加します。 

Scene View で、トランスフォームハンドルを使用してボールを中央の背景の
後方に移動します。タイムラインをスクラブして、ボールが弾みながら右に
進むことを確認します。フレーム 80 あたりで止めます。R を押して回転ハン
ドルを使用できるようにします。ボールを回転し、背景から斜めにバウンド
してくるように移動します。タイムラインをスクラブして、方向に問題がない
ことを確認します。 

01 オブジェクトレベルに移動します。soccerball_anim  をダブル
クリックして中に入ります。N を押し、すべてのジオメトリを選択

したら、Modify シェルフで Extract を選択します。これにより、ボールのす
べての動きと曲げが 1 つのネットワークにまとめられます。

ボールを extract_objectという新しいオブジェクトに抽出している 
objectmerge  ノードが表示されます。その出力を RMB クリックし、USD 
Export を見つけたら、クリックしてこのノードを配置します。このノード
を soccerball_anim  という名前に変更します。Export タブをクリック
し、Valid Frame Range を Render Frame Range に、Output File を 
$HIP/geo/soccerball_anim.usd  に設定します。Save to Disk ボタンを
クリックします。

02 Solaris デスクトップに戻り、/stage  を指定します。ネットワー
クビューで、karmarendersettings  ノードの直前に Null ノー

ドを追加し、その名前を SHOT_01  に変更します。 

3 つの light ノード（lightmixer  ではありません）を接続解除し、それらを 
backdrop  ノードの上に移動します。これにより、最初のショットのルックは
変わらず、2 つのショット間でノードを共有できるようになります。

backdrop、light、materiallibrary  ノードを右に移動します。 

03 ズームインして、Reference ノードを backdrop  ノードの右下
に追加します。backdrop  ノードをこの新しいノードに接続し、

Display フラグを設定します。File Pattern の横にある File Chooser を
クリックし、soccerball_anim.usd  ファイルを見つけます。ノードの名前を 
soccerball_anim  に変更します。 

Houdini GL ビューでタイムラインをスクラブすると、USD ファイルの一部で
あるキャッシュ化されたアニメーションを確認できます。

パート 9

ライト、カメラ、アクション!
アニメートしたサッカーボールをレンダリングするには、Solaris 環境に戻って 2 つ目のショットをセットアップする必要があります。 
まず、背景ジオメトリから新しい LOP ノードを分岐させてから、バウンドするサッカーボールのアニメーションに合わせてライトとカメラを
調整します。また、変形するジオメトリに対してモーションブラーもセットアップします。
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KARMA レンダラ
Karma は、Solaris/LOP コンテキストで USD ファイルを使用できるよう設計さ
れた物理ベースの HYDRA レンダラです。ビューポートで使用してインタラク
ティブに更新したり、Karma ノードを使用してディスクにレンダリングできます。
注 : Houdini 19 は、Karma XPU レンダリングエンジンのプレビューに対応し
ています。このハイブリッドな GPU/CPU レンダラはアルファ品質で、多くの機
能はまだ開発中であるため、テスト目的でのみ使用します。XPU は、Scene 
View の Display Options または Karma ノードで選択できます。

ビューポートメニュー Display Options

06 左上から右下へと、ボールがカメラに向かってアニメートされる様子が見えるまで、タンブルします。LOP Lights and 
Cameras シェルフで、Camera ツールを Alt クリックして、現在見ているア
ングルにカメラを配置します。 

Lock Camera/Light to View ボタンを押し、ビュー変更に応じてカメラの
位置が更新されるようにします。次にビューポートでタンブル、パン、ドリー
してカメラを微調整し、ショットに適したフレーミングにします。タイムライン
をスクラブし、シーケンス全体でカメラが機能していることを確認します。 

07 camera  の後に Light Mixer ノードを追加します。lightmixer  
ノードでは、ライト上にカーソルを移動します。こうすると、前に

紹介したライトハンドルを使用して、このショットのライティングを決定した
り、ビューポートの Karma 表示を使ってセットアップを確認することができ
ます。lightmixer  ノードを使用すると、このショットの強度や露出をさまざ
まに変えて試すことも可能です。 

これらの編集は lightmixer  ノードに保持され、元のライトは変更されませ
ん。lightmixer  では、マルチショットセットアップを使用しながら、既存のラ
イトを微調整できます。   

08 ネットワークビューで、SHOT_01、karmarendersettings、
usdrender_rop  ノードを Alt ドラッグします。lightmixer  ノー

ドをこのチェーンに接続します。新しい karmarendersettings  ノードを選
択し、Camera が /camera2  に設定されていることを確認します。Valid 
Frame Range を Render Frame Rangeに、Output Picture を $HIP/
render/anim/soccerball_anim_$F2.exr  に設定します。$F2  によって、
レンダリングにフレーム番号と 2 のパディングが追加され、/anim/  によっ
て、これらのフレームを保持するためのディレクトリが作成されます。 

usdrender_rop  ノードで、Render to Disk をクリックします。完了したら、
Render > Mplay > Load Disk Files を選択し、レンダリングした画像を開
いて最終的なシーケンスを確認します。作業内容を保存します。

05 ネットワークビューで、SHOT 1 ネットワークから assignmaterial  ノードを選択し、Alt ドラッグしてこのノードの
コピーを作成します。transform  ノードを assignmaterial  ノードに接続し
たら、Display フラグを設定します。これによりマテリアルが背景に割り当
てられますが、サッカーボールのプリミティブが変更されているため、マテリ
アルを割り当て直す必要があります。

soccerball_mat  の Primitives の横にあるフィールドで、プリミティブの
名前を /soccerball_anim に変更し、新しいジオメトリにマテリアルを割り
当て直します。
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04 フレーム 1 にいることを確認します。copytopoints  ノードの後
に RBD Bullet Solver ノードを追加します。 Collision タブをク

リックし、Ground Collision までスクロールダウンして、Ground Type を 
Ground Plane に設定します。Play を押して、シミュレーションをテストし
ます。シミュレーションはキャッシュ化され、タイムラインをスクラブして結
果を確認できるようになります。

Collisions タブで、Bounce を 0.8 に設定します。Properties タブで、
Density を 10に、Bounce を 1.1 に設定します。このノードのパラメータ
エディタの上部で、Reset Simulation ボタンをクリックしてから Play を	
押し、再度シミュレーションを実行します。スクラブして確認します。

01 Build デスクトップに戻り、オブジェクトレベルに移動します。	
すべてのアニメーションリグノードと extract_object  ノードを、

Display フラグをオフにして非表示にします。soccerball_geo  の表示をオ
ンにします。

soccerball_geo  ノードを選択してから、Modify シェルフの Extract ツー
ルをクリックします。これにより、サッカーボールのオブジェクトが結合
された、新しいオブジェクトが作成されます。1 つ上のレベルに移動し、
extract_object の名前を soccerball_sim  に変更します。soccerball_
geo  オブジェクトを非表示にします。

soccerball_sim オブジェクトの中に戻り、ジオメトリを作業していきます。
Match Size ノードを追加して、原点を基準とした中央にボールを配置します。 

02 ネットワークビューで、Tab > Box を押し、それを matchsize  
ノードの右側に配置します。 

box  ノードで次のように設定します。 
	� Center を 0, 8, 0 にする
	� Rotate を 45, 45, 45 にする 
	� Primitive Type を Polygon Mesh にする
	� Uniform Scale を 6 にする
	� Axis Divisions を 3, 3, 3 にする 

これで、シミュレーションでの位置が適切になります。

03 ネットワークビューで、その他のノードのすぐ下に Copy to 
Points ノードを追加します。matchsize  ノードを 1 つ目の入力

に接続し、box  ノードを 2 つ目の入力に接続します。 

Pack and Instance オプションをオンにします。これにより、ジオメトリが
立方体のポイントにインスタンス化されるので、シミュレーションが高速化し
ます。copytopoints ノードに Display フラグを設定します。

ネットワークビューで、Tab > Mountain を押して、box  と copytopoint  
ノードの間にそのノードを配置します。Noise Along Vector オプションを	
オフにしてから、Amplitude を 2 に、Range Values を Zero Centered 
に設定します。これで、ボックスのポイントが微震するようになります。 

パート 10 

リジッドボディシミュレーションのセットアップ
1 個のサッカーボールをアニメートするには、従来のアニメーション方法が適していますが、たくさんのサッカーボールをアニメートしたい
場合は、ダイナミクスの使用がお勧めです。ダイナミクスを使うには、ソルバがフレームごとに各オブジェクトの相互作用を判断できるよう、
シミュレーションを行う必要があります。パックドジオメトリを使用すると、効率よくシミュレーションの結果を得られます。
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SOP 内に隠れた DOP
Houdini では、シミュレーションは Dynamic Operators、つまり DOP を使用して
処理されます。Geometry/SOP コンテキストの RBD Bullet Solver ノードでは、
内部にダイナミクスネットワークが埋め込まれたノードを使用することになります。 
これにより、すべての DOP ノードを接続して準備を整え、かつビューに表示されて
ない状態を簡単にジオメトリレベルでセットアップできるようになりました。シンプ
ルなセットアップでは、ジオメトリレベルで作業することで適切なシミュレーションを
得られます。さまざまなソルバをより詳細に制御する必要がある場合は、DOP で直
接作業する必要があります。 

05 チェーンの終端に USD Export ノードを追加し、Display フラ
グを設定したら、それを soccerball_sim  という名前に変更し

ます。 

Valid Frame Range を Render Frame Rangeに、Output File を 	
$HIP/geo/soccerball_sim.usd  に設定します。 

Save to Disk ボタンをクリックして、USD ファイルを geo ディレクトリに
保存します。このキャッシュ化されたアセットは、3 つ目のショットとして 
Solaris セットアップで参照されます。

06 デスクトップを Solaris に戻し、パスを /stage  に設定します。
Persp  メニューで Houdini GL が選択されていることを確認し

ます。 

soccerball_anim Reference ノードを Alt ドラッグし、その Display フラグ
を設定します。File Pattern を $HIP/geo/soccerball_sim.usd  に設定し
ます。 

このノードを soccerball_anim  という名前に変更します。

07 ネットワークビューで、SHOT 2 ネットワークから assignmaterial  ノードを選択し、Alt ドラッグしてこのノードの
コピーを作成します。soccerball_anim  ノードを assignmaterial  ノード
に接続したら、その Display フラグを設定します。これによりマテリアルが
背景に割り当てられますが、サッカーボールのプリミティブが変更されてい
るため、マテリアルを割り当て直す必要があります。

soccerball_mat の Primitives  の横にあるフィールドで、プリミティブの
名前を /soccerball_sim に変更し、新しいジオメトリにマテリアルを割り当
て直します。

08 ボールがカメラに向かってアニメートされる様子が見えるまで、タンブルします。LOP Lights and Cameras シェルフで、
Camera ツールを Alt クリックして、現在見ているアングルにカメラを配置
します。 

Lock Camera/Light to View ボタンを押し、ビュー変更に応じてカメラの
位置が更新されるようにします。次にビューポートでタンブル、パン、ドリー
してカメラを微調整し、ショットに適したフレーミングにします。タイムライン
をスクラブし、シーケンス全体でカメラが機能していることを確認します。 
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まとめ
Houdini のさまざまな側面に触れながら、ゼロからシーンを構築してきました。 
モデリング、テクスチャのセットアップ、レンダリング、シミュレーションを行いました。
その過程で、さまざまな Houdini コンテキストと、それらの切り替え方法についても
学習しました。
このレッスンは、VFX の大作を作るものではありません。
Houdini を深く探り、その包括的なツールセットを探求するに
あたって必要となる基本スキルを紹介する
ものです。
SideFX の Web サイトには、スキルアッ
プのための学習教材が豊富に用意され
ています。 
最高の旅になりますように!  

10 ネットワークビューで、SHOT_02、karmarendersettings、
usdrender_rop  ノードを Alt ドラッグします。	

新しい lightmixer  ノードをこのチェーンに接続します。新しい 
karmarendersettings  ノードを選択し、Camera が /camera3  に設定さ
れていることを確認します。 

09 camera の後に Light Mixer ノードを追加します。lightmixer  
ノードでは、ライト上にカーソルを移動します。こうすると、前に

紹介したライトハンドルを使用して、このショットのライティングを決定した
り、ビューポートの Karma 表示を使ってセットアップを確認することができ
ます。lightmixer  ノードを使用すると、このショットの強度や露出をさまざ
まに変えて試すことも可能です。 

これらの編集は lightmixer  ノードに保持され、元のライトは変更されま
せん。lightmixer  では、マルチショットセットアップを使用しながら、既存の
ライトを微調整できます。   

11 usdrender_rop ノードで、Valid Frame Range を Render 
Frame Rangeに、Output Picture を $HIP/render/sim/

soccerball_sim_$F2.exr  に設定します。Render to Disk をクリックし
ます。 

完了したら、Render > Mplay > Load Disk Files を選択し、レンダリング
した画像を開いて最終的なシーケンスを確認します。
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HOUDINI FUNDAMENTALS

ノード、ネットワーク、	
デジタルアセット
Houdini のノードベースワークフローを理解するには、実際のプロジェクトで使ってみるのが一番です。	
重要なのは、プロシージャルな考え方や作業方法を学ぶことです。このレッスンでは、プロシージャルな	
ノードとネットワークを使用してカスタムの brickify（ブロック化）ツールを自作し、機能やインターフェースを	
定義する方法について学習します。

その過程で、Houdini ワークスペースのさまざまな機能を使います。冒頭の概要を参照して、UI 要素の仕組みを
確認しておきましょう。このレッスンは、アイデアを実践に移す場です。実践は、最も効果的な学習方法の 1 つです。 

レッスンの目標
	� 任意の 3D 形状をおもちゃのブロックに変えるカスタムツールを作成します。 

学習内容
	� プラスチックの連結ブロックをモデリングする方法
	� デフォルトのゴムのおもちゃの形状をグリッドポイントに分解する方法 
	� パックプリミティブとインスタンス化を活用して、相互作用を高速化する	
方法
	� アトリビュートを使って、テクスチャマップでブロックに色を付ける	
方法 
	� ノードとネットワークを使用してデータの流れを	
制御する方法
	� デジタルアセットを作成して、ソリューションを	
パッケージ化したり、他の人と共有する方法
	� 徐々に現れるブロックをアニメートする方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✔

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

ドキュメントバージョン 4.0.1J | 2023 年 8 月
© SideFX Software



パート 1

シングルブロックの作成
最初はシングルブロックモデルを作成します。その後、モデルをポイントにコピーして、ブロック化した形状を作成します。 
この形状を作成するために、いくつかのポリゴンモデリングツールを使用します。その際、Houdini でアクションを実行するたびに 
ノードが作成されますが、それはジオメトリ作成手順のレシピとなります。 

01 File > New Project を選択します。Project Name を 
brickify_lesson  に変更し、Accept を押します。これにより、

プロジェクトディレクトリとサブフォルダが作成され、このショットに関連す
るすべてのファイルがそこに配置されます。

File > Save As... を選択します。新しい brickify_lesson  ディレクトリが表
示されているはずです。ファイル名を bricks_01.hip  に設定し、Accept を
クリックして保存します。 

02 ビューポートで、C を押して Radial メニューを表示します。メ
ニューから Create > Geometry > Box を選択します。カーソル

の位置に、シーン内への配置待ちの状態にあるボックスの輪郭が表示され
ます。Enter を押して、原点の位置に配置します。オペレーションコントロー
ルツールバーで、Size を 0.2, 0.2, 0.2、Axis Divisions を 3, 2, 3 に設定
します。

ネットワークビューに box_object  が表示されています。このオブジェクト
レベルのノードには、この形状のトランスフォーム情報が含まれています。
オペレーションコントロールツールバーには、1 つ下のレベルの別の box  
ノードのパラメータが表示されています。

03 Select ツールをクリックし、4 を押してプリミティブ選択モード
に切り替えます。ボックス上部の 4 つのフェースを選択します。

C を押して Radial メニューを表示し、Model > Polygons > PolyExtrude 
を選択します。ネットワークビューで、box  ノードが polyextrude  ノードに
接続されているのを確認できます。

パラメータエディタで、スライダを使用して Inset を 0.04 に設定すると、ボッ
クスの上面に新しいポリゴンが作成されます。各ノードには、そのノードの
目的に関連するパラメータが含まれています。これらはジオメトリノードで、
SOP (Surface Operator) とも呼ばれています。

04 次に、T キーを押して Move ツールを呼び出します。これにより、
ネットワークに Edit SOP  ノードが追加されます。ビューポート

の何もない空間で RMB クリックしてメニューを表示し、Make Circle を選
択して、選択したポリゴンに丸みを付けます。

このメニューは Edit  ノードに関連付けられています。すべてのノードに独自
のインターフェースがあり、関連するツールがアクティブになっている場合
のみアクセス可能です。ここでは、Move ツールでハンドルにアクセスしてい
ます。Handle ツールを使用した場合は、ノードのインタラクティブなハンド
ルにアクセスできます。 
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05 C を押して Radial メニューを表示し、Model > Polygons > 
PolyExtrude を選択します。Scene View ペインで、ハンドルを

使用してポリゴンを上にドラッグし、Distance を 0.05 に設定します。

タンブルしたら、S を押して選択モードに切り替え、ボックス底部のポリゴン 
4 つを選択します。Q を押して PolyExtrude ツールを繰り返します。パラ
メータエディタで、スライダを使用して Inset を 0.025 に設定します。

Q を押してツールを繰り返し、Distance を -0.175 に設定します。完了した
ら、再度タンブルしてブロックの上面が見えるようにします。

06 3 を押してエッジ選択に切り替え、N を押してすべてのエッジを選択します。Scene View で Tab を押し、Group... と入力してい
き、Group を選択します。パラメータエディタで、Group Name を bevel_
edges  に設定します。 

次に、Base Group の Enable をオフにし、Include by Edges セクション
の Enable をオンに設定します。Min Edge Angle をオンにして 89 に設定
したら、Max Edge Angle をオンにして 91 に設定します。 

07 S を押して Select ツールに切り替えます。9 を押して 「Select 
Groups」オプションをオンにします。ポップアップウィンドウで、

bevel_edges  グループをクリックします。 

ビューポートで、C を押して Radial メニューを表示します。メニューから 
Model > Polygons > PolyBevel を選択します。polybevel ノードが追加
され、Group フィールドには bevel_edges  が自動的に入力されます。

Bevel Offset を 0.006 に設定します。Fillet で、Shape を Round、
Divisions を 3 に設定します。 

08 オブジェクトレベルに移動し、ネットワークビューでオブジェクトの名前を single_brick  に変更します。ブロックを選択した状
態で、Shift + を押して、この形状のサブディビジョンサーフェスの表示をオ
ンにします。ブロックを選択解除して、細分化されたモデルを表示します。
オブジェクトにワイヤーラインが見えたら、V を押し、Radial メニューから 
Shading > Smooth Shading を選択して非表示にします。

作業内容を保存します。

サブディビジョンの表示
Shift + および Shift - を使用すると、選択したポリゴンオブジェクトのサブ
ディビジョン表示をオンまたはオフにできます。オンにすると、ビューポート
で細分化が行われ、細分化された形状のルックを確認できます。これらの
ホットキーは、Display As パラメータを設定するものです。このパラメータ
は、オブジェクトレベルのオブジェクトの Render タブにあります。
オブジェクトをサブディビジョンとしてレンダリングするには、同じタブで 
Render Polygons As Subdivision (Mantra) をオンにする必要があります。
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パート 2

ポイントクラウドにブロックをコピー 
ここでは、特定のジオメトリの形状と一致するポイントクラウドを作成します。その後、ブロックを 3D グリッドにインスタンス化して、 
ブロック化したバージョンを作成します。インスタンスは、ブロックジオメトリをパック化して、それらをポイントにインスタンス化すること
で生成できます。 

01 Scene View で、Tab を押して Test... と入力していきます。	
Test Geometry: Rubber Toy を選択します。Enter を押して、

原点に配置します。 

I を押して、test geometry  オブジェクトの中に入ります。次のように設定
します。

	� Uniform Scale を 3 にする

Match Size ノードを追加して、Justify Y を Min に設定します。おもちゃが
持ち上がり、地面の上に配置されます。

02 ネットワークエディタで、matchsize  ノードの出力を RMB ク
リックし、Points... と入力して Points from Volumes を選択

し、そのノードをネットワークに配置します。次に Display フラグを設定し
て、この新しいノードの出力に集中できるようにします。

S を押して Select ツールに切り替え、2 を押してポイント選択にします。	
N を押してすべてのポイントを選択すると、それらが黄色でハイライトされ
ます。これらのポイントにブロックをコピーしていきます。

03 U を押してオブジェクトレベルに戻り、ゴムのおもちゃの名前を
短く rubbertoy  にします。ネットワークビューで Shift キーを押

し、rubbertoy  をクリックしてから single_brick  をクリックします。 

Modify シェルフタブで Combine を選択し、これらのオブジェクトを結合し
ます。ジオメトリレベルでは、ノードが merge ノードに接続されているのが
分かります。

04 ネットワークビューで、display_merge  ノードを選択し、
Delete キーを押します。これで、polybevel  ノードチェーンが

表示され、他のチェーンは非表示になります。Houdini では、オブジェクト
レベルに戻るときに、どのノードを表示するのかを選択できます。
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06 pointsfromvolume  ノードの下のドットをクリックして、
copytopoints  ノードの 2 つ目の入力に接続します。 

ブロックが重なっているように見えます。pointsfromvolume  モードに戻
り、Point Separation を 0.2 に設定します。

次に、ブロックをグリッドポイントにコピーします。

07 copytopoints  ノードをクリックします。ブロックの一部がダー
クグレーで表示され、適切なブロックを表示していません。

ビューポートでのジオメトリカリングが原因です。これは、表示設定で修正
できます。 

Scene View で、スペースバー + D を押して Display Options を表示し
ます。Optimize タブをクリックし、Scene Polygon Limit を 50 million 
よりも大きい値に設定するか、Distance-based Packed Geometry 
Culling をオフにします。フローティングパネルを閉じます。これで、すべて
のブロックがパックインスタンスとしてポイントにコピーされていることが確
認できます。

08 作業を保存する前に、ネットワークを整理しましょう。シングルブロックを構成しているノードを選択し、Shift + O を押してその
周りにネットワークボックスを作成します。ボックスのタイトルバーをクリッ
クし、Single Brick  と入力します。その後ボックスを折り畳み、下に移動し
てネットワークを少し整理します。

作業内容を保存します。

05 polybevel  ノードの出力を RMB クリックして、copy... と入力
していき、Copy to Points を選択します。そのノードをクリック

して 2 つのチェーンの下に配置し、Display フラグを設定します。 

Pack and Instance オプションをオンにします。このオプションをオンにす
ると、オフのときよりもずっと速くコピーしたブロックを表示できます。 

この時点でノードにエラーが表示されますが、それは 2 つ目の入力を接続
していないからです。 

パックインスタンス
Copy to Points ノードで Pack and Instance オプションをオフの
ままにすると、100 万以上のポイントとプリミティブを含む大規模
なモデルになります。インスタンス化を使用しないと、ビューポート
での操作が遅くなります。
このオプションをオンにすると、ブロックモデルの 338 ポイントが
パック化およびインスタンス化されるため、Copy to Points ノード
のポイント数を大幅に減らして効率化することができます。

Pack and Instance | オフ

Pack and Instance | オン

79

ポ
イ

ン
ト

ク
ラ

ウ
ド

に
ブ

ロ
ッ

ク
を

コ
ピ

ー
 



パート 3

カラーの追加とティーポットへの切り替え
ポイントにカラーを追加し、そのカラーをインスタンス化されたブロックが取得するようにします。最初、このカラー転送はビューポート内
のみで適用されますが、適切なマテリアルをセットアップすると、ポイントカラーを使用してブロックをレンダリングできるようになります。
その後、ゴムのおもちゃとティーポットの切り替えをセットアップし、異なる形状でもネットワークが機能することを確認します。

01 pointsfromvolume  ノードと copytopoints  ノードの間に 
color ノードを追加します。これによりポイントにカラーが追加さ

れ、ブロックにコピーされます。color を赤色に設定し、背景に対してブロッ
クが目立つようにします。

Render Region ツールをクリックし、境界ボックスをゴムのおもちゃ上にド
ラッグします。テストレンダリングが始まり、ブロックが赤色でレンダリング
されていないことが分かります。マテリアルを割り当て、カラーを取得する
必要があります。

レンダリング領域の右上にある X ボタンをクリックして終了します。 

02 ネットワークビューで Tab を押し、Mat... と入力します。
Material Network ツールを選択し、クリックしてネットワーク

にノードを配置します。 

Material Palette に移動して /mat  を閉じ、/matnet  を開きます。
Principled Shader を matnet  にドラッグします。brick_mat  と名前を付け
ます。

03 ネットワークビューのバックボタンを使用して、ジオメトリネットワークに戻ります。copytopoints  ノードの出力を RMB クリッ
クして、Material... と入力していきます。material を選択し、ネットワーク
に配置して、Display フラグを設定します。

Material パラメータの右端の Operator Chooser  ボタンをクリックし
ます。ポップアップウィンドウで、brick-material  に移動してハイライトしま
す。Export Relative Path オプションをオンにして、Accept をクリックし
ます。 

マテリアルは割り当てられましたが、ブロックはまだレンダリングされま
せん。

04 Material Palette に戻り、brick_material  を選択します。
Surface タブをクリックして、Base Color を 0.5, 0.5, 0.5 に設

定し、Use Packed Color オプションをオンにします。 

Render Region ツールをクリックし、境界ボックスをゴムのおもちゃ上にド
ラッグします。レンダリングされたブロックが赤色になるはずです。 

なっていない場合は、Scene View 上部のバーで Render をクリックして、
変更が適用されていることを確認します。 

作業内容を保存します。レンダリング領域の右上にある X ボタンをクリック
して終了します。
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06 ツールシェルフで Create メニューに移動し、Platonic ツールを
ネットワークビューにドラッグします。これにより、platonic ノー

ドがジオメトリレベルに配置されます。ツールをネットワークビューにドラッ
グできるのは、ノードタイプが現在のネットワークレベルに対して有効な場
合のみです。 

platonic ノードの Solid Type を Utah Teapot に設定します。Radius を 
4.2 に設定します。Points from Volume ノードが新しいボリュームに合わせ
てポイントを更新し、異なる構成のブロックを生成します。

07 platonic  ノードの出力を switch  ノードの入力に接続します。
switch  ノードを選択し、Select Input を 1 に変更します。ゴム

のおもちゃと同じセットアップを使用して、プラトン立体が生成されます。 

これは、プロシージャルシステムの最大のメリットの 1 つです。後で、このネッ
トワークをデジタルアセットと呼ばれるカスタムツールにパッケージ化しま
す。デジタルアセットなら、簡単に他の人とネットワークを共有できます。	
また、ツール進化に合わせて変更や更新が必要となるスタジオ環境に配備
する場合でも、ツールの管理が容易です。 

08 switch  ノードで Select Input を 0 に設定し、rubbertoy  に戻
ります。これら 2 つの形状を切り替えたり、さらに形状を追加し

てブロック化できるようになりました。

作業内容を保存します。

05 ネットワークビューのバックボタンを使用して、ジオメトリネットワークに戻ります。S を押して Select ツールに切り替えます。
ネットワークビューで、Tab を押して Switch と入力し、それを Sourcing 
フォルダからネットワークビューにドラッグします。 

次に、rubbertoy  ノードと matchsize  ノードを接続しているワイヤー上に
ドラッグします。これで、ネットワークの 2 つのノードの間に switch ノードが
挿入されます。

このノードにより、異なる入力形状の間での切り替えが容易になります。 

SWITCH ノード
Switch ノードは、ノードネットワークにオプションを提供する素晴らしいツール
です。このノードを使用すると、さまざまなチェーンを接続 / 接続解除することな
く、素早く複数のオプションを探求できます。 
このノードはまた、ネットワークをデジタルアセットにまとめる際にも大変便利で
す。メニューまたはスライダのいずれかとしてアセットにプロモートすれば、さま
ざまなオプションに素早くアクセスできます。
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パート 4

テクスチャを使用したポイントへのカラー付け
先ほどは、ポイントにカラーアトリビュートを追加して、ブロックインスタンスのカラーに影響するようにしました。 
ここでは、単色の代わりにテクスチャマップを使用して、ブロックのルックをさらに面白くしていきます。 
いくつか特殊なノードを使用して、テクスチャをポイントカラーに変換します。

01 testgeometry_rubbertoy  の Display フラグをオンにします。
rubbertoy  ノードを選択し、パラメータエディタで Add Shader 

パラメータをオフにします。

パースビューで UV を非表示にするため、Display Options バーに移動し
て Show UV Texture when UV’s Present ボタンをオフにします。

ディスク上のテクスチャマップからカラーを抽出するという別の方法で、ブ
ロックに再度カラーを付けます。

02 Asset メニューから、Edit Asset Properties > Rubber Toy を
選択します。Type Properties ウィンドウで、Extra Files タブ

をクリックし、toylowres.jpg  を選択します。 

Save as File ボタンをクリックして、tex  フォルダに保存します。テクスチャ
がデジタルアセットに保存されたので、アセットと一緒に共有することがで
きます。ディスク上のテクスチャを使用して、ブロックにカラーを追加してい
きます。

03 ネットワークビューで、Tab を押して Attribute...  と入力してい
きます。Attribute VOP ノードを選択し、pointsfromvolume  

ノードの横に配置します。 

matchsize  ノードの出力を、attributevop  ノードの 1 つ目の入力に接続
します。この新しいノードに Display フラグを設定します。 

パラメータエディタで、Run Over を vertices に設定します。 

04 attributevop  ノードをダブルクリックして中に入り、
Tab キーを使用して Texture VOP を追加します。それを 

geometryvopoutput  ノードの Cd 入力に接続します。 

UV coordinate ノードを追加して、texture  ノードの UV 入力に接続し
ます。
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06 U を押して 1 つ上のレベルに移動します。Texture Map パラ
メータが表示されています。ここでは、デフォルトの Mandril.

pic テクスチャのままに設定しておきます。終端に toylowres  テクスチャ
マップを追加します。 

このチェーンの終端に Attribute Promote を追加します。Original 
Name を Cd、Original Class を Vertex に設定します。New Class の設
定は Point のままにしておきます。   

05 texture  ノードを選択します。Texture Map パラメータの右
端のギア  アイコンをクリックして、メニューから Promote 

Parameter を選択します。このパラメータがこのノードの上位レベルに追
加されます。

マップの横にある小さいノブ（ツマミ）をクリックします。パラメータエディタ
で、Label を Texture Map に変更します。

07 Attribute Transfer ノードを追加します。pointsfromvolume  
を 1 つ目の入力に接続し、attribpromote  を 2 つ目の入力に

接続します。Attributes タブで、Points フィールドの右側の矢印をクリック
し、Cd を選択します。

color ノードの後に switch ノードを追加し、attribtransfer  ノードを switch 
に接続します。このノードの名前を texture_switch  に変更します。

Switch を 1 に設定します。copytopoints  ノードに Display フラグを設定
します。これで、テクスチャマップからのカラーがコピーしたポイントに転送
されるようになりましたが、ブロックが回転しています。Transform Using 
Target Point Orientation をオフにして、ブロックをまっすぐにします。

08 material  ノードに Display フラグを設定します。

attribvop  ノードを選択したら、Texture Map パラメータの右
端のファイル選択ボタンをクリックして、toylowres.jpg  テクスチャに移動
し、Accept をクリックします。テクスチャマップのカラーが頂点に割り当て
られているのを確認できます。

作業内容を保存します。

ATTRIBUTE TRANSFER
あるジオメトリから別のジオメトリにアトリビュートを転送したい場合、
Attribute Transfer を使用します。このノードは、Distance Threshold（距
離の閾値）などのパラメータを使用して、アトリビュートをコピーします。 
ゴムのおもちゃの場合は、ジオメトリ上のポイントの Cd アトリビュートを、ブ
ロックをコピーするのに使用したポイントクラウドに転送しています。UV や
キャプチャウェイトなどのアトリビュートもコピーできます。

Distance Threshold

ギア
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パート 5

ブロック化したデジタルアセットの作成
ブロック化のレシピが機能するようになり、ノードが適切に接続されました。次はいくつかのノードをまとめて、1 つの Houdini デジタル
アセット（HDA）ノードを作成します。アセット内部からトップレベルにパラメータをプロモートしたネットワークを共有して、アセットが使用
されるたびにユニークな結果を生成できるインターフェースを作成します。

01 ネットワークビューで、platonic  ノードを横にドラッグします。
ネットワークの他のすべてのノードを選択し、Assets メニューか

ら New Digital Asset From Selection... を選択します。これで、単一の
ノードに折り畳まれます。  

Operator Name を brickify  に設定すると、Operator Label が Brickify  
に変更されます。Save to Library の右端のボタンをクリックします。
Locations サイドバーで $HIP を選択し、HDA  ディレクトリをダブルクリッ
クします。Accept を押し、Create New Digital Asset ダイアログで再度 
Accept をクリックします。

02 これにより Type Properties ウィンドウが表示されます。Basic 
タブが表示されていることを確認します。Minimum Inputs を 

0 に設定して、入力がなくてもアセットが機能するようにします。Maximum 
Inputs パラメータを 1 に設定して、入力できるノードの数を定義します。 

これは、platonic ノードに現在接続されている入力です。このデジタルアセッ
トを後で使用する際は、この入力を使用して別の形状を指します。

Apply を押します。ウィンドウが閉じてしまうので、Accept は押さないでく
ださい。

03 ネットワークビューで、新しいアセットノードを brickify_
asset  という名前に変更し、ダブルクリックして中に入ります。

testgeometry_rubbertoy  と Subnetwork Input  ノードを切り替えてい
る switch  ノードをクリックします。Subnetwork Input ノードは、上のレベ
ルからプラトン立体のティーポット形状を取り込んでいます。

Type Properties ウィンドウで Parameters タブをクリックします。Select 
Input パラメータ名をクリックして、それを Type Properties ウィンドウの 
Existing Parameters リストに LMB ドラッグします。それを root にドロッ
プして、UI に追加します。Apply をクリックするとパラメータが追加されま
すが、Type Properties ウィンドウは終了しません。

.HDA ファイルとは ?
アセットを保存すると、ディスク上に .hda ファイルが作成されます。HDA とは 
Houdini Digital Asset という意味で、アセット定義がこのファイル内に格納され、
シーンに参照されます。このファイルには、ノード、プロモートされたパラメータ、 
UI 要素などの情報が含まれています。このファイルは、複数の人がさまざまなショッ
トで参照し、共有できます。
シーンに参照されているアセットを管理するには、Assets メニューで Asset 
Manager... を選択し、Current HIP File を開きます。
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08 attributevop  ノードを選択し、Texture Map パラメータをパラ
メータリストにプロモートします。

Parameter Description セクションで、Channels タブをクリックしてデフォ
ルト値を Mandril.pic に変更します。これは、パスを読み込む必要のない
デフォルトのテクスチャマップで、より信頼性の高いデフォルトです。後で、
toylowres.jpg  テクスチャマップを再読み込みします。 

Type Properties ウィンドウで Apply を押すと、brickify_asset  パラメータ
インターフェースにこのパラメータが表示され、Mandril テクスチャマップに
よってブロックに色が付いています。 

05 パラメータリストで Select Input  パラメータをクリックします。
左側に、表示を微調整するためのオプションがあります。Name 

を shape  に、Label を Shape  に変更します。

Menu タブをクリックして、Use Menu をオンにします。Menu Items で、
Token に 0、Label に Rubber Toy と入力して、Enter を押します。次に、
Token に 1、Label に Custom Shape  と入力します。Apply を押します。 

フローティングパラメータウィンドウには、Shape パラメータとメニューが
表示されるようになります。実際に試して動作を確認しましょう。 

04 ネットワークビューのパスバーで brickify_asset  を RMB ク
リックして、Parameter and Channels > Parameters を選択

します。2 つの brickify  アセットパラメータを含むフローティングパラメータ
ウィンドウが表示されます。これらは、このアセットを使用する誰もが使用で
きるパラメータです。さらに追加していきましょう。 

brickify  ノードには新しいパラメータがあります。値を 0 から 1 に変更し
て、シーンへの影響を確認します。問題は、名前があまり適切でないことと、
このケースではスライダよりもメニューのほうがずっと効率的に機能するこ
とです。そこで、Type Properties を使用して UI を微調整します。

06 color  と attributetransfer ノードの下にある 2 つ目の switch  
ノードを選択し、Select Input パラメータをパラメータリストに

プロモートします。Name を look  に、Label を Look  に変更します。

Menu タブをクリックして、Use Menu をオンにします。Menu Items で、
Token に 0、Label に Color  と入力して、Enter を押します。次に、Token 
に 1、Label に Texture Map  と入力します。Apply を押します。  

07 ネットワークで color  ノードを選択し、Color パラメータをパラ
メータリストにプロモートします。これにより、カラーウィジェッ

ト、カラーホイール、RGB フィールドが表示されます。 

Type Properties ウィンドウで Apply を押し、このパラメータが brickify_
asset  パラメータインターフェースでどのように見えるのかを確認します。 

注 : 間違って Accept を押した場合、新しいパラメータはアセットに保存さ
れますが、Asset メニューを使用して Edit Asset Properties... > brickify 
を選択し、再度開く必要があります。 

RMB クリック
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10 brickify_asset  テクスチャマップパラメータはデフォルトで 
Mandril.pic になっています。常に使用できるテクスチャマップ

で、汎用性の高いデフォルトです。おもちゃのマップに戻るには、Texture 
Map の横にあるファイル選択をクリックし、$HIP  を再度クリックしてから 
tex  ディレクトリの中に入り、toylowres.jpg  ファイルを選択する必要があ
ります。 

現在、アセットではデフォルトの Mandril.pic  が使用されるようになってい
ます。

11 Accept を押してアセットへの変更を保存し、Type Properties 
ウィンドウを閉じます。 

ネットワークビューで、U を押して 1 つ上のレベルに戻ります。brickify_
asset  ノードを選択した状態で、メインメニューから Assets > Lock Asset 
> Brickify を選択します。プロンプトが表示されたら、Save Changes を押
します。

brickify_asset  をダブルクリックして中に入ると、ネットワークがグレーア
ウトされ、これらのノードが保護されていることが分かります。このアセット
は、パラメータを介してのみ操作できます。内部の動作に変更を加えるには、
アセットのロックを解除する必要があります。

12 オブジェクトレベルに移動します。シーンファイルを保存して、	
これまでの作業内容を保持します。 

これで、シーンファイルと、シーンがアセットを作成するために参照する 
.hda ファイルができました。このライブラリを使用すると、このシーンでア
セットの他のインスタンスを作成したり、アセットを別のシーンに追加するこ
とができます。

次のセクションでは、アセットをテストして、適切に動作するかどうか確認し
ます。作業用のアセットを 1 つと、目的通りに動作するかどうかをテストす
るためのアセットを 1 つ用意しておくことをお勧めします。

09 どのパラメータがどの形状に関連付けられているのかを確認するには、メニュー選択に基づいてパラメータを無効にしたり有
効にします。Color パラメータをクリックし、Disable When フィールドに 
{ look != 0 } と入力します。

これにより、Look メニューで Color が選択されていなければ、このパラ
メータは無効になります。次に、Texture Map パラメータをクリックし、
Disable When フィールドに { look != 1 } と入力します。 

Apply を押して、Look メニューを使用して結果をテストします。必要ない
場合、パラメータが無効になっているのを確認できます。Hide When オプ
ションを使用して非表示にすることもできますが、ここでは無効で問題あり
ません。

アセットのロックとロック解除
Assets メニューを使用して、選択したアセットをロック/ロック解除できます。アセット
がロックされている場合、HDA ファイルが参照され、アセットの挙動が決まります。 
アセットがロック解除されている場合、アクティブ定義はシーンファイル内にあります。
アセットをロックしているとき、変更を加えた場合は保存するかどうかを確認されます。
アセットのノードを RMB クリックすると、Allow Editing of Contents でアセットの 
ロックを解除したり、Match Current Definition でアセットをロックできます。ただし、
保存するかどうかは尋ねられず、変更が失われる可能性もあるため注意してください。
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01 Tab キーを使用して、イカ蟹のテストジオメトリを選択します。
Enter を押して原点に配置したら、ハンドルを使用してゴムのお

もちゃの横に移動します。

新しいオブジェクトノードをダブルクリックして、ジオメトリレベルに入りま
す。ノードを選択して、Scale を 3、Translate Y を 1.5 に設定します。これ
により、イカ蟹がゴムのおもちゃよりも少し大きくなります。

02 テストジオメトリノードの出力を RMB クリックして、brickify... 
と入力し、 メニューから brickify アセットを選択します。これで、

アセットがこの新しいネットワークに配置されます。 

Display フラグを設定すると、赤色のゴムのおもちゃがもう 1 つ表示されま
す。こうなるのは、これらがこのアセットのデフォルトだからです。

03 brickify  アセットノードで、Shape パラメータを Custom 
Shape に設定すると、ブロック化されたイカ蟹が表示されます。

新しい形状がアセット内のノードネットワークを経て、ユニークな結果が生
成されています。この形状が地面より少し上にあるのは、アセット内部に 
Match Size ノードがあるためです。

このようにすると、デジタルアセットをツールとして使用できます。複数のア
クションを単一のノードにパッケージ化して、パイプラインに配置することが
できます。ワークフローが高速化するうえ、一貫した結果を実現しやすくな
ります。

パート 6

デジタルアセットのテスト
デジタルアセットは、単一のシーンファイルで複数回インスタンス化できます。異なるジオメトリでこのアセットを使用して、動作をテストし
ていきます。最初のアセットに設定された変更を素早く確認できるよう、テストバージョンを用意しておくことをお勧めします。アセットが
適切に動作すれば、他のシーンファイルでも使用できます。   

04 testgeometry_squab  ノードを選択します。Asset メニュー
から、Edit Asset Properties > Squab を選択します。Type 

Properties ウィンドウで、Extra Files タブをクリックし、squab_diffuse.
jpg  を選択します。Save as File ボタンをクリックして、tex  フォルダに保存
します。テクスチャがデジタルアセットに保存されたので、アセットと一緒に
共有することができます。 

これで、ディスク上のこのテクスチャと、brickify  ノードの Texture Map パ
ラメータを使用して、ブロックにカラーを追加できるようになりました。

完了したら、オブジェクトレベルに移動して、このオブジェクトに squab、	
もう 1 つのオブジェクトに rubbertoy  と名前を付けます。作業内容を保存
します。
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パート 7

ブロックのアニメート
アセットには機能を追加していくことができます。ブロックが自動で積み上がるアニメーションを作成しましょう。 
このためには、ネットワークにさらにノードを追加して、アセットにこの新しい機能を含める必要があります。 
結果を .hda ファイルに保存したら、誰でもこのアセットを使ってその機能を使用できるようになります。

01 squab  オブジェクトを非表示にして、rubbertoy  オブジェクト
の中に入ります。brickify_asset  を選択し、Assets > Unlock 

Asset > Brickify を選択します。brickify_asset  ノードをダブルクリックし
たら、texture_switch  の出力を RMB クリックして、Group by Range を
選択します。そのノードを配置して Display フラグを設定したら、次のよう
にパラメータを設定します。

	� Group Name を hide_points  にする
	� Group Type を Points にする
	� Range Type を Start and Length にする
	� Length を ($F-1)*20  にする
	� Range Filter で、Select を 1、Of を 1 のままにしておく

02 grouprange  ノードの出力を RMB クリックし、Polygon > 
Blast を選択します。このノードを配置したら、Group の横

の矢印を使用して、hide_points  グループを選択します。Delete Non 
Selected をオンにして、グループの外側のポイントを削除します。blast  
ノードに Display フラグを設定します。

Play を押して、フレーム毎に増えるポイントを確認します。チェーンの終端
の material  ノードに Display フラグを設定して、時間とともに増えるブ
ロックを確認します。

03 現在は、ブロックが地面からでなく片側から現れています。これは、ポイントがポイント番号を基準に表示されるようになってい
るからです。これを制御するには、ポイントの順番を変更して目的のルック
にする必要があります。

texture_switch  ノードの出力を RMB クリックし、Sort... と入力していき、
Sort ツールを選択します。このノードを配置したら、Point Sort を Along 
Vector に変更します。これを 0, 1, 0 に設定すると、ポイントが下から上に
向かって現れるようになります。 

再生して結果を確認します。さまざまなベクトルをテストして、アニメーショ
ンへの影響を確認してください。

04 ブロック化エフェクトをアニメートしたいかどうかを選択できるように、もう 1 つ switch ノードを追加します。ネットワークビュー
で、Tab を押して Switch... と入力していきます。Switch を選択して、ノー
ドを配置します。ノードの名前を animation_switch  に変更します。

texture_switch  ノードの出力をクリックして、switch  ノードの入力に接続
します。blast  ノードでも繰り返します。これにより、元の形状が最初のオプ
ション、アニメーションエフェクトが 2 番目のオプションになります。Select 
Input を 1 にすると、アニメートされたブロックが表示されますが、ここで
は 0 にしておきます。
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05 Assets メニューから、Edit Asset Properties > Brickify を選
択します。Parameters タブに移動して、Create Parameters 

セクションの Separator をリストの下部にドラッグします。 

次に、animation_switch  ノードの Select Input をパラメータエディタか
ら新しい Separator の下にドラッグします。Name を animate_bricks  に、
Label を Animate Bricks  に設定します。次に、Type を Toggle に変更し
ます。これで、オン (1) またはオフ (0) の設定に制限されます。 

Parameter Description セクションで、Channels タブをクリックしてデ
フォルト値を 0 (オフ) に設定します。 

Accept をクリックして変更を保存します。

まとめ
アーティストが利用しやすいノードベースのワークフローを使用して、スクリプトを
記述することなく、共有可能なツールを作成できました。HDA をディスクに保存す
ることで、ディスク上のアセットとなり、複数のショットで参照できるようになります。 
Houdini デジタルアセットは、アーティストがこうしたツールを効果的に共有できる
ようにするものであり、スタジオレベルのプロダクションを支えます。プロシージャ
ルアセットは反復作業の自動化が簡単にできるため、プロジェクトのクリエイティブ
なニーズに集中できます。

06 Type Properties の Create Parameters セクションから、
Integer パラメータを animate_bricks  パラメータの下にド

ラッグします。Name を build_speed  に、Label を Build Speed  に設定
します。 

Range オプションをオンにして、最初の値を 1、2 番目の値を 20 にします。
1 の横の錠アイコンをクリックすると、値が 1 よりも小さくなりません。 

Parameter Description セクションで、Channels タブをクリックしてデ
フォルト値を 1 に設定します。 

Accept を押して保存し、ウィンドウを閉じます。 

07 このパラメータはまだどこにも取り付けられていませんが、	これを使用して、grouprange  ノードの Length エクスプレッ
ションを駆動させることができます。新しい grouprange  ノードを選択し、
Length エクスプレッションを ($F-1)*ch(“../build_speed”) に変更
します。

ネットワークの終端に output ノードがあります。これにより、ネットワーク
の別のノードの Display フラグがオンになっていても、アセットの適切な出
力を取得できます。

brickify_asset  ノードを選択したまま、メインメニューから Assets > Save 
Asset > Brickify を選択します。Type Properties ウィンドウを再度開くこと
なく、.hda ファイルにこのエクスプレッションを保存できます。 

08 brickify_asset  ノードを選択したまま、メインメニューから 
Assets > Lock Asset > Brickify を選択します。これで、ブロッ

ク化エフェクトをカスタムツールにまとめることができました。このツール
は、アーティストたちがさまざまなショットで使用することができます。 

Squab ネットワークに移動すると、brickify  で新しい機能が使用できるよう
になっています。Animate Bricks トグルをオンにしたら、この形状はブロッ
クの数が多いので、Build Speed を約 30 に設定します。 

再生して結果を確認します。 
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01 ホストアプリケーションで Houdini Engine を使用するには、Houdini インストーラまたは Launcher を使用して、プラグイン
をインストールすることからはじめます。これによりプラグインが使用可能
になりますが、さらに、セッション内で Houdini Engine を使用できるように
する手順が必要な場合があります。 

詳細は、SideFX.com/engine を参照してください。

Engine プラグインのタブをクリックしてから目的のプラグインをクリック
して、詳細を確認します。インストールすると、ホストアプリケーションに 
Houdini Engine メニューが表示されるずです。メニューからアセットを読み
込むことができます。

02 プラグインのインストールが完了したら、Houdini Engine メ
ニューを使用してアセットを読み込むことができます。brickify  

アセットがビューポートに読み込まれ、アセットパラメータを使用して操作
できるようになります。  

また、Maya または 3ds Max 向けにアニメーションをオンにすると、タイムラ
インを使用してシーケンスを再生できます。

03 Unreal では、Import ボタンを使用して、デジタルアセットを
シーンに取り込みます。また、Shape を Custom Shape に設

定して、ホストアプリケーション内でアセットをジオメトリに接続すれば、そ
のオブジェクトにブロック化が適用されます。

パート 8

他のアプリケーションに HDA を読み込む
Houdini デジタルアセット（HDA）をディスク上に保存したら、Houdini Engine プラグインを使用して、そのアセットをホストアプリケーショ
ンに読み込むことが可能です。こうしたプラグインを使ってアセットを共有すれば、同僚は Autodesk Maya や 3ds Max などの 3D アプリ
ケーションや、Unity や Unreal Engine などのゲームエディタに直接アセットを読み込めるようになります。

ブロックのカラーに何が起きたのか
各種ホストアプリケーション内で、ブロック化された形状に色が付けられていないことに気付くはずです。 
これは、プラグインと Houdini で情報の処理方法が必ずしも同じではないことが原因です。ポイントカラーは
アセットに含まれていますが、ポストアプリケーションはその情報を受け取りません。
また、Maya および 3ds Max ではアニメーションが機能しますが、Unity や Unreal Engine では機能しません。
Houdini アセットはゲームの実行体験には関与せず、組み込まれたアニメーションは無視されるからです。
ホストアプリケーションの機能に合わせて、アセットを調整することが重要です。
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ワイングラスの粉砕 
このレッスンでは、ワイングラスを粉砕した後、時間を操作して液体（ワイン）を空中に保持します。このエフェクト
では、グラスの粉砕に RBD シミュレーション、ワインに流体シミュレーションを使用します。ダイナミクスネットワー
クをセットアップする方法と、シミュレーションを出力する方法を学習できます。ビジュアルエフェクトショットでは
たいてい、さまざまな種類のダイナミクスソルバを組み合わせて使用します。Houdini のダイナミクスネットワーク
は、多様なソルバを使い、それらによって 1 つのまとまった結果を得られるように設計されています。

また、Retime ノードを使用して、爆発が最大のときにシミュレーションの速度を落としてから、時間を逆戻りさせ
て始点に戻します。次にシミュレーションを Solaris/LOPS に移動し、ライトとカメラをセットアップした後、Karma 
レンダラを使用してショットをレンダリングします。  

レッスンの目標
弾丸がワイングラスに当たってグラスが割れ、液体が飛び散る様子を 
シミュレートします。

学習内容
	� ワイングラス、弾丸、液体のジオメトリをモデリングする方法
	� ブーリアンを使用してガラスジオメトリを事前に破壊する方法
	� グラスを粉砕する弾丸のリジッドボディシミュレーションを実行する方法
	� 液体が飛び散る FLIP 流体シミュレーションを実行する方法
	� シミュレーションをリタイムし、速度を落としてから、逆行させる方法
	� Solaris/LOPS で使用するために、結果を USD として	
エクスポートする方法
	� Solaris/LOPS でライトとマテリアルをセットアップする方法
	� Karma を使用して最終ショットをレンダリングする方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✘

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

ドキュメントバージョン 4.0.1J | 2023 年 8 月
© SideFX Software



プロジェクトファイル
SideFX.com の流体チュートリアルのページ

（このドキュメントを入手した場所です）から、
fluids_lesson_start  ディレクトリをダウン
ロードします。名前を fluids_lesson  に変更
し、Houdini Projects ディレクトリに配置し
てください。  

パート 1

ワイングラスのモデリング
まず、ポリゴンカーブを描画して回転させ、ワイングラスを作ります。 
Creasing（折り目）を使用してエッジを鋭くしたら、細分化して粉砕用に 
ジオメトリの密度をあげます。その後、ワイングラスからジオメトリを抽出し、 
液体のシミュレーションに使用する形状を作成します。 

最初のポイントを 
グリッドスナップ

2 つ目の 
ポイントを 
グリッドスナップ

最後の 4 つの 
ポイントを 
グリッドスナップ

Shift を 
押しながら、 
これら 4 つの
エッジを選択

01 File > Set Project を選択します。fluids_lesson  ディレクトリ
に移動し（上記の説明を参照）、Accept を押します。これにより、

このショットに関連するすべてのファイルがこのプロジェクトディレクトリと
そのサブフォルダに集められます。 

File > Save As... を選択します。新しい fluids_lesson ディレクトリが表示
されているはずです。ファイル名を wineglass_01.hip に設定し、Accept 
をクリックして保存します。これで、Tex  フォルダのリファレンス画像にアク
セスできるようになります。

02 Scene View で、V を押して Radial メニューを表示し、
Viewport Layout > Four Views を選択します。カーソルを 

Front  パネルの上に移動して、スペースバー + B を押して拡大します。

マウスがビューポート上にある状態で D を押します。Background タブ
をクリックし、Front タブで、ファイルピッカーを使用して $HIP、それから 
tex>wineglass_profile.jpg  に移動します。次のように設定します。

	� Auto-Place Image がオフであることを確認する
	� Image Offset を 0, 3 にする 
	� Image Scale を 5, 5 にする

これで、ビューをパンおよびドリーすると、背景も一緒に動きます。

03 Polygon シェルフで、Curve Polygon ツールをクリックします。
これにより、Primitive Type が Polygon に設定された Curve 

ノードが作成されます。X を押して Grid を選択し、グリッドスナッピングを
有効にして、ポイント A をクリックします。次に、同じようにグリッドポイント
の上にある 2 つ目のポイントをクリックします。グリッドスナッピングをオフ
にして、画像のトレースを続けます。

グラスのプレート部分（土台）の最後の 4 つのポイントでは、ずれないように
グリッドスナッピングをオンに戻します。ポイント B で終了したら、Enter を
押してカーブを完了します。グリッドスナッピングをオフにします。

オペレーションコントロールツールバーの Edit モードボタンをクリックする
と、ずれたポイントを移動できます。

04 スペースバー + B を押して、4 ビューのレイアウトに戻ります。
次に、マウスをパースビューの上に移動し、再度スペースバー 

+ B を押して拡大します。これで、カーブが 3D で表示されるようになりま
した。

S を押して Select ツールにしたら、N を押してカーブ上のすべてのプリミ
ティブを選択します。C を押して、Model > Curves > Revolve を選択しま
す。これで、ワイングラスのモデルになります。 

3 を押してエッジの選択に移り、カップの最上部（リム）のエッジをダブルク
リックします。Shift を押して、上から 2 番目のエッジとプレート（土台）の 
2 本のエッジをダブルクリックします。Tab > Crease を押して、Crease を 
0.75 に設定します。 
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09 4 を押して、プリミティブ選択に切り替え、N を押してすべての
プリミティブを選択します。C を押して、Model > Polygons > 

PolyExtrude を選択します。Distance を 0.01 に設定してワイングラスと
のオーバーラップを作成すると、液体を適切にレンダリングできます。 

ネットワークエディタで、チェーンの終端に Null ノードを追加して、	
その Display フラグを設定します。このノードの名前を FLUID_OUT  に	
変更します。 

オブジェクトレベルに上がり、このオブジェクトの名前を wine  に変更し
ます。 

05 4 を押して、プリミティブ選択に切り替え、N を押してすべて	
選択します。次に Tab > Subdivide を押します。Depth を 2 

に設定します。 

これにより、モデルが細分化されます（折り目が付けられたエッジは他の	
領域よりもシャープになるようセットアップされています)。Crease Weight 
を高くするとエッジは尖ります。このグラスでは、ソフトな見た目の方がうま
く機能します。

ネットワークエディタで、チェーンの終端に Null ノードを追加して、その 
Display フラグを設定します。このノードの名前を GLASS_OUT  に変更します。

オブジェクトレベルに戻り、オブジェクトの名前を wine_glass  に変更し
ます。 

06 wine_glass  ノードを選択した状態で、N を押してすべての	
プリミティブを選択します。次に、Modify シェルフに移動して、

Extract ツールをクリックします。これにより、ワイングラスジオメトリの 
objectmerge  が作成されるので、それを新しいオブジェクトに配置します。 

Front ビューから、ワイングラスの上部の面を選択して、Delete を押します。
すると、ネットワークに面を削除する Blast  ノードが追加されます。

注 : オリジナルのワイングラスのゴースト（半透明）表示バージョンが見える
のは、Scene View が Ghost Other Objects に設定されているからです。
この設定は、作業状況の前後関係を確認できるので便利です。

07 ここでパースビューに戻って、カップの下部をダブルクリックし、
Delete を押します。これにより、2 つ目の Blast ノードが追加さ

れます。これで、液体にしたい内側の面が残ります。ワインジオメトリの面
は、外側が暗く見えます。これは、そちら側がプリミティブの後面側というこ
とです。

N を押してすべてのプリミティブを選択します。Tab > Reverse を押して 
法線を外向きに反転させます。これで、各プリミティブの暗い側が形状の	
内側になります。

08 3 を押してエッジの選択に変更したら、形状のエッジをダブルク
リックして、開いたエッジを選択します。Tab を押して polyfill 

と入力します。Polyfill がハイライトされたら、Enter を押します。 

次のように設定します。
	� Fill Mode を Quadrilateral Grid にする
	� Tangent Strength を 0 にする 

これで閉じた形状が作成され、レッスンの後半で使用する FLIP 流体のソー
スになります。
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パート 2

弾丸のモデリング
弾丸のジオメトリを作成するためには、プリミティブの球から始め、それを半分にスライスします。次に、開口部を PolyExtrude で 
押し出したら、PolyFill で四角形トポロジを使用して形状を閉じます。その後、細分化して最終的な形状を定義します。 
このオブジェクトは非常に素早く移動するため、多くのディテールは必要ありません。  

1. LMB クリック

2. A を押して             
MMB クリック Delete を押す PolyFill で閉じる

01 オブジェクトレベルに移動し、ネットワークビューで、wine および wine_glass  オブジェクトの Display フラグをオフにします。
Scene View で、C を押して、Create > Geometry > Sphere を選択します。
Enter を押して原点に配置したら、中に入って次のように設定します。

	� Orientation を X Axis にする
	� Radius を 0.2, 0.125, 0.125 にする
	� Columns を 12 にする

Scene View で Tab > Clip を押したら、N を押してすべてのプリミティブを
選択し、Enter を押して、Direction を 1, 0, 0 に設定します。 

02 Select ツールをクリックしたら、3 を押してエッジ選択を有効に
し、球の開口部をダブルクリックします。C を押して、Model > 

Polygons > PolyExtrude を選択します。  

Extrusion タブで、次のように設定します。
	� Transform Extruded Front をオンにする
	� Translate Z を 0.04 にする
	� Scale を 0.7, 0.7, 0.7 にする

これにより少しジオメトリが追加されます。この後、弾丸の前面の三角形を
削除して、形状を閉じます。

03 タンブルして、S を押して Select ツールにし、4 を押して 面 /プ
リミティブ選択にします。弾丸の先端で三角形の 1 つを選択し

たら、A キーを押しながら 2 つの三角形を MMB クリックして、三角形の面
をすべて選択します。Delete キーを押して、それらを削除します。これによ
り、ネットワークに Blast  ノードが追加されます。

ネットワークビューで、Tab > PolyFill を押して、blast  の後にそのノードを
追加します。Fill Mode を Quadrilateral Grid、Corner Offset を 1 に設
定し、Display フラグをオンにします。これにより、弾丸の両開口部が適切
な四角形トポロジで閉じられます。 

04 最後に Subdivide ノードを追加して、Depth を 2 にして、
Display フラグを設定します。 

ネットワークエディタで、チェーンの終端に Null ノードを追加して、その 
Display フラグを設定します。このノードの名前を BULLET_OUT  に変更し
ます。 

オブジェクトレベルに戻り、このオブジェクトの名前を bullet  に変更します。
wine_glass  の Display フラグをオンにします。弾丸を X 軸で -20、Y 軸で 
5、移動させます。Front  正射投影ビューに戻り、ワイングラスとの衝突ポイ
ントが意図した通りかどうかを確認するとよいでしょう。

作業内容を保存します。
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パート 3

ワイングラスの破砕
ワイングラスのひび割れを定義するために、Draw Curve ツールを使用して自然に見える線を作成し、それらを押し出してジオメトリの 
シートにします。次に、Mountain ツールを使用してサーフェスにノイズを加えます。その後、この混沌とした見た目の形状をワイングラス
オブジェクトに結合し、シートを使用してグラスを粉砕するブーリアン演算をセットアップします。

04 S を押して Select ツールを表示し、4 を押してプリミティブ選択
に切り替えます。シートの 1 つをダブルクリックして、シート全

体を選択します。Tab > Duplicate を押して、コピーを作成します。回転 (R) 
ハンドルを使用して、複製したシートの向きを変更し、他のシートとほぼ直
交させます。カップのみを切断し、ステムは避けるようにします。これにより、
カップが別の方向に割れ、よりリアルなガラスの破片を作成できます。

別のシートでも繰り返し、異なる角度で切断する別のサーフェスを作成し
ます。

01 Scene View でオブジェクトレベルに移動し、C を押して、
Create > Geometry > Grid を選択します。Enter を押して	

原点に配置したら、I で中に入って次のように設定します。
	� Orientation を YZ Plane にする
	� Center Y を 4 にする
	� Size X を 5 にする
	� Size Y を 8 にする
	� Rows を 16 にする

これにより、ワイングラスの形状に一致する、Draw Curve ツールのための
描画サーフェスが作成されます。

02 Right  ビューに移動し、V を押して Shading > Wireframe を
選択し、ワイヤーフレームモードにします。グリッドとワイングラ

スの背後に弾丸が見えます。N を押してグリッド全体を選択し、Create シェ
ルフの Draw Curve ツールをクリックします。 

ワイングラスの上に、弾丸がガラスに当たる場所で交わるカーブを何本も
描画します。グラスのステム（脚）も粉々になる予定なので、ステムを横切る
カーブも追加します。不要なカーブを描いてしまったら、いつでも Ctrl + Z 
を押して取り消せます。

03 Select ツールに移動し、N を押してすべてのカーブを選択しま
す。次に、C を押して、Model > Polygons > PolyExtrude を

選択します。Divisions を 4 に設定します。

Extrusion タブで、次のように設定します。
	� Transform Extruded Front をオンにする
	� Transform Space を Global にする
	� Translate X を -4.5 にする

次に、別の箇所をクリックしてからすべてのジオメトリを選択し、Tab > 
Transform を押します。Translate X を 2.25 に設定して、このジオメトリ
を原点周辺の中央に配置します。
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BOOLEAN SHATTER
Boolean ノードは、ほとんどの場合、加算、交差、減算といった従来のブーリアンを
作成するのに使用されます。これらは閉じた形状にはうまく機能しますが、Shatter 
オプションを使用すればシートでジオメトリをスライスできます。
Houdini には Voronoi Shatter ツールもあり、使用することができますが、割れた
ガラスに必要なギザギザなルックにはなりません。また、ガラスのような粉砕を作成
できる RBD Material Fracture ノードもありますが、これらは平坦なサーフェスで
の使用に最適な機能なので、このワイングラスのレッスンでは使用していません。

Boolean Shatter

Voronoi

RBD Material 
Fracture

05 すべてのジオメトリを選択し、Tab > Mountain を押して、	
さまざまなシートのポイントにノイズを追加します。Amplitude 

を 0.75 に設定します。グラスの破砕がより面白いものになります。

ネットワークビューで、Null ノードをチェーンの終端に追加し、その名前
を FRACTURE_OUT  に変更します。このノードに Display フラグを設定し
ます。 

オブジェクトレベルに移動し、このノードの名前を fracture_geo  に変更し、
Display フラグをオフにして非表示にします。

06 wine_glass  オブジェクトの中に入ります。ネットワーク
ビューで、Tab > Object Merge を選択し、ノードを配置しま

す。Object 1 の横にあるノードセレクタをクリックし、fracture_geo > 
FRACTURE_OUT に移動して、このノードを選択します。Transform が 
Into Specified Object に設定されていることを確認してください。

これにより、ノイズを含むシートがワイングラスジオメトリネットワークに	
追加され、グラスを Boolean で Shatter できるようになりました。

07 ネットワークビューで Tab > Boolean を選択し、クリックして	
新しいノードを配置します。Subdivide  ノード（GLASS_OUT  で

はありません）を 1 つ目の入力に接続し、object_merge  を 2 つ目に接続
します。その Display フラグを設定したら、次のように設定します。

	� Set B: Treat As を Surface にする
	� Operation を Shatter (Pieces of A) にする

破砕を確認するため、Exploded View ノードをチェーンの終端に追加しま
す。破砕する様子を変更したい場合は、fracture_geo  オブジェクトに戻っ
てシートを編集します。編集内容は、プロシージャルに更新されます。

08 ネットワークビューで、exploded_view  ノードをバイパスする 
Null ノードを追加し、その名前を GLASSFRACTURE_OUT  に

変更します。このノードに Display フラグを設定します。 

これで、このネットワークに 2 つの出力ノードができました。GLASS_OUT 	
で元の形状のワイングラスが出力され、GLASSFRACTURE_OUT で破砕した
グラスが出力されます。これら両方を流れに沿って使用し、ショットを完成
させます。

作業内容を保存します。

96

HO
UD

IN
I F

OU
ND

AT
IO

NS



パート 4

RBD シミュレーションのセットアップ
シェルフツールを使用してリジッドボディシミュレーションを作成します。これにより、ジオメトリ、フォース、ソルバノードをまとめた  
DOP（Dynamic Operator）ネットワークが追加されます。ワイングラスのジオメトリネットワークには、シミュレーション用のジオメトリ 
準備のためのノードが追加されます。Convex Proxy を使用して、Bullet RBD ソルバが不規則なガラス破片を処理できるようにします。 

CONVEX DECOMPOSITION
RBD シミュレーションでは、高速シミュレーションを維持するために、
Houdini は 凸型形状を好む Bullet ソルバを使用します。Convex 
Decomposition では、凹型の形状をつながった凸型の形状に分解で
きます。その後、これらは Bullet ソルバによって 1 つの合成ピースとし
てシミュレートされます。 
ワイングラスの破片の形状はさまざまなので、Convex Decomposition 
によってすべての破片が正確に衝突するようにします。 元のジオメトリ Convex Decomposition

1
2

3 4

5

01 オブジェクトレベルで wine_glass  オブジェクトを選択し、
Rigid Bodies シェルフの RBD Convex Proxy ツールを	

クリックします。これにより、AutoDopNetwork  という初期ダイナミクス
ネットワークがセットアップされます。V を押して Shading > Smooth Wire 
Shaded を選択します。 

このツールを使用し、複雑な衝突の作成に使用できる凸状形状にワイング
ラスのパーツを分解します。ソースジオメトリよりも粗く表示されますが、	
シミュレーションの後で、クリーンなトポロジを確認できます。

02 Collisions タブに移動し、Ground Plane シェルフツールを	
クリックします。これにより、衝突するジオメトリ用に無限の	

地面が作成されます。 

groundplane_object  の Display フラグをオフにして、Scene View に	
表示されないようにします。それでもシミュレーションでは引き続き衝突	
するサーフェスとして機能します。

03 AutoDopNetwork  に入ります。wine_glass  ノードを選択
し、Physical タブで Density をガラスのおおよその密度である 

2000 に設定します。 

プレイバーで Play を押し、どうなるかを確認します。ガラスが地面に落下
します。現時点では、破片に作用する力は重力しかありません。

衝撃まで破片を接着しておく Glue ネットワークをセットアップしてもかまい
ませんが、弾丸は非常に高速なため、パーツの接着は不要です。
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05 オブジェクトレベルに上がって bullet  オブジェクトを選択し、
Rigid Bodies シェルフの RBD Objects ツールをクリックし

ます。弾丸からパックされた RBD オブジェクトが作成され、ダイナミクス	
ネットワークに追加されます。

AutoDopNetwork  に移動し、bullet  ノードを選択します。 
	� Initial State タブで、Velocity を 400, 0, 0 にする 
	� Physical タブで、Density を 20000 にする 

これは鉛の密度で、弾丸に適しているはずです。 

06 シミュレートする前に、グラスのプレートが地面に固定されたままになるようにします。wine_glass  オブジェクトに移動し
て、ディスプレイバーでプリミティブ番号をオンにします。ここではプレート
のパックプリミティブは 171 ですが、皆さんのものはおそらく違っているで
しょう。

Attribute Create ノードを create_packed_primitive  と proxy_geo 
ノードの間に作成します。次のように設定します。

	� Group を !171（または皆さんのプレートの番号）にする
	� Name を active  にする
	� Value を 1, 0, 0, 0 にする   

07 次に、transform_hires  ノードの Display フラグをオンにして、
Global Animation Options を開き、End を 50 に設定します。 

シミュレーションを再生します。ソースジオメトリがプロキシに合わせてアニ
メートされているのが分かりますが、衝突はそれほどドラマチックではあり
ません。

08 ソルバでの弾丸シミュレーションでは、デフォルトのサブステッ
プは 10 です。これは、弾丸のスピードの衝突を解決するのに

十分ではありません。オブジェクトレベルに上がり、AutoDopNet  ノードで 
Substeps を 5 に設定します。これで、ソルバ設定でサブステップが追加さ
れます。これによりシミュレーション時間が長くなりますが、正確さが増すう
えに、たいていはシミュレーションがよりアクティブになります。

シミュレーションをもう一度再生して、衝突の様子が改善されていることを
確認します。何か変更したい場合は、戻って設定を調整します。戻って一部
の亀裂の位置を変更してもかまいません。

作業内容を保存します。

04 オブジェクトレベルに上がって wine_glass  オブジェクトに入り
ます。たくさんのノードを追加してプロキシジオメトリを作成して

おり、このチェーンは現在表示されている dopimport  ノードで終わります。 

convexdecomposition  ノードで、Max Concavity を 0.05 に変更して	
衝突ジオメトリを調整します。 

Play を押してシミュレーションを確認します。
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01 フレーム 1 に進みます。ネットワークビューで wine  オブジェ
クトを選択し、Particle Fluid シェルフの FLIP Fluid from 

Object ツールをクリックします。 

すると、流体が流体パーティクル群になります。AutoDopNet  で、
flipfluidobject  ノードを選択し、Particle Separation を 0.05 に設定し
ます。これによりパーティクルが増え、シミュレーションにディテールが加わ
ります。

02 flipsolver1  ノードを選択して Particle Motion タブをクリック
し、Behavior で次のように設定します。
	� Add ID Attribute をオンにする 

Reseeding で次のように設定します。
	� Reseed Particles をオフにする 

Volume Motion で次のように設定します。 
	� Velocity Transfer を (APIC) Swirly にする

Surface Tension で次のように設定します。
	� Enable Surface Tension をオンにする
	� Surface Tension を 500 にする

03 Play を押してシミュレーションを実行します。追加のサブステッ
プのため時間は少し長くかかりますが、より正確な結果が得ら

れます。フレーム 10 を過ぎたら、Escape を押してシミュレーションを止め
ます。フレーム 10 に移動して、ここまでの流体をプレビューします。 

これをサーフェスとして表示するには、オブジェクトレベルに上がって 
wine_fluid  オブジェクトに移動します。Render Null ノードに Display フ
ラグを設定すると、サーフェス化された流体を確認できます。これはクック
するのに長い時間がかかりますが、サーフェスがどのように見えるかをフ
レーム毎に確認することができます。

パート 5

シミュレーションへ流体を追加
弾丸によるグラスの粉砕ができたので、ワインオブジェクトを流体に変換し、シミュレーションの一部として統合します。 
つまり、RBD と流体シミュレーションを同一 DOP ネットワークにまとめ、1 つのシステムとして動作するようにします。 
最初は、流体はパーティクルで表現されますが、サーフェス化して流体を視覚化できます。

Display フラグとレンダーフラグ
wine_fluid ジオメトリネットワークが最初に作成されたとき、
Display フラグはパーティクルを表示する dopimport ノードにあ
りますが、レンダーグフラグは particle surface ノードから生じた 
Null ノードにあります。このセットアップにより、ビューポートでのパ
フォーマンスが高速になり、レンダリングした場合は最終的なサー
フェスを確認できます。このレッスンでは、サーフェスをキャッシュ化
するため、ノードはレンダリングに使用されません。
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パート 6

シミュレーションのキャッシュ化とリタイム
このショットでは、10 フレームのシミュレーションを計算します。これをディスクに保存したら、Retime ノードで、流体が減速してから 
時間が逆戻りする長いショットに伸ばします。リタイムされた流体パーティクルがサーフェス化され、レンダリングのための最終ショットを
定義する 50 フレームのシーケンスとして出力されます。その後、ワイングラスと弾丸も流体に合わせてリタイムします。

01 オブジェクトレベルで、シェルフツールで作成した wine_fluid_
interior  ノードを削除します。wine_fluid  オブジェクトに入っ

て、import_wine、compressedcache  ノード、particlefluidsurface  ノー
ドを除くすべてのノードを削除します。 

compressed_cache  で次のように設定します。
	� Base Name を wine_fluid  にする
	� Base Folder を $HIP/geo/fluid/  にする
	� Version チェックボックスをオフにする
	� End を 10 にする（最初に RMB クリック > Delete 

Channels）

Save to Disk を押します。

02 完了したら、ジオメトリレベルのまま、Scene View の右上に	ある Visibility メニューから、Hide Other Objects を選択し
ます。 

Load from Disk をオンに設定して、ジオメトリシーケンスをスクラブしま
す。10 フレームのみ再生します。これからシーケンスをリタイムし、50 フレー
ム以上に伸ばしてエフェクトを減速します。

03 compressed_cache  ノードの後に Retime ノードを追加して、
Display フラグを設定します。次のように設定します。 
	� Evaluation Mode を By Frame にする
	� Scale Velocities オプションをオンにする

Frame フィールドで RMB クリックし、Delete channels を選択します。 
	� フレーム 1 : Frame を 1 に設定し、Alt クリック してキーフ
レームを設定
	� フレーム 5 : Frame を 1 に設定してキーフレームを設定
	� フレーム 10 : Frame を 7 に設定してキーフレームを設定
	� フレーム 40 : Frame を 10 に設定してキーフレームを設定
	� フレーム 45 : Frame を 1 に設定してキーフレームを設定

04 Animation Editor ペインをクリックして、作成したアニメーショ
ンカーブを確認します。グラフ上で H を押してビューをホーム

し、RMB クリックしながらドラッグして少しズームアウトします。

カーブハンドルをクリックアンドドラッグし、この図と同じような形状にしま
す。カーブの接線を分割する必要がある場合は、キーを選択し、T を押して
接線を統一します。次に、それぞれの端を個別に選択してドラッグします。
ここでの目標は、液体が素早く飛び出した後、ゆっくりになって短時間止ま
り、その後スピードアップして元の形状に素早く戻るようにすることです。
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リタイム
ワイングラスの粉砕で一番面白い部分は、最初の 10 秒間です。シミュレーショ
ンのこの部分を強調するため、10 フレームの流体パーティクルを保存してから、
Retime ノードを使用してシーケンスを伸ばします。時間を逆戻りさせて元のワイン
グラスに戻す、一種の「バレットタイム」効果を作成します。 
これを流体に設定したら、ポイントをサーフェス化して、長いシーケンスを保存しま
す。同じ Retime ノードは、粉砕するグラスと弾丸にコピーアンドペーストして使用
できます。

08 フレーム 1 に行き、wine_glass  ネットワークに移動します。
transform_hires  ノードの下に、File Cache ノードを配置して

接続し、次のように設定します。 
	� Base Name を glass_pieces  にする
	� Base Folder を $HIP/geo/  にする
	� Version チェックボックスをオフにする
	� End を 10 にする（最初に RMB クリック > Delete 

Channels)

Save to Disk を押します。Load from Disk をオンに設定したら、フレーム 
1 から 10 までをスクラブして、正確に見えることを確認します。

05 Retime  ノードが particlefluidsurface  ノードに接続されて	
いることを確認し、Display フラグを設定します。これにより、	

リタイムをベースとした最終的な流体が得られます。particlefluidsurface  
ノードを選択して次のように設定します。

	� Method を Average Position にする 
	� Union Compressed Fluid Surface をオフにする

Filtering タブで次のように設定します。
	� Dilate をオンにし、2 にする
	� Smooth をオンにし、Laplacian Flow にする

06 チェーンの終端に USD Export ノードを追加します。それを 
wine_surface  という名前に変更します。次のように設定し

ます。
	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/wine_surface.usd  にする 

Save to Disk  を押します。

07 Retime  ノードを選択し、Ctrl + C を押してコピーします。別の
ネットワークでこれをペーストして、砕けるワイングラスをリタイ

ムします。これにより、両方のネットワークでキーフレームが一致します。 

作業内容を保存します。
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USD と SOLARIS
このプロジェクトのルックデベロップメント工程をサポートするため、流体、ワイングラ
ス、弾丸を USD にキャッシュ化します。こうすることで、シミュレーションの再計算を 
気にすることなく、レンダリングに集中できるようになります。ここではシミュレーション
と同じシーンファイルにキャッシュを表示しますが、新しいシーンファイルにキャッシュを
インポートしてもかまいません。こうするとショットのライティングとレンダリングに集中
できますが、シミュレーションに戻って微調整するのが大変になります。

09 Ctrl + V を押して Retime  ノードをペーストし、それを 
filecache  ノードの後に配置して Display フラグを設定します。

これで流体とグラスでタイミングが一致しました。タイムラインをスクラブし
て、破片のタイミングを確認します。

Retime  ノードの後に、Attribute Delete を追加します。Primitive 
Attributes の横にある矢印から、name  を選択して、ジオメトリから	
このアトリビュートを削除します。

10 Switch ノードをネットワークに追加します。GLASS_OUT、	
それから attribdelete  ノードをそれに接続します。 

Select Input を $F>5 && $F<45  に設定します。タイムラインでスクラブし
て、その動作を確認します。このエクスプレッションは、フレーム 5 でひび割
れのないグラスから割れたグラスに切り替わり、フレーム 45 で元に戻るよう
にするものです。

これらの形状をまとめて、ワイングラスの USD ファイルで、衝撃の前後は	
グラスが割れていないようにします。

11 チェーンの終端に USD Export ノードを追加します。次のように
設定します。
	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/wineglass.usd  にする 

Save to Disk を押します。

12 フレーム 1 に移動し、bullet  オブジェクトを選択します。
Modify メニューから Extract を選択します。これにより、ジオ

メトリのワールド空間位置を取得できます。extract_object  の中に入り、
retime  ノードを object_merge  ノードの下にペーストして、それらを接続
します。 

チェーンの終端に USD Export ノードを追加します。それを bullet  という
名前に変更します。次のように設定します。

	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/bullet.usd  にする 

Save to Disk を押します。
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シミュレーションのキャッシュ化
このプロジェクトのルックデベロップメント工程をサポートするため、流体、ワイングラ
ス、弾丸をジオメトリ（USD）シーケンスにキャッシュ化しました。こうすることで、シミュ
レーションの再計算を気にすることなく、レンダリングに集中できるようになります。 
大量のハードディスク容量を消費する VFX ショットでは、こうしたワークフローが一般
的です。たくさんのパーティクルを含む巨大なシミュレーションを送る際は、この点に注
意するようにしてください。さまざまな中間段階を保管できる場所を確保することが重
要です。

01 デスクトップを Solaris に変更します。パスバーで Stage を選
択します。 

ネットワークビューで Tab > Reference を選択してからクリックし、
Reference ノードを追加します。Reference File の横にある File 
Chooser をクリックして、wineglass.usd  ファイルを指定します。ノードの
名前を wineglass  に変更します。Primitive Path を /geo/$OS  に設定し、
ノード名を使用して、geo  というグループに配置されるようにします。

Scene View で、ビューをホームするスペースバー + H のような表示ツール
を使用して、ワイングラスがよく見えるようにします。

02 このノードを Alt ドラッグして複製し、さらにもう 1 つ複製しま
す。1 つ目のコピーで、File Chooser をクリックして wine_

surface.usd  ファイルを指定します。ノードの名前を wine  に変更します。

2 つ目のコピーでも同じことを行い、bullet.usd  ファイルを指定します。	
ノードの名前を bullet  に変更します。 

ネットワークに Merge ノードを追加して、3 つすべての参照ノードをそれに
接続します。Display フラグを設定したら、スクラブして結果を確認します。

シーングラフには、geo  エントリの下に 3 つの参照 USD ファイルが表示さ
れているはずです。

03 ネットワークビューで、Tab を押して Grid と入力します。	
クリックしてノードを配置したら、名前を backdrop  に変更して、

Merge  ノードに接続します。Import Path Prefix を /geo/$OS  に設定しま
す。backdrop  ノードをダブルクリックして、ジオメトリレベルに入ります。  

Grid  ノードを選択し、Size を 200, 200、Rows および Columns を 20 
に設定します。Grid  ノードの出力を RMB クリックして、Bend と入力しま
す。クリックして Bend ノードを配置したら、Display フラグを設定します。
Bend を 75、Capture Origin を -40、0、0、Capture Direction を -1、0、0、
そして Capture Length を 20 に設定します。Grid  ノードの出力を RMB ク
リックして、Subdivide と入力します。Display フラグを設定し、Depth を 
2 に設定します。

パート 7

ショットの設定とレンダリング
ショットのレンダリングには、USD ファイルを Solaris ステージで参照し、背景を追加します。Solaris は Houdini のコンテキストで、 
LOP ノードを使用して USD シーングラフを定義します。次に、カメラを配置し、環境ライトを追加します。その後、ビューポートで Karma 
レンダラを実行し、ショットのプレビューレンダリングを行います。
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ビューポートレンダリング
Houdini のレンダラである Karma を使用して、シーケンスをレンダリン
グします。はじめは、Display Options の設定でレンダリングを実行し
ます。Display Options を表示するには、Scene View で D を押します。
デノイザをオンにしたり、Pixel Samples や Image Resolution の設定
が可能です。  
その後、Karma LOP をセットアップすれば、最終出力はそのノードの 
レンダリング設定で実行されます。

Denoiser を 
オンにする

04 表示ツールを使用して、正面から wineglass  が見えるようにし
ます。LOP Lights and Camera シェルフで、Camera ツール

を Ctrl クリックします。ネットワークに Camera ノードが加わり、カメラ越し
にビューポートを見られるようになります。 

Lock Camera/Light to View ボタンを押し、ビュー変更に応じてカメラの
位置が更新されるようにします。ビューポートでタンブル、パン、ドリーして
カメラを再配置し、ワイングラスが左側にきて、しぶきは右側に飛ぶように
します。タイムラインをスクラブし、シーケンス全体でカメラが機能している
ことを確認します。

05 LOP Lights and Camera シェルフで、Camera ツールを 	
Ctrl クリックします。Domelight  ノードをチェーンの終端に追

加します。

Domelight  ノードを選択し、Base Properties タブで Texture の横にある 
File Chooser  ボタンをクリックします。サイドバーで $HFS/houdini/
pic/hdri  リストをクリックして、HDRIHaven_skylit_garage_2k.rat  ファ
イルを選択します。Accept をクリックします。

Display Options バーで、High Quality Lighting with Shadows ボタ
ンをクリックします。

06 Persp  メニューで Karma を選択し、ビューポートで Karma を
使ってレンダリングします。タイムラインで異なるフレームに移

動すると、ビューポートが素早く更新されます。

Karma は USD を使用するよう設計されているので、LOP コンテキストの
すべてが USD シーングラフに変換されます。Houdini のこの部分からのみ 
Karma レンダラを使用できます。 

07 レンダリング時によりクリーンな画像を得るには、Nvidia グラフィックカードがあり、最新のドライバをインストールしている場
合は Denoiser をオンにします。Denoiser は、Display Options でオンに
できます。
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シーングラフ
ジオメトリやライトと同じように、LOP ノードを使用して追加し
たマテリアルはシーングラフに追加されます。Material Library 
LOP を使用したとき、Material Path Prefix のデフォルト設定は 
/materials/ でしたが、それはグラフでのマテリアルの位置でもあり
ます。編成を変えることも可能ですが、これがデフォルトです。
このマテリアルパスは、マテリアルをジオメトリに配置するために 
Assign Materials LOP で使用したパスです。

01 ネットワークビューで Tab > Material Library を押します。	
それをチェーンの終端に接続し、Display フラグを設定します。

Material Palette ペインに移動します。/stage/materiallibrary  の横に
ある矢印をクリックし、このエリアを開きます。パレットの左側のマテリアル
ギャラリーをスクロールして、ワイングラスとワイン用に Glass マテリアルを 
2 つ materiallibrary  作業エリアにドラッグします。

次に Copper マテリアルを見つけ、materiallibrary  作業エリアにドラッグ
します。これは弾丸に使用します。

02 2 つ目の Glass  マテリアルを選択し、名前を wine  に変更し
ます。 

ワインの IOR である Inside IOR を 1.3443 に設定します。	
次に、Reflectivity を 0.2 に設定し、環境の反射率を下げます。 

Transmission Color を 0.2, 0, 0 に設定して、赤みがかったワインの色に
変更します。それから At Distance を 0.3 に設定します。

03 ステージレベルに戻ります。Material Library の後に Assign 
Material ノードを追加します。

シーングラフから wineglass  を Primitives フィールドにドラッグしたら、
Material Path の横にある矢印をクリックして、このプリミティブ用に 	
glass  マテリアルを選択します。 

次にチェックボックスの横にある +（プラス）記号を 2 回クリックして、2 つ
の新しいエントリを追加します。同じ方法で wine  マテリアルを wine  プリ
ミティブに割り当て、copper  マテリアルを bullet  プリミティブに割り当て
ます。

パート 8

マテリアルの割り当てとシーケンスのレンダリング
最後に、ワイングラス、ワイン、弾丸にマテリアルを追加します。これらのマテリアルは USD シーングラフの一部となり、 
LOP ノードでジオメトリに割り当てられます。次に、Karma LOP で、Nvidia Optix Denoiser を含むレンダリングの設定を行い、 
レンダリング後、シーケンスを MPlay にロードし、結果を確認します。
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まとめ
Bullet RBD と FLIP 流体ソルバを使用して、ワイングラスを粉砕する  
VFX ショットを完成させました。Retime ノードを使用して、速度を落として 
から時間を逆戻りさせ、ワイングラスが最初と同じ位置に戻るようにしました。
そして結果を USD ファイルにキャッシュ化しました。 
その後、Solaris/LOPS コンテキストを使ってショットを設定し、ライトを追加
しました。マテリアルを作成してプリミティブに割り当て、ショットに適切な外
観を得ることができました。 
このプロジェクトでは、Houdini のダイナミクスノードとネットワークを使用 
してさまざまな種類のエフェクトを統合したり、ジオメトリノードを使用して 
シミュレーションのセットアップと出力を行う方法を紹介しています。 
VFX ショットの作成に使用されるノードとネットワークを理解できたら、
Houdini をさらに深く探求し、独自のエフェクトを作成してください。 
楽しむことが一番です!

05 ビューポートの Denoiser はこのノードからの出力に影響しないので、明示的に選択します。karmarendersettings  ノード
を選択して、Image Output > Filters タブで Denoiser を nvidia Optix 
Denoiser に設定してデノイザをオンに戻します。

nVidia Optix Denoiser がビューポートで使用されるものと一致します。
Intel OIDN デノイザもありますが、ディスクにレンダリングする場合のみ	
利用可能です。

作業内容を保存します。usdrender_rop  ノードを選択して、Render to 
Disk をクリックします。 

04 ネットワークビューで、Tab > Karma を押し、Karma Render 
Settings と USD Render ROP ノードを追加します。それらを

チェーンの終端に接続します。karmarendersettings  ノードを選択して、
Image Output > Filters タブで Denoiser を nvidia Optix Denoiser に
設定してデノイザをオンに戻します。

usdrender_rop  ノードを選択します。Valid Frame Range を 
Render Frame Range に設定し、Output Picture を $HIP/render/
wineglass_$F4.exr  に設定します。名前の $F  は、レンダリングにフレーム
番号を付加するのに必要で、4  はフレーム番号のパディングです。 

06 完了したら、Render > Mplay > Load Disk Files を選択し、	
レンダリングした画像を開いて最終的なシーケンスを確認し

ます。 

後で別の Karma ノードを分岐させて、解像度とレンダリング設定を上
げて最終的なレンダリングを行います。Convergence Mode に戻って 
Variance に設定し、サンプル数を上げ、デノイザをオフにします。	
最初は低解像度でテストレンダリングを行い、すべてが希望通りになって	
いることを確認するようにしてください。
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HOUDINI FOUNDATIONS 

破壊 FX 
ビジュアルエフェクトが楽しい理由の 1 つは、現実には何も破壊せずに、さまざまなものを爆破できることです。
このレッスンでは、パーティクルの火花を使用して導火線に火を付け、カートゥーンの爆弾を爆発させます。	
爆弾にはリジッドボディダイナミクス、火と煙には Pyro FX を使用します。このレッスンでは、さまざまなシェルフ
ツールやネットワークノードを使用して、ダイナミックシミュレーションをセットアップする方法を学びます。

作成するショットを完全に理解するために、すべての要素をゼロから作成して、エフェクトをシミュレートします。
Houdini シーンのさまざまなコンテキストで、シミュレーションノードがどう機能するかを理解しやすくなるはず
です。最後に、Karma レンダラを使用してショットをレンダリングします。 

ACES | OPENCOLORIO セットアップ
Pyro FX の使用時、より正確にカラーを表示するに
は、Academy Color Encoding System (ACES) 
を使用します。そのためには、Scene View のビュー
ポート（Persp）メニューから、Correction ツールバーを表示します。右にある矢印ボタンから、
OpenColorIO を選択します。これにより、ディスプレイが sRGB、出力が SDR Video - ACES 1.0 に	
なります。この設定は現在のセッションにのみ有効で、Houdini を開くたびに戻す必要があります。

レッスンの目標
爆弾をモデリングし、パーティクルの火花、リジッドボディダイナミクス、Pyro FX を使用して爆発させます。

学習内容
	� 爆弾をモデリングし、導火線をアニメートする方法
	� カメラをアニメートし、ショットをセットアップする方法
	� すすの軌道（トレイル）と導火線の火花をセットアップする方法
	� 爆弾のジオメトリを粉砕して爆発させる方法
	� 爆発用の Pyro FX シミュレーションをセットアップする方法
	� マテリアルとテクスチャをセットアップする方法
	� Solaris コンテキストで Karma を使用してエフェクトをレンダリングする方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✘

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

ドキュメントバージョン 4.0.1J | 2023 年 8 月
© SideFX Software



パート 1

爆弾のモデリング
爆弾のジオメトリを作成するには、プリミティブの球から始め、上部を開口部に変更します。 
これにはポリゴンの押し出しとベベルを使用して、最終形状に必要なジオメトリを定義します。 
レッスンの後半で、この爆弾を砕きます。

01 File > New Project を選択します。Project Name を 
destruction_lesson  に変更し、Accept を押します。これによ

り、プロジェクトディレクトリとサブディレクトリが作成され、このショットに
関連するすべてのファイルが格納されるようになります。

File > Save As... を選択すると、新しい destruction_lesson  ディレクトリ
が表示されます。ファイル名を destruction_01.hip  に設定し、Accept を
クリックして保存します。 

02 ビューポートで、C を押して Radial メニューを表示します。こ
のメニューからCreate > Geometry > Sphere を選択します。

ビューポートで、Enter を押して球を原点に配置します。上部のオペレー
ションコントロールツールバーで、Radius を 0.3, 0.3, 0.3 に設定します。

S を押して Select ツールにしたら、3 を押してエッジ選択を呼び出します。
スペースバー + 2 を押して Top ビューに移動します。球の上部と下部のエッ
ジを矩形選択し、Delete を押します。これによりエッジが削除され、2 つ
の円形ポリゴンができます。スペースバー + 1 を押してパースビューに戻り
ます。

03 S を押して Select ツールにし、4 を押してプリミティブ（フェース）
選択にします。球の上部の円形ポリゴンを選択します。

C を押して Radial メニューを表示し、Model > Polygons > PolyExtrude 
を選択します。Distance を約 0.075 にして、ハンドルを上に移動します。
Output Front をオフにします。

04 球の下部の円形ポリゴンを選択し、Delete を押します。これに
より、ネットワークに blast ノードが追加されます。S を押して 

Select ツールに移動し、3 でエッジ選択に切り替えます。先ほど作成した
穴のエッジをダブルクリックして、すべてのエッジを選択します。

Tab > Polyfill を押します。パラメータエディタで、Fill Mode を 
Quadrilateral Grid、Smooth を 270 に設定します。球の下部に、単一の
ポイントに集中しない、クリーンなトポロジが作成されます。
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サーフェス法線
すべてのプリミティブに法線方向があり、片方の側が内側、もう片方
の側が外側になっています。爆弾のジオメトリを押し出すと、最初は
ジオメトリが裏返しになります。これは、青色のフェースで示されます。
その後、Reverse ノードを使用して法線の方向を変えます。
サーフェス上に法線を表示するには、Scene View ペインの右側の 
Display Options バーにある Primitive Normals ボタンを使用し
ます。 

05 N を押してすべてのフェースを選択し、再度 Polyextrude ツー
ルを選択します。約 -0.04 の Distance 値に押し出します。パラ

メータエディタの Extrusion タブで、Output Back をオンにします。

N を押してすべてのフェースを選択し、再度 Tab を押して Reverse と入力
していきます。このノードは、すべてのポリゴンの法線を反転させます。これ
で、法線が正しい方向を向くようになりました。

06 S を押して Select ツールに移動したら、3 でエッジ選択に変更
します。爆弾の上部のエッジをダブルクリックしたら、Shift を

押しながらダブルクリックして上部の内側の円を選択します。

C を押し、Radial メニューから Model > Polygons > Polybevel を選択し
ます。Distance を 0.005 に設定します。Shape を Round、Divisions を 
3 に設定します。

07 S を押して Select ツールに切り替えます。爆弾の円の部分と上
部の押し出された部分が交わる箇所のエッジをダブルクリック

します。

Q を押して最後に使用した Polybevel ツールに戻り、Distance を 0.01、
Shape を Round、Divisions を 3 に設定します。 

08 ネットワークビューで、Tab > Transform を押して、それをネッ
トワークの終端に追加します。Translate Y を 0.3、Rotate X 

を 27 度に設定します。 

Null ノードを追加します。終端に null  を接続し、null  ノードに Display 
フラグを設定して表示します。null ノードの名前をダブルクリックして、
BOMB_OUT  に変更します。

オブジェクトレベルに移動して、オブジェクトの名前を bomb_geo  に変更
します（爆弾のジオメトリが含まれるため）。 
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パート 2

導火線のモデリング
導火線の作成は、爆弾の上部から伸びる Bezier カーブから始めます。地面にカーブをくねらせて、長い導火線を作成します。 
カーブの方向を逆にして導火線のアニメーションの準備をしてから、Polywire ノードを追加して導火線に厚みを与えます。 

ツールのヒント
Curve ツールにはツールのヒントが付属しており、作業時に Scene View 
に表示されます。このツールのさまざまなショートキーオプションが表示
され、ツールの機能を理解するのに役立ちます。 
Shift + F1 を使用して折り畳むと、ツール名のみが表示されます。ヒント
付きのツールは増えています。Houdini の今後のバージョンでは、さらに
多くのツールでヒントが表示されるでしょう。 

3

2

1

4

5

6

01 スペースバー + B を押してすべての角度から爆弾を表示しま
す。Right ビューに移動し、スペースバー + B を押して拡大し

ます。 

C を押して Radial メニューを表示し、Create > Geometry > Curve を	
選択します。クリックアンドドラッグして、カーブの 1 つ目のポイントと接線
ハンドルを作成します。次に、ポイントを追加し、下にドラッグして下向きの
カーブを簡単に描画します。

02 X を押して Grid を選択し、グリッドスナッピングをオンにします。
地面でクリックアンドドラッグして 3 つ目のポイントを作成し、	

接線ハンドルは地面に揃えます。

03 スペースバー + B を押して 4 面ビューに戻ります。マウスを	
パースビューの上に移動し、再度スペースバー + B を押して

ビューを拡大します。 

グリッドスナッピングをオフにし、Display Options バーの
上から 2 つ目のボタンを使用して、コンストラクション平面 
をオンにします。これにより、カーブが地面から離れなくなり
ます。 

接線をドラッグして新しい 3 つのポイントを描画し、カーブの
形状を定義します。

MMB クリックしてカーブを完成させます。
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08 Blast ノードを追加して、Group を 0 に設定します。これにより、
導火線のジオメトリの終端が削除されます。Normal ノードを

チェーンの終端に追加します。

normal  ノードの後に Null ノードを追加して、FUSE_OUT  と名前を付けま
す。これで、導火線全体のジオメトリを表すノードができました。

オブジェクトレベルに戻り、オブジェクトの名前を fuse_geo  に変更します。

05 Scene View で、Tab > Reverse を押します。N を押してカーブ
全体を選択し、Enter を押します。カーブを爆弾から出てきたよ

うに描いたため、このままでは逆の方向からアニメートされてしまいます。
これで、導火線の火が付く側から、カーブが開始するようになります。 

06 Display Options バーの Points オプションを
オンにします。Resample ノードを追加します。

resample  ノードで、Maximum Segment Length を 0.025 
に設定して、ディテールを追加します。resample  ノードによっ
て、ポイントが均一に配置されます。 

07 Polywire ノードを追加して、ワイヤーに厚みを与えます。	
Wire Radius を 0.0075、Divisions を 8 に設定します。 

reverse  ノードと polywire  ノードの間に、Transform ノードを追加
します。polywire ノードに移動し、Wire Radius パラメータを RMB ク
リックして、Copy Parameter を選択します。transform  ノードに戻り、
Translate Y を RMB クリックして、Paste Relative References を選択し
ます。 

これで、導火線全体が持ち上がり、地面のグリッドに半分埋まっていた状態
が解消します。

04 オペレーションコントロールツールバーで、カーブの Mode を 
Edit に変更します。カーブ上の編集ポイントをクリックして、

カーブの形状を微調整できるようになります。 

地面でポイントを選択して編集し、カーブを希望通りのルックにします。タン
ブルして、カーブが地面上にあることを確認します。
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01 fuse_geo  オブジェクトの中に入ります。transform  ノードと 
Polywire  ノードの間に、Carve ノードを追加します。First U ス

ライドをドラッグして、カーブにどのような影響を与えるのか確認します。

First U を 0 に設定します。First U を Alt クリックして、フレーム 1 にキー
フレームを設定します。パラメータボックスの色が変わり、キーフレームが
設定されたことと、現在のフレームにキーがあることが示されます。

02 フレーム 180 に移動します。First U を 0.999 に設定します。	
これにより、キーフレームが設定されます。フレーム 200 に移

動します。First U を 1.0 に設定します。これにより、もう 1 つキーフレーム
が設定されます。

プレイバーの左下で、再生が速くなりすぎないように Real Time Playback 
をオンに切り替えて、Play を押します。

これで、導火線が爆弾のジオメトリに向かってアニメートするようになりまし
た。爆弾には爆発をセットアップします。 

03 Animation Editor ペインタブをクリックします。アニメーショ
ンカーブを選択して、パネル上部の Straight ボタンをクリック

します。カーブが直線になり、導火線の最初から最後まで、速くなったり遅
くなったりせず、均一の速度にアニメートされます。

Scene View ペインタブに戻って、アニメーションを再生し、この変更がモー
ションに与える影響を確認します。

作業内容を保存します。

04 ネットワークビューで、Sphere ノードを追加して、Display フ
ラグを設定します。次のように設定します。
	� Radius を 1, 1, 1 にする
	� Center Y を 0.0075 にする
	� Uniform Scale を 0.0075 にする

スペースバー + F を押して、球にフォーカスします。 
	� Orientation を Z Axis にする
	� Rows を 9、Columns を 8 にする 

Scene View で、N を押してすべてを選択してから、Tab > Clip ノードを選
択し、Direction を 0, 0, -1 に設定します。 

パート 3

導火線のアニメート
導火線のアニメーションでは、Carve ノードを使用して、時間の経過とともにカーブの長さが変化するようにします。 
導火線に丸いキャップを追加して、すすと火花を放出するのに使用します。カーブ上に接線をセットアップして、 
キャップが適切に動くようにします。次に、NULL オブジェクトをいくつか追加して、パーティクルの放出に使用する 
キャップを簡単にエクスポートできるようにします。 
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06 Copy to Points ノードをネットワークに追加します。球からの 
polyfill  ノードを 1 つ目の入力に、carve  ノードを 2 つ目の入力

に接続します。Target Points を 0 に設定します。 

Merge ノードを追加します。blast  ノードと copytopoints  ノードを接続し
てから、normal  ノードに接続します。

キャップはカーブの終端に適切に配置されましたが、方向が正しくありませ
ん。カーブに法線を追加して、適切に揃える必要があります。

07 reverse  ノードと carve  ノードの間に、Orientation Along 
Curve ノードを追加します。Output Attributes で Y Axis オプ

ションをオフにします。Tangent (Z Axis) は N のままにしておきます。	
これにより、法線がカーブに追加され、先端のキャップが導火線に合わせて
動くようになります。

08 polyfill  ノードの後に Color ノードを追加して、Color を黄色に
設定します。導火線の blast ノードの後に Color ノードをもう 

1 つ追加して、Color をダークグレーに設定します。こうした色分けは、	
作業中に、導火線を視覚化するのに役立ちます。また、これらの色を基に、
後で割り当てるマテリアルに影響を与えることも可能です。 

09 copytopoints  ノードの後で Null ノードを分岐させて、横に配
置します。null  ノードの名前を CAP_OUT  に変更します。後で

これを使用して、キャップを別のネットワークに抽出します。パーティクルの
放出では、そのネットワークを参照することになります。Display フラグを
設定し、球の半分が表示されることを確認します。プレイバーをスクラブし
て、球が導火線とともに動くことを確認します。

完了したら、Display フラグ の設定を FUSE_OUT null に戻します。

05 タンブルして、S を押して Select ツールにし、4 を押してフェー
ス/プリミティブ選択にします。球の先端で三角形の 1 つを選択

したら、A キーを押しながら 2 つの三角形を MMB クリックして、三角形の
面をすべて選択します。Delete キーを押して、それらを削除します。これに
より、ネットワークに Blast  ノードが追加されます。

3 を押してエッジ選択に切り替え、先ほど削除した領域のエッジをダブルク
リックします。Tab > polyfill を押して、blast  の後にノードを配置します。
Fill Mode を Quadrilateral Grid に設定し、Display フラグをオンにしま
す。Smooth を 100 に、Tangent Strength を 0 に設定します。これによ
り、球の先端に四角形トポロジが作成されます。  
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1

2

カーブを直線にする 接線ハンドルをドラッグ

パート 4

アニメーションカメラの作成
このショットをさらに発展させていくうえで、最終ショットをフレーミングするカメラをセットアップしておくと便利です。 
このカメラリグを構築するには、Null オブジェクトをカーブに拘束してから、Aim 拘束を使用してカメラを Null オブジェクトに向けます。
カメラが導火線の終端に追従するようになるため、パーティクルの放出を評価しやすくなります。

01 ドリーアウトして上からシーン全体を表示します。コンストラク
ション平面がオンになっていることを確認します。C を押して 

Radial メニューを表示し、Create > Geometry > Curve を選択します。	
導火線の開始付近のポイントをクリックアンドドラッグしたら、さらにドラッ
グして接線を伸ばします。 

次に、爆弾の背後で 2 つ目のポイントをクリックアンドラッグしたら、さらに
ドラッグして接線を伸ばし、カーブの形状を作成します。MMB クリックして
終了し、形状を調整したい場合は Edit モードを使用します。

02 Curve ノードで、Z Axis オプションをオンにして、N に設定します。これにより、カーブに沿ってアニメーションを補助する法線が作
成されます。

03 原点に Null オブジェクトを追加します。このノードの名前を 
camera_lookat_null  に変更します。Constraints シェルフか

ら、Follow Path ツールをクリックします。これで、Null が開始オブジェク
トとして受け入れられます。パスオブジェクトとしてカーブを選択し、Enter 
を押します。look at オブジェクトまたは look up オブジェクトは必要ない
ので、Enter をもう 2 回押します。 

タイムラインをスクラブすると、開始フレームから終了フレームまで、Null オ
ブジェクトがパスに沿って一定のペースで移動することを確認できます。

04 拘束ネットワークが Null オブジェクトに追加され、path ノードが作成されました。フレーム 1 に移動します。Path ノードを選
択したまま、Position パラメータを RMB クリックして Delete Channels 
を選択し、パスに沿って Null をアニメートしているエクスプレッションを削
除します。Position を 0 に設定します。Position を Alt クリックして、キー
フレームを設定します。

フレーム 195 に移動して、Position を 1 に設定します。Position を Alt ク
リックして、2 つ目のキーフレームを設定します。

Animation Editor タブをクリックし、H を押してカーブ全体を表示します。
カーブを選択し、Straight ボタンを押して直線にします。2 つ目のポイント
の接線を使用して、最後が滑らかになるように調整します。 
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拘束
Null オブジェクトをパスに追従させ、カメラをパスに向かせるために、Constraints シェ
ルフにあるアニメーション拘束を使用しました。これらは、チャンネルオペレータまたは 
CHOP と呼ばれる特別なノードタイプを使って行われます。これらのノードは、null ノードや 
camera ノードの内部にあります。これらを使用して、拘束の動作を制御することができます。
CHOP ノードは、任意のパラメータを RMB クリックすると表示される Motion FX メニュー
でも使用できます。  

1 Z に沿って移動

2 X に沿って移動

3 上に移動

06 Constraints シェルフから、Look At ツールをクリックします。
これにより、選択したカメラが look at オブジェクトとして使用

されます。null  オブジェクトを look at オブジェクトとして選択し、Enter を
押します。再度 Enter を押して、look up オブジェクトとしては何も割り当
てないようにします。

これで、カメラが Null オブジェクトに向くようになりました。Camera メ
ニューから cam1  を選択し、このカメラ越しに見てみましょう。

05 ネットワークビューで、Tab > Camera を選択し、Enter を押し
て、クリックして原点に配置します。Move ツールを使用して、

カメラを導火線の前の少し右側に移動します。Y 軸に沿って上に移動し、	
地面から約 0.75 ユニット上げます。

07 フレーム 1 に移動します。camera を選択して、Handle ツール
がアクティブなことを確認します。カメラハンドルが表示される

ので、ハンドルを使用して導火線の開始点がよく見えるようにカメラを再配
置します。 

フレーム 195 に移動します。同じハンドルを使用して、爆弾がフレーム内の
適切な位置に見えるようにカメラを再配置します。

シーケンスを通してカメラが適切に動作するように、前後にスクラブして微
調整しましょう。シーケンス全体を通して、導火線が見えるようにします。  

08 オブジェクトレベルに移動して、curve、camera_lookat_null  
オブジェクトと cam1  ノードを選択して整列させ、ネットワーク

ボックスに入れます。ボックスのタイトルバーをダブルクリックし、ボックス
の名前を Camera Rig  にします。すべてのパーツの Display フラグをオフに
して、作業時に Scene View に表示されないようにします。このボックスは
必要に応じて折り畳んだり、展開したままにすることができます。 

シーンを保存します。
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パート 5

すすのトレイルの作成
すすのトレイルを作成するには、キャップを使用してパーティクルトレイルを放出します。これらのポイントを適切に放出する方法と、 
重力などのフォースを追加してパーティクルの動きを制御する方法を学びます。また、衝突をセットアップして、パーティクルが地面に 
ぶつかったり、爆弾のサーフェスを滑り落ちるようにする方法も学びます。

01 fuse_geo  オブジェクトのノード中に入ります。CAP_OUT  の 
Display フラグをオンにした状態で、Modify シェルフに移動し

て、Extract ツールを使用します。N を押してすべてのフェースを選択し、
Enter を押すと、Object Merge ノードを使ってキャップを取り込んだ新しい
オブジェクトが作成されます。オブジェクトレベルに移動して、このオブジェ
クトの名前を soot_trail  にします。

fuse_geo  オブジェクトに戻り、FUSE_OUT に Display フラグを設定します。
これで、レンダリング時には導火線のジオメトリ全体が表示され、パーティ
クルの生成には新しいオブジェクトが使用されます。

02 soot_trail  ノードの中に入り、POP Network ノードをチェーン
の終端に追加します。その中に入り、Source First Input  ノー

ドで、Const Birth Rate を 1000 に設定します。Play を押します。パーティ
クルが放出されるのを確認できますが、ただそれだけです。

1 つ上のレベルに戻り、Simulation タブで Substeps を 3 に設定します。
Play を押します。パーティクルがより均一に放出されているのが分かり
ます。

03 object_merge  ノードを Alt ドラッグ して、2 つ目のコピーを
作成します。Object 1 を fuse_geo>resample  ノードに設定し

ます。このカーブを使用して、キャップに Velocity を転送します。

Orient Along Curve ノードを追加したら、Output Attributes の 
Tangent (Z Axis) をオンにして、v に設定します。

オリジナルの object_merge ノードと popnet  ノードの間に Attribute 
Transfer  ノードを追加します。Primitives チェックボックスをオフにして、
Points を v に設定します。

04 attributetransfer  と popnet の間に Attribute Adjust 
Vector ノードを配置します。Adjustment Value で次のように

設定します。
	� Adjustment for を Direction Only にする
	� Adjust with を Noise にする
	� Range Values を Zero Centered にする
	� Amplitude を 0.5 にする

Noise Pattern の Element Size を 0.025 に設定し、Post-Process の 
Enable Post-Process をオンにします。Play を押してテストします。
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06 オブジェクトレベルに戻り、グリッドを作成します。Size を 30, 
30、Rows と Columns を 31, 31 にします。 

名前を ground  に変更します。popnet  の中に入り、Pop Collision 
Detect ノードを source_first_input  ノードの後に追加します。SOP Path 
を obj/ground/grid1 に設定します。Behavior タブで、Response を 
Stick に設定します。Color Hits は赤色のままにしておきます。 

Pop Collision Detect ノードをもう 1 つ追加します。SOP Path を 
bomb_geo  ジオメトリオブジェクトに設定します。Response を Slide に
設定します。Color Hits を緑色に変更します。Play を押します。

05 popnet  の中に入って、popsolver  の下に Gravity Force ノー
ドを追加します。これでシミュレーションを再生すると、パーティ

クルが地面に落ちるようになります。

07 現在は、パーティクルがシーケンス全体を通して放出されています。爆弾が爆発する瞬間に、パーティクルを止めなければな
りません。POP Kill ノードを wire_pops_into_here  merge ノードの後に
追加します。フレーム 1 に移動して、Activation を $F>199 に設定します。
これで、パーティクルはフレーム 200 で終了します。

Rule タブで Enable をオンにします。Play を押してテストします。

08 ジオメトリコンテキストに戻り、attribute create ノードを作
成して popnet に接続します。Name を pscale に、Value を 

0.001 に設定します。 

Color SOP を追加して、Color をダークグレーに設定します。

null ノードをチェーンの終端に追加して、名前を SOOT_OUT  に変更し
ます。

パーティクル FX
すすのトレイルは、パーティクルダイナミクスを使用して作成します。パーティクルとは、風や
重力といったフォースを使用して影響を与えることのできるポイントです。導火線の末端から、
ポイントを発生させ、さまざまなテクニックでシミュレートすることができます。 
パーティクルは Houdini の Dynamics または DOP セクションを使用してシミュレートした
後、SOP に戻してジオメトリとして扱うことができます。次のセクションでは、パーティクルを
使用して導火線の末端に火花を作成します。
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火花 | PARTICLE TRAIL
Particle Trail SOP は、アニメーションするパーティクルシステムを受け取り、 
そのパーティクルからモーショントレイルを生成します。これらのトレイルは、火花、
花火、雨などの様々なエフェクトで使用可能です。 
このノードは、そのトレイルのルックを制御することもできます。これによって、 
長い期間のモーションブラーを使ってポイントをレンダリングすることなく、 
SOP コンテキスト内でルックを微調整することができます。

パート 6

パーティクルの火花の作成
火花を作成するには、すすのパーティクルオブジェクトをコピーして、火花を生成する新しいオブジェクトとなるように設定を変更します。
火花のパーティクルの方が寿命が短く、活発になるようにします。Spark Trail ノードを使用すると、希望通りのルックの火花をショットに
追加することができます。このノードのパラメータを調整することで、目的のルックを実現します。 

01 フレーム 1 に戻り、オブジェクトレベルに移動します。Ground 
オブジェクトを非表示にします。soot_trail  オブジェクトを Alt 

ドラッグ して、コピーを作成します。コピーの名前を sparks  にします。 

この新しいオブジェクトには既に popnet があり、これを火花のパーティク
ルシミュレーションを生成するように変更します。Houdini では、すべてを
ゼロから作成するのではなく、既にあるネットワークを再利用することをお
勧めします。

02 sparks  オブジェクトに入ります。いくつか変更を加えて、火花を
作成するネットワークをセットアップします。

atttributecreate  と color  ノードを削除します。これらはこのパーティクル
ネットワークには必要ありません。null ノードの名前を SPARKS_OUT  に
変更します。

attributeadjustvector  ノードで、Amplitude を 1.75 に変更します。 

このノードの上に、新しい Attribute Adjust Vector ノードを追加します。
Enable Pre-Process をオンにして、Constant Value を 0, 1, 0 に設定し
ます。これで、パーティクルが上昇してから落下するようになりました。Play 
を押します。    

03 フレーム 1 に戻ります。Attribute Adjust Float ノードを 
popnet  ノードの直前に追加します。次のように設定します。
	� Attribute Name を life にする
	� Unit Settings を Duration にする
	� Pattern Type を Random にする
	� Min Value を 2、Max Value を 4 にする
	� Random で、Seed を $F にする
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05 ジオメトリレベルに戻ります。フレーム 1 に移動します。 ネットワークビューで、Tab > Spark Trail を押します。少し遅
れて、timeblend  と sparktrail  の 2 つのノードが追加されます。popnet  
を timeblend  ノードに接続し、sparktrail  を SPARKS_OUT  Null に接続
します。

Play を押します。火花が見えますが、導火線の末端よりも遅れています。 

04 popnet  の中に入り、2 つの collisiondetect  ノードを 削除し
ます。この時点では衝突を気にする必要はありません。後から

必要に応じて別のノードを追加します。 

Play を押して、パーティクルが放出されるのを確認します。

06 キャップを取り込む object_merge  と、attributetransfer  ノー
ドの間に Time Shift ノードを追加します。Frame パラメータ

名をクリックして、使用されているエクスプレッションを確認します。それを 
$FF + 1 に変更します。

これによりキャップが 1 フレーム分進むため、火花と導火線の末端が揃うよ
うになります。Play を押してテストします。

07 フレーム 1 に移動し、sparktrail  ノードを選択します。Split タ
ブをクリックし、Enable Split チェックボックスをオンにします。

Percent to Split を 40 に設定します。

Shape の Splits per Point を 4 に設定します。 

Play を押してテストします。

08 フレーム 1 に戻り、オブジェクトレベルに移動します。 カメラを cam1  に設定し、ツールバー下部の Flipbook  ボタ
ンを押します。表示されるウィンドウで Start をクリックします。Scene View 
のアニメーションシーケンスが作成され、パーティクルの動きを評価でき
ます。

Realtime トグル  がオンになっていることを確認したら、フリップブック
を再生して、ショットの進行を確認します。
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パート 7

爆弾の爆発
爆弾のジオメトリに必要なのは、リジッドボディダイナミクスシミュレーションです。ジオメトリを粉砕してから、アトリビュートを追加して
爆発を作成します。その後、移動するパーツの速度を制御して、芸術的な観点でルックを調整します。シミュレーションの準備が整ったら、
ジオメトリをキャッシュして、効率的に PyroFX の段階に進めるようにします。 

01 fuse_geo、soot_trail、sparks  オブジェクトを非表示にしま
す。スペースバー + G を押して、爆弾のジオメトリを中心に寄

せます。プレイバーでフレーム 1 に移動します。スペースバー + G を押して、
爆弾を中心に寄せます。

bomb_geo  オブジェクトを選択し、Simple FX シェルフから Simple 
Fracture を選択します。衝突オブジェクトの選択を求められたら、何も選
択せずに Enter を押します。すると、このネットワークがすぐにセットアップ
されます。このオブジェクトは爆弾のジオメトリを結合して、粉砕とシミュ
レーション用のノードをセットアップします。

02 fracture_solver  ノードで、Start Frame を 200 に設定します。
プレイバーの開始フレームを 200 に設定します。 First Frame 

ボタンをクリックし、フレーム 200 に移動します。爆発のシミュレーションが
必要なのはフレーム 200 から 240 のみです。 

fracture_solver  ノードで Collision タブに移動して、Ground Collision 
セクションの Ground Type を Ground Plane に設定します。Advanced 
タブに移動し、Constraints > Glue セクションで、Data Name フィールド
の Glue  という語を削除します。

Play を押して、爆弾がバラバラになるのを確認します。次は、パーツを爆発
させるために開始 Velocity を追加します。

03 フレーム 200 に移動します。Attribute Adjust Vector ノード
を追加して、他のノードの右側に配置します。rbd_configure  

ノードの 3 つ目の出力を attributeadjustvector  ノードに接続し、
attributeadjustvector  ノードを fracture_solver  ノードの 3 つ目の入力
に接続します。

このノードで次のように設定します。
	� Enable Pre-Process をオンにする
	� Overwrite Initial Value をオンにする
	� Initial Vector を 0, 1, 0 にする

04 Adjustment Value で、次のように設定します。
	� Adjustment for を Direction Only にする
	� Operation を Spread にする
	� Adjust with を Noise にする
	� Spread Angle Minを 15 にする
	� Spread Angle Maxを 120 にする

Noise Pattern で Element Size を 0.5 に設定します。

Post-Process で Enable Post-Process をオンにしたら、Minimum 
Length をオンにして、20 に設定します。
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05 Play を押します。爆弾が爆発するようになりました。ジオメトリ
に対する Velocity アトリビュートの設定がシミュレーションに送

られ、破片の初期 Velocity を使用して破片を押し動かします。 

Houdini では、多くのビジュアルエフェクトのセットアップで、アトリビュート
の操作が効果的です。

06 rbdconfigure  ノードを選択します。Speed Limit セクション
を開き、Speed Max と Spin Max パラメータをオンにします。

Speed Max を 2、Spin Max を 30 に設定します。Play を押します。シミュ
レーションが元の速度よりもだいぶ遅くなります。 

今度は、Speed Max を 10、Spin Max を 60 に設定します。Play を押し
ます。 

07 rbdmaterialfracture ノードを選択して、Cell Points の Scatter 
Points を 25 に設定します。Play を押します。これで、破片が

かなり増えました。 

attributeadjustvector  ノードに戻り、Length Scale を 50、Initial 
Vector を 0, 5, 0 に設定します。Play を押します。 

08 フレーム 200 に移動します。fracture_io ノードで、Base Name 
を exploding_bomb、Base Folder を $HIP/geo/bomb  に

設定します。Save to Disk をクリックすると、Load From Disk がオンにな
ります。Play を押して、キャッシュ化されたジオメトリをプレビューします。

09 Null ノードを追加して、それに fracture_io  ノードの 1 つ目の
出力を接続します。このノードを EXPLODING_BOMB_OUT  と

いう名前に変更します。  
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01 オブジェクトレベルに移動します。Simple FX シェルフから、
Simple Fireball をクリックします。Scene View で、Enter を

押して原点に配置します。これにより、fireball  オブジェクトの内部に複数
のノードが作成されます。 

pyroburstsource  ノードに Display フラグを設定し、Burst Animation 
タブで Start Frame を 200 に設定します。フレーム 200 に移動します。	
このノードは、爆発の最初の爆風です。   

Quick Setups メニューから、Single Input Point を選択します。これによ
り、1 個のポイントが追加されます。このトランスフォームハンドルを使用し
て、ポイントを約 0.3 引き上げ、爆弾のジオメトリの中央に配置します。 

02 pyrosolver_fireball  ノードで、Start Frame を 200 に変更し
ます。Simulation Type を Minimal OpenCL に設定し、GPU 

を使用してシミュレートするようにします。 

Sourcing タブで、Limit Source Range オプションを開き、Frame Range 
を 200, 240 に設定します。Cycle Length をオフにします。 

RENDER_Simple_Fireball  Null ノードに Display フラグを設定します。
ズームアウトしてシーンを広く見えるようにしたら、Play を押して、シミュ
レーションをテストします。ずいぶん大きい火の玉です。さらにズームアウト
して爆発全体を表示します。

03 フレーム 200 に移動します。pyroburstsource  ノードで、
Burst Shape タブに移動して Initial Size を 0.35、Spread 

Angle を 180 に設定します。

次に fireball  の Pyro Solver ノードに移動して Bound タブで Size を 15, 
12, 12、Center を 0, 4, 0 に設定します。ボックスが小さくなり、GPU 上で
効率的にシミュレートできるようになります。Setup タブで、Voxel Size を 
0.035 に設定します。これで、小さくしたシミュレーションにディテールが追
加されます。 

Play を押して、シミュレーションをテストします。爆発がシーンにうまく収ま
るようになりました。

パート 8

PyroFX の爆発の作成
爆弾の爆発には、火の玉が伴います。GPU で動作する Simple Fireball から始め、変更を加えてショットにふさわしいルックを作成します。
また、爆発する爆弾のパーツを組み込んで、PyroFX ボリュームを押したり、作用したり、さらに面白い見た目にすることもできます。 

04 次に、Pyro FX と爆発する爆弾を統合します。File ノードを追加
して、ディスクから $HIP/geo/bomb/exploding_bomb.$F.

bgeo.sc  ジオメトリシーケンスをロードします。このノードを fireball  の 
Pyro Solver ノードの 2 つ目の入力に接続します。 

Play を押して、シミュレーションをテストします。適切に準備されていない
ので、衝突ジオメトリにエフェクトがありません。
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06 unpack  と vdbfrompolygons  の間に、Peak ノードを追加し
て破片を大きくします。Distance を 0.1 に設定します。peak  

ノードと vdbfrompolygons  ノードの間に、Attribute Adjust Vector ノー
ドを追加します。Adjust Value をオフ、Enable Post Process をオンにし
てから、Length Scale をオンにして 2 に設定します。

fireball  ノードに Display フラグを再度設定します。Collision タブか
ら、Limit Collision Range セクションを開き、Range Type を Frame 
Range、Frame Range を 200, 240 に設定します。Cycle Length をオフ
にします。Play を押して、シミュレーションをテストします。爆発する爆弾に
コリジョンが構築され、Pyro FX シミュレーションに影響するようになりまし
た。

07 fireball  の Pyro Solver ノードと pyrolook  ノードの間に、
Pyro Post Process ノードを挿入します。Convert to VDB 

と Convert to 16bit Float チェックボックスをオンにします。次に、Cull 
Volume と Resample Volumes オプションをオンにして、どちらも vel  の
ままにしておきます。  

このノードにより、ボリュームがより効率的になり、ボリュームをキャッシュ
化する際のディスク容量を節約できます。

08 fireball  の Pyro Solver ノードで、Quick Setups をクリック
し、Cache Simulation を選択します。そのノードを横に移動し

て、pyropostprocess  ノードを sim_pyrosolver_fireball File Cache ノード
に接続し、cache ノードを pyrolook  ノードに接続します。Base Folder を 
$HIP/geo/pyrosim/  に設定し、Save to Disk をクリックします。

Load from Disk オプションをオンにしたまま、プレイバーをスクラブして 
PyroFX の爆発を確認します。

05 フレーム 200 に移動します。fireball  ノードを選択します。右上
の Quick Setups メニューから、Setup SDF Collision を選択

します。これにより、vdbfrompolygons  ノードが追加されます。このノー
ドの Voxel Size は Pyro Solver ノードから取得されます。

file  ノードと vdbfrompolygons  ノードの間に RBD Unpack ノードを追加
します。 

rbdunpack  ノードと vdbfrompolygons  ノードの間に Unpack ノード
を追加します。unpack  ノードで、Transfer Velocity を v に設定します。
vdbfrompolygons  ノードに Display フラグを設定し、Play を押して衝突
ジオメトリを表示します。

09 pyrolook  ノードに Display フラグを設定します。これは Pyro 
Bake Volume ノードで、Scene View でシミュレーションを視覚

化するのに使用できます。後でレンダリング時に使用する、Pyro Shader と
インターフェースがよく似ています。

Smoke タブで Smoke Color を暗くして、Scatter タブで Intensity Scale 
を 2500 に設定します。他の調整も行って、シミュレーションが目的のルッ
クになるようにします。
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内部のループ

下部のループ

内部のループ

縦方向の 
分割線の 
ループ

01 オブジェクトレベルに移動して、fireball  オブジェクトを
非表示にします。bomb_geo  をダブルクリックし、2 つ目の 

polybevel  ノードに Display フラグを設定します。これにより、所定の位置
に回転される前の状態の爆弾のジオメトリが表示されます。

Hide Other Objects を設定し、このネットワークのコンテンツに集中でき
るようにします。

02 Select ツールに移動し、3 を押してエッジ選択にします。W を
押してワイヤーフレームモードにしたら、Shift を押しながらダ

ブルクリックして下部のループの部分を選択します。Shift を押しながらダ
ブルクリックして、4 つのすべての領域を選択します。内部ループでも繰り
返します。  

内部の球の上部にあるループに移動し、Shift を押しながらダブルクリック
して選択します。X 軸と平行な横方向の分割線を、Shift を押しながらダブ
ルクリックして選択します。  

Scene View で、Tab > Group を押します。Group Name を uv_edges  に
変更します。 

03 Scene View で、Tab > UV Flatten を押すと、group ノードの後
に uvflatten  ノードが追加されます。Seams を uv_edges  に

設定し、Layout Constraints で Enable Manual Layout をオフにします。
こうすると UV レイアウトがよく見えるため、爆弾のテクスチャリングに好都
合です。

BOMB_OUT  null ノードに Display フラグを設定します。

パート 9

ジオメトリを USD にエクスポート
レンダリング向けにショットをセットアップするには、USD ファイルにジオメトリをエクスポートして、Solaris コンテキストで参照できる
ようにする必要があります。ジオメトリを直接インポートすることもできますが、USD としてキャッシュ化すると、シーケンスを固定して、
Solaris でライティングとレンダリングに集中できます。これらのオブジェクトの一部では、エクスポートする前に UV を追加して、テクスチャ
リングに備えます。

04 チェーンの終端に USD Export ノードを追加します。	
static_bomb  という名前に変更します。次のように設定し

ます。
	� Valid Frame Range を Render Current Frame にする 
	� Output File を $HIP/usd/static_bomb.usd  にする

Save to Disk を押します。
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USD と SOLARIS
このプロジェクトのルックデベロップメントをサポートするために、レイアウト、ルックデブ、ライ
ティングワークフローは Solaris コンテキストでセットアップします。これは、LOP ネットワーク
で表現されます。ここで作成する USD キャッシュを、Solaris コンテキストに取り込みます。 
このシーンファイルを使用して USD キャッシュを LOP ネットワークで参照しますが、より大規模
なパイプラインでは、新しいシーンファイルを開始し、新しいシーンで USD ファイルをインポー
トする方法もあります。こうするとショットのライティングとレンダリングに集中できますが、ジオ
メトリとシミュレーションに戻って微調整するのは難しくなります。

06 attributedelete  ノードの後に、Normal ノードを追加します。
これにより、爆弾のジオメトリが Solaris で適切に表示されるよ

うになります。

チェーンの終端に USD Export ノードを追加します。exploding_bomb  と
いう名前に変更します。次のように設定します。

	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/exploding_bomb.usd  にする 

Save to Disk を押します。

07 オブジェクトレベルに戻り、ground  ネットワークをダブルク
リックします。grid  ノードの後に、UV Project ノードを追加し

て、Display フラグを設定します。Initialize タブに移動して、Initialize ボ
タンを押します。Transformation タブで、Scale X を -1、Scale Y を 1、
Rotate Y を -90 に変更します。

これにより、1 つの大きいテクスチャが作成されるのではなく、テクスチャが
地面で繰り返されるようになります。

08 チェーンの終端に USD Export ノードを追加します。それを 
ground  という名前に変更します。次のように設定します。
	� Valid Frame Range は Render Current Frame のままに
する 
	� Output File を $HIP/usd/ground.usd  にする 

Save to Disk を押します。

05 オブジェクトレベルに戻り、bomb_geo_fracture  ネットワーク
をダブルクリックします。fracture_io  ノードを選択し、Save to 

Disk をクリックして、新しい UV 付きでジオメトリをキャッシュ化します。ジ
オメトリはパック化されているため表示されません。

fracture_io  ノードと EXPLODING_BOMB_OUT  ノードの間に 
Unpack ノードを追加したら、Attribute Delete ノードを追加します。
attributedelete  ノードで、Primitive Attributes を name  に設定します。
Point Attributes セクションをオフにします。

これにより、シーケンスが単一のメッシュとして Solaris に取り込まれます。
name アトリビュートはシーケンスを個々のパーツに分割します。
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Scene Import
ジオメトリとシミュレーションを Solaris に取り込むもう 1 つの方法は、Scene 
Import LOP を使用することです。これにより、作業しているジオメトリおよびオブ
ジェクトと、LOP ネットワークの間に、直接的なつながりができます。この方法では、
モーションブラーをサポートする Cache LOP が必要になります。この追加のノード
は、USD ファイルを参照する場合には必要ありません。 
このツールは、アニメーションカメラをオブジェクトレベルから Solaris コンテキス
トに取り込むのに使用します。

10 オブジェクトレベルに戻り、soot  ネットワークをダブルクリック
します。チェーンの終端に USD Export ノードを追加します。	

それを soot_trail  という名前に変更します。次のように設定します。
	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/soot_trail.usd  にする 

Save to Disk を押します。

11 オブジェクトレベルに戻り、sparks  ネットワークをダブルクリッ
クします。  

チェーンの終端に Attribute Create ノードを追加します。Name を 
width、Value を 0.0005 に設定します。これにより、レンダリングされる
火花のルックが決まります。

チェーンの終端に USD Export ノードを追加します。それを sparks  という
名前に変更します。次のように設定します。

	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/sparks.usd  にする 

Save to Disk を押します。

12 オブジェクトレベルに戻り、fireball  ネットワークをダブルクリッ
クします。sim_fireball  ノードから、USD Export ノードを分岐

させます。pyrolook  ノードをバイパスしてください。それを pyro_fireball  
という名前に変更します。次のように設定します。

	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/pyro_fireball.usd  にする 

Save to Disk を押します。

09 オブジェクトレベルに戻り、fuse  ネットワークをダブルクリック
します。チェーンの終端に USD Export ノードを追加します。	

それを fuse  という名前に変更します。次のように設定します。
	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/fuse.usd  にする 

Save to Disk を押します。
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01 オブジェクトレベルに戻ります。Tab > LOP Network を押して、
ショットをセットアップするのに使用するサブネットワークを作成

します。名前を destruction_stage  にします。そのノードをダブルクリック
して、中に入ります。

デスクトップを Solaris に変更します。Scene View のパスバーに obj > 
destruction_stage  が表示されていることを確認します。Scene View で 	
D を押して、Background タブで Color Scheme を Dark に設定します。

ネットワークビューで Tab > Reference を選択し、クリックして reference  
ノードを追加します。Reference File の横にある File Chooser をクリック
し、static_bomb.usd  ファイルを指定します。ノードを static_bomb  とい
う名前に変更します。Primitive Path を /geo/$OS  に設定します。

02 このノードを Alt ドラッグしてコピーを 3 つ作成します。それら
に exploding_bomb、ground、fuse  という名前を付け、File 

Chooser パラメータをこれらの USD ファイルに設定します。 

Merge ノードを追加してこれらを接続し、Display フラグを設定します。
static_bomb  ノードの後に、Prune LOP を追加します。Prune パラメータ
を $F >200  に設定します。expoding_bomb  ノードの後に、Prune LOP 
をもう 1 つ追加します。Prune パラメータを $F <199  に設定します。これ
で、プレイバーをスクラブすると、フレーム 200 で静的な爆弾と爆発する爆
弾が切り替わります。 

03 Tab > Scene Import (Cameras) を押します。このノードを
配置して、merge  ノードに接続します。Destination Path を 

/cam/  に設定します。これにより、オブジェクトレベルの任意のカメラを 
Solaris コンテキストに追加できます。 

カメラメニューに移動して、cam1  を選択し、このアニメーションカメラ越し
に見るようにします。merge ノードが選択されていることを確認します。プ
レイバーをスクラブし、オブジェクトレベルでセットアップしたカメラのレン
ズを通して、導火線と爆弾がアニメートされ、爆弾が爆発することを確認し
ます。このカメラに変更を加えた場合は、ここ Solaris で反映されます。

パート 10

Solaris でのショットのセットアップ
すべての USD ファイルを Solaris で参照して、オブジェクトレベルからカメラをインポートする方法を学びます。マテリアルをすべての 
要素に適用し、Karma を使用してレンダリングを開始して、結果を評価します。また、キーライトとレンダリング設定を準備して、 
ショットの最終ルックを探求します。

04 ネットワークビューで Tab > Reference を選択し、クリックし
て reference  ノードを追加します。Reference File の横にあ

る File Chooser をクリックし、sparks.usd  ファイルを指定します。ノード
を sparks  という名前に変更します。Primitive Path を /fx/$OS  に設定し
ます。

このノードを Alt ドラッグしてコピーを作成します。soot という名前を付け
たら、File Chooser をクリックして soot_trail.usd  ファイルを指定します。
Merge ノードを追加してこれらのファイルをまとめたら、それをメインの 
Merge ノードに接続し、Display フラグを設定します。スクラブすると、	
火花が見え、火花が消えた後にすすが残るのが分かります。USD ファイルは
フレーム 240 までパーティクルを維持します。 
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06 merge  ノードの後に Material Library ノードを追加しま
す。Material Palette に移動して、Principled Shader と 

Concrete Shader を /stage/materiallibrary  にドラッグします。 

ネットワークビューに移動して、Principled Shader の名前を bomb_mat  
に変更します。Alt ドラッグ して Principled Shader のコピーを 3 つ作成し、
fuse_mat、sparks_mat、soot_mat  という名前にします。 

07 1 つ上のレベルに戻り、チェーンの終端に Assign Material 
ノードを追加します。シーングラフから、static_bomb  と 

exploding_bomb  を Primitives フィールドにドラッグします。 

Material Path の横の矢印をクリックして、bomb_mat  を選択します。
+（プラス）記号を押してセクションを追加し、この手順を繰り返して fuse、
sparks、soot  にマテリアルを割り当てます。 

concreteマテリアルを ground  に割り当てます。

08 フレーム 180 あたりに移動します。LOP Lights and Cameras 
シェルフの Light ツールをクリックします。ショットにライトが	

追加され、ライト越しに見えるようになります。 

Base Properties タブに移動し、Intensity を 50 に設定します。

Scene View で、Shadow ボタンをクリックします。爆弾のサーフェスで	
クリックしたら、その背後を Shift クリックしてシャドウを作成します。

09 Scene view で、Persp メニューから Karma を選択します。
Reference Plane をオフにします。  

Material Palette に戻り、concrete  シェーダを選択します。
Texture セクションで、Effect Scale を 0.005 に設定します。

サイドバーで Denoiser をオンにします。グラフィックスカード
（nVidia カードのみ）を使用して、レンダリング時に、ノイズが	
素早く解決されるようになります。 

05 エフェクト merge  ノードの後に、Prune LOP を追加します。
Display フラグを設定します。Prune パラメータを $F >199 に

設定します。これで、この時点ですすと火花が消えるようになります。
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レンダリング設定
Karma Render Settings ノードで、シーングラフの一部となるレンダリング 
設定が追加されます。このノードは、ビューポートやディスクにレンダリングする
のに使用されます。
これらの設定を追加する前、ビューポートでのレンダリングにはビューポート 
設定が使用されていました。Scene View で Karma レンダリングをセットアップ
してある場合は、D を押すとこれらの設定が表示されます。シーングラフにレン
ダリング設定がある場合は、ビューポート設定が上書きされます。 

11 fuse_mat  と soot_mat  シェーダで、Base Color をダークグ
レーに設定します。 

fuse_mat  シェーダで、Use Point Color をオフにして、Base Color でルッ
クを制御できるようにします。 

10 bomb_mat  シェーダを選択します。Surface で次のように設定
します。
	� Base Color を黒色 (0, 0, 0) にする
	� Roughness を 0.7 にする

Displacement で、Enable Noise Displacement をオンにし、次のよう
に設定します。

	� Noise Type を Alligator Noise にする
	� Frequency を 30, 30, 30 にする
	� Amplitude を 0.01 にする
	� Roughness を 0.8 にする

12 sparks_mat  シェーダを選択し、Emission で次のように設定し
ます。
	� Emission Color を 1, 1, 1 ( 白 ) にする
	� Emission Intensity を 10 にする
	� Use Point Color をオンにする

これで火花がより明るく光り、地面も少し照明されるようになります。

13 ステージレベルに戻ります。ネットワークビューで、Tab > 
Karma を押し、Karma Render Settings と USD Render 

ROP ノードを追加します。それらをチェーンの終端に接続します。
karmarendersettings  ノードを選択し、Primary Samples を 32 に設
定します。Image Output > Filters タブで、Denoiser を nVidia Optix 
Denoiser に設定してデノイザをオンに戻します。

Advanced タブで、Sampling セクションに移動し、Convergence Mode 
を Path Traced に設定します。
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01 Persp ビューメニューを Houdini GL に再度設定します。
ネットワークビューで Tab > Reference を選択し、クリック

して Reference  ノードを追加します。Reference File の横にある File 
Chooser をクリックし、pyrofx_fireball.usd  ファイルを指定します。ノー
ドを fireball  という名前に変更します。Primitive Path を /fx/$OS  に設定
します。

このノードを元の merge  ノードに接続します。接続されたワイヤーを Alt ク
リックしてドットを追加し、そのドットを右下に移動します。Karma  ノードの 
Display フラグをオンにしたまま、フレーム 204 あたりにスクラブして爆発
を確認します。

02 オブジェクトレベルに移動して、fireball  オブジェクトに戻りま
す。pyrosolver_fireball  ノードを選択します。Quick Setups 

メニューから、Create Render Stage を選択します。これにより、このネッ
トワークに lopnet_fireball  が追加されます。その中に入り、推奨される
セットアップを確認します。これを単独で使用して火の玉をレンダリングする
こともできますが、既存の LOP ネットワークの一部としてこのセットアップ
を使用する必要があります。

rendergeometrysettings  ノードを選択し、Ctrl + C を押してコピーし
ます。

03 destruction_stage  LOP ネットワークに戻り、Ctrl + V を押し
てネットワークにペーストします。それを fireball  reference ノー

ドのすぐ下に接続します。 

このノードは 2 つのことを行います。1 つ目は火の玉で Velocity モーション
ブラーをセットアップすることで、2 つ目はボリュームを使用してショットの
照明をサポートすることです。

パート 11

PyroFX のレンダリング
ショットを完成させるには、火の玉の USD ファイルを追加して、適切なマテリアルを割り当てる必要があります。次に、もう 1 つカメラ
をセットアップして爆発の広角ショットを作成したら、2 つのシーケンスをレンダリングして最終的なシーケンスに仕上げます。その後、
Mplay 画像ビューアを使用して結果をプレビューします。 

04 materiallibrary  ノードを選択し、Number of Materials 
の横にある +（プラス）記号をクリックします。新しいリスト

の Material VOP の横にある Operator Chooser ボタンをクリックし
て、fireball  オブジェクト、lopnet_fireball、matnet  と移動していき、
Pyro_Shader を選択します。Accept をクリックします。

このマテリアルは異なる LOP ネットワーク内にありますが、その位置からこ
の materiallibrary  ノードに参照することができます。  
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05 assignmaterial  ノードで、マテリアルリストをもう 1 つ追加しま
す。シーングラフから /fx/fireball  を Primitives セクションに

ドラッグして、Material Path の矢印をクリックし、Pyro_Shader を選択し
ます。

Persp ビューメニューを Karma に再度設定します。 

06 ネットワークに Prune ノードを追加し、
rendergeometrysettings  ノードの下に接続します。Pruning 

Options で、Prune を $F<201 に設定します。 

フレーム 200 で火の玉が爆弾のジオメトリから出ていましたが、これにより
爆発が 1 フレーム後ろにずれます。

07 Karma ノードで、Valid Frame Range を Render Frame 
Range に設定します。240 に設定されている End 値を RMB ク

リックし、Delete Channels を選択します。End 値を 210 に変更します。

最初の 210 フレームはアニメーションカメラを使用し、最後の 30 フレーム
は別のカメラに切り替えます。

08 Persp ビューメニューを Houdini GL に戻します。ネットワーク
ビューで、karmarendersettings  と usdrender_rop  ノード

を右側に Alt ドラッグします。Display フラグを設定します。

09 Scene View でタンブルし、爆発を上から見下ろす新しいカメラ
アングルにします。LOP Lights and Cameras シェルフで Ctrl 

キーを押しながら Camera ツールをクリックします。 

Primitive Path を /cam/$OS  に設定し、名前 を cam2  にします。 
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まとめ
パーティクル、リジッドボディダイナミクス、Pyro FX を
使用して破壊ショットを作成しました。ゼロからすべ
てのプロジェクトを作成し、Houdini アーティスト
が日常的に使用するさまざまなツールやテクニッ
クを体験しました。 
また、作業内容を Solaris に取り込んで、 
USD を使用してシーングラフをセットアップ
し、Karma でレンダリングしました。 
これらのスキルを活用して、皆さん自身の 
破壊 FX ショットを探求してみてください。 

11 cam2  ノードを karmarendersettings2  ノードの上に移動しま
す。usdrender_rop2  ノードで、Start と End を 211 と 240 に

変更し、Camera を /cameras/cam2  にします。

1 つ目の karmarendersettings  ノードを選択し、Camera が /cam/
cam1  に設定されていることを確認します。そうでない場合、デフォルトの 
camera1  はシーン内にないので、ノードはレンダリングしません。

両方の karmarendersettings  ノードを選択し、Output Picture を $HIP/
render/bomb/destruction_fx_$F2.exr  に変更します。

10 Lock Camera to View をオンにし、ビューポイントを微調整し
て目的のショットにします。210 と 240 の間のさまざまなポイン

トを確認して、準備ができたら Lock Camera to View オプションをオフに
します。

12 usdrender_rop1  ノードを選択します。Render to Disk ボタン
をクリックします。usdrender_rop2 でも繰り返します。

Render メニューに移動し、MPlay > Load Desk Files を選択します。
render/bomb  ディレクトリに移動し、画像シーケンスを選択して、Load 
をクリックします。これにより、1 つのアニメーションとして画像が再生され
ます。
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	  		  133

HOUDINI FOUNDATIONS

地形の生成
Houdini には、地形を生成したり、形状変更するための専用のツールセットが備わっています。これらのツールは、
Height Field と呼ばれる 2D ボリュームを使って地形を表現します。このボリュームの各ボクセルには、そのグリッ
ドポイントでの地形の高さが含まれています。Houdini のビューポートでは、2D Height Field を 3D サーフェスと
して視覚化できます。また、Mask Field をセットアップして、地形の特定の部分に編集を集中させることもできます。
このレッスンでは、パターン、ノイズ、侵食を使用して地形を構築し、その結果をゲームエンジンで使用できるよう
にエクスポートします。

レッスンの目標
Houdini の Height Field ツール を使用して地形を作成し、Unreal Engine または Unity に取り込みます。 

学習内容
	� Height Field を使用して地形を作成する方法
	� パターン、ノイズ、歪みを追加する方法
	� 地形の特徴に基づいてマスクを作成する方法 
	� Height Field にポイントをばら撒く方法 
	� Terrain Scattering を使用してインスタンス化をセットアップする方法
	� 地形をデジタルアセット（HDA）としてエクスポートする方法
	� HDA を Unreal Engine にインポートする方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✔

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

ドキュメントバージョン 4.0.1J | 2023 年 8 月
© SideFX Software



パート 1

Height Field による地形の形状変更
Houdini で地形を作成するには、Height Field を使用します。空の Height Field から始め、ノイズと歪みを加えて、 
景観の基本的なルックを定義します。ノード上でパラメータ値を微調整しながら、ディテールを重ねていきます。 

01 デスクトップのセレクタで、Terrain を選択します。地形に特化
したシェルフツールと Radial メニューが表示されます。ディス

プレイオプションの一番上にある Reference Plane ボタンをオフにしたら、
ビューポートで D を押し、Background タブの Color Scheme を Dark に
設定します。 

File > New Project を選択します。Project Name を terrain_lesson  
に設定し、Accept を押します。File > Save As... を選択すると、新しい 
terrain_lesson  ディレクトリが表示されます。表示されない場合は、サイド
バーの $JOB をクリックすると、そのディレクトリが表示されるはずです。	
ファイル名を terrain_01.hip  に設定し、Accept をクリックして保存します。 

02 Terrain ツールシェルフで、Height Field ツールをクリックし
ます。Enter を押して原点に配置します。スペースバー + H を

押し、Height Field 全体を表示します。 

これにより、1000 x 1000、グリッド間隔 2 のグリッドが定義されます。

03 メインの Radial メニュー（ホットキー C）を使用して、Deform > 
Noise を選択します。次のように設定します。
	� Noise Type を Worley Cellular F1 にする
	� Amplitude を 360 にする
	� Offset を 20, 0, 300 にする

地形は、このようなノイズから始めるのがお勧めです。

メインの Radial メニューを使用して、Deform > Blur を選択し、
Heightfield Blur ツールにアクセスします。Radius を 20 に設定します。
エッジがソフトになり、風化作用の影響が示されます。

04 Radial メニューを使用して Deform > Distort を選択します。
次のように設定します。
	� Amplitude を 40 にする
	� Element Size を 220 にする

このノードは、ノイズフィールドを通して既存の値を移流させ、それらを動か
します。ここで提案されたパラメータ値をそのまま使用しても、独自に試し
て好みのルック（外観）にしてもかまいません。 

Houdini のプロシージャルアプローチなら、後で戻ってパラメータ値を変更
し、設定によって結果がどう変化するかを確認することができます。
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05 Radial メニューを使用して Deform > Noise を選択します。	
次のように設定します。 
	� Amplitude を 10 にする
	� Element Size を 20 にする

ネットワークビューで最後の 4 個のノードを選択したら、Network box ア
イコンをクリックしてネットワークボックスを追加します。エッジを調整して
ボックスの形状を整えたら、上部のバーをクリックして Shape the Terrain  
と名前を付けます。

ネットワークボックスは、ネットワークを読みやすくするため、他のアーティ
ストとファイルを共有する場合に特に便利です。

06 Radial メニューを使用して Mask > Mask by Feature を選択
します。次のように設定します。
	� Min Slope Angle を 35 にする
	� Max Slope Angle を約 60 にする

これで、山の側面の領域に集中できるようになります。 

このノードに送られる地形の形状を後から変更したら、それに応じてマスク
も更新されます。 

07 Radial メニューで Erode > Slump を選択します。Spread 
Iterations を 75 に設定します。 

heightfield_slump  ノードが作成するのは、不安定に重なった岩片が、	
安定した状態に移行しようとする際に起こる崩壊による浸食です。マスクレ
イヤーに影響を与え、Flow および Flow Direction レイヤーを出力します。

このノードを MMB クリックすると、どのレイヤーが作成されているかを	
確認できます。比較するには、チェーンの前のノードを MMB クリックし
ます。

08 Terrain ツールシェルフで、Heightfield Remap ツールを選択
します。Layer to Remap を Flow に設定したら、Compute 

Range ボタンをクリックします。Output Max を 1 に設定して、これらの値
を正規化します。Radial メニューを使用して Mask > Clear Mask を選択し
ます。マスクレイヤーがクリアされ、セットアップにより多くのレイヤーを作
成できるようになります。 

ネットワークビューで最後の 4 個のノードを選択したら、Network box ア
イコンをクリックしてネットワークボックスを追加します。エッジを調整して
ボックスの形状を整えたら、上部のバーをクリックして Create Flow Mask  
と名前を付けます。作業内容を保存します。

HEIGHT LAYER
ジオメトリネットワークに渡すデータには、複数の Height Field を含めることができます。
Houdini の Terrain ツールの用語では、これらのデータのことを Height Layer と呼びます。 
例えば、ツールが 1 つの Height Layer で岩盤を表現し、別の Height Layer でその岩盤に重
なった緩い土壌を表現することができます。デフォルトの Height Layer の名前は height です。
各ボクセルには、マスクレイヤーと呼ばれる「選択性」の値が含まれています。ほとんどの 
Terrain ノードは、2 番目の入力でマスクレイヤーを受け取り、マスクによってそのノードが 
修正する地形の部分を制御することができます。デフォルトのマスクレイヤーの名前は  
mask で、3D サーフェス上に赤く表示されます。
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パート 2

マスクレイヤーの追加と視覚化
地形にレイヤーをセットアップするには、まずマスクを設定し、その情報を特定のレイヤーにコピーします。 
この操作を何回か行うことで、さらにレイヤーを追加できます。その後これらのレイヤーを使用して、 
地形の重要な特徴を視覚化します。 

01 Radial メニューで Mask > Mask by Feature を選択します。
Mask by Slope で次のように設定します。 
	� Min Slope Angle を 0 にする
	� Max Slope Angle を約 45 にする 

Mask By Direction をオンにして、次のように設定します。
	� Goal Angle を約 136 にする
	� Angle Spread を 180 にする 

この設定は、谷を含む広い範囲の地形をカバーします。

02 Radial メニューで Layer > Copy Layer を選択します。Source 
を Mask のままにして、Destination を slope  に設定します。

マスクを新しいレイヤーにコピーすることで、マスクをクリアして他のタスク
に使えるようになります。

Radial メニューで Mask > Clear Mask を選択します。マスクレイヤーが
再度クリアされ、セットアップにより多くのレイヤーを作成できるようにな
ります。ネットワークボックスを追加してノードを整理し、そのボックスに 
Create Slope Mask  と名前を付けます。

03 メインの Radial メニューを使用して Mask > Mask by Feature 
を選択します。Mask by Slope で次のように設定します。
	� Min Slope Angle を 0 にする
	� Max Slope Angle を約 70 にする

Mask By Curvature をオンにして、次のように設定します。
	� Max Curvature を 0.5 にする 

Curvature Ramp のポイントを中心に向かって動かし、地形のピークを見
つけます。これで非常に細かいマスクができるので、景観の主な特徴すべて
のピークを特定できます。

04 Radial メニューで Layer > Copy Layer を選択します。Source 
を Mask のままにして、Destination を peaks  に設定します。

次に、Mask > Clear Mask を選択します。再度マスクレイヤーをクリアし
ます。 

これで、マスクから 3 つのレイヤーができました。ネットワークボックスを追
加してノードを整理し、ボックスに Create Peak Mask  と名前を付けます。

次の手順では、これらを使用して地形を視覚化します。
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Height Field の視覚化
Height Field の視覚化は、地形全体の高さに割り当てられたランプから始め
ます。まず、ランプが相当する範囲を計算し、その後ランプでカラーを調整して、
景観を視覚化します。
その後、ランプ上の各種レイヤーに色を追加します。これで、よりリッチな 
ルックのシーンにできます。

08 Height Ramp で、2 つを除くすべてのマーカーを選択して	
削除します。右側のマーカーを黒、左側のマーカーをダークグ

レーに設定します。これにより、雪のレイヤーの下に暗いルックが作成され、
暗い領域が視覚的に目立って見えるようになります。 

作業内容を保存します。

05 Radial メニューで Visualize > Heightfield Visualize を選択
します。Compute Range ボタンをクリックして、ビジュアライ

ゼーションを現在の Height Field の範囲に揃えます。  

これにより、地形の最下部から最上部までの傾斜のビジュアライザが設定
されます。3D ビューで傾斜がどのように見えるかを確認することができ、山
の頂上は白でハイライトされます。 

06 ランプウィジェットで、次のように設定します。	� Layer 1 を peaks  にする
	� Layer 2 を slope  にする
	� Layer 3 を flow  にする

マスクを使って作成した 3 つのレイヤーを使用して、3D ビューにデフォルト
のカラーが表示されます。これらを使って地形のルックを定義していきます。 

07 これら 3 つのレイヤーすべてを白（1, 1, 1）に設定します。すると
雪で覆われたようなルックになります。これらのレイヤーを使っ

てさまざまな特徴を表現できますが、この山は、雪のルックを強調します。
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パート 3

地形の再マップと浸食
現在、高さマップには 0 より下の領域と、0 以上の領域があります。Remap ノードを使用して範囲を変更してから、 
そのノードのランプを使用して山の周りに細長い台地を追加します。その後、浸食させて、地形に新しいレイヤーを追加します。  

01 Shape by Terrain ネットワークボックスの最後にある Heightfield Noise ノードを見つけます。Display フラグをオン
にし、クリックしてこのノードを選択します。  

Terrain ツールシェルフで、Height Remap ツールをクリックします。
Compute Range ボタンをクリックします。高さを再構成するために、次の
ように設定します。

	� Output Min を 0 にする
	� Output Max を 300 にする

02 Remap ランプを使用して、中央にポイントを追加したら、さら
に次のようにポイントを追加して調整します。
	� Point 2 を追加し、Position を 0.25、Value を 0.25 に設定
する 
	� Point 3 を追加し、Position を 0.4、Value を 0.27 に設定
する

これで、山の基部に沿って細長い台地が作成されます。  

03 Erode > Erode を選択します。Visualization タブをクリック
し、Compute Range ボタンをクリックします。Play を押して、

地形の浸食を確認します。フレーム 15 あたりで Stop を押します。

04 Display フラグをチェーンの最後にある Heightfield 
Visualization ノードに戻します。Erode ノードに由来するレイ

ヤーである Layer 3 を water  に設定し、カラーを青に変更します。これに
より、ビジュアライゼーションでこれらの領域がはっきり見えるようになり
ます。  
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パート 4

地形にポイントをばら撒く
木と岩を追加するには、新しい台地の領域をマスクしてから、このマスクを使用する地形へのばら撒きをセットアップします。 
これらのばら撒かれたポイントは、木を表す、インスタンス化された円錐をコピーするのに使用されます。 
これらは後ほど Unreal で置き換えます。  

01 Radial メニューを使用して Mask > Mask by Feature を選択
します。次のように設定します。
	� Min Slope Angle を 0 にする
	� Max Slope Angle を 50 にする

Mask by Height をオンにして、次のように設定します。
	� Min Height を 70 にする
	� Max Height を 85 にする 

これにより、Remap  ノードで作成した細長い台地がハイライトされます。	
ハイライトされない場合は、マスクでこの領域が分離されるまで、これらの
値を調整してください。

02 ネットワークエディタで、maskbyfeature  ノードの出力を RMB 
クリックし、scatter... と入力していきます。 

Heightfield Scatter を配置して、その Display フラグをオンにします。
maskbyfeature  ノードの出力を scatter  ノードの 2 番目の入力に接続し
て、入力マスクで定義した領域にポイントを制限します。

Coverage を 0.05 に設定します。Keep Incoming Terrain オプションを
オフにします。 

03 ネットワークエディタで、Tab を押して Copy to Points と入
力していき、クリックしてそのノードを追加します。Pack and 

Instance チェックボックスをクリックしてオンにします。Heightfield 
Scatter を Copy の 2 番目の入力に接続して、Display フラグを設定します。

ネットワークエディタで、tube ノードを追加し、copytopoints  ノードの 
1 番目の入力に接続します。次のように設定します。 

	� Radius を 0, 2 に、Radius Scale を 1 にする
	� Height を 10 に、Center を 0, 5, 0 にする 

tube  の後に color ノードを追加して、木を緑にします。Merge ノードを	
追加して、それに Heightfield Visualize  と copytopoints を接続します。  

04 heightfield_scatter  ノードに戻り、Match Normals with 
Terrain と Match Direction with Slope をオフにします。	

これで、すべての木が上を向くようになります。 

ここで Random Up を 10 に変更して向きに変化を付け、Randomize 
Yaw を 20 に設定します。この効果は分かりにくいですが、後で木を置き換
えると、ランダムに回転しているのが確認できます。

木のスケールは Variability でコントロールします。Range を 1, 2 に変更
して、これら 2 つの値の間でランダムにスケールするようにします。
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パート 5

Unreal で地形を開く
Unreal Engine または Unity のようなゲームエンジンに地形を取り込むには、まず Houdini デジタルアセットを作成します。 
Houdini Engine プラグインを適切にセットアップしたら、このアセットをゲームエディタにロードして、コピーした木のスタンドインを 
インスタンス化されたオブジェクトとしてインポートすることができます。地形を Unreal Engine にインポートすると、Height Field は 
ランドスケープとして認識されます。Houdini Engine プラグインを使用して、Unity にアセットをインポートすることもできます。

01 ネットワークエディタですべてのノードを選択します。Create Subnet from Selected ボタンをクリックします。新しいサブ
ネットを RMB クリックして、Digital Asset > Create New を選択します。 

Type Name を terrain  に設定し、Branch と Version をオフにします。
Library Path を HIP File Directory に、Library Filename を Node 
Name  に設定します。 

Create をクリックします。Edit Type Properties ウィンドウが開きます。
Accept をクリックして、このウィンドウを閉じます。

02 Unreal Engine を起動したら、メインパネルで New Project タ
ブをクリックして、Third Person テンプレートを選択します。

Create Project をクリックします。開いたら、地形を妨げないようデフォル
トのジオメトリを削除します。

Content Browser で、Import to Game をクリックして terrain.hda  アセッ
トファイルを見つけます。そのアセットを Content Browser から 3D ワー
クスペースにドラッグします。ThirdPersonCharacter の Translate Z を
約 10,000 に設定したら、Play を押して地形の周りを歩きます。  

03 Houdini Instanced Inputs セクションに移動して、
terrain1_1  を展開します。この円錐のインスタンスを、Unreal 

内のコンテンツで置き換えます。

Content Browser で、StarterContent > Props を開きます。SM_Bush  プ
ロップを Houdini Instanced Input 上にドラッグします。Scale Offset を 
5, 5, 5 に設定します。ジオメトリがポイントにインスタンス化され、円錐のよ
うにランダムにスケールおよび回転されます。 

アウトライナ―で、terrain 下の Landscape ノードを選択します。
Landscape マテリアルの横にあるメニューをクリックして、草のマテリアル
を見つけます。Play を押して、地形を確認します。

まとめ
地形レイヤーを使用してテクスチャマップを作成し、それを使って景観のルックを定
義することもできます。これを行うには、Heightfield Output ノードを使用します。
これらのチャンネルを使用して、景観の特徴を参照したマテリアルを Unreal Engine 
で構築できます。
Houdini の地形の機能について、概要を把握しておくことをお勧めします。 
ゲーム用に景観を作成し、岩や木などのディテールを追加する際の可能性が大きく
広がります。
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CHARACTER FOUNDATIONS 

KINEFX リギング | FUR DUDE 
このレッスンでは、2 足歩行キャラクタ、ファー・デュード（Fur Dude）のリギングとアニメーションを行い、その後
ファーを追加します。既存のジオメトリから始め、スケルトンを描画し、ジオメトリをキャプチャしてから、アニメー
ションリグのリグコントロールを構築します。その後、歩行サイクルのキーフレームを設定し、サーフェスにファー
を追加します。

このレッスンでは、Houdini の新しい SOP ベースのプロシージャルリギングツール KineFX を使用します。主にリ
ターゲットワークフローに使用するツールですが、キャラクタやクリーチャのリギングに使えるツールも含まれてい
ます。ただし、ツールはどれも発展の過程にあります。このレッスンで体験していただくのは、現時点で可能なこと
です。今後のリリースで、KineFX やアニメーションのワークフローはさらに拡張され、洗練されていく予定です。 

レッスンの目標
クリーチャ「ファー・デュード」のリギングとアニメーション、 
ファーの追加を行います。

学習内容
	� KineFX ジョイントを使用してスケルトンを作成する方法
	� 変形およびリジッドジオメトリをスケルトンにキャプチャする方法
	� キャプチャリグをデジタルアセットにラップする方法
	� コントロールを追加して、アニメーションリグを構築する方法
	� 歩行サイクルをアニメートする方法
	� クリーチャにファーを追加する方法
	� Solaris と Karma を使用してレンダリングする方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✔

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

ドキュメントバージョン 4.0.1J | 2023 年 8 月
© SideFX Software



プロジェクトファイル
SideFX.com のファー・デュードのチュートリ
アルページ（このドキュメントを入手した場所
です）から、furdude_lesson_start  ディレク
トリをダウンロードします。名前を furdude_
lesson  に変更し、Houdini Projects ディレ
クトリに配置してください。  

パート 1

スケルトンの描画
シーンファイルを開き、ファー・デュードのジオメトリを確認してから、 
Skeleton ツールを使用してジョイントを配置します。このツールは、ジョイントを
作成して名前を付けたり、アニメートしたいキャラクタに合わせて調整するために
使えます。 

01 File > Set Project を選択します。先ほどダウンロードした 
furdude_lesson  ディレクトリに移動し、Accept を押します。	

これにより、先ほどコピーしたプロジェクトディレクトリとそのサブフォルダ
に、このショットに関連するファイルがすべて配置されるようになります。 

File > Open を選択すると、新しい furdude_lesson  ディレクトリが表
示されます。furdude_start.hip  という名前のファイルを開きましょう。
File Save As... を選択し、furdude_01.hip  にファイル名を変更します。
Accept をクリックして保存します。こうしておくと、後でもう一度レッスンを
やりたくなったときに、手つかずのスタートファイルに戻れます。

02 シーンを開くと、fur_dude_rig  という名前のオブジェクトが 	
1 つ表示されます。これから、KineFX ツールセットを使用して	

作成したボーンに、このジオメトリをキャプチャしていきます。 

ノードをダブルクリックして、ジオメトリレベルに入ります。このレッスンプ
ロジェクトでは、ディスクから fur_dude_geo.bgeo  ファイルをインポート
している File ノードを確認できます。

このジオメトリには、プリミティブカラーやグループなどの情報が保存され
ています。情報を確認するには、ノードを MMB クリックして、リストされた
アトリビュートやグループを表示します。これらのグループは、後でジオメト
リをキャプチャする際に使用します。

03 Scene View にカーソルを移動し、スペースバー + B を押して 	
4 画面ビューにします。右上のアイコンから、Link Ortho 

Views をオンにします。こうすると、Top、Front、Right のビューをすべて	
同時にパン、ズームできるようになります。

Right  ビューにカーソルを移動し、再度スペースバー + B を押します。	
ジョイントの描画には、このビューがやりやすいはずです。

04 ネットワークビューで Tab > Skeleton を選択し、File ノードの
横に新しいノードを配置します。そのノードに Display フラグを

設定します。File ノードに Template フラグを設定して、skeleton ノードの
作業時に、ジオメトリがグレーのワイヤーフレームとして表示されるように
します。

Handle ツールが選択されていることを確認します。上部のバーで、Joint 
Placement を Freehand に設定します。こうすると、ジオメトリとは関係
なく、コンストラクション平面での描画が可能になります。脚のすぐ上に最初
のジョイントを配置したら、図のように、上方向に 6 つのジョイントを配置し
ます。

MMB クリックして、ジョイントの描画を終了します。ここから開始
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05 上部のバーで、Mode を Modify に設定します。これで、ジョイ
ントを編集できるようになります。最初のジョイントをクリックし

て、上部のバーで Name を COG  に設定します。 

パラメータエディタのタブ領域で、+（プラス）記号をクリックします。New 
Pane Tab Type > Animation > Rig Tree と選択します。すると、スケルト
ンジョイントを表示したペインが表示されます。2 つ目のジョイントをダブル
クリックして、spine1  と名前を付けます。Scene View または Rig Tree を
使用して、残りのジョイントに図のように名前を付けます。

06 上部のバーで、Mode を Create に戻します。デフォルトで
は、選択したジョイントの端から描画を始めることになります。

MMB クリックして、その動作を停止します。Right ビューで COG  ジョイント
をクリックし、その下に pelvis  ジョイントを描画します。

Scene View で、スペースバー + B を押して 4 面ビューに戻ります。Front 
ビューで、キャラクタの左側に hip  ジョイントを描画します。 

07 Right ビューに戻り、脚の最後の 4 つのジョイントを図のように描画します。

Modify モードに戻し、Rig Tree を使用してジョイントの名前を変更します。
または、ジョイントを選択し、上部のバーで名前を変更することもできます。
pelvis  の後、すべてのジョイントに「l_」の接頭辞を付けるのは、これらの
ジョイントを左脚に使用するためです。

08 Scene View で、Tab > Skeleton Mirror を選択します。このコ
マンドは、すべてのジョイントのミラーコピーを作成します。パラ

メータエディタに移動して、Group の横の矢印をクリックします。脚のジョ
イントのみを選択し、Enter を押します。脚のみがミラー化されました。

Naming で、Find Tokens を l_、Replace Tokens を r_  に設定します。	
これで、右脚のジョイントに適切な名前（接頭辞 r_）が付けられます。

File > Save を選択して、ここまでの作業を保存します。

COG

spine1

spine2

spine3

neck1

neck2

head

COG

pelvis

l_hip

l_toe

l_knee

l_ankle

l_ball

l_hip
pelvis

KINEFX とオブジェクトレベルのリギング
Houdini の KineFX ツールは、ジオメトリ（SOP）レベルでのジョイントベースの
ワークフローを提供します。Houdini の他のキャラクタワークフローはボーン
ベースで、この場合、作業は主にオブジェクト（OBJ）レベルで行うことになります。
KineFX ワークフローでは、ジョイントは基本的にカーブ上のポイントにすぎま
せん。このように扱うことで、SOP レベルのツールでリグを操作する可能性が大
きく開けました。ここでは、キャラクタやクリーチャのリギング専用に設計された
ツールについて学習します。   

オブジェクト
レベル
3 ボーン

ジオメトリ 
レベル
4 ジョイント
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パート 2

ジオメトリのキャプチャ
キャラクタのリギングには、ジオメトリをスケルトンジョイントにキャプチャする操作が含まれます。このようにすることではじめて、 
ジョイントの回転によってジオメトリが変形したり曲がるようになります。Houdini は、最初のキャプチャで素晴らしい結果を得られる 
Biharmonic（重調和）キャプチャ手法を使用しており、リグをすぐにテストできます。その後、キャプチャウェイトをペイントして結果を 
微調整し、キャラクタを動かせるようにします。  

01 スペースバー + B を使用して、Scene View をパースビューに変
更します。ネットワークビューを少し大きくして、作業スペースを

確保します。 

ネットワークビューで Tab > Joint Capture Biharmonic を選択し、	
このノードを skeleton ノードの下に配置します。fur_dude_geo  を 
jointcapturebiharmonic  ノードの 1 つ目の入力に接続します。
skeletonmirror  ノードを jointcapturebiharmonic  ノードの 2 つ目と  
3 つ目の入力に接続し、Display フラグを設定します。

ジオメトリにキャプチャウェイトが表示されるようになりました。後でこれら
を微調整およびペイントして、ジオメトリの変形をセットアップします。

02 ネットワークビューで、Tab > Bone Deform を選択します。	
その 3 つの入力に、jointcapturebiharmonic  の 3 つの出力

を接続します。bonedeform  に Display フラグを設定します。 

このレッスンでは、おそらく変形する必要のない歯、つめ、目をキャプチャし
ます。これらは後ほど分離し、別の方法でキャプチャしていきます。

03 次に、Tab > Rig Pose を選択してノードを配置します。それを、
jointcapturebiharmonic  と bonedeform  の 3 つ目の入力を

接続している 3 つ目のライン上に移動して、チェーンに追加します。ここで
リグにアニメーションを付けます。rigpose を使用してジョイントを回転させ
たり、キーフレームを設定することができます。

04 rigpose  ノードを選択して、Scene View で Handle ツールが	
アクティブなことを確認します。さまざまなジョイントを選択お

よび回転して、変形をテストします。これは後でリセットできるので、自由に
試してください。
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パート 3

ボーンの追加
口の領域にもっとボーンが欲しいですね。Houdini のプロシージャルネットワークなら、前に戻ってジョイントを追加できます。 
また、Biharmonic（重調和）キャプチャを含む他のすべてのノードは、変更を反映して更新されます。クリーチャのリグの最初のセットアッ
プを柔軟に行うことができます。

jaw

lower_mouth

neck1

04 bonedeform  ノードに Display フラグを設定し、File  ノード
の Template フラグをオフにします。ジオメトリが再構成され、

新しいボーンからキャプチャが実行されます。rigpose  ノードを選択して、
Handle ツールを選択します。

新しい jaw  ジョイントをクリックし、下に回転させます。回転はしますが、
上唇と下唇が一緒に動きます。下唇のみが影響を受ける方が良いですね。
チュートリアルの後のセクションでキャプチャウェイトをペイントし、これを
修正します。 

01 ネットワークビューで、skeleton ノードに Display フラグを設定
し、元の File  ノードに Template フラグを設定します。Scene 

View でスペースバー + B を 2 回押して、Right ビューに移動します。

skeleton ノードに Display フラグを設定します。skeleton  ノードを選択し
て、Handle ツールをオンにします。Mode を Create に設定します。スケル
トンにさらにジョイントを追加できるようになります。KineFX ならこの時点
でボーンを追加でき、ネットワーク内のその他のノードがプロシージャルな
おかげで、後からの変更も可能です。 

02 neck1  ジョイントをクリックして描画を開始したら、顎および下
唇をクリックして、2 つのジョイントを作成します。ジョイントを

配置できたら、MMB クリックして描画を終了し、Mode を Modify に戻し
ます。ジョイントをクリックして名前を jaw と lower_mouth  に変更します。
Rig Tree ビューで名前を変更することもできます。

03 ジョイントの位置は Modify モードで編集します。上部のバーで 
Tweak Mode をオンにすると、ジョイントをクリック & ドラッグ

で移動できます。1 つのジョイントを移動すると、子のジョイントもすべて移
動するため、子を元の位置に戻す作業が発生します。この動作を回避する
には、Child Compensate をオンにします。

ジョイントで RMB クリックすると、ジョイントの分割、親子の解除、コピー、
ペーストなどのオプションが表示されます。このスケルトンでは使いません
が、こうしたオプションは知っておくと便利です。

ジョイントをミラー化することもできますが、このネットワークでは別のノー
ドを使用します。
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ジョイントの向き
ジョイントベースのシステムでは、各ジョイントはポイントです。ジョイントの向きが
非常に重要なのは、それによって、フォワードキネマティクスでジョイントがどう回転
するかが決まるからです。 
KineFX に含まれるツールを使用すると、チェーンに沿って次のジョイントの方を向
くようにすることができます。また、Child Compensate オプションを使って手動で
ジョイントを回転すると、チェーン内の他のジョイントに影響を与えずに、ジョイント
の向きを変更できます。

06 Mode を Create に設定します。head  ジョイントをクリックし
たら、eyeball ジョイントの上をクリックして新しいジョイントを

作成します。MMB クリックして選択を解除します。再度 head  ジョイントを
選択して、eyeball  ジョイントの下をクリックして新しいジョイントを作成し
ます。

Modify モードに切り替えて、Name でジョイントにそれぞれ upper_lid  と 
lower_lid  と名前を付けます。アニメーション時にはこれらのジョイントで
まぶたを回転させますが、ジョイントは目の中央に配置しておく必要があり
ます。

05 skeleton ノードに Display フラグを再度設定し、元の File  ノー
ドに Template フラグを設定します。

skeleton  ノードを選択して、Handle ツールをオンにします。Mode を 
Modify に設定します。head ジョイントをクリックし、Tweak Mode を使用
して、眼球の高さと揃うまで下げます。 

Mode を Create に設定します。head  ジョイントをクリックしたら、眼球の
中央でクリックして新しいジョイントを作成します。Modify モードに切り替
えて、Name でこのジョイントに eyeball  と名前を付けます。

07 ジオメトリの Template フラグをオフにします。upper_lid  ジョ
イントを選択し、Tweak Mode を使用して eyeball  ジョイン

トに重なるようにドラッグします。lower_lid  でもこの作業を繰り返して、
eyeball  ジョイントに重ねます。

これで、3 つすべてのジョイントが同じ場所に揃いました。後で、それぞれ個
別にジオメトリをアタッチして、独立してアニメートできるようにします。

08 bonedeform  ノードに Display フラグを設定します。ジオメト
リが再構成され、新しいボーンを使用してキャプチャされます。

ジオメトリはまだ適切にアタッチされていないので、新しいジョイントにポー
ズを付けることはできません。いくつかの手順を行い、体と舌にキャプチャ
ウェイトをペイントした後で、ようやく可能になります。 
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パート 4

ジョイントの向き
キャラクタをアニメートするときは、ジョイントの向きがリグの操作に大きく影響します。このパートでは、一部のジョイントの向きを手動で
変更します。その後、Orient Joints ノードを使用して、残りすべてのジョイントの向きをマイナス Z 軸基準に変更します。後の工程でリグ
を評価する際、必要に応じてここに戻って向きを微調整してください。

01 もう一度、skeleton  ノードに Display フラグを設定します。
Scene View で RMB クリックして Display Joint Axes を選択

し、ジョイントの向きが確認できるようにします。COG  ジョイントを選択して 
RMB クリックし、Show Handle を選択します。これで、ジョイントを回転
させると、リグ全体が一緒に動きます。Ctrl + Z を押して元に戻しましょう。

Child Compensate チェックボックスをオンにすると、残りのスケルトンに
影響を与えることなく、ジョイントを回転できます。Ctrl キーを使用して、	
45 度のインクリメントに拘束します。

02 Scene View で、P を押してこのジョイントのパラメータを表示
します。ワールドで COG の向きを変更するために、Rotate と 

Local Rotate を 0, 0, 0 に設定します。

何もない空間でクリックして COG ジョイントの選択を解除したら、pelvis  
ジョイントをクリックします。Rotate と Local Rotate を 0, 0, 0 に設定し
ます。 

03 Skeleton ノードの後に、Orient Joints ノードを挿入します。	
このノードは、デフォルトではプラス Z 軸を基準にジョイントの

向きを変更します。Orient Group の横の矢印をクリックして、Scene View 
ですべてのジョイントを選択します。Ctrl を押しながら COG  ジョイント、
pelvis  ジョイント、neck1  ジョイントを選択し、選択から除外します。	
Enter を押します。 

これで、選択解除した 3 つのジョイント以外、すべてのジョイントが	
プラス Z 軸を基準とした向きになります。

04 Bone Deform ノードに Display フラグを再度設定します。他の
すべてのノードが更新され、新しいジョイントの向きが受け入れ

られます。 

ジョイントの向きを変える前後では、違いはないように見えますが、アニメー
ション時のキャラクタのポーズ決めや操作に影響してきます。
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パート 5

キャプチャジオメトリの取り付け
現在はスケルトンジョイントを使用してジオメトリをキャプチャし、キャラクタの各ポイントにキャプチャウェイトを割り当てています。 
これをさらに詳細にコントロールするには、そのジョイントの影響を延長するジョイントにカーブを取り付けます。このようにすると、かな
り素早く素早く目的を達成することができます。 

01 ネットワークビューで、Tab > Split を選択して、File  ノードと 
jointcapturebiharmonic  ノードの間にノードを配置します。

split ノードの 1 つ目の出力を、jointcapturebiharmonic  ノードの 1 つ目
の入力に接続します。

Group フィールドのプルダウンメニューをクリックして、fur_dude_body  
グループと fur_dude_tongue  グループを選択します。これで、この 2 つは 
split ノードの 1 番目の出力に送られ、眼球、歯、つめなど残りのパーツは 
2 番目の出力に送られるようになります。このジオメトリにウェイトをペイン
トしてから、残りのパーツを別の方法を使ってスケルトンにバインドします。 

02 ネットワークビューで、Tab > Visibility を選択して、	
Split  ノードと jointcapturebiharmonic  ノードの間にノードを

配置します。Group フィールドのプルダウンメニューをクリックして、fur_
dude_tongue  グループを選択します。 

このノードは選択したジオメトリを非表示にします（削除はしません）。つま
り、Paint Capture Weights ツールを使用する際に重要となるポイント番号
とプリミティブ番号が変更されません。この処理でジオメトリを非表示にす
るたびに、これらの情報が変更されてしまっては大変です。

03 visibility ノードに Display フラグを設定します。

S を押して Select ツールにしたら、3 を押してエッジ選択を	
有効にします。下唇の左側中央でエッジを選択したら、Shift + A を押して
反対側のエッジを選択します。

04 Tab > Curve from Edges を押すと、選択されたエッジがジオメ
トリから抽出されます。このノードの名前を lower_lip  に変更し

ます。

curvefromedges  ノードが File  ノードと jointcapturebiharmonic  ノー
ドに間に配置されています。それを横に移動して、visibility  ノードの出力
を jointcapturebiharmonic  ノードの 1 つ目の入力に再接続します。これ
により、curvefromedges  ノードが横に分岐します。
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06 Tab > Merge Packed を選択し、このノードを抽出した 2 つの
カーブのノードの下に配置します。その後、その 2 つのノードの

出力を mergepacked  ノードに接続します。

Tab > Attach Capture Geo を押します。このノードをネットワークに追加
したら、skeletonmirror  ノードを 1 つ目の入力に接続し、mergepacked  
ノードを 2 つ目の入力に接続します。 

05 visibility ノードに Display フラグが設定されていることを	
確認します。

S を押して Select ツールにしたら、3 を押してエッジ選択を	
有効にします。上唇の左側でエッジを選択したら、Shift + A を押して反対
側のエッジを選択します。

Tab > Curve from Edges を押すと、選択されたエッジがジオメトリから	
抽出されます。このノードの名前を upper_lip  に変更します。

このノードを、もう片方のノードで行ったのと同じように分岐させます。

07 add_capture_geometry  ノードの出力を、
jointcapturebiharmonic  ノードの中央の入力に接続します。

Advanced Shape Settings で、Assign Shapes の +（プラス）記号ボタン
を 2 回クリックします。1 つ目は次のように設定します。

	� Group を @name=lower_mouth  にする
	� Shape Name を lower_lip  にする

2 つ目は次のように設定します。
	� Group を @name=neck2  にする
	� Shape Name を upper_lip  にする

どちらの形状でも、Keep Shape World Transform をオンにします。

08 jointcapturebiharmonic  に Display フラグを設定します。	
ここで add_capture_geometry  ノードをバイパスして、キャプ

チャウェイトの違いを表示します。

このノードがオンのとき、取り付けられたカーブは、関連付けられたジョイン
トへのジオメトリのキャプチャを補助します。これにより、キャラクタのセッ
トアップをより細かくコントロールできるようになります。

09 bonedeform  ノードに Display フラグを設定します。
rigpose  ノードをクリックしたら、パラメータエディタで 

Transformations の横の Clear ボタンをクリックします。これでジョイン
トがリセットされます。Handle ツールをアクティブにして、Scene View で 
jaw  ジョイントをクリックします。それを下に回転させて唇を下げます。 

この操作で、腹部のパーツがまだ変形していることが分かります。これを修
正するには、キャプチャウェイトをペイントして、キャプチャウェイトを各種
ジョイントに割り当て直す必要があります。
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パート 6

キャプチャウェイトのペイント
Biharmonic（重調和）キャプチャは、スケルトンの各種ボーンに関連付けられたキャラクタのジオメトリに、ウェイトを追加します。 
次は、新しいノードを追加して、ブラシワークフローによってキャプチャウェイトを調整します。このクリーチャのレッスンで目指すのは、 
上唇が下唇のジョイントの影響を受けないようにすることと、足の領域のウェイトを微調整することです。 

01 ネットワークビューで、Tab > Joint Capture Paint を押して、
ノードを bonedeform  の真上に配置し、3 つすべてのコネクタ

を接続します。Display フラグを設定してから、Target Joint の横のプルダ
ウンメニューをクリックして、neck2  ジョイントを選択します。 

Scene View には、カーソルに大きい円形のペイントアイコンが表示され、
これを使ってウェイトをペイントします。頭部の領域をペイントすると、ジオ
メトリのこの部分が neck2  ジョイントにキャプチャされます。

02 頭部と上唇の領域を neck2 ジョイントにキャプチャする必要があります。影響の度合いが最も強い領域のジオメトリは、赤くなり
ます。 

頭の上部では太いストロークを使用します。その後、マウスのスクロール
ホイールを使用してブラシの半径を小さくするか、パラメータエディタの 
Brush タブに移動して半径を変更します。 

03 上唇をペイントして、この領域に対する neck2  ジョイントの影響
を強くします。ペイントするのは上唇のみで、下唇には及ばない

ようにします。間違えたら、Ctrl + Z でストロークを取り消しましょう。タンブ
ルして口の中が見えるようにして、上部もペイントします。 

オペレーションコントロールツールバーには、Display Deformed 
Geometry、Display Joints、Display Color のオプションが表示されて
います。これらのオン/オフを切り替えることで、キャプチャウェイトを評価し
ながらペイントできます。

04 F を押して Smooth を選択し、この部分のペイントを周りの領
域のキャプチャウェイトに馴染ませます。ブラシの半径を少し大き

くして、滑らかにしましょう。 

完了したら、rigpose  ノードをクリックします。Handle ツールをアクティブ
にして、Scene View で jaw  ジョイントをクリックします。それを下に回転さ
せて唇を下げます。今回は、上唇は動かず、下唇およびその下のパーツが
回転しているのが分かります。
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09 visibility ノードに Bypass フラグを設定します。 

完了したら、rigpose  ノードをクリックします。Handle ツールを
アクティブにして、Scene View で jaw  ジョイントをクリックします。それを
下に回転させて唇を下げます。すべてのパーツの動きに満足したら、リジッ
ドジオメトリをキャプチャする準備の完了です。

06 時々前に戻って、jaw をテストしながら、調整します。余分な領域に jaw が影響しなくなったら、完了です。再度スムースをかけ
て、馴染ませてもよいでしょう。

次は、スケルトンの別のジョイントにウェイトをペイントします。Biharmonic
（重調和）のおかげで、脚や足に問題はないはずですが、rigpose  を使用
してリグをテストし、改善点があればウェイトをペイントして微調整してくだ
さい。

05 jointcapturepaint  ノードを選択します。Capture Region 
フィールドのプルダウンメニューをクリックして、jaw  ジョイント

を選択します。F を押して Subtract を選択し、頭頂や目の領域に対する 
jaw ジョイントの影響をなくします。

この方法を使用すると、腹部に対する jaw ジョイントと lower_mouth ジョ
イントの影響もなくすことができます。そうすると、口が動くとき、腹部があ
まり影響を受けなくなります。

07 toe ジョイントを選択して、足の先端が左右の toe ジョイントにキャプチャされていることを確認します。後ほど、リバースフット
のセットアップを構築して、ジオメトリをつま先にアタッチします。

08 visibility ノードで Apply to を Non-Selected Primitives に	
設定します。すると、舌だけが表示されます。

デフォルトで適切にウェイトが付いているはずですが、必要に応じてウェイト
をペイントできます。jointcapturepaint  ノードを選択して、neck1  ジョイ
ントと jaw  ジョイントのウェイトをペイントします。 

完了したら、visibility  ノードを再度バイパスします。
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パート 7

リジッドジオメトリのキャプチャ
パート 5 で、目、歯、つめのジオメトリを分割しました。ここでは、このジオメトリをパック化し、その後 Capture Packed Geometry ノー
ドを使用して、各パーツをジョイントに割り当てます。KineFX では、親子化はジオメトリレベルでは使用できません。この操作は、各オブ
ジェクトをスケルトンの子にすることに相当します。

01 ネットワークビューで、Tab > Name from Groups を選択して、
ノードを File  ノードと split  ノードの間に配置します。Group 

Mask を * に変更します。これで、すべてのグループが name アトリビュー
トになります。 

これを表示するには、Geometry Spreadsheet タブをクリックして、左上
の Primitives ボタンをクリックします。下にスクロールすると、name アト
リビュートがあることと、グループ名がすべてのジオメトリの値として使用さ
れていることを確認できます。

02 ネットワークビューで Tab > Pack を選択し、split  ノードの右側
にノードを配置します。split  ノードの 2 番目の出力を pack  ノー

ドに接続して、Display フラグを設定します。すると、Scene View に目、歯、
つめのパーツが表示されます。

Path Attribute チェックボックスをオフにして、Name Attribute チェック
ボックスをオンにします。Transfer Attributes を name に設定します。 

ネットワークビューの右上の矢印を使用して、Split を選択します。
Geometry Spreadsheet に、8 つのパックプリミティブが表示されます。 	
これらは、リジッドジオメトリとしてスケルトンにキャプチャできます。

03 ネットワークビューで Tab > Capture Packed Geometry を選
択して、そのノードを pack  ノードの下に配置します。pack ノー

ドの出力を、capturepackedgeo  ノードの 1 つ目の入力に接続します。	
次に、skeletonmirror ノードの出力を、capturepackedgeo  ノードの 2 つ
目の入力に接続して、capturepackedgeo  ノードに Display フラグを設定
します。

これだけではまだ何も起こりません。ボーンとキャプチャしたいジオメトリ
を関連付ける必要があります。

04 パラメータエディタで、Manual Capture の横にある +（プラス）
記号をクリックします。Capture Geo の横の矢印をクリックし

て、Scene View で下の歯を選択します。ワンクリックで済むのは、下の歯は
パックグループの 1 つだからです。Enter を押して確定します。

次に、Joint の横の矢印をクリックします。ジオメトリが消え、スケルトンを
表すラインとポイントが表示されます。lower_mouth  ジョイントを選択し
たら、カーソルを Scene View 上に置いたまま Enter を押して確定します。 
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ネットワークの統合
ジオメトリのキャプチャ、ウェイトのペイント、アニメーション用のジオメトリの準備
のために作成したネットワークは適切に動作しますが、変更を加えると更新に時間
がかかります。 
より効率的なリグを作成するには、ネットワークを統合し、キャプチャウェイトをジオ
メトリに格納した単一ファイルにします。このファイルを Bone Deform SOP に接続
すると、最初にジオメトリをキャプチャするのに使用したボーンと同じボーンのスケ
ルトンであれば、効率的に変形されるようになります。

06 capturepackedgeo  ノードの出力を、bonedeform  ノードの 	
1 つ目の入力に接続します。bonedeform  ノードに Display フ

ラグを設定します。 

rigpose  ノードを選択したら、Scene View でジョイントを選択して回転し
ます。ジオメトリがジョイントにキャプチャされ、変形がないことを確認でき
ます。 

目とまぶたのジョイントは重なっているため、ジョイントをクリックしたら、
小さいポップアップメニューを使用していずれかを選択します。必要なジョ
イントにたどり着くまで、数回クリックする必要がある場合もあります。選択
したジョイントを使用して、目とまぶたを別々に回転します。

05 +（プラス）記号をクリックして、Capture Geo の横の矢印をク
リックします。Scene View で、Shift を押しながら fur_dude_

upteeth  と fur_dude_gums  を選択します。Enter を押して確定します。
次に、Joint の横の矢印をクリックします。neck2  ジョイントを選択して、
Enter を押します。

この手順をさらに 2 回繰り返して、以下を関連付けます。
	� fur_dude_rclaws  と r_toe
	� fur_dude_lclaws  と l_toe
	� fur_dude_eye  と eyeball
	� fur_dude_uplid  と upper_lid
	� fur_dude_lowlid  と lower_lidl

07 ネットワークビューで Tab > Merge を選択して、ノードを 
capturepackedgeo  ノードと bonedeform  ノードの間に配置

します。capturelayerpaint  ノードを merge ノードに接続します。merge  
ノードで、capturelayerpaint  の横の青い上向き矢印を押して、入力の順
番を変更します。 

これですべてが変形するようになりました。しかし、パックジオメトリには	
色が付いていて、体と舌はグレーです。merge ノードにも問題があります。
一方には Primitive アトリビュートとしてカラー（Cd）が設定されているのに
対し、もう一方には Point アトリビュートとしてカラーが設定されています。

08 ネットワークビューで Tab > Unpack を選択し、
capturepackedgeo  ノードと merge ノードの間にノードを配置

します。Iterations を 2、Transfer Attributes を * ^Cd に設定します。	
* ですべてのキャプチャアトリビュートが取り込まれます。また ^Cd により、
元のカラーアトリビュートが除去されません。これで、どちらもポイントカ
ラーを使用するようになり、リグが正しく表示されるようになりました。

rigpose  ノードを選択し、Scene View でジョイントを選択して回転します。
すべてのキャプチャされたジオメトリが一緒に動くのを確認できます。

作業内容を保存します。 
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パート 8

キャプチャリグのデジタルアセットの作成
キャプチャしたジオメトリとスケルトンを、デジタルアセットにラップして、アニメーションリグの土台として使用します。まず、キャプチャウェ
イトやスケルトンとともにジオメトリをエクスポートして、デジタルアセットファイルに埋め込みます。こうすると、キャラクタのアニメートで
効率の良いリグが得られます。

01 ネットワークビューで Tab > ROP Geometry Output を選択
し、merge  ノードの下にノードを配置します。merge  ノードの

出力を rop_geometry  ノードの入力に接続します。パラメータエディタで、
Output File を次のように設定します。

$HIP/geo/furdude_capt.bgeo.sc

Save to Disk をクリックして、ジオメトリを geo  ディレクトリに保存します。
このジオメトリは、レッスンの最初にインポートしたジオメトリと同じように
見えますが、変形を可能にするキャプチャアトリビュートなどの重要な情報
が含まれています。 

02 ネットワークビューで Tab > ROP Geometry Output を選
択し、skeletonmirror  ノードの横にノードを配置します。

skeletonmirror  ノードの出力を rop_geometry  ノードの入力に接続しま
す。パラメータエディタで、Output File を次のように設定します。

$HIP/geo/furdude_skel.bgeo.sc

Save to Disk をクリックして、ジオメトリを geo  ディレクトリに保存します。
このジオメトリはスケルトンを表し、アニメーションリグアセットの構築に使
用できます。 

03 オブジェクトレベルに戻ります。オブジェクトの名前を 	fur_dude_capture  に変更します。その Display フラグをオフ
にします。

Create シェルフの File ボタンをクリックします。$HIP  をクリックして、
geo  ディレクトリに移動し、furdude_capt.bgeo.sc  ファイルを選択しま
す。Enter を押して原点に配置したら、新しいオブジェクトノードの名前
を furdude_rig  に変更します。ダブルクリックしてこのオブジェクトの中
に入ります。File  ノードを Alt ドラッグ して、2 つ目のノードを作成します。
Geometry File を $HIP/geo/furdude_skel.bgeo.sc  に変更します。

それを furdude_skel.bgeo  という名前に変更し、furdude_capt.bgeo  
ノードに Display フラグを設定します。

04 2 つの File ノードを選択し、Assets メニューから New Digital 
Asset from Selection を選択します。次のように設定します。
	� Operator Name を fur_dude_capture_rig  にする
	� Operator Label を Fur Dude Capture Rig  にする
	� Save to Library を $HIP/hda/fur_dude.hda  にする

Accept をクリックして、HDA ファイルを作成します。Edit Operator Type 
Properties ウィンドウが表示されます。Maximum Outputs を 3 に設定
し、Accept をクリックします。サブネットを fur_dude_capture_rig  という
名前に変更します。
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HDA
このようなノードのネットワークは、Houdini デジタルアセット（HDA）として保存さ
れます。これはディスク上の 1 ファイルで、簡単に共有できます。キャプチャリグは
ディスクから参照されるアセットです。次のセクションで、内部にキャプチャリグをネ
ストしたアニメーションリグを構築します。どちらのファイルも、bgeo ファイルとと
もに単一の HDA ファイル内に保存されます。
ディスク上の HDA ファイルが変更されると、アニメータがシーンファイル内で作業
しているアセットのインスタンスが更新されます。

05 このノードをダブルクリックして、サブネットの中に入ります。
Tab > Output を選択して、output ノードを fur_dude_geo_

capt File  ノードの下に配置します。File  ノードを output  ノードに接続しま
す。名前を CaptureGeo  に変更します。

Alt ドラッグ操作を 2 回行い、新しい Output ノードを 2 つ作成します。	
2 つ目の名前を RestSkeleton  に変更し、Output Index を 1 に設定しま
す。3 つ目の名前を AnimSkeleton  にして、Output Index を 2 に設定し
ます。fur_dude_skel.bgeo File  ノードを、2 つ目および 3 つ目の output  
ノードに接続します。

CaptureGeo  output ノードに Display フラグを設定します。

06 Asset メニューから、Edit Asset Properties > Fur Dude 
Capture Rig を選択します。Edit Operator Type Properties ウィ

ンドウが開きます。Extra Files タブをクリックします。 

左下の Filename の横にある選択ボタンをクリックして、$HIP/geo/fur_
dude_capt.bgeo.sc  に移動します。Accept をクリックします。Add File 
をクリックします。 

この手順を fur_dude_skel.bgeo.sc  ファイルでも繰り返します。これで、
これらのファイルがデジタルアセットファイル内部に配置できました。完全な
パッケージとして他の人と共有しやすくなります。

Accept をクリックして完了します。

07 最初の file ノードで、Geometry File の横にある選択アイコン
をクリックします。Locations サイドバーで opdef:/  を選択し、

Sop  ディレクトリをダブルクリックしたら、fur_dude_capture_rig  フォル
ダをクリックします。fur_dude_capt.bgeo.sc  ファイルを選択し、Accept 
を押します。これにより、以下の opdef エクスプレッションが作成されます。

opdef:/Sop/fur_dude_capture_rig?furdude_capt.bgeo.sc

この手順を fur_dude_skel.bgeo.sc File  ノードでも繰り返します。 

Assets メニューから Lock Asset > Fur Dude Capture Rig を選択します。
Save Changes をクリックして、このアセットのコンテンツを保護します。	
これらのファイルは、必要に応じて後からロックを解除して、更新できます。

08 1 つ上のレベルに移動すると、3 つの出力があるキャプチャリグを確認できます。Tab > Bone Deform を選択し、このノードを
下に配置します。fur_dude_capt_rig  の 3 つの出力を、bonedeform  ノー
ドの 3 つの入力に接続します。3 つ目のチェーンの中央に、rigpose ノード
を追加します。bonedeform  ノードに Display フラグを設定します。

rigpose  ノードを選択して、Handle ツールがアクティブなことを確認しま
す。すべてのスケルトンジョイントが再度表示されます。スケルトンにポーズ
を付け、変形が前と同じように動作しているかをテストします。  

155

キ
ャ

プ
チ

ャ
リ

グ
の

デ
ジ

タ
ル

ア
セ

ッ
ト

の
作

成



01 3 つのノードを選択し、Assets メニューから New Digital Asset 
from Selection を選択します。次のように設定します。
	� Operator Name を fur_dude_anim_rig  にする
	� Operator Label を Fur Dude Anim Rig  にする

Save to Library では、ブラウザボタンをクリックします。$HIP をクリックし、
HDA ディレクトリをダブルクリックします。fur_dude.hda ファイルを選択し、
Accept をクリックします。これで、$HIP/hda/fur_dude.hda  に設定され
ました。

Accept をクリックし、Edit Operator Type Properties ウィンドウで再度 Accept 
をクリックします。これで、新しいアセット定義が同じ HDA ファイルに追加され
ました。サブネットを fur_dude_anim_rig という名前に変更します。

02 オブジェクトレベルに移動します。furdude_rig  ノードを Alt ド
ラッグして新しいジオメトリノードを作成し、test_rig  と名前を

付けます。T を押して、テストリグを左に動かします。 

ダブルクリックして、このノードに入ります。fur_dude_anim_rig  ノードを
選択し、Assets メニューから、Lock Asset > Fur Dude Anim Rig を選択
します。

1 つ上のレベルに戻ります。これで 2 つのバージョンのリグができました。
test_rig はロックされ、完成したアセット内でどのように振舞うかを確認でき
ます。現在は相互作用するものが何もありません。これは後ほど解決します。

ネットワークエディタでクリックして、Ctrl + 1 を押して Quick マークを設定
します。

03 furdude_rig  オブジェクトに移動したら、さらに fur_dude_
anim_rig  に戻ります。ネットワークエディタでクリックして、

Ctrl + 2 を押して Quick マークを設定します。これで、これらのネットワーク
間を素早く行き来できるようになりました。

rigpose  を選択し、Transformations の横にある Clear ボタンをクリッ
クします。Asset メニューに移動し、Save Asset > Fur Dude Anim Rig 
を選択します。Asset メニューから、Edit Asset Properties > Fur Dude 
Anim Rig を選択します。Node タブをクリックして、Default State を 
kinefx__rigpose に設定します。Accept をクリックします。

パート 9

アニメーションリグアセットの作成
このパートでは、内部にキャプチャリグをネストした 2 つ目のデジタルアセットを作成します。この新しいアセットをアニメートして、 
キャラクタの最終的なモーションを作成します。また、この新しいアセットに、アニメーションをサポートするインバースキネマティクスや 
Aim 拘束などのリギングツールを追加していきます。コントロールを追加するたびにテストしていきます。このためには、ロックされた 
テストリグをセットアップし、2 つ目の Scene View ペインに表示させます。

04 ネットワークビューで、1 を押して test_rig に戻ります。左側の 
Scene View で、ツールバーを展開して Handle ツールをクリッ

クします。 

これで、test_rig  にジョイントが表示されます。ジョイントをクリックして
も変更は不可能です。これは、パラメータがアセットにプロモートされてい
ないためです。ここから、このキャラクタにアニメーション可能なインター
フェースを構築していきます。
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リグにジョイントを追加する
これらの追加ジョイントは右端のノードストリームに追加されました。一方、中央
の静止スケルトンは元のジョイントのままです。追加のジョイントを bonedeform 
ノードに接続しても、「ファントム」ジョイントは無視されます。元のジョイントだけ
が、リグの最終出力を決定します。
これらの追加ジョイントを bonedeform ノードの中央の静止スケルトン入力に接
続すると、エラーになります。これらのジョイントは、入力ジオメトリに、対応する
キャプチャウェイトを持っていないからです。

静止 
スケルトン 追加ジョイントを 

含むスケルトン

eye_target

l_heel

パート 10

コントロールジョイントの追加
コントロールリグの柔軟性を高めるため、スケルトン全体のルートジョイント、リバースフットのセットアップ用にかかとジョイント、 
眼球のターゲットとなる Look At ポイントなど、複数のジョイントを追加します。これらのジョイントには、元の静止スケルトン内の 
ジョイントと同じ名前を付けます。こうしておくと、キャラクタのモーションを駆動するために使用できます。

01 ネットワークビューで、2 を押して fur_dude_anim_rig に戻り、
Display フラグを設定します。fur_dude_capture_rig  ノード

に Template フラグを設定します。 

Delete Joints ノードを fur_dude_capture_rig  ノードの 3 つ目の出力か
ら分岐させます。Group の横にある矢印をクリックして、ファー・デュード
の右脚のジョイントを選択します。Enter を押します。

Skeleton ノードを追加します。Mode を Create に変更します。グリッドス
ナッピングをオンにして、原点にポイントを追加します。Modify モードに変
更して、新しいジョイントの名前を furdude_main  に変更します。

02 Right ビューに移動します。Create モードに戻り、MMB クリッ
クしてメインジョイントの選択を解除します。l_toe  ジョイントを

クリックして、かかとがあるべき場所に新しいジョイントを追加します。 

Modify モードに変更して、新しいジョイントの名前を l_heel  に変更しま
す。P を押して、Child Compensate をオンにし、Rotate を 0, 0, 0 に設
定します。

03 目の領域に移動します。Create モードに戻し、MMB クリックし
て現在の選択を解除します。目の前に新しいジョイントが追加さ

れました。

Modify モードに変更して、新しいジョイントの名前を eye_target  に変更
します。P を押して、Rotate を 0, 0, 0 に設定します。
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テストリグの役割
現在作業しているリグは、ロックされていないアセットです。アセット内のすべてのジョイントを操作
できます。ただし、アセットがアニメータに渡されたときにアニメータが扱えるのは、キャラクタのトッ
プレベルにプロモートされたパラメータのみです。
test_rig  はアセットの 2 つ目のロックバージョンであり、パラメータをプロモートしたりコントロー
ルを構築するまで、アセットを操作することはできません。テストリグが素晴らしいのは、アニメーショ
ンを付けられる状態になっているかどうかを確認できるツールだからです。テストリグを操作できな
ければ、アニメータはキャラクタにポーズを付けることができません。

05 Skeleton Mirror ノードをチェーンに追加します。これにより、
すべてのジョイントのミラーコピーが作成されます。パラメータ

エディタに移動して、Group の横の矢印をクリックします。左脚のジョイン
トのみを選択して（新しい l_heel  ジョイントを含む）、Enter を押します。	
脚のみがミラー化されました。

Naming で、Find Tokens を l_、Replace Tokens を r_  に設定します。	
これで、右脚のジョイントに適切な名前が付けられます。

06 skeletonmirror ノードを rigpose  ノードに接続します。
bonedeform  ノードに Display フラグを設定します。足のつめ

が反転しているように見えます。そのスケルトンジョイントに戻り、l_toe  を
選択し、P を押してパラメータを表示します。Rotate を 0, 0, -90 に設定し
ます。

ジョイントを追加するのに使用した 4 つのノードを選択し、Add Network 
Box ボタンをクリックします。ノードを囲むようにボックスを配置します。
ボックスのタイトルをクリックして、Add Joints  と入力します。

07 Assets メニューから、Save Asset > Fur Dude Anim Rig を選
択します。変更がアセット定義に保存され、test_rig  が更新さ

れます。まだ test_rig  を編集することはできません。いずれのパラメータも
トップレベルにプロモートされていないからです。

次は、メインコントロールをセットアップし、パラメータをプロモートして、
test_rig  に生命を吹き込んでいきます。 

04 Parent Joints ノードを追加します。+（プラス）記号を 2 回クリッ
クします。Joint1 の横にある矢印をクリックして、Scene View 

で COG  ジョイントをクリックします。（カーソルを Scene View に置いたま
ま）Enter を押して確定します。次に、Parent1 の横にある矢印をクリック
して、furdude_main  ジョイントを選択します。 

2 つ目のエントリでは、Joint2 の横にある矢印をクリックして、Scene View 
で eye_target  ジョイントをクリックします。（カーソルを Scene View に置
いたまま）Enter を押して確定します。次に、Parent2 の横にある矢印をク
リックして、COG  ジョイントを選択します。 
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04 ネットワークエディタに Skeleton Blend ノードを追加します。
skeletonmirror  ノードを左側の入力に、rigpose  ノードを右側

の入力に接続します。その後、skeletonblend  ノードを bonedeform  ノー
ドの 3 つ目の入力に接続します。 

skeletonblend  のパラメータエディタで、World Space チェックボックス
をオンにして、weight1  を 1 にします。

01 Delete joints ノードを skeletonmirror  から分岐させま
す。Group の横にある矢印をクリックして、Scene View で 

furdude_main、COG、pelvis、l_heel、r_heel  ジョイントを選択します。
Enter を押し、Operation を Delete Non-Selected に設定します。

02 deletejoints ノードの後に Parent Joints ノードを追加します。
+（プラス）記号をクリックして、ジョイントリストを追加します。

Joint1 の横にある矢印をクリックして、Scene View で 2 つの heel  ジョイン
トを選択します。Enter を押します。 

Parent1 の横にある矢印をクリックして、Scene View で furdude_main  
ジョイントを選択します。Enter を押します。

heel ジョイントが COG  から切り離され、脚の下部で IK を駆動するのに使
用できるようになりました。COG  ジョイントに親子化されている pelvis  ジョ
イント以外、すべてのジョイントは furdude_main  ジョイントに親子化され
ています。

03 parentjoints  ノードを rigpose  ノードに接続します。このノード
からの既存のジョイントをすべてクリアして、Display フラグを

設定します。furdude_main  ジョイント、COG  ジョイント、pelvis  ジョイン
ト、2 つの heel  ジョイントをクリックします。

ここで bonedeform  ノードに Display フラグを設定すると、ジョイントの多
くがなくなっているため、想像とは違う表示になります。これは、Skeleton 
Blend を使用して修正できます。

パート 11

メインコントロール
キネマティクスを追加するためには、COG の下に足がある、現在の階層を切り離す必要があります。いくつかのジョイントを切り離し、 
再度親子化して、希望通りの階層を構築します。Bone Deform を適切に動作させるには、この再親子化を別に行ってから、結果を元の
スケルトン階層にブレンドすることが重要です。
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コントロールジオメトリ
ジョイントを rigpose に追加するとき、アセットのトップレベルにプロモートすると、ジョイント
を選択してアニメートできるようになります。Attach Control Geometry ノードを使って、ジ
オメトリをリグのさまざまなパーツに割り当てれば、ジョイントの選択や操作が簡単になりま
す。好きな形状を作成して、コントロールに使用できます。 
コントロールジオメトリの用途としては、眼球や、重なり合った 2 つの lid（まぶた）ジョイントな
どが挙げられます。コントロールジオメトリを使用すれば、それらのジョイントを簡単に選択し
て、その部分のリグをセットアップできます。ここでは、メインコントロールに使用します。

05 Assets メニューから Save Asset > Fur Dude Anim Rig を選
択します。これにより現在の設定が保存されます。ネットワーク

ビューで、1 を押して test_rig に戻ると、rigpose にリストされている 5 つ
のジョイントのみが表示されます。 

パラメータはまだプロモートされていないため、ジョイントの選択や移動は
できません。 

06 ネットワークビューで、2 を押して fur_dude_anim_rig に戻ります。
Circle ノードをネットワークに追加します。Orientation を ZX に設

定します。Uniform Scale を 0.2 に設定します。Divisions を 36、Arc Type を 
Open Arc に設定します。Color ノードを追加して、Color を黄色に設定します。

さらに Merge Packed ノードを追加して、Name 1 を circle_ctrl  に設定し
ます。

parent ノードと rigpose ノードの間に Attach Joint Geometry ジオメトリを配
置します。その 2 つ目の入力に mergepacked ノードを接続します。このノードに 
Display フラグを設定し、Scene View で Enter を押します。表示されているジョ
イントをすべて選択したら、G を押し、スクロールホイールを使用して circle_ctrl 
ジオメトリを見つけます。ジオメトリがすべてのジョイントに割り当てられます。

07 上部のオペレーションコントロールツールバーで、Mode を 
Tweak Shapes に変更します。 

COG と pelvis ジョイントを選択し、G を押してトランスフォームハンドルを
表示します。E を押してスケールハンドルにしたら、中央のハンドルをクリッ
ク & ドラッグして、これらのコントロールが少し小さくなるまで 3 方向すべて
でスケールします（パラメータエディタで約 0.67）。 

2 つの heel  ジョイントを選択し、G を押してトランスフォームハンドルを表示
します。E を押してスケールハンドルにしてから、中央のハンドルをクリック 
& ドラッグして、かかとのコントロールがかなり小さくなるまで 3 方向すべて
でスケールします（パラメータエディタで約 0.3）。

08 rigpose  ノードを選択し、コントロールジオメトリを使用して 
4 つのジョイントを選択します。これをテストリグで動作させるに

は、パラメータをプロモートする必要があります。

Assets メニューから、Edit Asset Properties > Fur Dude Anim Rig を選
択します。Parameters タブをクリックします。 

rigpose  ノードで、furdude_main  に移動し、Scale で RMB クリックし
て Lock Parameter を選択します。Translate をドラッグして、root  の下
のパラメータリストに移動します。Label を Main Translate  に設定しま
す。Rotate パラメータも同じようにして、Main Rotate  と名前を付けます。
Accept をクリックして終了し、結果をアセットに保存します。 
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ネットワークの整理
ひと手間かけて、ノードを整列させたり、ネットワークボックスを追加しておきましょ
う。よく整理されたネットワークは、後で作業しやすく、他のスタッフにも意図が伝
わりやすいものです。
また、各ノードにはコメントを追加して、ネットワークに表示させることができます。
ステッキーノートを使用すれば、ノードの大きいブロックについての説明も付加で
きます。チームでネットワークを作成する場合には、コミュニケーションが常に重要
です。

10 ネットワークビューで、2 を押して fur_dude_anim_rig に
戻ります。Assets メニューから、Edit Asset Properties > 

Fur Dude Anim Rig を選択します。 COG、l_heel、r_heel  ジョイントの 
Translate と Rotate、pelvis ジョイントの Rotate をドラッグします。	
いずれの場合も、各ジョイントの使用しない Scale や Translate パラメータ
（pelvis の場合）はロックします。

Accept をクリックして終了し、結果をアセットに保存します。 

09 ネットワークビューで、1 を押して test_rig に戻ります。テストリ
グが更新され、新しいコントロールが表示されています（Handle 

ツールがアクティブになっている場合）。コントロールジオメトリを使用して 
furdude_main  ジョイントを選択すると、トランスフォームハンドルが表示
され、それを使ってリグを動かすことができます。

動かした後は取り消して、元の位置に戻します。

11 ネットワークビューで、1 を押して test_rig に戻ると、新しいコ
ントロールが表示されるようになりました。コントロールジオメ

トリを使って COG  ジョイントと heel  ジョイントを選択し、パーツをトランス
フォームさせてみましょう。

終了したら取り消して、すべてのパーツを元の位置に戻します。

12 ネットワークビューで、2 を押して fur_dude_anim_rig に戻り
ます。メインコントロールのセットアップに使用したノードを選択

し、Add Network Box ボタンをクリックします。ノードを囲むようにボック
スを配置します。ボックスのタイトルをクリックして、Main Controls  と入力
します。

Assets メニューから、Save Asset > Fur Dude Anim Rig を選択します。
この操作はリグに影響しませんが、アセットを最新の状態に保つことができ
ます。また、シーンファイルも保存しましょう。
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パート 12

脚のインバースキネマティクス
キャラクタのアニメーションでは、脚にインバースキネマティクスを設定して、足あるいは腰の動きに合わせて膝が適切に曲がるようにで
きます。このパートでも、メインのスケルトンのジョイントを利用し、KineFX を使ってセットアップしていきます。結果も、前のパートと同じ
ようにオリジナルの階層にブレンドして戻します。

01 skeletonblend  ノードの名前を skeletonblend_controls  に
変更します。これらのノードはよく使用するので、識別しやすくし

ましょう。 

skeletonblend_controls  ノードから Delete Joints ノードを分岐させ、
Display フラグを設定します。Group の横の矢印をクリックし、Scene View 
で左右の hip、knee、ankle  の各ジョイントを選択します。Enter を押し、
Operation を Delete Non-Selected に設定します。

02 Parent Joints ノードを分岐させ、Display フラグを設定しま
す。+（プラス）記号をクリックしてジョイントを追加し、Joint1 を 

* に設定します。Parent1 は空のままにします。これで、すべてのジョイント
の接続が解除されました。各ジョイントを個別に使用できます。

03 IK Chains ノードをネットワークエディタに配置します。その 1 つ
目の入力に skeletonblend_controls  を接続し、2 つ目の入力

に parentjoints  ノードを接続します。Display フラグを設定します。

パラメータエディタで +（プラス）記号をクリックし、Root Name の横の矢
印をクリックします。l_hip  ジョイントを選択して、（Scene View にカーソル
を置いたまま）Enter を押します。Mid Name を l_knee、Tip Name を 	
l_ankle  に設定します。矢印を使用してジョイントを選択してもよいですし、
名前を入力してもかまいません。Match by Name をオンにし、Blend を 1 
に設定したら、Orient Tip をオンにします。 +（プラス）記号をもう一度クリッ
クして、右脚についても同じ手順を繰り返します。 

04 Rig Pose ノードを parent  ノードと ikchains  ノードの間に追加
します。左右の ankle  ジョイントをクリックして動かし、インバー

スキネマティクスが機能していることを確認します。Match by Name をオ
ンにしたので、ankle ジョイントは、IK チェーンのエンドエフェクタとして動
作しています。 

足首を動かすと、時々、膝が逆方向に曲がります。これは、knee ジョイント
がツイストエフェクタとして使用され、適切に配置されていないことが原因
です。脚の前方に移動するようにしなければなりません。
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FK/IK のブレンド
IK と FK をブレンドする方法はいくつかありますが、このレッスンでは使用
しません。このキャラクタの脚には IK しか使わないからです。ブレンドする
には、rigpose を使用しているアセットに脚のジョイントのパラメータをプ
ロモートしてから、IK Chains ノードの Blend アトリビュートを使用するか、
IK ソリューションと rigpose の回転ジョイントの間で Skeleton Blend を
使用します。ファー・デュードに腕があれば、このセットアップをすることに
なるでしょう。

06 rig_ankles  ノードに戻り、左右の ankle ジョイントをテストしま
す。膝をオフセットしたので、逆方向に曲がることはありません。

また、knee_offset  ノードを選んで膝を動かし、IK チェーンのツイストエフェ
クタとして動作していることも確認します。

05 Rig Pose ノードを最初の rigpose  ノードと ikchains  ノードの
間に追加します。Shift キーを押しながら両方の knee  ジョイン

トを選択し、それらをキャラクタの前方に動かします。これで、IK での膝の
向きは正常になるはずです。 

1 つ目の rigpose ノードの名前を rigpose_ankles、2 つ目の rigpose ノー
ドの名前を knee_offset  にします。

07 Skeleton Blend ノードを追加して、1 つ目の入力に 
skeletonblend_controls  ノード、2 つ目の入力に ikchains 

ノードを接続します。この新しい Skeleton Blend ノードの出力を Bone 
Deform ノードの 3 つ目の入力に接続します。

このノードの名前を skeletonblend_ik  に変更し、World Space チェック
ボックスをオンにして、weight1  を 1 に設定します。

08 rigpose_ankles  ノードに戻り、ankle ジョイントがキャプチャし
たサーフェスに作用するかどうかをテストします。 

この時点では、デジタルアセットを保存して変更をテストリグにプッシュす
る操作は行いません。最終的なリグでは、足首のコントールに rigpose_
ankles  ノードは使用しないからです。以降の手順でリバースフットのセット
アップを構築し、足全体のセットアップを機能させてから、脚全体のセット
アップをアセットに保存します。
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01 rigpose_ankles  ノードを削除します。足首は、リバースフット
のセットアップを使用してコントロールします。

skeletonmirror  ノードから Delete Joints ノードを分岐させ、Display フ
ラグを設定します。Group の横の矢印をクリックし、Scene View で 	
l_ankle、l_ball、l_toe、l_heel  ジョイントを選択します。Enter を押し、
Operation を Delete Non-Selected に設定します。

注 : ワイヤーを迂回させて、ネットワークボックスの周りを通るようにしたい
ときは、ワイヤーを Alt クリックしてドットを追加します。 

02 Parent Joints ノードを追加し、Display フラグを設定します。	
+（プラス）記号をクリックしてジョイントを追加し、Joint1 を 	

* に設定します。Parent1 は空のままにします。

2 つ目の Parent Joints ノードを分岐させ、Display フラグを設定します。
Scene View で l_heel  ジョイント、l_toe  ジョイント、l_ball  ジョイント、	
l_ankle  ジョイントとクリックします。MMB クリックして終了します。	
パラメータエディタでは、これらのジョイントが次の順番で表示されます。

	� Joint1 :@name=l_toe  | Parent1 : @name=l_heel
	� Joint2 : @name=l_ball  | Parent2 : @name=l_toe
	� Joint3 : @name=l_ankle  | Parent3 : @name=l_ball

03 Skeleton Mirror ノードをチェーンに追加します。パラメータエ
ディタの Naming で、Find Tokens を l_、Replace Tokens を 

r_  に設定します。これで、右脚のリバースフットを作成できます。

この階層内のすべてのジョイントは、オリジナルのスケルトンと同じ名前で
す。このためリグのポーズを設定する際にも、情報が正しく転送されます。

パート 13

リバースフットのセットアップ
足をコントロールするために、伝統的なリバースフットのセットアップを作成します。かかと（heel）がルートで、つま先（toe）、ボール（ball: 
土踏まずから前）、足首（ankle）の親になります。KineFX なら簡単に作成でき、元のスケルトンにブレンドできます。ここでは右足を完全
に再構築しますが、ジョイント名が揃っているので、すべて正常に機能するはずです。

04 脚にセットアップした deletejoints  と parentjoints  の間
に Skeleton Blend ノードを追加します。このノードの名前を 

skeletonblend_reversefoot  に変更し、World Space チェックボックス
をオンにして、weight1  を 1 に設定します。Group の横の矢印をクリック
し、左右の ankle  ジョイントを選択します。Enter を押します。

skeletonmirror  の後に Rig Pose ノードを追加します。rigpose_foot  に
名前を変更します。次に、skeletonblend_reversefoot  ノードの 2 つ目の
入力に接続します。  
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05 ikchains  ノードに Display フラグを設定します。rigpose_foot  
ノードに移動し、l_heel  ジョイントを選択します。そのジョイント

を動かすと、足と脚のチェーン全体が動きます。l_toe  ジョイントを選択し
て、回転します。同じようにリバースフットが機能し、IK チェーンがアクティ
ブになります。

最後は Clear を押して、すべてのジョイントを削除します。いくつかは後で
また追加します。かかとのジョイントについては、メインコントロールの一部
として前にセットアップした、heel ジョイントを使用します。

REVERSE FOOT SOP
Reverse Foot SOP は、足のコントロールや脚のキネマティクスの
駆動に利用できます。Reverse Foot SOP には足の回転を制御でき
るスライダや、部位別のコントロールがあります。ただし、このレッス
ンでは使用しません。
ここでは手作業でリバースフットソリューションを作成して、ジョイン
トをどのように操作すれば必要なコントロールが得られるかを学び
ます。 

06 つい先ほど使用したリバースフットの skeletonmirror  と 
rigpose  ノードの間に Skeleton Blend ノードを追加します。	

このノードの名前を skeletonblend_heels に変更し、World Space チェッ
クボックスをオンにして、weight1  を 1 に設定します。その 2 つ目の入力に 
skeletonblend_controls  ノードの出力を接続します。 

Group の横の矢印をクリックし、2 つの heel  ジョイントを選択します。
Enter を押します。メインコントロールの rigpose  を選択したら、左また
は右のかかとを動かして、セットアップ全体をコントロールしてみましょう。
COG ジョイントを選択して上下に動かしても、IK チェーンは適切に機能す
るはずです。

07 Attach Joint Geometry ノードを skeletonblend_heels  ノー
ドと rigpose_foot  ノードの間に配置します。その 2 つ目の入力

に、Main Controls ネットワークボックスの mergepacked  ノードを接続し
ます。このノードに Display フラグを設定し、Scene View で Enter を押し
ます。 

toe  と ball  ジョイントを選択し、G を押してスクロールホイールを使用して 
circle_ctrl  ジオメトリを見つけます。上部のオペレーションコントロール
ツールバーで、Mode を Tweak Shapes に変更します。toe  と ball  ジョイ
ントを選択し、G を押します。E を押してスケールハンドルにしたら、中央の
ハンドルをクリック & ドラッグして、コントロールを約 0.3 にスケールします。 

08 bonedeform  ノードに Display フラグを設定します。	
rigpose_foot  ノードを使用して l_ball  のポーズを決めます。

ボール（足の土踏まずから前）を回転させると、つま先は曲がるのではなく、
下を向きます。 
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RIG POSE の役割
ここまで、Rig Pose ノードを使用してリグをテストしてきました。アニメーションコ
ントロールリグを構築するときは、このノードを使って、トップレベルにプロモート
されるパラメータをセットアップしたり、デジタルアセットの使用時に表示される
ジョイントを定義することもできます。
こうしたノードのセットアップでは、不要なパラメータを誤って追加して、トップレ
ベルに余計なジョイントが追加されてしまうことがよくあります。また、X ボタンを
間違えてクリックして、必要なパラメータを削除してしまう可能性もあります。 

10 rigpose_feet  ノードを選択します。このノードには左右の ball  
と toe  のジョイントのみがリストされていることを確認します。

すべてのジョイントに対して、Translate、Rotate、Scale パラメータ上で 
RMB クリック > Lock Parameter を選択します。その後、それぞれのジョ
イントの Rotate Y で RMB クリック > Unlock Parameter を選択します。 

これで、これら 4 つのジョイントのいずれかを選択したときに、Rotate Y の
みが使用可能になりました。

09 ikchains  と skeletonblend_ik  ノードの間に Skeleton Blend 
ノードを追加します。このノードの名前を skeletonblend_toes  

に変更し、World Space チェックボックスをオンにして、weight1  を 1 に
設定します。その 2 つ目の入力に rigpose_foot  ノードの出力を接続しま
す。Group の横の矢印をクリックし、toe  と ball  ジョイントを選択します。
Enter を押します。

これで ball  ジョイントを回転すると、つま先が正しい方向を向くようになり
ました。

11 Main Controls ネットワークボックスに戻ります。Box ノード
をネットワークに追加します。Uniform Scale を 0.02 に設定

します。次に Color ノードを追加して、赤色に設定します。このノードを 
mergepacked  ノードに接続して、Name 2 を box_ctrl  に設定します。

parentjoints  ノードと knee_offset  ノードの間に Attach Joint 
Geometry ノードを配置します。その 2 つ目の入力に mergepacked  ノー
ドを接続します。Mode を Tweak Shapes に設定したら、knee  ジョイント
を選択します。G を押してスクロールホイールを使用し、box  ジオメトリを
見つけます。 

12 knee_offset  ノードに移動します。2 つの knee ジョイントのみが
リストされていることを確認します。その両方のジョイントに対し

て、Rotate と Scale パラメータ上で RMB クリック > Lock Parameter を
選択します。この 2 つのジョイントは、移動によってコントロールできるよう
になりました。 

両方の膝の Translate を -0.15, 0, -0.05 に設定します。

背骨と頭部のジョイントを定義するのに使用したこれらすべてのノードを囲
むネットワークボックスを追加し、Leg Controls  と名前を付けます。
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パート 14

脚と背骨のコントロールのプロモート
脚と背骨のすべてのコントロールをアニメータが利用できるようにするには、パラメータをアセットのトップレベルにプロモートする必要が
あります。この手順を行わないと、アニメータに必要なコントロールを渡すことができません。また、アニメータに使用してほしくないパラ
メータを非表示にしておくことも可能です。

01 Assets メニューから、Edit Asset Properties > Fur Dude 
Anim Rig を選択します。Parameters タブをクリックします。

フォルダを 4 つ作成します。それぞれ Head、Body、Legs、Main  と名前を
付けます。COG パラメータを Body フォルダ、Main パラメータを Main フォ
ルダにドラッグします。 

Legs フォルダの中に 2 つのフォルダを作成し、それぞれ Left および Right 
と名前を付けます。Left Heel  パラメータを Left フォルダに、Right Heel  
パラメータを Right フォルダに追加します。

02 knee_offset  ノードから、l_knee  の Translate 値を Leg フォル
ダの Left フォルダにドラッグします。名前を Left Knee Offset 

に変更します。Channel タブをクリックして、デフォルトを -0.15, 0, -0.1 に
設定します。 

rigpose_foot ノードで、l_ball  ジョイントから Rotate Y をドラッグし、	
名前を Left Ball Rotate に変更して、Range を 0, 30 に設定します。同様
に l_toe  ジョイントから Rotate Y をドラッグし、名前を Left Toe Rotate に
変更して、Range を 0, 20 に設定します。Knee Offset と Ball Rotate パ
ラメータの間に Separator をドラッグします。

右膝および右足についても同じ手順を繰り返します。 

03 Accept をクリックし、新しいパラメータとコントロールをアセッ
トに保存します。1 つ上のレベルに移動して、furdude_rig  にレ

イアウトされたアセットパラメータを確認します。 

これらのパラメータは、作業対象のロックしていないリグに設定されていま
す。これらのパラメータをそのままテストするのではなく、test_rig  を使って
テストしましょう。

04 ネットワークビューで、1 を押して test_rig  に戻ると、新しいコ
ントロールが表示されるようになりました。

Scene View のテストリグのさまざまな動作を、ハンドルやフローティング	
パネルのパラメータを使って試します。 
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背骨のコントロール
このリグでは、ジョイントの回転を使用して背骨をセットアップしました。これは
フォワードキネマティクスと呼ばれるものです。リグの他のパーツと同じく、メイ
ンのスケルトンのジョイントをベースに、Rig Pose でセットアップして、トップレ
ベルにプロモートします。
これらのパーツにはコントロールジオメトリは使用しませんでした。Scene View 
でジョイントを簡単に選択できるからです。すべてのジョイントにコントロールジ
オメトリが必要なわけではありません。

06 Rig Pose ノードを追加して、名前を rigpose_spine  に変更
します。skeletonblend_ik  と bonedeform  ノードの間に 

Skeleton Blend ノードを追加します。ノードの名前を skeletonblend_
spine  に変更し、World Space チェックボックスをオンにして、weight1  
を 1 に設定します。その 2 つ目の入力に rigpose_spine  ノードの出力を接
続します。 

背骨と頭部のジョイントを定義するのに使用したこれらすべてのノードを囲
むネットワークボックスを追加し、Spine Controls  と名前を付けます。

05 skeletonblend_ik  ノードから Delete Joints ノードを分岐さ
せて、その Display フラグを設定します。名前を deletejoints_

spine  に変更します。

Group の横の矢印をクリックし、Scene View で spine1、spine2、
spine3、neck1、neck2、jaw  ジョイントを選択します。Enter を押し、
Operation を Delete Non-Selected に設定します。 

07 Display フラグを設定したら、Scene View で S キーを押しなが
らすべてのジョイントを選択します。これらのジョイントがリグ

ポーズのリストに追加されます。

これらすべてのジョイントについて、Translate および Scale パラメータを
ロックします。ここでは回転のみを使用します。

08 Assets メニューから、Edit Asset Properties > Fur Dude 
Anim Rig を選択します。Parameters タブをクリックします。

neck1、neck2、jaw  を Head フォルダにドラッグして、Neck 1 Rotate、
Neck 2 Rotate、Jaw Rotate と名前を付けます。spine1、spine2、spine3  
を Body フォルダにドラッグして、Spine 1、Spine 2、Spine 3  と名前を付
けます。COG パラメータと背骨パラメータの間に Separator を追加します。

Accept をクリックします。これで新しいコントロールがリグに保存されまし
た。test_rig  でコントロールを試してみましょう。
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04 上部のオペレーションコントロールツールバーで、Mode を 
Tweak Shapes に変更します。 

eyelid  ジョイントを選択し、G を押してトランスフォームハンドルを表示しま
す。E を押してスケールハンドルにしたら、中央のハンドルをクリック & ドラッ
グして、これらのコントロールが少し小さくなるまで 3 方向すべてでスケー
ルします（パラメータエディタで約 0.5）。 

upper_eyelid  ジョイントを選択して、上に 0.02 移動します。次に、
lower_eyelid  ジョイントを選択して、下に 0.02 移動します。

01 skeletonblend_spine  ノードから Delete Joints ノードを分岐
させて、Display フラグを設定し、deletejoints_eyelids  と名

前を付けます。Group の横の矢印をクリックし、Rig Tree で upper_lid  と 
lower_lid  を選択します。カーソルを Scene View に移動して Enter を押し
たら、Operation を Delete Non-Selected に設定します。

Rig Pose ノードを追加して、名前を rigpose_eyelids  に変更します。
Display フラグを設定したら、Scene View で S キーを押しながらすべての
ジョイントを選択します。これらのジョイントがリグポーズのリストに追加さ
れます。

02 skeletonblend_spine  と bonedeform  ノードの間に 
Skeleton Blend ノードを追加します。このノードの名前を 

skeletonblend_eyelids  に変更し、World Space チェックボックスを	
オンにして、weight1  を 1 に設定します。その 2 つ目の入力に rigpose_
eyelids  ノードの出力を接続します。 

03 deletejoints  ノードと rigpose  ノードの間に Attach Joint 
Geometry ジオメトリを配置します。その 2 つ目の入力に 

mergepacked  ノードを接続します。このノードに Display フラグを設定
し、Scene View で Enter を押します。Mode が Assign Shapes に設定さ
れていることを確認します。まぶたのジョイントを 2 つとも選択したら、G を
押し、スクロールホイールを使用して circle_ctrl  ジオメトリを見つけます。

パート 15

目のコントロール
次は、コントロールジオメトリを使ってまぶた（eyelid）をセットアップし、重なり合ったジョイントを選択しやすくします。また、VOP と呼ば
れる Houdini の別のセクションを使用して、目のターゲットジョイントを眼球の Look At としてセットアップします。これらのパーツのリギ
ングが終了したら、適切なパラメータをキャラクタのアセットに再度プロモートします。
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06 skeletonblend_eyelids  ノードから Delete Joints ノードを	
分岐させて、Display フラグを設定し、deletejoints_eyes  と

名前を付けます。Group の横の矢印をクリックし、Scene View で eyeball  
および eye_target  ジョイントを選択します。Enter を押し、Operation を 
Delete Non-Selected に設定します。

Rig Pose ノードを追加して、名前を rigpose_eyetarget  に変更します。
Display フラグを設定し、Scene View で eye_target  ジョイントを選択し
ます。そのジョイントがリグポーズのリストに追加されます。Look At 拘束で
コントロールするので、eyeball  ジョイントは必要ありません。eye_target  
ジョイントについて、Rotate および Scale パラメータをロックします。 

07 Rig Attribute VOP ノードを追加します。1 つ目の入力に 
deletejoints_eyes  ノードを、2 つ目の入力に rigpose_

eyetarget  ノードを接続します。

skeletonblend_eyelids  と bonedeform ノードの間に Skeleton Blend 
ノードを追加します。このノードの名前を skeletonblend_eyeball  に変更
し、World Space チェックボックスをオンにして、weight1  を 1 に設定し
ます。その 2 つ目の入力に rigattributevop  ノードの出力を接続します。 

bonedeform  ノードに Display フラグを設定します。

08 rigattributevop  ノードをダブルクリックして、中に入りま
す。Scene View で eyeball  ジョイントをクリックし、eyeball 

(deletejoints)  バージョンをネットワークエディタにドラッグします。これに
より Get Point Transform ノードが配置されます。これは First Input か
らの eyeball  ジョイントにフォーカスするノードです。

eye_target  ジョイントをクリックし、eyetarget (ripose_eyetarget)  
バージョンをネットワークエディタにドラッグします。これにより Get Point 
Transform ノードが配置されます。これは Second Input からの eye-
target  ジョイントにフォーカスするノードです。

05 Assets メニューから、Edit Asset Properties > Fur Dude 
Anim Rig を選択します。Parameters タブをクリックします。

これらすべてのジョイントについて、Translate、Rotate、Scale パラメー
タをロックします。Rotate X パラメータをロック解除します。rigpose_
eyelids  ノードで、Rotate X を upper_lid から Head フォルダにドラッグし
ます。Range を -10, 30 に設定します。次に、Rotate X  を lower_lid から 
Head フォルダにドラッグします。Range を -20, 20 に設定します。

Separator を追加して、目のコントロールを頭部のコントロールから分割し
ます。

Accept をクリックします。これで新しいコントロールがリグに保存されまし
た。test_rig  でコントロールを試してみましょう。

09 eyeball  ジョイントをクリックし、eyeball  バージョンをネット
ワークエディタにドラッグします。Set Point Transform ノード

が配置されます。これは eyeball  ジョイントにフォーカスするノードです。
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VOP でのリギング
Rig Attribute VOP は、このレッスンで紹介したもの以外にもさまざまなソリューションを提供します。
IK チェーンはこの方法で構築でき、前に使用した IK チェーン SOP にはその 1 つが含まれています。 
VOP を使用すると、Curve Solver、Realistic Shoulder、リバースフットなどもセットアップできま
す。Scene View から VOP ネットワークにジョイントをドラッグできるこれまでにないワークフローは、
ワークフローを高速化します。

11 Attach Control Geometry ノードを deletejoints_eyes  ノー
ドと rigpose_eyetarget  ノードの間に配置します。その 2 つ

目の入力に、先ほどのネットワークから mergepacked  ノードを接続しま
す。このノードに Display フラグを設定して、Handle ツールに移動します。
Mode が Assign Shapes に設定されていることを確認します。3D ビュー
で eye_target  ジョイントを選択したら、G を押し、スクロールホイールを
使用して square_ctrl  ジオメトリを見つけます。

bonedeform  ノードに Display フラグを設定します。rigpose_target  を
クリックします。eye_target  ジョイントを選択して動かすと、それに合わせ
て眼球の向きが変わります。Undo を実行して元の位置に戻します。 

10 Tab > Look At (KineFX) を選択し、ノードを中央に配置します。
eyeball getpointtransform  ノードの xform 出力を、lookat  

ノードの from 入力に接続します。eye_target getpointtransform  ノード
の xform 出力を、lookat  ノードの to 入力に接続します。lookat  ノードの 
outxform 出力を、eyeball_set  ノードの xform 入力に接続します。

眼球のジオメトリが反転しています。lookat  ノードを選択し、Look At Axis 
を Z に設定すると、最初にリグをセットアップしたときに設定した方向と
一致します。

12 目を定義するのに使用したすべてのノードを囲むネットワーク
ボックスを追加し、Eye Controls  と名前を付けます。

Assets メニューから、Edit Asset Properties > Fur Dude Anim Rig を	
選択します。Parameters タブをクリックします。

rigpose_eyetarget  ノードで、Translate  パラメータを eye_target  か
ら Head フォルダの目（eye）のセクションにドラッグします。Eye Target 
Position と名前を付けます。  

Accept をクリックします。これで新しいコントロールがリグに保存されま
した。 

13 test_rig  でコントロールを試してみましょう。

このコントロールリグのすべてのパーツが完成しました。歩行サ
イクルのアニメーションを付け始められます。テストリグのコピーをもう 1 つ
作成し、そのネットワークを使ってアニメートします。 

このデジタルアセットは、複数のシーンファイルに複数のインスタンスを作
成できます。後で戻って変更を加えた場合、すべてのアセットが更新されま
す。これが、デジタルアセットリグを使用したパイプラインの利点です。
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01 オブジェクトレベルに移動します。Tab > Geometry を選択して
ノードを配置します。名前を walkcycle に変更します。すべての

オブジェクトの Display フラグをオフにします。

ダブルクリックして walkcycle  の中に入り、ネットワークビューで Tab > 
Fur Dude Anim Rig を選択します。Enter を押して、原点に配置します。
これは新しいロックバージョンの Fur Dude リグで、ゼロからアニメートして
いきます。

この方法では、シーンに別バージョンのキャラクタアセットを配置します。	
このシーンファイル（または任意のシーンファイル）には、複数のバージョン
を配置でき、いずれもディスク上の同じアセット定義を参照します。

02 Desktop メニュー（ここでは Build）から、Animate を選択しま
す。キーフレームワークフローに対応したパネルが表示されま

す。場合によっては、walkcycle  オブジェクトに戻る必要があります。

左側の Channel List は、キャラクタのアニメーションのブロッキングで重
要な役割を果たします。アニメーションエディタでは、アニメーションカー
ブを表示および編集できます。このレッスンでは、動きをブロッキングするま
でにとどめ、カーブの編集は行いません。 

03 ネットワークビューで、walkcycle  オブジェクト内の fur_dude_
anim_rig  を選択します。パラメータエディタで、右上のボックス

アイコンをクリックします。Parameters and Channels > Create Nested 
Channel Groups を選択します。ポップアップウィンドウで Close をクリッ
クします。アセットのパラメータがリストされ、フォルダ別に整理されてい
ます。 

fur_dude_anim_rig  チャンネルグループの横のピンアイコンをクリックし
て、これらのチャンネルをピン留めします。タイムラインがフレーム 1 に設定
されていることを確認したら、K を押して、すべてのチャンネルにキーフレー
ムを設定します。

パート 16

リグのアニメーション
ファー・デュード（Fur Dude）にキーフレームを設定して、歩行サイクルを作成します。Channel List を使用してチャンネルをピン留めし、
動きをブロッキングするなど、新しいツールも使用します。簡単な歩行サイクルを完成させて、動くファー・デュードを確認しましょう。 
ここでの目標は、基本のキーフレームワークフローを計画し、KineFX リグのアニメーション方法を理解することです。

チャンネルの動作
ジョイントを選択すると、そのチャンネルがチャンネルリストに読み込まれます。K を押すと、該当
のジョイントにキーフレームを設定できます。 ブロッキングのためにチャンネルを読み込んだまま
にしたい場合は、チャンネルをピン留めするか、チャンネルグループとしてまとめてピン留めしま
す。チャンネルグループはアセットから直接作成できます。グループは、キャラクタ用の UI をどの
ように構築したかに基づいて編成されます。独自のグループを構築して、特定のチャンネルをピン
留めすることも可能です。
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05 フレーム 15 に移動し、K を押します。 

左のかかとを回転して平らにします。ただし、移動はしません。
左足の動きに合わせて COG を動かします。左足に合わせて、右の heel  を
上に移動します。右の ball  を回転して元に戻し、足を平らにします。

COG  を左足の方に少し回転させます。背骨の 3 つのジョイントをいくらか	
回転させて、この傾きを強調してもよいでしょう。

06 フレーム 20 に移動し、K を押します。 

右の heel  を前に動かし、上に回転させたポーズを作成します。
COG  を少し下げ、左の ball  を前方に回転させます。つまり、フレーム 10 と
は逆のポーズです。

COG  と背骨のジョイントを回転して中央に戻します。 

07 フレーム 25 に移動し、K を押します。 

右の heelを回転して平らにします。ただし、移動はしません。
右足の動きに合わせて COG  を動かします。左足に合わせて、左の heel を
上に移動します。左の ball  を回転して元に戻し、足を平らにします。

COG  を右足の方に少し回転させます。背骨の 3 つのジョイントをいくらか	
回転させて、この傾きを強調してもよいでしょう。

08 フレーム 30 に移動し、K を押します。 

左の heel  を前に動かし、上に回転させたポーズを作成します。
COG  を少し下げ、右の ball  を前方に回転させます。 

COG と 背骨 のジョイントを回転して中央に戻します。

04 タイムラインを 10 で開始し、50 で終了するように設定します。
フレーム 10 に移動します。すべてのチャンネルをピン留めした

状態のまま、K を押し、もう 1 つキーフレームを設定します。先にキーフレー
ムを設定してから、ポーズを付けることをお勧めします。ポージングによっ
て、キーフレームを設定したフレームで値が更新されます。 

左の heel  を前に動かし、上に回転させたポーズを作成します。COG  を少
し下げ、右の ball  を前方に回転させます。 
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アニメ―ションのキャッシュ化
Houdini のワークフローはプロシージャルなため、アニメーションのキャッシュ化は絶対に必要なわ
けではありません。このネットワークのアニメーションは、任意のネットワークで参照してグルーミング
することもできますし、Solaris で参照するために USD に変換することも可能です。キャッシュ化のメ
リットは、アニメーションを固定したり、統合したディスク上のファイルを使用できることです。これは、
プロダクションにとって非常に好都合なアプローチです。 Solaris では、ディスクを参照する USD ファ
イルの方が効率的でもあります。Houdini はディスクからファイルを参照するので、いつでも自由にア
ニメーションを変更したり、新しいシーケンスを出力できます。また、それらを自動的に取得するよう
にできます。

10 fur_dude_anim_rig  ノードの出力を ROP Geometry ノードに
接続します。これで、ファー・デュードのジオメトリのキャッシュを

エクスポートできるようになります。Output File を次のように設定します。 

$HIP/geo/furdude_walk.$F.bgeo.sc

次に、Valid Frame Range を Render Frame Range に設定します。
Start/End/Inc パラメータで RMB クリックし、Delete Channels を選択し
ます。Start を 1、End を 50 に設定します。

Save to Disk ボタンをクリックして、キャッシュをディスクに保存します。	
これを使って後ほどファーを追加します。 

11 fur_dude_anim_rig  ノードから Attribute Delete ノードを分
岐させます。Primitive Attributes で Cd を選択します。これで、

全ボディパーツから、カラーが取り除かれます。 

12 attributedelete  ノードの出力を USD Export ノードに接続しま
す。これで、ファー・デュードのジオメトリを USD フォーマットで

エクスポートできるようになります。Output File を次のように設定します。 

$HIP/usd/furdude_walk.usd

次に、Valid Frame Range を Render Frame Range に設定します。
Start/End/Inc パラメータで RMB クリックし、Delete Channels を選択し
ます。Start を 1、End を 50 に設定します。

Save to Disk ボタンをクリックして、キャッシュを USD ファイルに保存しま
す。このファイルは、後のレンダリングプロセスで使用します。

09 このパターンをフレーム 50 まで続けます。同じポーズを繰り返
すと、前に進む歩行サイクルを作成できます。

この時点で、戻ってポーズを調整したり、動きを整えることができます。キー
フレームをさらに追加して、追従するアクションを作成してもよいでしょう。
目の動きやまばたきをアニメートしたり、もちろん、50 フレーム以上の長い
アニメーションにしてもかまいません。  
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パート 17

ファーの追加とグルーム
このキャラクタをファー・デュード（Fur Dude）と名付けたのには理由があります。さまざまなグルーミングツールを使用して、もじゃもじゃ
ヘアーを追加し、形状を整えていこうというわけです。グルーミング用に設計されたデスクトップを使用して、縮毛、クランプ（束）、ヘアー
のダイナミクスを追加し、Fur Dude の歩行に合わせてシミュレートします。完成したら、レンダリング用にエクスポートします。

01 Grooming デスクトップに切り替えます。4 つの既存のオブ
ジェクトをネットワークボックスで囲み、そのボックスに Rig & 

Animate  と名前を付けます。

ネットワークエディタで、Tab > File を選択します。ノードを配置したら、	
ダブルクリックして中に入ります。Geometry File の横のブラウズボタン
をクリックして、$HIP/geo  に移動します。furdude_walk.$F.bgeo.sc  を
選択し、Accept を押します。Blast ノードを追加し、Group を fur_dude_
body  に設定します。体に集中できるよう、Delete Non-Selected チェッ
クボックスをオンにします。Display フラグを設定したら、オブジェクトレ
ベルに移動して、名前を fd_anim  に変更します。そのオブジェクトを Alt 
ドラッグしてコピーを作成し、fd_rest と名前を付けます。その中に入り、
Geometry File を $HIP/geo/ furdude_walk.1.bgeo.sc  に変更します。

02 タイムスライダを少し進めましょう。片方のオブジェクトはファー・デュードの静的バージョンで、もう一方はアニメートされてい
ます。Add Fur ボタンをクリックします。fd_rest  ジョイントを選択して、
Enter を押します。 

次は fd_anim  ジョイントを選択して、Enter を押します。fd_rest_anim、
fd_rest_deform、fd_rest_hairgen  の Display フラグをオフにします。 

fd_rest  および fd_rest_groom  の Display フラグをオンにします。  

03 fd_rest_groom  ノードを選択し、Hair Tools シェルフで Set 
Guide Length をクリックします。Randomize ボタンをオンにし

ます。Min Length を 0.03 に設定し、右側のメニューから Texture を選択
します。 

ファイルブラウザボタンを使用して $HIP  を選択したら、tex  ディレクトリに
移動して fur_length.jpg  を選択します。

Max Length を 0.15 に設定し、Texture を再度選択します。右側の矢印
を使用して、fur_length.jpg  を選択します。

これで、目、唇、足の裏がマスクアウトされ、残ったファーの長さはランダム
になります。

04 Hair Tools シェルフで Bend Guides をクリックします。Angle 
を 45 に設定して、ガイドをいくらか曲げます。

次は Frizz Guides ツールをクリックします。次のように設定します。
	� Frequency を 15にする
	� Amplitude を 0.005 にする
	� Random Amplitude を 0.02 にする

これで、ヘアーをレンダリングしたとき、真っすぐすぎません。モジャモジャ
感を増したい場合は、縮毛を追加します。
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ヘアーブラシ
グルーミングデスクトップには、キャラクタのサーフェス上でインタラクティブに使用で
きるヘアーブラシツールもあります。ヘアーを長くしたり、滑らかにしたり、カットした
り、伸ばすことができます。ファー・デュードのグルーミングには使いませんでしたが、
後でこれらを使用して、最終的なルックに磨きをかけてもよいでしょう。

06 fd_rest deform  ノードを選択し、Hair Tools シェルフで 
Simulate Guides をクリックします。fd_rest_sim  ノードで、

Vellum Constraints タブに移動し、Bend の Stiffness を 5 に設定し
ます。 

fd_anim  ノードを Alt ドラッグしてコピーを作成し、fd_collision  と名前
を付けます。このノードの中に入り、blast  ノードで Delete Non Selected 
をオフにします。Group に舌、上の歯、歯茎を追加したら、Null ノードを追
加して COLLISION_OUT  と名前を付けます。

オブジェクトレベルで、fd_rest_sim を選択します。Vellum Collisions 
で External Collisons をオンにして、Collider SOP を ../fd_collision/
COLLISION_OUT  に設定します。

07 Caching タブをクリックして、Valid Frame Range を Save 
Frame Range に設定します。Start/End/Inc パラメータで 

RMB クリックし、Delete Channels を選択します。Start を 1、End を 
50 に設定します。Save to Disk をクリックして、シミュレーションを実行し
ます。

ここで Load from Disk チェックボックスをオンにします。フレーム毎にヘ
アーを計算するのではなく、キャッシュを使用してファーが定義されるよう
になります。  

08 fd_rest_hairgen  ノードを選択します。Distribution の 
Density を 1000000 に設定します。Guide Interpolation にス

クロールし、Clump Crossover を 0.25 に設定して、束同士が少し重なる
ようにします。これで、ふさふさのヘアーを持つファー・デュードの見た目
が定まります。 

これらは、Solaris と呼ばれる Houdini のライティングコンテキストでレンダ
リングするヘアーではありません。代わりに、ガイドヘアーを取り込んで、	
レンダリング時にヘアープロシージャルを使用してレンダリングします。

05 Hair Tools シェルフで Clump Guides をクリックします。
Clump Size を 0.02、Tightness を 0.5 に設定します。

Clump Profile を変更します。束の根本から中間では高い値を維持し、	
ヘアーの先端付近で徐々に細めます。

オブジェクトレベルに移動し、fd_rest と fd_rest_groom の Display フラ
グをオフにします。そして、fd_anim、fd_rest_sim、fd_rest_hairgen  の 
Display フラグをオンにします。 

fd_rest_groom  ノードを選択し、Density を 20000 に設定します。
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04 ステージレベルに戻ります。Material Library  の後に Assign 
Material ノードを追加します。シーングラフから fur_dude_

body  を Primitives フィールドにドラッグしたら、Material Path の横に
ある矢印をクリックして、body_mat  を選択します。横にある +（プラス）記
号をクリックして、4 つの新しいエントリを追加します。次のように割り当て
ます。

	� fur_dude_eye  > eyeball_mat
	� fur_dude_lowid/uplid  > eyelid_mat
	� fur_dude_lowteeth/upteeth/claws  > teeth_mat
	� fur_dude_tongue/gums  > tongue_mat  

01 デスクトップを Solaris に変更します。パスバーで Stage を選択
します。ネットワークビューで Tab > Reference を選択してから

クリックし、Reference ノードを追加します。 

Reference File の横にある File Pattern をクリックして、furdude_walk.
usd  を指定します。ノードの名前を furdude  に変更します。Primitive 
Path を /char/`@sourcename`  に設定し、ノード名を使用して、char  
というグループに配置されるようにします。シーングラフツリーで char、
furdude  の順に展開すると、名前の付いたプリミティブをすべて確認でき
ます。

Scene View で、ビューをホームするスペースバー + H のような表示ツール
を使用して、歩行サイクルがよく見えるようにします。

02 Tab > Material Library を選択します。それを reference  ノー
ドの出力に接続し、Display フラグを設定します。

Material Palette ペインに移動します。/stage/materiallibrary  の横
にある矢印をクリックし、このエリアを開きます。パレットの左側のマテ
リアルギャラリーをスクロールして、Principled Shader マテリアルを 
materiallibrary  作業エリアにドラッグします。

ネットワークビューに移動して、このマテリアルを Alt ドラッグしてさらに 	
4 つ作成します。5 つのマテリアルの名前を、それぞれ body_mat、
eyeball_mat、eyelid_mat、teeth_mat、tongue_mat  に変更します。
マテリアルは、シーングラフツリーでも確認できます。

03 furdude_body_mat  で、Surface タブの Base Color を 	
1, 1, 1 に設定します。Textures タブをクリックし、Base Color 

の Use Texture をクリックしてオンにしたら、Texture の横のボタンを使用
してファイルウィンドウを開きます。左側のリストで $HIP をクリックしたら、
tex  フォルダをクリックして開き、skin_color.jpg  をワンクリックして選択し
ます。Accept をクリックし、テクスチャをマテリアルに割り当てます。次に、
Roughness を 0.5、Reflectivity を 0 に設定します。

同じ手順で、eye_color.jpg  と eye_lid.jpg  をそれぞれのマテリアルに割
り当てます。tongue_mat  を赤に近いピンクに、teeth_mat  を黄色がかっ
た白に設定します。 

パート 18

ショットの設定とレンダリング
ショットのレンダリング時には、USD ファイルを Solaris ステージで参照し、背景を追加します。Solaris は Houdini のコンテキストで、
LOP ノードを使用して USD シーングラフをセットアップします。次に、ファーを読み込んで、カメラとライトを配置します。その後、Karma 
レンダラを使ってショットのプレビューレンダリングを作成してから、アニメーションシーケンスをレンダリングします。
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USD シーングラフ
Solaris で作業するとき、LOP ノードを使用して追加するジオメトリやマテリ
アルは、シーングラフに追加され、USD に変換されます。ライトやカメラを
追加すると、それらも USD シーングラフの一部になります。
アーティストの皆さんは、Houdini でライティングやレンダリングを行ううえ
で、USD を完璧に理解する必要はありません。しかし、プロジェクトのパイ
プラインの観点から考えると、USD はショット管理に便利なツールとなる
はずです。

05 ネットワークビューで、Tab を押して SOP Import と入力しま
す。クリックしてノードを配置します。hair  と名前を変更します。

Import Path Prefix を /char/$OS  に設定します。SOP Path の横のノード
アイコンをクリックして、fd_rest_hairgen  ノードに移動します。 

Merge ノードを furdude  と materiallibrary  ノードの間に追加します。
hair  ノードをそれに接続します。 

06 Material Palette ペインに移動します。	
/stage/materiallibrary  を開きます。Hair マテリアルを 

materiallibrary  作業エリアにドラッグします。

ヘアーの Root Color と Tip Color の設定はデフォルトのままにします。	
次に Secondary Reflection タブをクリックして、Root Color をダークグ
レー、Tip Color をミディアムグレーに設定します。

Assign Material ノードに戻り、Primitives の横にある矢印をクリックして、
シーングラフでファーのカーブを選択します。Material Path の横の矢印を
クリックして、hair  を選択します。 

07 ネットワークビューで、Tab を押して Grid と入力します。クリッ
クしてノードを配置します。ノード名を backdrop  に変更し、

merge  ノードに接続します。Import Path Prefix を /geo/$OS  に設定し
ます。backdrop  ノードをダブルクリックして、ジオメトリレベルに入ります。 

Grid  ノードを選択し、Size を 50, 50、Rows および Columns を 10 に設
定します。Grid  ノードの出力を RMB クリックして、Bend と入力します。	
クリックして Bend ノードを配置したら、Display フラグを設定します。
Bend を 75、Capture Origin を 0, 0, -10、Capture Direction を 0, 0, 
-1、Capture Length を 10 に設定します。bend  ノードの出力を RMB ク
リックして、Subdivide と入力します。Display フラグを設定し、Depth を 
2 に設定します。

08 オブジェクトレベルに移動し、Rotate Y を -45 度に設定します。
マテリアルを追加して割り当てます。デフォルトのグレーのままに

しても、独自のベースカラーを追加してもかまいません。

時間範囲を 10 から 50 に設定します。ヘアーが安定した挙動になるまで 
10 フレームほどかかるため、このシーケンスはフレーム 10 からレンダリン
グします。
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KARMA レンダラ
Houdini のレンダラである Karma を使用して、シーケンスをレンダリングします。Karma は USD 
をレンダリングするよう設計されており、これはレンダーデリゲートと呼ばれています。最初は 
Scene View でレンダリングします。Scene View で D を押して表示オプションを表示し、レンダ
リングをコントロールします。Denoiser をオンにしたり、Pixel Samples を設定したり、Image 
Resolution を定義することができます。  
その後 Karma LOP をセットアップすると、そのノードのレンダリング設定を使用して最終的な出力
を作成し、ディスクに保存できます。

10 Lock Camera/Light to View ボタンをオフにしたら、タンブル
してファー・デュードを見下ろすようにしましょう。LOP Lights 

and Camera シェルフで、Area Light ツールを Ctrl クリックします。
arealight  ノードをチェーンの終端に追加します。

arealight  ノードを選択し、Base Properties タブの Intensity を 2 に	
設定します。

11 Persp メニューで Karma を選択し、Scene View で Karma を
使ってレンダリングします。タイムラインの別フレームに移動する

と、Scene View が素早く更新されます。

Karma は USD を使用するよう設計されているので、LOP コンテキストの
すべてが USD シーングラフに変換されます。Houdini のこの部分からのみ 
Karma レンダラを使用できます。 

レンダリン時によりクリーンな画像を得るには、Nvidia グラフィックカード
を使用している場合には、Denoiser をオンにします。Render メニューから 
Denoiser をインストールし、Display Options バーでそれをオンにしてく
ださい。

12 Tab > Karma を押し、Karma Render Settings と USD 
Render ROP ノードを追加します。それらをチェーンの終端に接

続します。karmarendersettings  を選択して、Image Output > Filters 
タブで Denoiser を nvidia Optix Denoiser に設定します。Output 
Picture を $HIP/render/walk/furdude_walk_$F2.exr  に設定します。
名前の $F  は、レンダリングにフレーム番号を付加するためのもので、2  は	
フレーム番号のパディングです。

usdrender_rop  を選択します。Start/End/Inc パラメータを RMB クリッ
クし、Delete Channels を選択します。Start を 10、End を 50 に設定し
ます。usdrender_rop  ノードを選択します。Render to Disk をクリックし
ます。

09 表示ツールを使用して、正面から furdude  が見えるようにしま
す。LOP Lights and Camera シェルフで、Camera ツールを 

Ctrl クリックします。ネットワークに camera ノードが加わり、カメラ越しに
シーンビューを見られるようになります。 

Lock Camera/Light to View ボタンを押し、ビュー変更に応じてカメラの
位置が更新されるようにします。Scene View でタンブル、パン、ドリーして
カメラを再配置し、ファー・デュードが左から右に動くようにします。タイム
ラインをスクラブし、シーケンス全体でカメラが機能していることを確認し
ます。

Denoiser を 
オンにする
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まとめ
Houdini の KineFX ツールを使用して、Fur Dude キャラクタのリギ
ング、アニメーション、レンダリングを行いました。キャプチャリグを
作成し、その上にアニメーションコントロールリグを重ねるなど、 
さまざまな重要な手順を見てきました。また、キャラクタを Houdini 
Digital Asset にパック化し、一般的な歩行サイクルのキーフレーム
を設定しました。
その後、さまざまなグルーミングツールを使ってファーを追加し、
Karma でレンダリングしました。ワークフローを一通り実行し、 
キャラクタのショットを作成できました。より完璧な結果を追求した
い場合は、戻って手順の一部を調整し、何度もやり直してください。

冒頭で述べたように、KineFX ツールセットの現時点での主な用途
は、本レッスンでは取り上げなかったリターゲティングとモーション
編集です。KineFX のリギングおよびアニメーションツールは進化を
続けています。このレッスンでは、今後の Houdini のプロシージャ
ルリギングワークフローの可能性を、わずかながら、体験していた
だきました。 

14 ヘアーやファーの設定を調整したい場合は、Scene View を LOP ネットワークにピン留めしてから、オブジェクトレベルに戻り、
Simulate Guides ノードで Load from Disk チェックボックスをオフにしま
す。これで、変更はすべて最終的なレンダリングに反映されます。

ヘアーが短くなり、さらにモジャモジャになりました。好きなように調整して
ください。完了したら、再キャッシュ化して、Load from Disk を再度オンに
します。

13 完了したら、Render > Mplay > Load Disk Files を選択し、	
レンダリングした画像を開いて最終的なシーケンスを確認し

ます。 

その後で別の Karma ノードを分岐させ、解像度とレンダリング設定を上げ
て最終的なレンダリングを行います。最初は低解像度でテストレンダリング
を行い、すべてが希望通りになっていることを確認するようにしてください。

15 Solaris ネットワークに戻って、ファーの色を変更し、再レンダリングすることもできます。

最終レンダリングでは、解像度を 1920 x 1080 に上げるなど、画質の設
定を変更しましょう。たとえば、Pixel Samples を 128、Light Sampling 
Quality を 16 に設定するとよいでしょう。
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	  		  181

HOUDINI FOUNDATIONS

UNREAL 用	
プロシージャルアセット
Houdini のノードベースのワークフローを使用してゲームアセットを作成するには、プロシージャルな考え方と	
作業方法を学ぶことが重要です。このレッスンでは、プロシージャルなノードとネットワークを使用してゲームア
セットを作成する方法と、Houdini Engine エンジンを使用してそれらを直接 Unreal に取り込む方法を学習します。

その過程で、Houdini のユーザインターフェースのさまざまな機能を使っていきます。UI 要素がどのように連携	
して、ゲームアセットの構築をサポートするのかを学びましょう。

このレッスンは、Unreal Engine 5 で実行可能です。Unreal を使ってレッスンを進めていきますが、Houdini 
Engine を使用して、同じアセットを Unity にインポートすることもできます。 

レッスンの目標
ゲームアートとして Unreal にインポートするアセットを作成します。 

学習内容
	� ノードとネットワークを使って、データの流れを制御する方法
	� Houdini デジタルアセットを使用して、ソリューションをパッケージ化したり、他のユーザと共有する方法
	� Unreal Editor に Houdini デジタルアセットをロードする方法
	� オブジェクトをポイントにインスタンス化し、アトリビュートを使用してオブジェクトの向きやスケールを	
制御する方法 
	� 衝突ジオメトリを含むゲームアセットを作成し、Unreal で使用する方法
	� リジッドボディシミュレーションを FBX ファイルとして Unreal にエクスポートする方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✔

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✘

Houdini Education ✔

ドキュメントバージョン 4.0.1J | 2023 年 8 月
© SideFX Software



パート 1

シンプルなビルの作成
プロシージャルなノードネットワークを使用して、シンプルなビルを作成する方法を学習します。Scene View での操作で作成される 
ノード、ネットワークビューで作成されるノード、両方のノードがあります。あるノードの一部をシステム内の別のノードと接続するには、 
チャンネル参照を使用します。このようにして作成されたプロシージャルソリューションは、Houdini デジタルアセットにラップすることが
できます。 

01 File > New Project を選択します。hengine_lesson  と名前を
付け、Accept を押します。File > Save As... を選択し、ファイ

ル名を hengine_01.hip に設定したら、Accept をクリックして保存します。 

ビューポートで、C を押して、Create > Geometry > Grid を選択します。
Enter を押して、グリッドを原点に配置します。Scene View の上部のオペ
レーションコントロールツールバーで、次のように設定します。

	� Size を 5, 3 にする
	� Rows を 4 にする 
	� Columns を 6 にする

V を押して Shading > Smooth Wire Shaded を選択します。

02 C を押して Create > Geometry > Box を選択します。Enter 
を押して原点に配置します。ネットワークビューで box_object  

をダブルクリックします。これで、ジオメトリレベルでオブジェクト内に入り
ます。次のように設定します。 

	� Size を 0.1, 1, 0.1 にする

box  ノードを column  という名前に変更します。Scene View で Tab を押し、
Match Size と入力していき、Match Size を選択します。N を押してボック
スを選択し、Enter を押します。これにより、新しいノードが追加されます。
パラメータエディタの Matching で、Justify Y を Min に設定します。	
これでボックスが持ち上がり、地面の上に配置されます。

03 U を押してオブジェクトレベルに戻るか、ネットワークビューの
パスバーで obj をクリックします。Select ツールをクリックし、

何もない空間をクリックしてすべてのオブジェクトを選択解除します。

Modify シェルフで Copy to Points をクリックします。コピーするジオメト
リとして柱を選択し、Enter を押します。次に、コピー先となるポイント上
のジオメトリとしてグリッドを選択し、Enter を押します。

パラメータエディタで、Transform Using Implicit Target... をオフにし
ます。すると、柱が立ち上がります。Pack and Instance をオンにして、
Unreal でジオメトリがインスタンス化されるようにします。4 を押してプリミ
ティブ選択モードに移動します。こうすると、すべてのコーナーポイントが	
非表示になります。

04 ネットワークビューで Tab > PolyExtrude を押します。それを
横に配置します。grid ノードを polyextrude  ノードに接続し

たら、Display フラグを設定します。Distance を 0.1 に設定し、Output 
Geometry and Groups の Output Back をオンにします。copytopoints 
ノードに Template フラグを設定します。

ネットワークに Match Size ノードを追加し、polyextrude  を 1 つ目の入
力、copytopoints  を 2 つ目の入力に接続します。Justify Y を Max to 
Same、Offset を 0.1 に設定します。これで、押し出された形状が柱の上
に配置されます。

Merge ノードを追加し、それに copytopoints  と matchsize  を接続し
ます。 
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05 ネットワークビューで、Tab > Group を押します。それを、
polyextrude  と matchsize  の間に接続します。Group Name 

を edges  に変更します。
Alt ドラッグして group  ノードをもう 1 つ作り、Display フラグを設定し
ます。Group Name は edges  のままで、Initial Merge を Subtract 
from Existing に設定します。Base Group で Enable をオフにし、Keep 
by Normals で Enable をオンにします。Direction を 0, 1, 0、Spread 
Angle を 0 に設定します。このノードを Alt ドラッグしてコピーを作成
し、チェーンに接続します。Direction を 0, -1, 0 に変更します。これで、
edges  グループ内にあるのはボックスの側面のみとなりました。
PolyExtrude ノードを追加します。Group を edges  に、Distance を 0.15 
に設定します。

06 merge  ノードに Display フラグを設定し、ビルの 1 階をすべて
表示します。copytopoints  ノードの Template フラグをオフに

します。

Scene View で、N を押してすべてを選択してから、Tab > Copy and 
Transform を選択します。column  ノードを選択し、Center Y を RMB 
クリックして Copy Parameter を選択します。copy  ノードに移動し、
Translate Y を RMB クリックして、Paste Relative References を選択し
ます。エクスプレッションに + 0.1 を追加します。

ここで、Total Number を 4 に増やして、3 フロア追加します。 

07 ネットワークエディタですべてのノードを選択します。Assets 	
メニューから、New Digital Asset From Selection を選択し

ます。これにより、ネットワークがサブネットワークに折り畳まれ、そのサブ
ネットノードを使用してデジタルアセットが作成されます。

Operator Name を building  にすると、Operator Label が Building  
に変更されます。Save to Library の右端のボタンをクリックします。
Locations  サイドバーで、$HIP/ をクリックしてから hda  ディレクトリをダブ
ルクリックします。Accept を押したら、再度 Accept を押してアセットをディ
スクに保存します。

08 Edit Type Properties ウィンドウが開きます。このパネルで、
アセットのユーザインターフェースを構築します。このウィンドウ

はまた後で使用します。Accept をクリックして、このウィンドウを閉じます。

ネットワークビューのノードを building という名前に変更します。

アセットを構築するのに使用したノードは、保存した後もアセットの一部で
あり続けます。このため、Unreal ゲームレベルでアセットを使い始めた後
も、引き続き変更を加えることができます。

HDA ファイルとは ?
Houdini ノードとネットワークは、Houdini デジタルアセットと 
呼ばれる単一のノードにカプセル化でき、それを利用してテクニック
を同僚と共有できます。アセットは、ディスク上の .hda ファイルと 
呼ばれるファイルに保存されます。 
Houdini の旧バージョンで作成したアセットファイルは、 
.otl（Operator Type Library）という別の拡張子が付いていますが、 
どちらのタイプのファイルも同じように使用できます。

.hda ファイル

Houdini

デジタル アセット 
として 保存
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パート 2

Unreal にアセットをインポート
デジタルアセットファイルがディスクに保存され、Unreal Engine にインポートできる状態になりました。これが可能なのは、 
Houdini Engine プラグインが 2 つのアプリケーションを繋いでいるからです。Unreal にロードされる Houdini デジタルアセットは、
Houdini を使用して内部的にクックされます。このレッスンを完了するには、Houdini Engine for Unreal プラグインをインストール 
する必要があります（Sidefx.com/unreal をご覧ください）。Houdini Apprentice で Houdini Engine を実行することはできません。  

01 UNREAL で – ブループリントをサポートするサードパーソン
テンプレートをセットアップします。TextRenderActor  を	

削除します。Content Browser を開き、Import ボタンをクリックします。	
Content Browser をドッキングさせておくとよいでしょう。Houdini プロ
ジェクトに移動し、building  アセットを指定します。Open をクリックし
ます。 

Scale を 2, 2, 2 に設定し、アセットをコーナーに移動します。Play ボタン
を押すと、ゲームプレイ中にビルを確認できます。 

02 HOUDINI で – ジオメトリに法線と衝突を追加するには、ネット
ワークにノードをいくつか追加する必要があります。 

building  ネットワークに入り、polyextrude  と matchsize  ノードの間に 
Normal ノードを追加します。ジオメトリに法線が追加され、Unreal 内で適
切に表示されるようになります。normal  ノードの下に Group ノードを追加
し、Group Name を rendered_collision_geo  に設定します。これにより、
ジオメトリが衝突ジオメトリになります。

これら 2 つのノードをコピーアンドペーストして、新しいノードを column  
ノードの下に挿入します。

03 UNREAL で – building  アセットの Details パネルの Generate 
セクションで、Rebuild を押します。Play を押して、シーンを	

確認します。 

法線が適切に動作し、通り抜けようとすると、柱と衝突するようになりま
した。

04 HOUDINI で – Assets > Edit Asset Properties > Building 
を選択します。Type Properties ウィンドウで Parameters タブを

クリックします。column  ノードを選択し、Size Y パラメータを Parameter 
タブにドラッグします。それを Floor Height という名前に変更します。
次に、copy  ノードから Total Number パラメータをドラッグし、名前を 
Number of Floors に変更します。Accept をクリックします。 
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09 UNREAL で – Rebuild を押し、Floor Height を 1、	
Number of Floors を 6 に設定します。Play を押し、斜面を	

上がってビルを見て回ります。

06 HOUDINI で – HOUDINI に戻り、床板である polyextrude  	
ノードに Display フラグを設定します。4 を押してプリミティブ

選択にします。上部の中央にある 3 つのプリミティブを Shift を押しながら
選択したら、そのままタンブルして、スラブの下部の 3 つのプリミティブを選
択します。Delete を押します。これにより、Blast ノードが追加されます。

3 を押してエッジ選択にします。穴の下部のエッジをダブルクリックし、ルー
プ全体を選択します。Tab > PolyBridge に移動して Enter を押します。穴
の上部のエッジをダブルクリックし、Enter を押します。これにより、穴の
内側にジオメトリが追加されます。

07 matchsize  ノードに Display フラグを設定します。突出部の
ある新しい穴が表示されます。  

4 を押してプリミティブ選択にします。Select ツールにして、穴の側面を
選択します。選択されているようには見えませんが、実際にはされていま
す。Tab > PolyExtrude を押します。Extrusion で、Transform Extruded 
Front をオンにします。フェースを引き出し、下げます。

08 column  ノードの Size Y チャンネルをコピーし、Paste 
Relative Reference で新しい polyextrude  ノードの 

Translate Y にペーストします。エクスプレッションに −（マイナス）記号を	
追加し、0.1 を減算します。エクスプレッションは次のようになります。
-ch(“../column/sizey”)-0.1

Translate Z を 2.7 に設定します。

normal  と group  ノードを、polyextrude  ノードの後に移動します。	
こうすることで、新しい押し出しが衝突ジオメトリになり、斜面が適切に	
動作します。

output  ノードに Display フラグを設定します。Assets > Save Asset > 
Building を選択し、変更をディスク上の HDA ファイルに保存します。

05 UNREAL で – ビルのアセットの Details パネルで Rebuild を	
押します。下にスクロールすると、Floor Height と Number 

of Floors のパラメータを確認できます。 

Floor Height を 1.2、Number of Floors を 2 に設定します。

Play を押してアセットを見て回ったり、変更をレビューします。 
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UV
Houdini には、ジオメトリレベルで UV のセットアップと管理を行えるさまざまな 
ノードがあります。このレッスンでは、UV Unwrap と UV Transform を使用して 
ビルに UV を追加します。これらのノードは、ビルのモデリングに使用したようなシンプ
ルな形状でうまく機能します。より複雑な形状には、UV Flatten や UV Layout などの
ツールを使用します。
UV を配置すると、ジオメトリに UV グリッドが表示されます。グリッドを非表示にしたい
場合は、Display Options バーの Show UV Texture ボタンをクリックすると、オンと
オフを切り替えられます。

Show UV Texture

10 HOUDINI で– ゲームエディタで使用するには、ジオメトリに 
UV を追加する必要があります。ネットワークの column  ノード

がある部分に移動します。Tab > UV Unwrap を押し、column  ノードと 
normal  ノードの間にノードを配置します。

ネットワークの 2 つ目の polyextrude  ノードがある部分に移動します。
Tab > UV Unwrap を押し、polyextrude  ノードと normal  ノードの間に
ノードを配置します。  

11 柱に UV グリッドが表示されます。柱と床のグリッドのスケールが一致していません。Tab > UV Transform を押し、uvunwrap  
ノードと matchsize  ノードの間にノードを配置します。Scale を 5, 5, 5 に
設定します。これで、同じような UV になります。

Assets > Save Asset > Building を選択し、変更をディスク上の HDA ファ
イルに保存します。

  

12 UNREAL で – Rebuild を押します。マテリアルが追加されるま
で、UV は表示されません。 

Content Browser で、Content > Starter Content > Materials に移動
します。Building  アセットが選択されていることを確認し、M_Concrete_
Tiles  などのマテリアルを Scene View のビルのジオメトリに追加します。	
柱と床板の両方にドラッグしてください。

13 Play を押してレベルを歩き回り、テクスチャ付きのビルを探検し
ましょう。

このアセットは、1 つのレベルで何度も使用して、階数や高さの違うビルを
作れます。また、さらに多くのパラメータをアセットにプロモートすれば、	
より詳細にコントロールすることも可能です。デジタルアセットのネットワー
クやパラメータインターフェースに変更を加えると、レベル上のすべてのア
セットが即時に更新されます。

186

HO
UD

IN
I F

OU
ND

AT
IO

NS



パート 3

ポイントへのコピー
このパートでは、いくつかのボックスを別のグリッドのポイントにコピーします。次に、ポイントをランダム化してより有機的なルックに 
したり、ランダムなアトリビュートを追加してボックスを回転およびスケールすることで、形状の分布にバリエーションを持たせます。 
このようにしてもう 1 つプロシージャルシステムを作成し、後ほど Houdini デジタルアセットにラップします。 

01 HOUDINI で – オブジェクトレベルに移動して、ビルを非表示に
します。ビューポートで、C キーを押して Radial メニューを表示

し、Create > Geometry > Grid を選択します。Enter を押して原点に配置
します。このグリッドサーフェス上のポイントを使用して、ジオメトリをインス
タンス化していきます。

同じ Radial メニューを使用して Create > Geometry > Box を選択し、	
再度 Enter を押して原点に配置します。ビューポートの上部のオペレーショ
ンコントロールツールバーで、Size を 0.1 0.1 0.1 に設定します。このジオ
メトリを、グリッド上のポイントにコピーしていきます。

02 ボックスを選択したまま、Modify シェルフに移動して Copy to 
Points を選択します。グリッドを選択して、Enter を押します。

これで、ボックスがすべてのグリッドポイントにコピーされました。 

パラメータを編集して、システムのルックを調整します。grid  ノードを選択
し、Size を 6, 6、Rows と Columns を 12 に設定します。グリッドが増え、
ポイントの数も増加しますが、ボックスはすべてのポイントにコピーされて
いません。copytopoints  ノードをクリックすると、Target Points が元の	
グリッドのポイントに合わせて 0-99 に設定されているのが分かります。
0-99 を削除して、グリッド全体にボックスをコピーするようにします。

03 ネットワークエディタで、Tab > Scatter を選択します。ネット
ワークエディタの grid  と copytopoints  ノードの間に scatter  

ノードを配置します。すると、このノードが自動的にネットワークに接続さ
れ、ボックスが新しいポイントにコピーされます。

Force Total Count を 250 に設定します。Relax Iterations を変更し、	
ポイントの配置を調整します。scatter ノードを使用すると、元のグリッド
ポイントよりも有機的な配置にすることができます。

SOURCE GROUP
Scene View でモデリングする場合、選択したジオメトリは、ツールに
応じて番号付きのポイントまたはプリミティブとして、Source Group 
フィールドに設定されます。フィールドが空の場合、ツールはすべての
ポイントまたはプリミティブに作用します。 
ジオメトリレベルでツールを使用する場合、ツールを使用する前に 
Select All（N キー）を選択すると、このフィールドは空になります。 
ここでは 0-99 のポイントが設定されていますが、これはオブジェクト
レベルで copytopoints  をセットアップしたからです。
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アトリビュートの仕組み
ジオメトリに割り当てられたアトリビュートは、ネットワークチェーンを通じてさま
ざまなノードに渡されます。このネットワークの場合、グリッドジオメトリに
割り当てられたアトリビュートは、ばら撒かれたポイントに渡されて、
コピーされたジオメトリに作用しています。Houdini では、このよう
にしてデータの流れがコントロールされています。
アトリビュートは最初グリッド上のポイントに割り当てられるため、 
ポイント数が多いほど、アトリビュート値がランダムになります。

05 ネットワークエディタで、Tab を押して rand... と入力し
ていき、Attribute Randomize ツールを選択します。

attributerandomize  ノードを grid  と scatter  ノードの間に配置します。
デフォルトのアトリビュートがカラー (Cd) のため、最初はボックスがランダ
ムなカラーで表示されます。

Attribute Name を N に設定します。これによりアトリビュートが法線方向
に変わり、すべてのボックスが異なる方向を向くようになります。	
Max Value Y を 0 に設定し、ランダム化を X 方向と Z 方向に制限します。
ノードの名前を attribrandomize_rotate  に変更します。

06 Alt キーを押しながら attribrandomize_rotate  ノードを	
ドラッグし、コピーを作成します。それを、attribrandomize_

rotate  と scatter  ノードの間にドロップします。ノードの名前を 
attribrandomize_scale  に変更します。

次のように設定します。
	� Attribute Name を pscale  にする 
	� Min Value を 0.5 にする
	� Max Value を 2 にする  

これにより、グリッド上のボックスのサイズがいい具合にばらつき す。

07 grid ノードを選択し、Rows と Columns を 30 に上げます。	
グリッドのポイント数が増え、さらにランダムにポイントが	

ばら撒かれるようになります。

作業内容を保存します。 

04 ネットワークビューで Tab を押して、Match Size と入力して
いき、Match Size を選択します。このノードを box  ノードと 

copytopoints  ノードの間に配置します。パラメータエディタの Matching 
で、Justify Y を Min に設定します。

box  ノードで、Size Y を 0.3 に設定してエクスプレッションをテストします。
すべてのボックスが地面の上にあることが確認できます。 
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パート 4

Houdini デジタルアセットをもう 1 つ作成
このパートでは、デジタルアセットを 1 つ作成し、Unreal でシステムをテストします。ビルと同じように、ネットワークをラップして、 
結果を HDA ファイルとしてディスクに保存します。一部のパラメータをプロモートして、グリッドサイズ、ポイント数、リラックス化を 
コントロールできるようにします。そのパラメータは、Unreal でも使用できます。 

01 ネットワークエディタですべてのノードを選択します。Assets メ
ニューから、New Digital Asset From Selection を選択しま

す。これにより、ネットワークがサブネットワークに折り畳まれ、そのサブネッ
トノードを使用してデジタルアセットが作成されます。

アセットを構築するのに使用したノードは、保存した後もアセットの一部で
あり続けます。このため、ゲームレベルでアセットを使い始めた後も、引き
続き変更を加えることが可能です。

02 Operator Name を populate  にすると、Operator Label が 
Populate  に変更されます。Save to Library の右端のボタン

をクリックします。Locations  サイドバーで、$HIP/ をクリックしてから hda 
ディレクトリをダブルクリックします。Accept を押したら、再度 Accept を	
押してアセットをディスクに保存します。 

これにより、このシーンで参照される新しい Houdini デジタルアセットファイ
ル（.hda）が作成されます。別の Houdini シーンで参照することも、Houdini 
Engine を使用して Unreal など別のアプリケーションで参照することもでき
ます。

03 Edit Type Properties ウィンドウが開きます。このパネルで、
アセットのユーザインターフェースを構築します。このウィンドウ

はまた後で使用します。Accept をクリックして、このウィンドウを閉じます。

Houdini デジタルアセットのプロシージャルな性質を維持するために、ハイ
レベルなインターフェースを構築して、ネットワーク内のノードにアクセスで
きるようにします。レッスンの後半では、このアセットのインターフェースを
増やします。

04 UNREAL で – Content Browser で、Content  ディレクトリに	
戻ります。Import をクリックし、現在のプロジェクトディレ

クトリの populate.hda  ファイルを指定します。そのアセットを Content 
Browser から 3D ワークスペースにドラッグします。 

Play を押してアセットを見て回ります。アセットはありますが、特に変わっ
たところはありません。Esc を押してアセットの UI に戻ります。 
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頂点法線
デフォルトでは、ボックスなどの Houdini オブジェクトには、ポイント
法線はありますが頂点法線がありません。適切な頂点法線を設定す
るには、Normal ノードを追加し、cusp 値を使用してハードに見せ
たいエッジと、ソフトに見せたいエッジを決定する必要があります。
Unreal などのゲームエディタは、適切な表示に頂点法線を必要とし
ますが、これは既存のネットワークで簡単にセットアップできます。

法線あり 法線なし

05 HOUDINI で – Unreal でアセットについて気になるのは、ボッ
クスの角がくっきりしていないことです。これを修正するには、

Houdini に戻り、ネットワークエディタで Tab を押して norm... と入力して
いき、Normal ツールを選択します。

matchsize ノードの直後に Normal ノードを追加します。Assets メニュー
から、Save Asset > Populate を選択します。これにより .hda ファイルに
変更が保存されるため、.hda ファイルをロードしたすべての人が更新され
たアセットを使用できるようになります。ここでは、Unreal 内でアセット定
義を更新し、正しい法線を表示させます。

06 UNREAL で – Details パネルの Houdini Asset で、Cooking 
Actions セクションを開きます。Rebuild ボタンをクリックし、

変更を確定します。これにより、Houdini 内で加えられた変更が、Unreal 
シーンで適切に更新されます。

アセットの法線は適切になりましたが、プロシージャルネットワークをコント
ロールすることができません。Houdini で使用できるインターフェースを作
成するため、一部のパラメータをアセットの内部からトップレベルにプロモー
トします。

07 HOUDINI で – Assets > Edit Asset Properties > Populate 
を選択します。Parameters タブをクリックします。ネットワーク

エディタで、grid  ノードをクリックします。パラメータエディタから、Size パ
ラメータを Existing parameters リストの root にドラッグします。 

ネットワークエディタで、scatter  ノードをクリックします。パラメータエ
ディタから、Force Total Count パラメータを root にドラッグします。
Parameter Description で、Label を Number of Instances に変更しま
す。Relax Iterations と Max Relax Radius をドラッグして、これらのパラ
メータをアセットに追加します。Accept をクリックすると、これらの新しい
パラメータがアセットに保存されます。

08 UNREAL で – Rebuild ボタンをクリックして変更を確定します。
パラメータエディタにプロモートしたパラメータが表示されてい

ます。Size と Number of Instances を変更して、ボックスのグリッドのルッ
クにどう影響するかを確認します。

これで、アセットのプロシージャルな性質を体験し、それぞれのレベルに特
有のアセットを作成できるようになりました。このレベルで populate  アセッ
トを複数追加すると、.hda ファイルの同じアセットを参照しながら、それぞ
れのアセットに独自の設定を持たせることができます。このアセットを複数
のレベルで使用して、複数のアーティストが作業することも可能です。
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パート 5

インスタンス化のセットアップ
Houdini でインスタンス化を適切にセットアップすると、ポイントにコピーしたデフォルトの形状を、別の Unreal プロップに置き換え 
られます。複数のプロップを追加して、デフォルト形状の代わりにランダムに分布させることができます。ここでは、インスタンス化が 
実際に適切にセットアップされていることを確認し、それを利用して別のプロップをシステムに追加していきます。  

HOUDINI のパックプリミティブ
Houdini では、パックプリミティブを使用すると、ビューポート表示やレン
ダリング向けに効率的にインスタンスを管理できます。コピーノードに接
続されているジオメトリが単一のプリミティブにパックされ、インスタンス
のように扱われます。このレッスンで示されているボックスのコピーであ
れば、パック化を実行すると、プリミティブが 1,500 から 250 に減少します。
Houdini Engine for Unreal プラグインを使用すると、パックプリミティブ
は Unreal インスタンスとして認識されるため、より効率的なゲームプレイ
が可能になります。

01 UNREAL で – Details パネルで Houdini Outputs を開きま
す。すべてのボックスが単一のメッシュとしてインポートされて

いることが分かります。つまり、まだインスタンス化は使用されていません。
Houdini は、ボックスをポイントにコピーし、結果のジオメトリを Unreal 用
に出力しています。

これは、ゲームプレイにとってあまり効率的ではありません。セットアップを
少し変えてインスタンス化し、このツールが適切に機能するようにする必要
があります。

02 HOUDINI で – copytopoints  ノードを選択し、Pack and 
Instance をオンにします。Assets メニューから、Save Asset 

> Populate を選択します。

パックプリミティブを使用することで、copytopoints  ノードに接続され
ているボックスジオメトリが単一のプリミティブとして扱われます。これで 
Houdini でインスタンス化がセットアップされ、Houdini Engine プラグイン
を使用してこのアセットがエディタにロードされると、Unreal でのインスタ
ンス化がトリガされるようになりました。

03 UNREAL で – Rebuild ボタンをクリックして変更を確定します。
Houdini Outputs セクションに移動します。1 つのボックスの

みがインポートされ、ポイントにインスタンス化されていることが分かりま
す。そして、前にセットアップしたアトリビュートに基づいて、回転および	
スケールされます。 

デフォルトのボックスを、Unreal 環境で他のジオメトリに置き換えることが
できました。エディタでの柔軟性が高く、さまざまなオブジェクトをシステム
に追加できるので、複数のポイントに配置したい場合にはこの方法が最適
です。
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UNREAL のインスタンス
Houdini Engine プラグインがパックプリミティブを検出すると、
Details タブに Houdini Output Instancer が作成されます。そこに
は、入力ジオメトリと、インスタンスを回転およびスケールするための
パラメータが含まれています。このインスタンスを、Unreal のコンテン
ツウィンドウのジオメトリと置き換え、適切なサイズに変えることがで
きます。+（プラス）記号を使用して、インスタンス化する入力を追加す
れば、同じシステム内でさらにバリエーションを作成できます。

04 Houdini Outputs セクションに移動し、HoudiniOutput1  
Instancer  を展開します。このボックスのインスタンスを、

Unreal 内のコンテンツで置き換えます。

Content Browser で、StarterContent > Props を開きます。SM_Bush  
プロップを Houdini Outputs 上にドラッグします。3 軸すべての Scale 
Offset を 0.25 に設定します。ジオメトリが populate アセットのポイントに
インスタンス化され、ボックスと同じように回転およびスケールされます。 

05 インスタンスオブジェクトの横にある +（プラス）記号をクリック
します。これで 2 つ目が追加されます。SM_Rock  プロップを	

新しい Houdini Instanced Input 上にドラッグします。3 軸すべての 
Scale Offset を 0.1 に設定します。

Details パネルで、Houdini Engine セクションにスクロールして、Bake 	
ボタンをクリックします。Outliner で、HoudiniAssetActor  にスクロールし
ます。目のアイコンをクリックして非表示にして、デジタルアセットに集中で
きるようにします。Play を押してシーンを歩き回り、実際に置き換えられた
インスタンスを確認します。 

06 茂みのオブジェクトの横にある +（プラス）記号をクリックします。
これで 3 つ目が追加されます。Content > LevelPrototyping 

> Meshes フォルダに移動します。SM_ChamferCube  を新しい Houdini 
Instanced Input 上にドラッグします。Scale Offset を 0.4, 0.4, 0.2 に	
設定します。

インスタンス化されたオブジェクトをさらに追加し、バリエーションを増や
したり、サイズを変えたりします。インスタンス同士を少し離したい場合は、
Relax Iterations パラメータを使用します。

07 building  アセットの Details パネルの Generate セクションで、
Rebuild を押します。Bake セクションで、Replace Preview 

Bake をオンにし、Bake ボタンをクリックします。

Play を押してシーンを歩き回り、インスタンス化されたジオメトリを確認し
ます。衝突ジオメトリが適切にセットアップされている、キューブと衝突する
ようになりました。インスタンス化したオブジェクトには、衝突ジオメトリを
適切にセットアップしましょう。 
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04 UNREAL で – Rebuild ボタンをクリックして変更を確定します。
新しい populate  アセットを前景にドラッグします。Houdini 

Parameters セクションに移動し、Select Input メニューから Input 
Geometry を選択します。 

Details パネルで Houdini Inputs セクションに移動し、メニューから 
World Outliner Input を選択します。Start Selection ボタンをクリッ
クし、3D シーンで傾斜とプラットフォームのすべてのパーツを選択します。
Use Current Selection をクリックすると、インスタンスが細分化された	
プラットフォーム内にばら撒かれます。しかし、私たちが求めているのはこれ
ではありません。

01 HOUDINI で – Assets > Edit Asset Properties > Populate 
を選択します。Basic タブで、Maximum Inputs を 1 に設定し

ます。Type Properties ウィンドウで Accept をクリックし、変更を保存しま
す。これによりアセット内に入力ノードが作成され、ネットワークに接続でき
ます。後でこの入力を使用して、Unreal シーンからジオメトリを選択します。

Minimum Inputs は 0 のままにしておきます。これより高く設定すると、	
入力の最小要件が満たされないと、アセットが機能しません。そうなると	
アセットはクックされず、何も起こりません。

02 ネットワークエディタで、grid の後に Switch ノードを追加し、
新しい Input に接続します。Subdivide ノードを追加して入力

ノードの後に接続し、アトリビュート値のランダム化の際に十分なディテー
ルが得られるようにします。Depth を 5 に設定します。

subdivide ノードにエラーが発生するのは、Houdini で 3 つ目の入力に	
何も接続されていないからです。1 つ上のレベルに戻り、box をアセット
の入力に接続して、これがどう機能するかをプレビューしやすくします。
Houdini でボックスは球に細分化されますが、最終シーンではこのようには
なりません。

03 Assets > Edit Asset Properties > Populate を選択します。
switch  ノードから、Select Input パラメータをパラメータリス

トにドラッグします。Select Input パラメータを選択します。Menu タブを
クリックして、Use Menu をオンにします。 

0, Grid、次に 1, Input Geometry を追加します。Type Properties ウィ
ンドウで Accept をクリックし、変更を保存します。

これにより、アセットの UI にメニューが追加され、Unreal で使用できるよう
になります。

パート 6

ジオメトリを使用してアセットを駆動
ここまでは、このアセットが populate アセットに入力ジオメトリを供給してきました。Unreal シーンの既存のジオメトリを使用して、 
ジオメトリをインスタンス化することも可能です。ここでは、Unreal ジオメトリを受け取るアセットに、入力ノードを追加します。 
レベル上のオブジェクトを使用できるため、プロシージャルアセットと既存のゲームアートをよりよいかたちで統合できます。  
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UNREAL で入力ノードを使用する
アセットで入力ノードをセットアップする際、さまざまな方法で入力ジオ
メトリにアクセスできます。コンテンツブラウザからジオメトリを使用でき
ます。 
Curve Input をセットアップして、Unreal でカーブを描画できます。 
また、World Outliner からコンテンツを選択したり、Height Field に 
Unreal のランドスケープを入力して、Houdini の新しい Terrain ツール
セットで使用することもできます。

05 HOUDINI で – ボックスの上部のフェースを分離して、ポイ
ントがコピーされる場所を制限します。ネットワークエディタ

で、input  ノードの後に Group ノードを挿入します。Group Name を 
upfacing に設定します。Base Group で、Enable を オフにします。	
Keep by Normals で、Enable をオンにします。Direction を 0, 1, 0、
Spread Angle を 0 に設定します。

ポイントを Unreal 内のジオメトリのすべてのフェースにばら撒くのではな
く、上面のフェースを分離してそれを使用するようにします。 

06 group  ノードの後に Blast ノードを挿入したら、Group を 
upfacing  に設定し、Delete Non Selected をオンにします。

これで、上を向いているプリミティブのみが維持され、その他は削除され
ます。Assets > Save Asset > Populate を選択します。 

ここで重要なのは、グループを使用して上部のフェースを特定したので、	
ソリューションのアセットにどのジオメトリが入力されるのかは問題になら
ないところです。これが、プロシージャルアセット特有の動作です。	
一度限りのソリューションではなく、汎用のソリューションを提供します。

07 UNREAL で – Rebuild Asset ボタンをクリックして変更を	
確定します。これで、ジオメトリの上面にだけボックスが載って

います。 

このアセットで、デフォルトのグリッドまたは、レベルから取得したジオメトリ
を使用できるようになりました。Unreal で使用する Houdini デジタルアセッ
トを構築するには、いくつもの方法があります。

08 Number of Instances を 40 に設定します。Houdini 
Outputs セクションに移動し、インスタンス化したボックスを	

展開します。

Content Browser で、StarterContent > Particles を開きます。P_Fire  プ
ロップを Houdini Instanced Input 上にドラッグします。Rotate Y を 90 
に設定します。Play を押して、レベルをテストします。

このアセットでインスタン化されたポイントは、ジオメトリ以外にも使用でき
ます。これらのポイントは Unreal レベルの一部になっているので、さまざま
な問題解決に利用可能です。シーンにさらにポイントを追加する場合は、	
炎を設定した populate2  を非表示にしましょう。それでも、レベルを再生
すると表示されます。
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パート 7

Unreal に RBD シミュレーションをインポート
このパートでは、壁を作成し、リジッドボディダイナミクスを使用してそれを粉砕します。このシステムを FBX にエクスポートしたら、 
ゲームで使用するために Unreal にインポートします。Houdini から Unreal にビジュアルエフェクトを取り込む方法を、簡単な例で 
説明します。  

01 HOUDINI で - Box を作成します。ジオメトリレベルに移動し、
Size を 0.5, 4, 8 に設定します。 

Match Size ノードを追加し、パラメータエディタの Matching で、	
Justify Y を Min にします。これでボックスが持ち上がり、地面の上に配置
されます。

02 オブジェクトレベルに移動します。ノードの名前を wall  に変更
します。wall ノードを選択し、Model シェルフから Shatter を

選択します。 

ジオメトリレベルに入り、chunkcenters  ノードを選択し、Force Total 
Count を 100 に設定します。

チェーンの終端に Assemble ノードを追加します。Connect Inside Edges 
をオフにし、Create Packed Primitives と Path Attribute をオンにしま
す。Path Attribute を次のように変更します。

op:`opfullpath(‘.’)/path’

03 チェーンの終端に RBD Bullet Solver ノードを追加します。
Ground Collision タブで、Ground Type を Ground Plane 

に設定します。 

Play を押して、シミュレーションを実行します。壁が砕けて落ちるだけで、
特に面白みはありません。

04 sphere ノードをネットワークに追加します。それを壁の前に	
置き、Center X を 2、Center Y を 1 に設定します。Alt キーを

押しながら Center X をクリックし、キーフレームを設定します。 

フレーム 9 に移動します。Center X を -3 に設定し、Center X を Alt クリッ
クして 2 つ目のキーフレームを設定します。

sphere を rbdbulletsolver  ノードの 4 つ目の衝突入力に接続します。
Collisions で、Collision Type を Deforming に設定します。

Play を押して、シミュレーションを実行します。球によって壁が砕かれるよ
うになりました（シミュレーションでは、球は非表示になります）。
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まとめ
Unreal で使用する、さまざまなゲームアセットを
作成しました。Houdini デジタルアセットからリジッ
ドボディシミュレーションを含む FBX ファイルまで、
基礎を習得しました。デジタルアセットを使用すると、
Houdini のノードベースのワークフローを Unreal な
どのホストアプリケーションに統合できます。Unity、
Autodesk Maya、Autodesk 3ds Max といった他の 
アプリケーションでも、同じワークフローを活用する 
ことが可能です。
詳細は、SideFX.com/unreal をご覧ください。ここでは、
Unreal ですぐに使用できるアセットのスターターキットを 
入手できます。加えて、別のチュートリアルへのリンクもあり
ます。
Project Titan のチェックもお忘れなく。これは 3D 制作環境 
を探求するためのインハウス技術デモで、Unreal の最新テク 
ノロジーを活用しています。Project Titan 用に作成されたツール 
とテクニックは、学習資料およびダウンロード可能なコンテンツと
して、コミュニティに共有されています。  

06 UNREAL で – Content Browser で、Content  ディレクトリに	
戻ります。Import を押し、wall_destruction.fbx  ファイル

を選択します。Skeletal Mesh、Import Mesh、Import Animations の
チェックボックスをオンにします。

Animation セクションを展開し、Import Meshes in Bone チェックボッ
クスがオフになっていることを確認します。Mesh セクションを展開し、
Normal Import Method を Import Normals and Tangents に設定し
ます。Import をクリックします。

UV がまだセットアップされていないというメッセージウィンドウが表示されま
す。これを閉じます。コンテンツリストに 4 つの新しいアイテムが表示されます。  

wall_destruction_Anim  アセットをワークスペースにドラッグします。

05 rbdbulletsolver  ノードの後に Transform ノードを追加し、
Uniform Scale を 100 に設定します。これで、シミュレーショ

ンが Unreal で必要なサイズにスケールされます。

FBX Output ノードを追加します。Valid Frame Range を Render Frame 
Rangeに、Output File を $HIP/fbx/wall_destruction.fbx  に設定し
ます。

Build Hierarchy from Path Attribute をオンにします。

Save to Disk をクリックして、ディスクに保存します。

07 Play を押し、ゲーム内で動作しているシミュレーションを表示し
ます。この時点ではアニメーションはループするだけで、相互作

用もありません。ブループリントで、キャラクタの部位の動きに基づいてアニ
メーションをトリガするようにセットアップすることもできます。
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	  		  197

HOUDINI FOUNDATIONS

PDG による都市構築  
パイプラインのワークフローの管理には、Task Operator（TOP）を利用できます。TOP は PDG（Procedural 
Dependency Graph）と呼ばれるテクノロジを使って構築されています。PDG に基づいて作成されたワークフロー
は、TOP ノードを使用します。TOP ノードは、ローカルコンピュータまたは大規模な演算ファームにタスクを分散
させるワークアイテムを生成します。 

TOP ネットワークでは、各ワークアイテム間の依存関係や、各ワークアイテムが最終出力にどのように寄与するか
を決められます。この情報はノードグラフで容易に視覚化でき、ネットワーク内でのデータフローを定義することが
できます。TOP を使えば、パイプラインの自動化、分析、スケールが可能なワークフローを構築できます。

このレッスンでは、TOP ノードを使って都市マップを取得し、都市ブロックごとにビルを作成した後、このシステム
を拡張してより複雑なビルや大規模な都市マップを処理できるようにします。Houdini アーティストであれば、	
SOP でこれを行う方法をご存知でしょう。しかし、TOP を使えば、PDG のワークフローを学びながら、複数のタス
クを外部の演算ファームに分散して並列処理させられる、スケールが容易なシステムを作成できます。 

注 : このレッスンでは、Image Magick を使用します。このアプリケーションがコンピュータにインストールされて
いることを確認してください。

レッスンの目標
	� TOP（Task Operator）ネットワークを作成してプロシージャルな都市を構築し、それをレンダリングします。 

学習内容
	� 都市マップ画像をジオメトリに変換する方法 
	� TOP ネットワークをセットアップして、都市ブロックを保存する方法
	� TOP でジオメトリを作成し、各都市ブロックにビルを構築する方法
	� 都心部を作成し、一部のビルを他よりも高くする方法 
	� 都市景観を Wedge 化し、都心部にさまざまな位置を試す方法 
	� さまざまなマップ画像の使用を Wedge 化する方法
	� TOP を使用して都市をレンダリングし、画像モザイクで Wedge を	
比較する方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。

Houdini Core ✔

Houdini FX ✔

Houdini Indie ✔

Houdini Apprentice ✔

Houdini Education ✔

ドキュメントバージョン 4.0.1J | 2023 年 8 月
© SideFX Software



プロジェクトファイル
SideFX.com の Foundations チュートリア
ルのページ（このチュートリアルを入手した
場所）から、tops_lesson ディレクトリをダウ
ンロードします。home または documents 
ディレクトリにある Houdini Projects ディレ
クトリに配置してください。  

パート 1

都市グリッドの作成
プロシージャルな都市を構築するには、まず都市のグリッドを作成します。 
都市マップの白黒画像を含む画像ファイルをトレースすることで、ジオメトリを 
作成します。これが、TOP で構築するネットワークの入力ジオメトリとなります。 

01 File > Set Project を選択します。ダウンロードした 
tops_lesson  ディレクトリを見つけ、Accept を押します。	

これにより、先ほどコピーしたプロジェクトディレクトリとそのサブフォルダ
に、このショットに関連するファイルがすべて配置されるようになります。 

File > Save As... を選択します。新しい tops_lesson  ディレクトリが表示
されるはずです。表示されない場合は、左側の列で $JOB をクリックします。
ファイル名を city_01.hip  に設定し、Accept をクリックして保存します。 

02 ビューポートで、Tab を押してメニューを開き、TRACE と入力
していきます。Trace を選択すると、カーソルの位置に、シーン

内への配置待ちの状態にある正方形の輪郭が表示されます。Enter を押し
て、原点の位置に配置します。現時点では、トレースされた円が表示され
ます。

ネットワークビューでノードをダブルクリックして、ジオメトリレベルに入
ります。trace  ノードを選択し、Image Input パラメータの横にある File 
Chooser をクリックします。$HIP をクリックしたら、tex  ディレクトリに移
動します。citygrid.jpg  画像を選択し、Accept をクリックします。Scale to 
Size オプションをオンにして、値を 500, 500 に設定します。これにより精
度が向上します。

03 trace  ノードの上部のセクションで、次のように設定します。
	� Rotate X を -90 にする
	� Scale を 100, 100 にする

ネットワークビューで、Tab を押して Reverse と入力していきます。
Reverse ノードを選択して配置したら、それに trace  ノードを接続します。
Display フラグを設定します。このノードにより、法線が上を向くようになり
ます。ビューポートでスペースバー + H を押して、都市グリッド全体を表示
します。 

ディスプレイオプションバーで Display Points をオンにすると、各都市ブ
ロックの周りにトレースポイントが多数あることを確認できます。

04 ネットワークビューで Tab > Resample を押し、クリックして 
reverse  ノードの下に配置します。まだ接続はしないでくださ

い。Length を 1 に設定したら、reverse ノードの出力を resample  ノード
の入力に接続します。  

resample  ノードの出力を RMB クリックし、Null を選択します。チェーン
の終端に Null ノードをクリックして配置します。Display フラグを設定し、
名前を CITYBLOCKS_OUT  に変更します。

作業内容を保存します。
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パート 2

ワークアイテムの生成と表示
都市グリッドを作成できたら、さまざまな都市ブロックを個別のワークアイテムに分割します。これで、ブロックごとにビルを生成できる 
ようになります。各ブロックを保存するための TOP ネットワークをセットアップします。同時に、選択したワークアイテムを視覚化し、 
望みどおりの結果になっていることを確認するためのオブジェクトも作成します。 

01 オブジェクトレベルに戻り、オブジェクトの名前を street_grid  
に変更します。ネットワークビューで Tab を押して、TOP... と	

入力していき、TOP Network を選択します。クリックしてネットワークに
ノードを配置します。

ネットワークビューの右上にある小さい矢印をクリックします。メニューから 
Split Pane Left/Right を選択します。左側のネットワークビューでピンア
イコンをクリックします。右側のネットワークビューはすでにピン留めされて
います。右側のネットワークビューで、topnet  をダブルクリックして中に入
ります。これで、両方のネットワークを使用して都市を構築できるようになり
ました。

02 TOP ネットワークで Tab > Geometry Import を押します。	
クリックしてノードを配置します。Geometry Source を SOP 

Node に設定したら、SOP Path の横にある Choose Operator アイコン
をクリックします。フローティングウィンドウを使用し、CITYBLOCKS_OUT  
ノードに移動して選択します。 

Storage で、Store Geometry As は External File に設定したままにしま
す。Data Extraction で、Copy from Class を Primitive に設定します。	
これにより、ファイルがディスクに格納されるようになるので、次の TOP ノー
ドでそれらのファイルを取得できます。これは特に、演算ファームにタスク
を分散する TOP ネットワークをセットアップする場合に重要となります。

03 geometryimport  ノードの名前を cityblocks  に変更し、上部
のタスクバーで Cook Selected Node ボタンをクリックします。

または、このノードを選択して Shift + G を押しても、クックすることができ
ます。ノードがクックされるとき、ワークアイテムを表す小さいドットが表示
されます。

ドットを Ctrl + MMB クリックすると、ワークアイテムのアトリビュートが表
示されます。Index などの基本の TOP アトリビュートは、すべてのワーク
アイテムに備わっています。また、ワークアイテムのタイプに固有のアトリ
ビュートもあります。各ワークアイテムは、1 つの Output ファイルに関連
づけられていることが分かります。ワークアイテムを RMB クリックして、
View Work Item Output を選択すると、それに含まれるジオメトリを個別
のジオメトリビューアで確認することができます。

ワークアイテム
TOP ノードは、実行を依頼されたタスクごとにワークアイテムを作成します。TOP ノード
上で、これらはドットとして表現されます。これらのドットを使用して各ワークアイテムの
ステータスを視覚化したり、ドットを選択してそのワークアイテムの進捗状況を評価する
ことができます。 
すべてのワークアイテムのクックが完了すると、ノードにチェックマークが付き、完了した
ワークアイテムが緑色になります。
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スケジューラ系ノードとは
最初に TOP ネットワークを作成する際は、クック対象のタスクを管理する Local 
Scheduler ノードが作成されます。Local Scheduler はローカルコンピュータを指し、
利用可能なコアの特定の割合をクックに使用します。Total Slots を Equal to CPU 
Count Less One オプションに設定すると、利用可能なコア数と同数になります。 
また、より大規模な演算ファームにタスクを送信できるよう、HQueue、Deadline、
Tractor、Python 用のスケジューラ系ノードをセットアップすることも可能です。 
これにより、並列に処理できるワークアイテムの数が増え、グラフの効率が向上します。 

04 ネットワークでの処理速度を上げたい場合は、localscheduler  
ノードを選択して、Total Slots を Equal to CPU Count Less 

One に設定します。使用するプロセッサが増えるため、以降のクックの速度
が向上します。  

ワークアイテムをビューポートに表示させるには、ワークアイテムビューア
をセットアップする必要があります。左側のネットワークビューで、Tab > 
File を押します。クリックしてノードを配置し、名前を work_item_viewer  
に変更します。

File ノードは通常、ディスク上のファイルを指します。まずはこの方法で	
ファイルを見つけ、その後、別の方法を使ってワークアイテムを TOP から	
直接取得します。

05 work_item_viewer  ノードをダブルクリックしてその中に入り、
パラメータエディタで Geometry File ファイル選択ボタンをク

リックします。ファイル選択ダイアログで、$HIP をクリックしてから geo  フォ
ルダをダブルクリックします。 

city_01_cityblocks  ファイルシーケンスを選択します。保存されている	
ジオメトリが、番号付きのシーケンスとしてインポートされます。ジオメトリ
シーケンスの後に color ノードを追加し、そのカラーを赤色（1, 0, 0）に	
設定します。タイムラインをスクラブすると、さまざまなジオメトリが順番に
ロードされる様子を確認できます。ディスクに保存されたジオメトリは 73 個
です。

06 都市ブロックの表示をフレーム番号にリンクするのではなく、TOP ネットワークに直接リンクしてみましょう。File ノードを	
クリックして、Geometry File を次のエクスプレッションに変更にします。

 `@pdg_output` 

これは、ディスクから順番にファイルをロードするのではなく、topnet で	
アクティブになっているワークアイテムをロードすることを意味します。	
PDG ネットワークから出力されるワークアイテムがないため、最初はエラー
が返されます。 

07 ジオメトリネットワークビューの Active Work Item メニュー
で、異なるワークアイテムを選択し、Scene View でそれらを	

選択します。赤色が選択したジオメトリに移動します。そのワークアイテム
に関連するジオメトリがビューポートに表示されます。topnet では、黄色に
ハイライトされた cityblocks  TOP ノード上にドットが表示されます。 

作業内容を保存します。
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パート 3

アトリビュートの追加 
ビルを作成するには、固定のベース高さと、ランダムな高さのバリエーションを設定して、ビルによってサイズが異なるようにする必要が
あります。これらのアトリビュートは、都市マップのジオメトリレベルでセットアップできますが、ここ（TOP）で割り当てることも可能です。
そうすれば、後で TOP レベルで変更を加える必要が生じても、容易に対処できます。

01 TOP ネットワークで、Attribute Create TOP を追加します。
Generate When を Each Upstream Item is Cooked に	

設定します。

Float Attributes の下の +（プラス）記号をクリックして新しいアトリビュー
トを作成し、次のように設定します。 

	� Name を base_height  にする
	� Value を 10 にする

これにより、すべてのビルが 10 の最小値を持つことになります。最も低い
ビルの高さを変えたい場合は、後でこの値を調整します。

02 +（プラス）記号を再度クリックし、次のように設定します。 
	� Name を height_variation  にする
	� Value を rand(@pdg_index)*20 にする

この場合、ワークアイテムのアトリビュート Index をシードとして使用して、
0 から 20 までの乱数が作成されます。ビル作成用のネットワークを構築す
る際は、この値をベース高さの値に加算して、ビルの高さが決定されます。

03 attributecreate  ノードを選択し、Shift + G を押してクックし
ます。ビルをまだ作成していないため、3D ビューには依然とし

てフットプリントが表示されます。

ワークアイテムを MMB クリックすると、それぞれのワークアイテムに値 10 
の base_height  と、0 と 20 の間の数値である height_variation  が含ま
れていることが分かります。アトリビュートはこの TOP ノードで生成されま
したが、まだ使用されていません。 

TOP でアトリビュートを追加する
都市グリッドのジオメトリネットワークでアトリビュートを追加することも
できましたが、TOP でアトリビュートを追加すれば、TOP のコンテキスト
内で簡単に変更を加えられます。 
アトリビュートは、パイプラインに対して重要な情報を提供する重要な 
手段であるため、適切にセットアップすることが大切です。 

201

ア
ト

リ
ビ

ュ
ー

ト
の

追
加

 



01 ROP Geometry Output TOP を追加します。名前を create_
buildings  に変更します。Use External SOP オプションをオフ

にします。 

ノードを RMB クリックして Generate Node を選択し、ワークアイテムを	
作成します。これらは、まだ処理されていない灰色のワークアイテムです。
これらは実質上、ノードのセットアップ後に実行されるタスクのための	
プレースホルダーです。

重要 : ワークアイテムの 1 つをクリックしてみてください。このノードでは	
まだジオメトリが生成されていないため、work_item_viewer  ネットワー
クでエラーが生成されます。

02 このノードをダブルクリックして、ジオメトリレベルに入ります。 

PolyExtrude ノードを作成し、incoming  と output  ノードの
間に配置します。名前を block_offset  に変更します。Inset を 1 に設定し、
Extrusion で Output Side オプションをオフにします。これで、ビルをイン
セットして歩道を作成できるようになります。 

次に、polyextrude  ノードの後に Fuse ノードを追加し、Snap Distance 
を 0.2 に設定して、小さい線をすべて除去します。work_item_viewer  
ノードでエラーが発生しているにもかかわらず、ビューポートに何かが表示
されていることに注意してください。この問題は後で修正します。

03 fuse の後に、2 個目の PolyExtrude ノードを作成します。名前
を building_height  に変更し、Distance を次のように設定し

ます。

 @base_height + @height_variation

Distance パラメータがハイライトされていることを確認してください。パラ
メータを RMB クリックし、Copy Parameter を選択します。Divisions パ
ラメータを RMB クリックし、Paste Relative References を選択します。
次のように 2 で割って、結果のチャネル参照を編集します。
ch(“dist”)/2

これで、床と窓のグリッドが表示されるようになります。 

パート 4

都市グリッド用のビルの作成 
ROP Geometry ノードを使用して、シンプルなビルを作成します。作業内容をビューポートで確認するには、ワークアイテムを生成し、 
そのいずれかを選択する必要があります。その後、そのワークアイテムを使用して、ジオメトリレベルでビルをデザインします。

04 Extrusion タブで、Front Group をオンにし、名前を 
building_top  に変更したら、Side Group をオンにして名前を 

building_side  に変更します。これらを使用してビルにディテールを追加し
ていきます。
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ワークアイテムの進捗状況
これまで、ワークアイテムは非常に素早く処理されてきましたが、このノードは
やや長い時間を要します。進捗状況のホイールは、完了したタスクを暗い緑色
で、進行中のタスクを黄色で、キュー内のワークアイテムを灰色で表示します。
これを使えば、割り当てられたタスクがノード上で実行されていく様子を確認
できます。 
オブジェクトレベルの TOP ネットワークにも、ネットワークのすべてのタスク
についてワークアイテムの進捗状況が表示されます。 

05 Poly Extrude ノードをチェーンに追加し、名前を 
window_frames  に変更します。次のように設定します。
	� Group を building_side  にする
	� Inset を 0.05 にする
	� Divide Into を Individual Elements にする
	� Extrusion タブで、Front Group をオンにして、その名前を 

window_out  に変更します。

Poly Extrude ノードをもう 1 つ追加して、名前を windows  に変更します。
Group を window_out  に、Distance を -0.05 に設定します。 

06 新しい Poly Extrude を追加し、名前を extend_roof  に変更
します。次のように設定します。 
	� Group を building_top  にする
	� Distance を 0.5 にする 

Poly Extrude ノードをもう 1 つ追加して、名前を roof_edge  に変更しま
す。次のように設定します。

	� Group を building_top  にする
	� Inset を 0.3 にする
	� Extrusion タブで、Front Group をオンにして、その名前を 

roof_out  に変更します。
新しい Poly Extrude ノードをチェーンに追加し、名前を roof  に変更しま
す。Group を roof_out  に、Distance を -0.25 に設定します。

07 この後に color ノードを追加し、次のように設定します。 	� Group を windows_out  にする 
	� Color をダークグレー（0.2, 0.2, 0.2）にする 

これらのノードが output  ノードに接続されていることを確認し、そのノード
の Display フラグを設定します。これで、枠が明るい色に、窓が暗めの色
になり、ビューポートで識別しやすくなります。

08 1 つ上のレベルに戻り、create_buildings TOP で $F を 
`@pdg_index` に変更し、Output File を次のように設定します。

 $HIP/geo/$HIPNAME.$OS.`@pdg_index`.bgeo.sc

これにより、フレーム番号の代わりに各ビルのインデックスファイルが	
使用されるようになります。ROP Fetch タブをクリックし、Cache Mode を 
Write Files に設定します。

シーンファイルを保存したら、create_buildings  TOP を選択し、Shift + G 
を押してクックします。

work_item_viewer  内に戻り、赤色が表示されないように color ノードを
削除します。create_buildings  TOP ノードで、ワークアイテムをクリックす
ると、さまざまな高さのビルが表示されます。

203

都
市

グ
リ

ッ
ド

用
の

ビ
ル

の
作

成
 



パート 5

ビルの結合
ビルが完成したら、それらのビルを再度まとめて都市にします。そのためには、Wait for All と呼ばれるパーティションノードと、
Geometry Import を使用します。また、他の場所よりも高いビルが立つ都心部を追加します。

01 タスクの処理速度を上げるには、PDG Services というものを	使用します。TOP ネットワークビューで Tasks > PDG Services 
を選択します。ここではサービスがセットアップされ、使用できるようになっ
ていることが確認できます。

Services ウィンドウを閉じたら、create_buildings  TOP の ROP Fetch 	
タブに移動して、Cook Type を Services に設定します。これで TOP ノー
ドの処理速度が向上するはずです。

シーンファイルを保存したら、create_buildings  TOP を選択します。	
Shift + D を押して Dirty（変更あり）にしてから、Shift + G を押してクックし
ます。先ほどよりもずっと速くなっているはずです。

02 Wait for All TOP ノードを追加します。このノードは、ROP 
Geometry ノードによって生成されたすべてのワークアイテムを

受け取り、それらを結合して単一のワークアイテムにします。このノードは
また、上流のすべてのワークアイテムのクックが完了するまで、下流の TOP 
がクックされないようにします。

03 Geometry Import TOP を追加します。名前を building_
merge  に変更します。Generate When を Each Upstream 

Item is Cooked に、Merge Operation を Import and Merge All 
Geometry に設定します。

シーンファイルを保存したら、building_merge  ノードを選択し、Shift + G 
を押してクックします。ネットワークのクックが完了したら、最終的な 
building_merge  ノードのワークアイテムをクリックします。ビューポート
に都市全体が表示されます。

04 Attribute Create TOP に戻り、height_variation  アトリ
ビュートを次のように編集します。
	� Value を rand(@pdg_index) * 15 にする

これで、ビルの高さが全体的に少し低くなります 

attributecreate  TOP を RMB クリックし、Dirty This Node を選択します。
これにより、チェーン内の以降のワークアイテムがすべてクリアされます。 
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Dirty（変更あり）とクリーンなワークアイテム
PDG テクノロジーの主な目的の 1 つは、複雑なシステムに生じる依存関係
です。都心部に変更を加えると、Dirty（変更あり）になって再クックが必要と
なるノードと、そのままで問題のないノードに分かれます。TOP におけるこう
した依存関係の処理方法が、TOP の強みの 1 つです。 

06 street_grid  オブジェクトに移動し、その中に入ります。	
color ノードを作成し、チェーンの resample  ノードの後に	

接続します。Class を Primitive に、Color を黒色（0, 0, 0）に設定します。	
このノードの名前を base_color  に変更します。

street_grid  ネットワークに球を作成し、端の方に配置して次のように設定
します。

	� Primitive Type を Polygon にする
	� Uniform Scale を 5 にする

sphere  の出力に Color ノードを追加し、Class を Primitive に、Color を
緑色（0, 1, 0）に設定します。このノードの名前を transfer_color  に変更し
ます。

05 シーンファイルを保存します。building_merge  TOP ノードを
選択し、Shift + G を押してクックします。ネットワークのクック

が完了したら、最終的な building_merge  ノードのワークアイテムをクリッ
クして変更を確認します。  

07 base_color  ノードの後に Attribute Transfer ノードを追加し
ます。2 つ目の入力に transfer_color  ノードを接続します。 

Points チェックボックスをオフにして、Primitives フィールドを Cd に設定
します。Conditions タブで、次のように設定します。

	� Distance Threshold を 0 にする
	� Blend Width を約 30 にする 

カーソルを Scene View に置いた状態で、スペースバー + Y を押し、Hide 
Other Objects に切り替えます。タイルが球の中心に近づくにつれ、緑色
が徐々にタイルに浸透していくのが分かります。 

08 TOP ネットワークに戻り、attributecreate  を選択して、
height_variation  アトリビュートを次のように編集します。
	� Value を rand(@pdg_index) * 15 + @Cd.g*30 にする

これにより、都市部のビルの高さが高くなります。最大で、値 30 だけ高さ
が追加されるようになります。ビルの高さを低くまたは高くしたい場合は、	
この値を変更します。
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依存関係の更新
あるワークアイテムを選択すると、そのワークアイテムがシステム内の他の
ワークアイテムとどのように接続しているかを示す線が表示されます。 
これは依存関係のマッピングであり、グラフを効率的に動作させるのに役立ち
ます。なぜなら、Shift + D でノード上のすべてのワークアイテムを明示的に 
Dirty（変更あり）にしない限り、Dirty（変更あり）のワークアイテムのみが処理
されるからです 

10 street_grid オブジェクトに移動し、CITYBLOCK_OUT  ノードを
表示した状態で、sphere ノードを選択します。ハンドルツールを

使ってこのノードをあちこち動かすと、都市グリッドのさまざまな部分に作用
しているのが分かります。

11 TOP ネットワークに戻り、create_buildings  ノードを RMB ク
リックして Generate Node を選択します。ジオメトリレベルで

加えた変更のため、一部のワークアイテムが自動的に Dirty（変更あり）に	
されているのが確認できます。その他のワークアイテムはまだクリーンと	
みなされるため、再クックの必要はありません。

12 building_merge  ノードを RMB クリックし、Cook Selected 
Node を選択すると、Dirty（変更あり）のワークアイテムのみが

更新されます。ワークアイテムをクリックして、新しい都心部を表示します。
このようにすると、ワークフローを開発する際、TOP の依存関係グラフを効
率的に動作させることができます。

09 building_merge  ノードを RMB クリックし、メニューから 
Dirty This Node を選択します。または、このノードを選択して 

Shift+ D を押しても、Dirty（変更あり）にできます。 

building_merge  ノードを選択し、Shift + G を押してクックします。保存す
るかどうかを確認されます。準備が整ったら、最終的な building_merge 
ノードのワークアイテムをクリックします。 

もう一方のネットワークビューで、オブジェクトレベルに戻ります。都市が
更新され、ビューポートで都心部を確認できるはずです。   
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パート 6

1 つのビルを分離する
これまで、ビルの高さは、height_variation のランダム性によって決定されてきました。あるビルを特定の高さに固定したい場合は、 
2 つ目の attribute create ノードを使用してプリミティブを選択し、特定の値に設定します。この手法を使うと、アーティスティックな 
指示をシステムに簡単に出すことができ、ランダム性を上書きできます。 

04 building_merge  ノードのワークアイテムをクリックして、	
新しいビルがそびえ立つ都市景観を表示します。これで、ネット

ワークを再クックしてもブロック 24 のビルは更新されず、明示的に設定さ
れた状態に保たれるようになります。 

そのビルの高さを変更したい場合は、2 つ目の Attribute Create ノードを	
使用して、その高さを明示的に設定します。

01 スペースバー + Y を押し、Ghost Other Objects に切り替えま
す。street_grid  オブジェクトに戻り、ディスプレイオプション

の Display Primitive Numbers をオンにします。ブロック番号が表示され
ます。これで、ビルを特定し、そのいずれかを明示的に設定するかどうかを
決められるようになりました。ここではブロック 24 を選択します。

現在のセットアップのランダム性に依存する代わりに、この都市ブロックに
特定のパラメータを設定して、望みどおりの正確な高さが得られるように
しましょう。すべてをランダムに任せずに、TOP ネットワーク内でアーティス
ティックな制御ができるようになります。 

02 attributecreate TOP ノードを Alt + クリックしながらドラッグ
して、そのコピーを作成します。まだ接続はしないでください。

Create When の横にあるチェックボックスをオンにし、次のエクスプレッ
ションを追加します。

@primitiveoffset==24

height_variation  の Value パラメータを RMB クリックし、Delete 
Channels を選択してから、その値を 0、base_height  の値を 50 に設定
します。これで、ブロック 24 のビルの高さを明示的に 50 単位に設定でき
ます。 

03 このノードを、attributecreate  と create_buildings  ノードの
間に挿入します。作業内容を保存してから、building_merge  

ノードを再クックします。

create_buildings  ノードのインデックス 24 のワークアイテムをクリックす
ると、ブロック 24 に 50 単位の高さのビルが表示されます。
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WEDGING
Wedging は、さまざまな設定で撮影しておいて、現像所に持ち帰って最良のも
のを選ぶという、写真撮影に由来するアイデアです。ここでも考え方は同じです。
ただし、ランダム値を使ってシステムに作用し、固有の結果を 4 つ取得して比較
しようというわけです。 
後ほど、ランダムな Wedge 値が記載されたオプションすべてを含む、モザイク
をレンダリングします。

パート 7

都心部の位置を Wedge 化する
street_grid オブジェクト内で球の位置を Wedge 化するには、ネットワークを Houdini Digital Asset（HDA）に変換し、 
HDA Processor TOP ノードを介して実行する必要があります。これらのアセットをロードしてシステムに追加できるようになると、 
個別のツールから複雑なシステムを作成し、ツールを必要に応じて更新および適応することができます。

01 street_grid  ネットワークで、CITYBLOCKS_OUT  を除くすべ
てのノードを選択します。Assets メニューから New Digital 

Asset from Selection を選択します。アセットに streetgrid_maker  とい
う名前を付け、ラベルを Street Grid Maker  に設定したら、$HIP/hda/ 
ディレクトリに保存します。

Operator Type Properties パネルで Parameters タブをクリックします。
そのアセットの中に入ります。trace  ノードからパラメータリストに Image 
Input をドラッグします。Scale X を Scale Y にドラッグして、Relative 
Channel Reference を選択します。次に Scale X をパラメータリストに	
ドラッグして、名前を Scale  に変更します。sphere  ノードから Center を	
ドラッグして、名前を Sphere Center  に変更します。attributetransfer  
ノードから Blend Width をドラッグし、Accept をクリックします。

02 TOP ネットワークに戻ります。HDA Processor TOP を
作成し、それを Geometry Import ノードに接続します。

geometryimport  ノードで、Generate When を Each Upstream Item 
is Cooked に、Geometry Source を Upstream Output File に変更し
ます。

HDA Processor ノードを選択し、HDA File を $HIP/hda/streetgrid_
maker.hda  に設定します。HDA Parameters タブをクリッ し、Image 
Input、Center、Scale、Blend Width パラメータを表示します。

この TOP の名前を make_citygrid  に変更します。Shift + V を押し、	
ノードを Dirty（変更あり）にしてクックし、このノードが以前のような方法で
都市グリッドを生成していることを確認します。 

03 Wedge TOPノードを作成し、make_citygrid  に接続します。
次のように設定します。
	� Wedge Count を 4 にする

Wedge Attributes の横にある +（プラス）記号をクリックし、最初のアトリ
ビュートの Attribute Name を center_wedge  に設定したら、次のように
設定します。 

	� Type を Float Vector にする
	� Start（範囲）を -50, 0, -50, 0 にする 
	� End（範囲）を 50, 0, 50, 0 にする 
	� Random Samples をオンにする
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05 高さのバリエーションを Wedge 化して、異なる 4 つのルックが得られるようにします。wedge  TOP を選択し、Wedge 
Attributes の横にある +（プラス）記号をクリックして、2 番目のアトリビュー
トの Attribute Name を seed_wedge  に設定します。Type は Float の
ままにして、Start/End を 0, 1000 に設定します。 

Random Samples パラメータをオンにします。

最初の attributecreate  TOP で、height_variation  アトリビュートの 
Value を次のように変更します。

rand(@pdg_index*@seed_wedge) * 15 + @Cd.g*30

04 HDA Processor ノードを選択し、HDA Parameters タブで 
Center パラメータを次のように設定します。 

@center_wedge.0, @center_wedge.1, @center_wedge.2

make_citygrid  HDA Processor ノードを選択して Shift + V を押し、ノード
を Dirty（変更あり）にしてクックします。すると 4 つの都市グリッドが作成さ
れます。 

street_grid オブジェクトを非表示にします。ワークアイテムをクリックし、
それぞれのグリッドを視覚化します。グリッドごとに、都心部が配置されてい
る緑色の位置が異なります。 

06 出力ファイルを作成するすべての TOP について、出力ファイル名を更新し、Wedge 番号が含まれるようにする必要があります。
そうすれば、Wedge 番号でファイルを区別できるようになります。次の TOP 
ノードの出力ファイルパラメータで、.bgeo の直前に .`@wedgenum` を	
挿入します。 

	� make_citygrid  HDA Processor
	� geometryimport  Geometry Import
	� create_buildings  ROP Geometry
	� building_merge  Geometry Import

07 Wait for All ノードを Partition by Attribute TOP ノードに	
置き換えます。Partition By が Distinct Attribute Values に

設定されていることを確認してください。

Attributes の横にある +（プラス）記号をクリックし、Name を wedgenum  
に設定します。これにより、Wedge ごとにパーティションが作成されます。

08 作業内容を保存してから、building_merge  TOP ノードをクッ
クします。都市マップが 4 つ作成され、building_merge  ノード

のワークアイテムをクリックすることで視覚化できます。

ここでは Local Scheduler が使用されているので、処理に少し時間がかか
ります。スケジューラを使用してタスクを演算ファームに分散すると、処理
速度がかなり上がります。
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パート 8

街路のジオメトリの作成
ビルのコンテキストを作成するため、最終レンダリングで使用する都市ブロックと街路を作成します。4 つの Wedge には、現時点では 
すべて同じマップが使用されています。このジオメトリを TOP でセットアップして、後で異なるマップを使用できるようにします。 
非常に堅牢なシステムを作るには、柔軟性を組み込むことが大切です。

01 TOP ネットワークで、ROP Geometry Output ノードを追加し、
make_citygrid  HDA Processor から分岐させます。新しいノー

ドの名前を build_streets  に変更します。

Use External SOP オプションをオフにし、Output File のエクスプレッショ
ンで、.bgeo の直前に $F ではなく `@wedgenum` を追加します。

ROP Fetch タブで、Cache Mode を Write Files に設定します。

02 このノードを RMB クリックして Generate Node を選択し、	
4 つのワークアイテムを作成します。いずれかをクリックして

ワークアイテムをハイライトしたら、ノードをダブルクリックしてその中に	
入ります。

するとジオメトリレベルに移るので、そこで街路を作成していきます。

03 incoming  ノードと output  ノードの間に PolyExtrude ノー
ドを追加します。Distance を -0.05 に設定します。Output 

Front チェックボックスをオフにし、Output Back オプションをオンにし
ます。

その後に Reverse ノードを追加して法線を修正したら、Color ノードを	
追加してすべての都市ブロックを白色にします。 

04 ネットワークの端の方に Box ノードを追加します。box ノードに 
polyextrude  を接続し、境界ボックスを都市グリッドのジオメト

リに合わせます。 

box  の後に Blast ノードを追加し、Group を 2 に設定して、Delete Non 
Selected オプションをオンにします。

blast  の後に Transform ノードを追加し、次のように設定します。
	� Translate Y を -0.05 にする
	� Scale X を 1.05 にする
	� Scale Z を 1.05 にする
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もう 1 つの PDG 出力
以前は、pdg_output を使用して、各ノードの出力結果を視覚化するのに役立つ work_item_viewer ノードを作成していま
した。しかし、今はこのパーティションができたので、実際には 2 つの出力があり、ワークアイテム上を Ctrl + MMB クリック 
して確認することができます。そのため、この 2 つ目の出力が正しく表示されるようにするには、独自のビューアが必要です。

05 Color ノードを追加し、ミディアムグレー（0.33, 0.33, 0.33）に	
設定します。 

Merge ノードを作成し、2 つの color  ノードに接続します。街路のジオメト
リが表示されるよう、Display フラグが出力に設定されていることを確認し
ます。

06 シーンファイルを保存します。TOP ネットワークに戻り、ノードを
クックします。ワークアイテムをクリックすると、グリッドが表示

されます。 

現時点では、これら 4 つはすべて同じです。方程式に都市グリッドを追加す
れば、変わっていくはずです。

07 チェーンの終端に Partition by Index を追加します。その 1 つ
目の入力に building_merge  ノードを接続し、2 つ目の入力に 

build_streets  を接続します。

新しいノードをクックします。完了したら、ワークアイテムをクリックし、	
ビルのみが表示されることを確認します。ワークアイテムを中クリックする
と、Partition によって 2 つの出力ファイルが作成されていることを確認でき
ます。新しい出力ファイルを表示して、ビューポートで確認します。  

08 オブジェクトレベルに移動します。work_item_viewer  を 	
Alt ドラッグし、work_item_viewer1  という 2 つ目のノードを

作成します。ジオメトリレベルに入り、Geometry File を次のように設定し
ます。

`@pdg_output.1`

オブジェクトレベルに上がり、TOP ネットワークで partitionbyindex  ノー
ドのワークアイテムの 1 つを選択します。今度は、両方の出力がビューポー
トに表示されているはずです。これは、次の手順で都市の画像をレンダリン
グする際に重要となります。 
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01 wedge  TOP ノードに戻ります。Wedge Attributes の横にある 
+（プラス）記号をクリックし、新しい Wedge パラメータを追加し

ます。 

次のように設定します。
	� Attribute Name を file_wedge  にする
	� Attribute Type を Integer にする
	� Start/End を 1, 4 にする

これにより 1、2、3、4 の整数値が作成され、これらを使って異なる都市マッ
プを検索できるようになります。

02 streetgrid_maker  HDA Processor ノードで、Image Input の
横にあるファイル選択ボタンをクリックし、more_grids  フォル

ダに移動します。そこからファイルを選択したら、パラメータエディタで、	
エクスプレッションの $F を `@file_wedge` に変更します。

このフォルダには 4 つのファイルがあり、ネットワークをクックすると、その 
Wedge アトリビュートが順番にそれらを処理します。

03 streetgrid_maker  HDA Processor ノードを Dirty（変更あり）
にしてクックします（Shift + V）。4 つの異なるマップが使用さ

れ、以前のように都心部があちこち移動するのが確認できます。

パート 9

4 つの都市マップの Wedge 化 
Wedging にもう 1 つ変数を追加してみましょう。4 つの異なるマップにアクセスして、それぞれのマップに対して 1 つのレンダリングを 
作成します。異なる白黒画像がそれぞれトレースされ、システムへの入力情報として使用されます。これは、パイプラインにコンテンツを
追加するもう 1 つの方法です。

04 2 つ目の attributecreate  TOP ノードをバイパスします。	
これは、静的なマップ向けに設計されたもので、4 つの異なる

マップでは正しく動作しません。

最終的なパーティションノードをクックし（Shift + G）、4 つの都市の平面図
が都市に変換されるのを確認します。
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PDG 入力
PDG 出力は、あるノードの結果を取得してそれを表示できるのに対し、 
PDG 入力は前のノードの結果を取得して、それを代わりに表示します。 
この方法で、Mantra ノードは先行するノードの結果をジオメトリの入力として
使用した後、そのジオメトリをレンダリングします。これら 2 つのオプションは
似ていますが、違いを理解しておくことが重要です。 

パート 10

モザイクのレンダリング 
カメラとスカイライトを追加してから、都市をレンダリングします。その結果を単一のモザイクへとまとめますが、Wedge アトリビュートを
表示したままにすることで、結果をもとにクリエイティブな決定を下せるようにします。モザイクノードは Image Magick を使用するので、
この手順を実行するにはコンピュータにインストールしておく必要があります。

01 都市を斜め上から見下ろすようになるまでビューをタンブルします。カメラメニューから New Camera を選択します。4 つの都
市グリッドをチェックして、いずれもカメラに収まっていることを確認します。
必要に応じてカメラビューを調整します。これを使用してモザイクをレンダ
リングしていきます。 

Skylight を追加します。Environment Light の Intensity を 1.3 に設定し
ます。

02 オブジェクトレベルで、work_item_viewer  を Alt ドラッグし
てコピーを作成します。新しいノードを render_item_viewer  

という名前に変更します。このノードの中に入り、Geometry File パラメー
タを次のように変更します。
`@pdg_input`

この手順を繰り返して render_item_viewer1  を作成し、その Geometry 
File パラメータを次のように設定します。
`@pdg_input.1`

これらの render_item_viewer ノードの Display フラグを設定し、2 つの 
work_item_viewer ノードの表示をオフにします。

03 ROP Mantra Render Top を partitionbyindex  の後に追加
します。ROP Fetch タブで、Cache Mode を Write Files に	

設定します。 

Camera パラメータが、自分が作成したカメラに設定されていることを確認
します。Override Camera Resolution オプションをオンにして、½ に設
定します Output Picture パラメータを次のように変更します。 
$HIP/render/city.$OS.`@wedgenum`.exr

注 : Houdini Apprenticeを使用してこのチュートリアルを実行している場合
は、.exr ではなく .pic ファイルを使用して、Apprentice のウォーターマー
クが追加されないようにしてください。
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Houdini 以外にも使える PDG
PDG は Python に対応しているため、Houdini と直接接続していないタスクにも使用で
きます。ワークフローを整理する TOP ノードによって、パイプラインツールを整理するた
めの視覚ツールを提供します。
これらのネットワークは Houdini を通じて処理し、選択したスケジューラに送信できま
す。作業を演算クラウドに送信すれば、処理を高速化できます。

05 Overlaytext  ノードをダブルクリックして、中に入ります。	
Font  ノードを選択し、Text Size を 18 に変更します。	

これでテキストが小さくなり、都市の表示スペースが広くなります。

06 上に戻って、Wait for All パーティションノードを追加します。	
これはすべての要素をまとめるノードです。ImageMagick 	

ノードを追加します。

このノードをクックして、TOP ネットワークを処理します。4 つのレンダリン
グが作成されてから、テキストがオーバーレイされ、1 つのモザイクにまと
められます。

07 完了したら、ワークアイテムを RMB クリックし、View Task 
Output を選択します。すると Mplay 画像ビューアに最終画像

が表示されます。 

このコンタクトシートを使用すると、さまざまな Wedge を確認したうえで、
どれを採用するかを決定できます。画像上に表示されたパラメータは、	
希望する都市を得るために確定する必要のある値です。

04 Overlay Text Top を追加し、Output Picture を次のように	
設定します。 

$HIP/render/$HIPNAME.$OS.`@wedgenum`.exr 

ROP Fetch タブで、Cache Mode を Write Files に設定します。

Overlay タブで、次のように入力します。 
Map: `@file_wedge` 
City Core: `@center_wedge.0`, `@center_wedge.2` 

Variation Seed: `@seed_wedge`
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04 Partition by Index ノードを選択し、ネットワークをクックして、
新しいビルを表示します。ビルに床板、柱、窓がつきました。 

多くのジオメトリが生成されました。演算ファームを使用してワークアイテム
の数を増やす利点がわかり始めたのではないでしょうか。他のスケジューラ
系ノードの 1 つを使って、それを実現できます。

01 Wedge TOP で、Wedge Count を 1 に設定します。これにより、新しいマップを使用して都市をスケールアップする間、反復回数
が 1 回のみになります。

create_buildings  ROP Geometry TOP ノードを選択し、RMB クリックし
て Generate Node を選択します。次は、このノードの中に入り、デジタル
アセットを使用して、床、窓、柱を含むさまざまなタイプのビルを作成します。

02 ダブルクリックして中に入ります。Assets メニューから 	
Install Asset Library を選択します。hda  ディレクトリに	

移動し、make_buildings2.hda  を選択します。Accept をクリックして
から Install（Install and Create ではありません）をクリックします。	
Tab > Make Buildings Hi Res を選択して、ノードをグラフに配置します。

fuse  ノードを新しいアセットに接続します。

03 make_buildings_hi_res  デジタルアセットで、次のように設定
します。
	� Floor Height を 2 にする 
	� Base Building Height を @base_height にする
	� Height Variation を @height_variation にする

color  ノードと output  ノードの間に switch  ノードを追加したら、2 つ目の
入力に make_buildings_hi_res ノードを接続し、Select Input を 1 に	
設定します。

パート 11

スケールアップでより多くのコンテンツを作成 
冒頭で、この都市ビルのサンプルは SOP で割と簡単に作成できるだろうと説明しました。しかし問題は、システムが複雑になるにつれて
ボトルネックが発生することです。これは、すべての処理を単一のネットワーク内で実行することによります。TOP なら、演算ファームに
ワークアイテムを分散でき、スケールアップしても処理速度は低下しません。

215

ス
ケ

ー
ル

ア
ッ

プ
で

よ
り

多
く

の
コ

ン
テ

ン
ツ

を
作

成
 



まとめ
このレッスンでは、TOP ノードを使って都市マップを取得し、都市ブロックごとに 
ビルを作成した後、このシステムを拡張してより複雑なビルや大規模な都市マップ
を処理できるようにしました。このプロジェクトでは、TOP ベースのワークフローで
よく使用されるノードを紹介し、それらのノードを使ってワークアイテムのタスクを
作成および処理する方法について説明しました。
TOP を使って作成可能なものは数多くあり、これはほんの始まりにすぎません。 
このネットワークタイプを使用すると、一般的な Houdini ワークフローを 
自動化および処理できるだけでなく、Houdini がまったく関与しない
ワークフローも処理することができます。 
TOP は、効率を求める小規模なスタジオから、 
膨大なデータを管理する大規模なスタジオまで、
パイプライン全体の依存関係を管理でき
る優れたツールとなるはずです。 

06 streetgrid_maker  HDA Processor ノードを Dirty（変更あり）
にしてクックします。新しい都市マップが生成される様子を確認

できます。完了後は、元のマップよりもずっと多くの都市ブロックが生成さ
れ、ビルの数もずっと増えています。

この時点で、演算ファームを利用することが理にかなっているのは明らか
です。1 台のコンピュータでは、TOP の並列処理機能を十分に活用できな
いからです。  

05 別の都市グリッド画像を使用して、都市を大きくすることも	できます。その場合、streetgrid_maker  HDA Processor で 
Uniform Scale の値を 500 に上げ、Image Input を citygrid_large  	
マップに変更する必要があります。また、Blend Width の値を上げて、	
都心部の高さの変化を大きくしてもよいでしょう。

Wedge ノードで、center_wedge アトリビュートを -110, 0, 100 などに設定
することもできます。 

07 最後のノードを再クックし、都市の画像をレンダリングします。
これまで構築したシンプルなシステムが、どんなサイズにも	

拡張できる可能性を持っていることをお分かりいただけたと思います。 

シーンを保存します。
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  SCENE VIEW SHORTCUTS

  NETWORK VIEW SHORTCUTS

TOOLS

	 Select	 S�
	 Move	 T�	
	 Rotate	 R�	
	 Scale	 E�	
	 Pose	 Ctrl-R�	
	Handle 	 Enter�	
	View	 Esc�

Tool Menu	 Tab�
Custom Radial Menu	 C

Repeat Last Tool	 Q

VIEW 

	 Tumble	 Space/Alt + LMB
	 Track	 Space/Alt + MMB
	 Dolly	 Space/Alt + RMB

Home Grid	 Space + H
Home All	 Space + A

Home Selected	 Space + G

VIEW RADIAL MENU

Selection Tools	 V �
Selection Options	 V �
Viewport	 V �
Shading	 V 

SELECTION MODES

	 Objects	 1� 	

	 Points	 2�	

	 Edges	 3�	

	 Primitives (Faces)	 4�	

	 Vertices	 5�

Select Groups/Connected Geometry	 9�

Toggle Objects/Geometry	 F8

SELECTING

Select	 LMB

Add to Selection	 Shift + LMB

Remove from Selection	 Ctrl + LMB

Toggle Selection	 Ctrl + Shift + LMB

Select All	 N

Select Nothing	 Shift-N

SNAPPING RADIAL MENU

	 Grid Snap	 X �	
	 Primitive (Curve) Snap	 X �	
	 Point Snap	 X �	
	 Multi-Snapping Snap	 X 

VIEWPORTS

Expand Viewport	 Space + b

Select Viewport	 Space + n

Perspective View	 Space + 1

Top View	 Space + 2

Front View	 Space + 3

Right View	 Space + 4

UV View	 Space + 5

Toggle Wireframe/Shaded	 W

Display Options	 D

VIEWPORT LAYOUT

Single View	 Ctrl + 1

Four Views	 Ctrl + 2

Two Views Stacked	 Ctrl + 3

Two Views Side by Side	 Ctrl + 4

Three Views Split Bottom	 Ctrl + 5

Three Views Split Left	 Ctrl + 6

Four Views Split Bottom	 Ctrl + 7

Four Views Split Left	 Ctrl + 8

FINDING THINGS

Dashbox	 Ctrl + D

VIEW 

Pan  	 Space + LMB or MMB�

Zoom	 Space + RMB or Scroll Wheel�

Show all Nodes	 H�

Show Selected Nodes	 G

CREATE 

Node Menu	 Tab�

Add File Node	 =�

Create Subnet	 Shift + C

Add Background Image	 Shift - I

NOTES AND NETWORK BOXES

Add Network Box	 Shift + O�

Add Sticky	 Shift - P

Minimize Selected Notes/Boxes	 Shift - J

Expand Selected Notes/Boxes	 Shift - K

Shrink box to fit contents	 Shift - M

WIRING

Connect Nodes	 LMB on Connector

Connect Multiple Nodes	 J drag over nodes �

Insert Node	 RMB on Connector�

Branch 	 MMB on Connector

Connector List 	 Alt + MMB on Node�

Cut Wire	 Y drag across wire

Disconnect from Wires	 Shake Node

DOTS

Add Dot	 Alt + LMB on wire�

Pin/Unpin Dot	 Alt + LMB on dot

TOOLS

Toggle Parameter Pane	 P�

Toggle Tree View	 Shift + W�

Toggle Network Overview	 O

Toggle Color Palette	 C�

Toggle Shape Palette	 S

CLICKS AND DRAGS

Select	 LMB�

Add to Selection	 Shift + LMB�

Remove from Selection	 Ctrl + LMB

Start Wiring from Node	 Alt + LMB

Select Node + Inputs	 Alt + Shift + LMB

Select Node + Output	 Alt + Ctrl + LMB

Select Inputs + Outputs	 Alt + Shift + Ctrl  + LMB

Move Node	 LMB-Drag�

Move Node + Inputs	 Shift + LMB-Drag�

Move Node + Outputs	 Ctrl + LMB-Drag

Copy Selected Nodes	 Alt + LMB-Drag 

Copy Node + Inputs	 Alt + Shift + LMB-Drag

Copy Node + Output	 Alt + Ctrl + LMB-Drag

Reference Copy	 Alt + Shift + Ctrl + LMB-Drag

NAVIGATION

Enter a Node	 Double-click or Enter�
Go up a level	 U�
Radial Menu	 N
Create a Quickmark	 Ctrl + <# 1-5>
Go to a Quickmark	 Shift + <# 1-5>
Go to Previous View	 ` (Backtick)
Select the Node Upstream	 PgUp
Select the Node Downstream	 PgDn
Select Previous Sibling 	 Shift + PgUp
Select Next Sibling 	 Shift + PgDn

ORGANIZE NODES

Lay out all	 L

�Align	 a + LMB-Drag Down/Across 

DISPLAY FLAGS | SOP LEVEL

Render	 T + LMB�
Display	 R + LMB
Template	 E + LMB�
Footprint	 W + LMB

Bypass	 Q or B + LMB




